# Table of Contents

User Guide ................................................................................................................................................ 1

Table of Contents ....................................................................................................................................... iii

1  Introduction ................................................................................................................................... 1

2  Installing and Updating Origin .......................................................................................................... 3

3  Origin Resources ............................................................................................................................ 9

4  OriginPro ..................................................................................................................................... 13

5  What's New in 2021 ...................................................................................................................... 19

6  The Origin Interface ...................................................................................................................... 33

7  Origin File Types ........................................................................................................................... 61

8  Import Data .................................................................................................................................. 63

9  Workbooks Worksheets Columns ................................................................................................... 87

10 Matrix Book Matrix Sheet Matrix Objects ....................................................................................... 125

11 Graphing .................................................................................................................................... 145

12 Customizing Graphs ....................................................................................................................... 191

13 Graphical Exploration of Data ......................................................................................................... 247

14 Gadgets ...................................................................................................................................... 267

15 Data Analysis .............................................................................................................................. 273

16 Statistics ................................................................................................................................... 301

17 How to Handle Repetitive Tasks ...................................................................................................... 313

18 Publishing and Export ................................................................................................................... 333

19 Apps for Origin ............................................................................................................................ 347

20 Programming in Origin .................................................................................................................. 355

21 Customizing Origin ....................................................................................................................... 361

22 Sharing Origin Files ....................................................................................................................... 373

23 Origin Toolbars ............................................................................................................................ 377

Index .............................................................................................................................................. 395
1 Introduction

Welcome, and thank you for using Origin!

Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists and engineers. What sets Origin apart from other applications is the ease with which you can customize and automate your data import, analysis, graphing and reporting tasks.

Customizations can range from simple modifications to a data plot, saved as a graph "template" for later use, to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple files or datasets.

We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your findings. And to help you get the most from Origin, we offer first-class customer and technical support, training and consulting services.

In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing and Image Handling.

The purpose of this guide is to try and present a broad overview of Origin's capabilities. We hope that new users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or two about Origin features that you had overlooked previously.

More detailed information is provided in the Origin Help file (Help:Origin from your Origin software's main menu) and numerous other learning resources exist. For a complete listing of available resources, see the Origin Resources chapter of this guide.

Some things to look for in this guide:

- We have added short tutorials to numerous topics throughout this guide. These short tutorials are intended to give you a quick introduction to a key Origin feature. These tutorials will be marked with this icon.

- Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are marked with this icon.

- Features that are new to this version of Origin will be marked with this icon.

- Important changes to key features and other critical information will be marked with this icon.

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter of this guide.
2 Installing and Updating Origin

2.1 Notes for Upgrade Users

- The Origin upgrade installs into a new program folder - it does not update a previous version. It is therefore not necessary to install or uninstall a previous version of Origin before upgrading.
- If you are upgrading from Origin 2018 or a later version, the process should be pretty painless. Origin 2018 and later versions share a common license file and User Files Folder. The first time you run Origin 2021, it should be licensed and know where your User Files are located.
- If you are upgrading from Origin 2017, you will be prompted to pick a new User Files Folder (see Selecting a User Files Folder, below). If you have custom Origin files from your previous version, you can transfer them to your new User Files Folder. From the Preferences menu, select Transfer User Files. Provided your Maintenance has not expired, you should not have to re-license your software. If your Maintenance has expired, you will need to re-license your Origin 2021 software (See Registering Origin, below).
- If you are upgrading from Origin 2016 or earlier, you will need to complete the license management process. When your upgrade is launched for the first time, a license dialog will display asking for your Product Key. If you have custom Origin files from your previous version, you can transfer them to your new User Files Folder. From the Preferences menu, select Transfer User Files.
- If you have a dongle package, please update your dongle after the Maintenance renewal to make sure your dongle is available for the latest version. Upgrade your dongle by entering a Product Key in the License Activation dialog. Once done, you can use this dongle for Origin installed with the same serial number on any other computers without re-activating the dongle.

Lastly, we want to point out that your Origin software has some great new features. For more information on key features by version, see the originlab.com/VersionComparison page on our website.

2.2 Notes for Administrators of Multi-user Packages

Instructions for getting started with the multi-seat node-locked and concurrent network packages are available on the OriginLab website (originlab.com/GetStarted).

In addition to the InstallShield setup that runs from the Product DVD, an MSI installer and sample transform are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin installation package for distribution. Information on the MSI installer and alternate deployment techniques can be found on our website:

- MSI Installation
- Silent Install
- Building an Installation Package
- Installing Origin on a Remote Access Server such as Windows Terminal Server or Citrix.

2.3 Installing Origin
Origin is a Windows application. You can run Origin on an Intel-based Mac from **Boot Camp** or by running a virtualization software. For more information, see the *Running Origin on Mac using Virtualization Software*, on the OriginLab website.

There are three steps that must be completed to prepare Origin for use:

- **Installation**
- **Selecting a User Files Folder**
- **License management**

Both the Origin upgrade and the newly-purchased products install into a new program folder. Origin does not overwrite previous versions when upgrading, so your old version continues to function. Likewise, your original version does not have to be installed when running the upgrade.

If you are installing from a DVD, the startup program that launches when you insert the Origin DVD, includes an Origin installation button. If the startup program does not automatically run, you can browse the DVD to launch the `setup.exe`.

Please note that **Origin** and **OriginPro 2021** are only available as **64-bit** versions.

### 2.3.1 How to Proceed if You Already Have the Origin Trial Version Installed

If you already have the trial version of Origin installed on your computer, you can convert it to the full product or upgrade.

- If you have purchased the Origin package with node-locked license management, run Origin and select **Help: Convert Trial to Product**; or you can use **Help: Activate License**, click the “Or if you have purchased already” radio button and choose **Activate for this computer**. In either case, you will be asked to enter the **Product Key** that was generated when you registered your software purchase on originlab.com.

- For all other license management packages, run the Origin **Add or Remove Files** program located in the Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the **Modify** option and then select **Install Product** (requires serial number).

### 2.3.2 How to Correct or Change your Serial Number After you Complete an Installation

If you installed Origin with an incorrect serial number, you can correct it by running the Origin **Add or Remove Files** program located in your Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the **Modify** option and then click **Yes** to change your serial number.

### 2.4 Selecting a User Files Folder

Each Windows login user must maintain a **User Files Folder (UFF)** for storing Origin user data:
Installing and Updating Origin

- If you are upgrading from Origin 2018 or later versions, your User Files Folder (UFF) location is unchanged.
- If you are upgrading from Origin 2017 or earlier, you will be prompted to pick a location for a new UFF. You must choose a different path from your old UFF.
- To transfer the contents of your old UFF and your toolbar and workspace configurations to the new UFF, you can run the Origin software and selecting **Preferences: Transfer User Files**. For more information, see Transfer User Files.

**Consider these points in selecting your UFF:**

- If you have a mobile computer, it is best to select a location on your computer rather than on your network.
- For non-mobile computers, you can select a location on the computer or on the network, as long as you have stable access to the folder.
- Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin users, please see the chapter on Sharing Origin Files, later in this Guide.

Each time Origin starts, the program checks to see that your UFF is accessible. If Origin cannot connect to the UFF, you will be prompted to select a new location for the UFF. Note that you can change the location of your UFF at any time while running Origin. From the **Preferences** menu, select **Options** and then click the **System Path** tab.

### 2.5 Licensing Origin

All Origin packages include license management. The type of license management provided with your package is determined at the time of your Origin purchase.

#### 2.5.1 Node-locked

Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website by entering a **Product Key** in the **License Activation** dialog when you start Origin. In-dialog instructions are provided for computers with no internet access.

#### 2.5.2 Concurrent Network

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains a license for this server from the OriginLab website, and then sets up a license service. The license service counts and restricts the number of Origin computers that can run concurrently. For more information, see the Help Center on the OriginLab website (originlab.com/HelpCenter).

#### 2.5.3 Dongle

A dongle (USB hardware key) is provided with the Origin dongle-license package and must be present in the computer's USB port to run Origin. From Origin 2019, dongles are cross-version.

### 2.6 Registering Origin

Registering Origin is required to obtain product support from OriginLab and the team of Origin distributors. Registration also activates Origin's **Check for Updates** menu command (**Help: Check for Updates**), allowing
you to obtain patch and help file updates directly from your Origin software. In addition, Origin's **App Center** dialog, which provides direct access to Apps and App updates from your Origin software, requires that your installation be registered.

For **Node-locked** licenses, registration is completed automatically when you enter a **Product Key** into the License Activation dialog box that opens when you start Origin. To verify that you are registered, select **About Origin** from the **Help** menu. The dialog should display the **Registration ID** that is assigned to your Origin installation.

![Registration ID](image)

For all other license management packages, open Origin, and then select **Register on-line...** from the **Help** menu to open the **Registration** dialog box. Use the Registration dialog to register your Origin installation on the Origin website. During this process, a **Registration ID** is issued. Enter or copy and paste this Registration ID into the Registration dialog to complete the process. The **About Origin** dialog should now display your Registration ID.

### 2.7 Maintenance

Most Origin packages are sold with the first year of **Maintenance** included. Maintenance provides you with free Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting services, and a home-use license.

- To check if your Origin package includes Maintenance, select the **Help** menu and then select **About Origin**. If your package includes Maintenance, the About Origin dialog will show your Maintenance expiration date.
- To learn about the **benefits of Maintenance**, contact OriginLab or your local Origin distributor.
- As your maintenance expiration date approaches, Origin will display a maintenance expiration message with a link to the OriginLab website to learn how to renew your maintenance. This reminder message provides a check box to prevent showing in the future.

### 2.8 Service Releases

When called for, OriginLab publishes free service releases (patches). A service release typically provides bug fixes and may include some minor improvements. All customers are encouraged to apply service releases to ensure that your Origin software performs correctly. To check if a patch is available, select the **Check for Updates** command from the **Help** menu. Patches are also available from the Support area of the OriginLab website ([originlab.com/Support](http://originlab.com/Support)).

### 2.9 Notification of Upgrade

OriginLab regularly releases new versions of Origin, adding features and feature improvements based on customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin version. After a new version release, OriginLab and the team of Origin distributors notify maintenance customers by email. However, to make sure you receive notification of a new version release, please create an account on the OriginLab website ([originlab.com](http://originlab.com)) and select the check box in your user profile to receive "product updates".
2.10 Setting the Origin Display Language

Origin packages sold to organizations in a limited number of countries, including Japan, Germany, Switzerland, Austria, Liechtenstein, and China, may support running Origin with English display, or with Japanese, German or Chinese display. To access this language control, select Change Language from the Help menu.

2.11 System Transfers - Deactivating a License

2.11.1 Node-locked Licenses (Computer ID-based)

A system transfer is required if you plan to replace your licensed Origin computer with a different computer.

- If Origin can still be used on your computer:

Open Origin and then select Deactivate License from the Help menu. After successful deactivation, your Computer ID will be removed from OriginLab’s server so that you can install and activate on another computer.

- If your licensed Origin computer is no longer available:

2. Under Licensing, click the Manage my License(s) link.
3. Click on the Serial Number associated with the license that you want to deactivate.
4. Click the go link in the Deactivation column.

2.11.2 Concurrent Networks

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not required when replacing an Origin computer.

To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available from the Support area of the OriginLab website.

2.12 Uninstalling Origin

To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder, or use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays providing options to Modify, Remove, or Repair. Select the Remove option and complete the wizard as prompted.
The **Remove** program deletes all folders and files that were installed by the Origin setup program. It also deletes folders and keys created by the installer in the Windows registry.
### 3 Origin Resources

The following tables list key Origin resources available to you. If you purchased Origin from a local distributor, your Origin distributor may provide additional resources. Please contact your distributor to learn more.

#### 3.1 Direct Support Resources for Origin

<table>
<thead>
<tr>
<th>Technical Support</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Contact information for OriginLab or your Origin Distributor</td>
<td>originlab.com/Support</td>
</tr>
<tr>
<td></td>
<td>• Report a bug</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Suggest a feature</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chat Online</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Chat online with an OriginLab representative</td>
<td>originlab.com</td>
</tr>
<tr>
<td></td>
<td>... and click Chat Now in the lower-right corner</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Forum</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Share information with and get help from the Origin user community</td>
<td>originlab.com/Forum</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Training and Consulting</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Making optimal use of OriginLab products</td>
<td>originlab.com/Support</td>
</tr>
<tr>
<td></td>
<td>• Help in developing custom tools for your particular application</td>
<td></td>
</tr>
</tbody>
</table>

#### 3.2 Resources Installed with your Origin Software

<table>
<thead>
<tr>
<th>Learning Center</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Load graph samples and analysis samples</td>
<td>Help: Learning Center (or press F11)</td>
</tr>
<tr>
<td></td>
<td>• Transfer User Files when upgrading to the latest version</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Learning Center for direct access to Tutorials, Videos, Origin Blog, User Forum and</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help Files</th>
<th>Help: Check for Updates (to update CHM files)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online or local (CHM) Help for Origin (GUI, Programming)</td>
<td></td>
</tr>
<tr>
<td>Control-by-control explanation of Origin dialog boxes</td>
<td></td>
</tr>
<tr>
<td>The dialog box must be open</td>
<td></td>
</tr>
<tr>
<td>Some dialogs have multiple sections/tabs and you may have to click on that section/tab to set the focus</td>
<td></td>
</tr>
<tr>
<td>Press F1 when the dialog box is open or Click in the upper-right corner of the dialog box</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Context-sensitive Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recent files</td>
</tr>
<tr>
<td>Help with problems or questions that arise while using Origin</td>
</tr>
<tr>
<td>Direct access to Origin features and dialog boxes</td>
</tr>
<tr>
<td>Open or search for Apps relevant to a particular task</td>
</tr>
<tr>
<td>Location of Origin menu commands for searched-for features</td>
</tr>
<tr>
<td>Press F1 when no dialog box is open or Click the Start menu icon at the bottom-left of the workspace. For additional information on using this feature, see The Origin Interface, Start Menu.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start Menu - Windows-like Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recent files</td>
</tr>
<tr>
<td>Help with problems or questions that arise while using Origin</td>
</tr>
<tr>
<td>Direct access to Origin features and dialog boxes</td>
</tr>
<tr>
<td>Open or search for Apps relevant to a particular task</td>
</tr>
<tr>
<td>Location of Origin menu commands for searched-for features</td>
</tr>
<tr>
<td>Press F1 when no dialog box is open or Click the Start menu icon at the bottom-left of the workspace. For additional information on using this feature, see The Origin Interface, Start Menu.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tutorials</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step-by-step instructions on performing many Origin operations, from the simple to the complex</td>
</tr>
<tr>
<td>Help: Origin : Tutorials</td>
</tr>
</tbody>
</table>

### 3.3 Online Resources for Origin

<table>
<thead>
<tr>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td>social media pages.</td>
<td></td>
</tr>
<tr>
<td>Online Documentation</td>
<td>• Product documentation</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Help Center</td>
<td>• Resources list</td>
</tr>
<tr>
<td></td>
<td>• Installation and License Documentation</td>
</tr>
<tr>
<td></td>
<td>• Contact Info</td>
</tr>
<tr>
<td>Video Tutorials</td>
<td>• Help with a range of Origin features including &quot;tips and tricks&quot;</td>
</tr>
<tr>
<td></td>
<td>• Available in playlists and categories</td>
</tr>
<tr>
<td></td>
<td>• Search Origin video or YouTube pages by keyword or type v &lt;key phrase&gt; in the Origin Start menu.</td>
</tr>
<tr>
<td>Webinars</td>
<td>• Live and recorded webinars highlighting key features</td>
</tr>
<tr>
<td>Origin Blog</td>
<td>• Blog posts with plenty of software tips and tricks</td>
</tr>
<tr>
<td>Case Studies</td>
<td>• How others are using Origin in their work</td>
</tr>
<tr>
<td>Graph Gallery</td>
<td>• Outstanding examples of Origin graphs, many of them submitted by the Origin community</td>
</tr>
</tbody>
</table>

Information on key Origin features often can be found by just doing a quick web search. Open a browser and search on phrases such as... "Origin shortcut keys", "LabTalk graph legend", or "OriginC NAG functions".
4  OriginPro

**OriginPro**, the professional version of Origin, provides all of the features of Origin, plus additional analysis tools and capabilities. If you don't know which product you have -- Origin or **OriginPro** -- look to the title bar.

Users of standard Origin will note that some menu commands are marked with `(Pro)`, indicating that the feature is available only in OriginPro. If you own the standard version of Origin, but find that you need features of OriginPro, you can upgrade by contacting your **Origin representative**.

If you wish to continue using standard Origin without seeing `(Pro)` menu commands, click **Preferences: System Variables** and enter the following in the **Set System Variables** dialog box and click **OK** (Comment is optional):

```
<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPM</td>
<td>1</td>
<td>Turns off menu display of (Pro) features</td>
</tr>
</tbody>
</table>
```

**4.1.1 Curve Fitting**

In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the following:

- Linear fitting with X error.
- Nonlinear fitting with X and Y errors (orthogonal regression).
• Fitting with implicit functions (orthogonal distance regression).
• Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two datasets to one model.
• Global fitting of multiple curves using different functions, with the option of sharing parameters.

For more information, see these web pages: Linear and Polynomial Fitting and Nonlinear Fitting.

### 4.1.2 Surface Fitting

With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function.

• Fit worksheet data (XYZ) or matrix data (Z values).
• Locate and fit multiple peaks using one of several peak identification methods.
• Automatic peak parameter initialization.
• Apply constraints and bounds to parameters and fix parameter values.
• Output parameter and statistical results plus residual curves.
• Find specific Z values along the fit surface and include them in your output.
• Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use.

For more information, see this web page: Surface Fitting.

### 4.1.3 Peak Fitting

OriginPro includes the Peak Analyzer tool with support for the following:

• Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative).
• Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined, None).
• Fit Peaks with built-in or user-defined functions.
• Fit individual peaks with different fitting functions.
• Fit Baseline as part of the peak fitting process (user-defined or built-in functions).
• Control fit parameters (fix, share, set bounds).

For more information, see this web page: Peak Fitting.

### 4.1.4 Statistics

OriginPro includes support for advanced statistical analyses in these areas:

• Descriptive statistics (cross-tabulation, distribution fit, correlation coefficient, partial correlation coefficient).
• ANOVA (one-/two-way repeated measures, three-way).
- Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial least squares).
- Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival functions)
- Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one-/two-sample proportion test).
- Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney, two-sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood's median test, Friedman ANOVA, support for simultaneous tests).
- Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test, one-way ANOVA).
- ROC curve analysis.

For more information, see this web page: Statistics.

4.1.5 Signal Processing

In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro:

- Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT).
- Filtering (IIR filter design, 2D FFT filter).
- Correlation (2D correlation).
- Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D wavelet reconstruction).
- Rise-time Gadget (linear search, histogram, largest triangle).
- Decimation (moving average, finite impulse response).
- Coherence.
- Envelope curves (upper and/or lower, smooth during envelope detection).

For more information, see this web page: Signal Processing.

4.1.6 Gadgets

Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a region-of-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets:

- Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and deleting points).
- 2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data).
- Rise-time Gadget (analyze rise/fall time of stepped signals).
For more information, see this web page: [Exploratory Analysis](#).

### 4.1.7 Image Processing

Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional tools in the following areas:

- Image adjustments (function lookup table, leveling).
- Image conversion (dynamic binary, threshold, RGB merge/split, image scale).
- Spatial filters (user filter).
- Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological filter, pixel logic, replace background, subtract background, subtract interpolated background).

For more information, see this web page: [Image Processing](#).

### 4.1.8 Apps

Many add-on Apps are coded to integrate with an OriginPro feature and therefore, they require an OriginPro license to run. OriginPro-only Apps will be listed in the [Origin File Exchange](#) with a red symbol beside them.

Here are some of our more popular [OriginPro Apps](#):

- [Rank Models](#)
- [Peak Deconvolution](#)
- [Design of Experiments](#)
- [Independent Component Analysis](#) (Requires R software)
- [Logistic Regression](#)
- [Sequential Fit](#)
- [Piecewise Fit](#)
- [Piecewise Smooth](#)
- [Principal Component Analysis](#)
- [Principal Component Analysis for Spectroscopy](#)
- [Slope Analyzer](#)
- [Global Peak Fit](#)
- [Cyclic Voltammetry](#)
- [Enzyme Kinetics](#)
- [Polynomial Surface Fit](#)
- [Heat Map with Dendrogram](#)
- [Simple Time Series Analysis](#)
- [Time-Frequency Analysis](#)
- [Monte Carlo Simulation](#)
- [General Linear Regression](#)
• **Chi-Square Test**
• **Sequential Fit**
• **3D Confidence Ellipsoid**

*For general information on Apps visit [www.originlab.com/apps](http://www.originlab.com/apps).*
5 What's New in 2021

5.1 Origin 2021 New Feature Highlights

Visit www.originlab.com For Origin 2021 Feature Highlights, including a Highlights video.

- New Color Manager
  - Manage which color lists and palettes show in Mini Toolbars and other places in the user-interface.
  - Create your own color lists and palettes, including by color-picking and interpolation of colors.
  - Import color lists or palettes, with expanded support for more color formats.

- New Formula Bar
  - Enter formula for the selected cell.
  - Enter formula for selected column or F(x)= cell.
  - Better visibility when editing complex formulas, including font size support.
  - Interactively select cell ranges while editing.
  - Search and insert Origin built-in functions.

- Expanded Embedded Python Support
  - New originpro package for easy, high-level access to Origin objects and data.
  - Use Python functions in Set Column Values dialog.
  - Define nonlinear fitting functions using Python.
  - Python support added to Import Wizard.
  - Access Python functions from LabTalk and Origin C.
  - Sample projects and templates showing use of Python are included in Origin 2021.

- New Mini Toolbars for Quick Editing
  - Tick Label Tables.
  - Tables in Graphs.
  - Date-Time Display in worksheets.
  - Graph Legends.
• Set step-size for Toolbar buttons that increment some property (e.g. font size, rotation angle, etc).

• **New Graph Types**
  
  • Chord Diagram.
  • Lollipop Plot.
  • Polar Vector.
  • Stacked Browser Plot.
  • Plus, Unicode Symbols for Scatter Plots.

**5.2 New Features by Category**

**5.2.1 Import & Export**

• **Data Connector**
  
  • [CSV Connector adds support for .DAT files, including drag-and-drop support](#).
  • CSV Connector support for **Append Rows** by setting wks.DC.flags=256. Once set, data source change or re-import will continue to append rows to existing data.
  • **MATLAB Connector support for opaque variables** (Date, Time, Duration, Table, etc.) in v6/v7 files.
  • **MATLAB Connector support for importing tables from .MAT files**
  • Data Connectors that use a tree framework (MATLAB, JSON, NetCDF, etc.) now support preserving custom name of sheet upon data import.
  • **New TDMS Connector**: Import NI TDMS file using a new Connector App.
  • **New DIFFRAC Connector** App to import Bruker DQL/RAW files.
  • **Data: Connect Multiple Files** dialog (files2dc) now lets you specify all files in a folder as opposed to selecting individual files.
  • Cache control for web-connected data (**Data: Connect to Web**). To limit need for data download, data is cached across sessions (saved with project) for a period that is a function of file size and data age (see `@CFDT`). Cache can be manually cleared by LT command `delete -web "URL"`.
  • **Support Clone Import** for Data Connectors.

**5.2.2 Data Handling**

• **Excel-like Formula Bar**
  
  • Read current cell content. Especially useful for reading long text strings
  • Enter column (**F(x)=**) and cell formulas
What's New in 2020b

- **fx** button to search and insert functions
- Edit mode: hunt to select a column, cell or range of cells
- Font size control using system variable @FBFS
- Toggle view on or off by View: Cell Formula Bar

- **Faster Set Values Function Selection**
  - Speed improvements were made to the Set Column Values Function menu.

### 5.2.3 New Graph Types

- **Lollipop Plot**
  - Specialized scatter plot with drop lines connecting two inline data points.

- **Stack Variant for Browser Graph**
  - Stack plots by Long Name, Units, etc.
  - Select plots on Browser panel will select plots with the same name in each layer.

- **Vector Plots, Polar Coordinates**
  - Polar Vector θr θr.
  - Compass Plot.

- **Chord Diagram**
  - Sankey-like flow diagram on a radial axis.

### 5.2.4 Graphing

- **Install Palettes by Drag-and-Drop**
  - Added palettes are available from applicable color lists (Style toolbar, Fill dialog box, etc).
  - Support for Scribus (.xml), Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch Exchange (.ase) and JASC PaintShopPro (.pal).

- **Custom Colors Improvement**
  - Added “+” symbol to blank custom color well to cue you where to add custom colors.

- **Image Plot Color Improvement**
• You can now customize head and tail colors for image plots.

• **More Output Parameters for Bland-Altman Plot**
  
  • Mean of Pairwise Means
  • Bland-Altman Ratio \(0.5\times(\text{upper LoA} - \text{lower LoA})/\text{Mean of Pairwise Means}\)

• **Improvements to Browser Graph**
  
  • **Add Browser** button for adding Browser panel to 2D graph page, added to Mini Toolbar
  • **Flip Through** function added to menu of Browser panel. Specify Move By to view every Nth plot as a sequence

• **Export Settings Saved to Graph Page**
  
  • Export Graphs **Dialog Theme** menu now has *Save to <Graph>* so that settings can be recalled graph-by-graph.

• **More Display Options for Scientific Notation**
  
  • Addition of **Scientific: 1\times10^3 Display as** drop-down to **Preferences: Options: Axis** tab with spacing options (e.g. 1\times10^3 vs 1 x 10^3)

• **Change of Zero Tick Label Display Defaults**
  
  • **Preferences: Options: Axis** for **No Trailing Zero** and **Zero is '0'** are now OFF (cleared) by default

• **Tick Label Alignment**
  
  • Align labels to the left, right, or center of the tick label block.

• **Radial Rotation of Polar Plot Tick Labels**
  
  • **Perpendicular** and **Parallel** options added to Axis dialog **Tick Labels > Format > Rotate** (deg.)

• **Offset Overlapped Points Vertically or Horizontally**
  
  • **Arrangement** drop-down list added when you enable **Overlapped Points Offset Plotting**, to choose **Vertical** or **Horizontal** offset.
• **Center Layer(s) to Page Button for Mini Toolbar**
  - Button added to the graph page Mini Toolbar for centering all layers on the graph page without changing relative positions.

• **Remove Format Codes from Object Manager**
  - Format codes for special characters (e.g. Unicode) in the plot legend will no longer show in the Object Manager.

• **Layer Background Image Control for Google Maps App**
  - Support drawing background image before layer **Background** (set `layer.bib=1`).
  - Mini Toolbar buttons for layer **Background Color** and **Transparency**.
  - When **Background Color** enabled and `layer.bib=1`, adjust **Transparency** from Mini Toolbar.
  - **Mini Toolbar** buttons also work to set **Background Color** and **Transparency** when no background image exists.

• **Improve Color List Popup GUI**
  - Color List and Palette List popup is now dynamic

• **Support Data Masking in 3D OpenGL Graphs**
  - Mask data points on source worksheet to mask points in the graph

• **Batch Plot Support for Inexact Data Match**
  - When **Batch Plot** with **Book** or **Sheet** and **Exact** is checked, the only matching column, sheet and Modifier will display (same as previous behavior). Only group plots support **Exact**.
  - When **Exact** is cleared, display any book/sheet that matches by at least one column

• **Support Color-blind Safe Colors for Brace Matching**
  - **Formula Bar, Custom Scale** option (**Direct Formula** and **Inverse Formula**), **At Axis Value** for **Reference Lines**, **Scatter Size Formula**.

• **Change Default Plot Mask Mode to Rectangle**
  - Default **mask or unmask mode** changed from row index number to rectangular region.
  - System variable `@MTI` (persistent) added to revert to old behavior.
- **Independent Control of Color Scale Head and Tail**
  
  - Display of color scale head and tail levels can now be controlled independently.

- **Rescale Control for Ternary Plot Axes**
  
  - Can be set to **Fixed**, **Normal**, **Auto**, etc.

- **Improved Handling of Properties When Grouping Plots with Object Manager**
  
  - When you Set as Group Begin/End for plots with different properties (e.g. different color lists), an increment list is created “on the fly.”
  - If all plots share a common property (e.g. same color list), then no incrementing is done (i.e. the current color of each plot is kept).

- **Merge Graph Windows Dialog, Better Labeling**
  
  - The control that opened the **Graph Browser** has been changed for clarity. The same was done for the **Matrix Browser** and **Image Browser**.

- **Specify Unicode Characters for Plot Symbols**
  
  - Enter a code point beside the new **Unicode** check box on the Plot Details **Symbol** tab

- **Scatter Matrix: Separate Bins by Layer**
  
  - New page-level **Layer** tab check boxes for **Independent Layer Control** and **Independent Binning Control**.

- **Better Axis Display in Scatter Matrix**
  
  - Axis scale of the upper-left layer now displays for scatter plots instead of histogram.

- **Improvements to Row-wise Plot**
  
  - Option for Plot Order to follow categorical order of source data.
  - Get filter information from source data.

- **Sankey Node Order New Option**
  
  - Sankey categories are ordered by an algorithm designed to minimize link overlap. A new **Node** tab check box **Order by Data** lets you order categories by list order in the column.
• **Easier Layer Reorder for Double-Y**
  
  • When layers are linked by a common X axis, you can now simply select the "front" layer and push it to the back using Object Manager (OM). Previously, swapping layers in OM would prompt to break layer linking.

5.2.5 **Text and Data Labels, Legends and Graphic Objects**

• **Mini Toolbars for Legends**
  
  • Legend-specific buttons in addition to text formatting.
  • Mini Toolbar for legend symbols.
  • Mini Toolbar for color scale.
  • Mini Toolbar for bubble scale.

• **Improved Rotation of Graphic Objects**
  
  • *Rotate* combo-box added to Properties dialog *Dimension* tab for rotating to a specific angle.
  • Mini Toolbar buttons for rotating clockwise or counter-clockwise in 45 degree increments.

• **Mini Toolbar Button for Applying Formatting to Data Labels**
  
  • Apply formatting to *This Layer, This Window* (Color, Font, Font and Size).

• **More Flexible Labeling of Grouped 3D Plots**
  
  • Specify different label source for each plot.

• **Keywords for Creating Special Points and Labels at Begin/End of Plot**
  
  • Naming a special point as *begin* or *end*; or when labeling, using these keywords to *Show at Specified Points Only*, applies special point or label properties to the point associated with the plot's first or last row index.

• **Shift Key to Limit Movement of Selected Objects**
  
  • Pressing the Shift key while moving a selected object (graph layer, line, text) will limit movement to horizontal or vertical directions.

• **System Variables for Mini Toolbar Increments**
User control for buttons which increment plot properties up or down, by one unit for each click.
Uses a root @INC## with ## options for symbol size, font size, line thickness, etc.

• **Other Mini Toolbar Additions**

  • Button for **Table Row Title at End**.
  • Buttons for configuring **Parallel Plot axes**.
  • Button for **Flip ColorMap**.
  • Button for data label **Leader Lines**.
  • Button to **Wrap Text** in text object.
  • Mini Toolbar for table objects on graphs.

• **Support Legend Substitution in Data Labels**

  • Support for the form `%@(?,@L)` similar to axis titles

**5.2.6 Worksheet and Matrix**

• **Format Data Mini Toolbar**

  • New buttons for setting displayed digits, date and time formats.

• **Column Label Row Mini Toolbar**

  • Buttons for enabling Rich Text, hiding columns, inserting User-parameter rows, changing row order, etc.

• **Change Column/Cell Format on Pasting Date-Time**

  • When copying and pasting date-time from Excel, Origin worksheet cells will be auto-formatted as date-time
  • Insert info variable and select a date from file info list, cell is auto-formatted as date

• **Better Handling of Time Data That Wraps Past Midnight**

  • A new **Fix Time Wrap Around** Mini Toolbar button for incrementing days with time-only data

• **Improvement to Worksheet Transpose Tool**

  • No longer necessary to duplicate `wtranspose` output before using it as analysis input
• **New Color Format for Worksheet Column**
  - Direct entry of HTML color code to set cell background color
  - Use color(A,B,C) to calculate hex values and set colors from RGB values in cols A, B, C
  - Check box in Properties to control display of HTML color codes
  - Mini Toolbar button to set color and **Save as Increment List**
  - **Create Color List from Column** option for **Custom** colors

• **Support HTML Color Code in Colors Popup**
  - Add Custom Colors by pasting an HTML code

• **Save and Load Formula improvements for Set Values**
  - A **Save Formula** button is added to the left of Search and Insert Functions button in Set Values

• **Mask Column Data as Outliers of IQR**
  - New option for **Mask Cells by Condition**

• **Extract Data No Longer Limited to Rectangular Area**
  - In addition to rectangle, matrix image mode supports circle, polygon, region tool, to define region-of-interest.

• **Alt+Enter for New Line**
  - Replaces **Ctrl+Enter** but revert with system variable @FCA=1
  - Also applies to multi-line text in graph and script window

• **Support Undo for Column List View**
  - Users who accidentally shift to **Column List View** by Ctrl+W and who think they may have deleted their data, may try to "undo" (Ctrl+Z) to restore data. Support added for Ctrl+Z to return to standard view.

5.2.7 **Analysis**

• **Improve Handling of NANUM for Moving Functions**
  - Options for movavg, tmovavg, movcoef.
• Omit missing values from calculation (current default).
• Include missing values.
• Omit missing values from calculation but show in output.

• **Improve Operation Lock Tooltip**
  
  • Show better data range information.
  • Change background color for increased visibility.
  • For Set Values operations, show formula, input range and Before Formula Script (if it exists).

• **Average Multiple Curves with Different X Range**
  
  • Add No Extrapolation option when Averaged X = Full X Range, Custom or Follow Curve Trace.

• **Set Sampling Interval on Locked Columns**
  
  • Allow setting a sampling interval (Column: Set Sampling Interval) for columns that show operations locks.

• **Peak Analyzer Default Theme Changes**
  
  • Enable Linear Constraints Status and Constraints are now checked by default.

• **Simplify GCAS Function**
  
  • Eliminate abs() function from GCAS function formula.

• **Improvements to Specifying Analysis Output**
  
  • Clearer labeling and presentation of Range String Builder dialog, plus better context labeling of controls (e.g. "Range String Builder" is now "Custom" (for custom range string) in the Output flyout menu.

• **More Support for Open Book(s), Reprocess, Update Buttons on Summary Sheet**
  
  • Previously, these buttons were only added to the Summary Sheet when Data Source was Import From Files. Now added for use with existing data.

• **Vertical Cursor Supports Horizontal Layer Arrangement**
  
  • A Linked Cursor for Each Layer button is added to track the same X position for all layers
What's New in 2020b

- **Fitting Function Library App**
  - Download fitting functions or share a function with the OriginLab community.

5.2.8 Statistics

- **Statistics on Rows Support for Multi-sheet Input**
  - Data from multiple sheets now accepted for input range.

5.2.9 Miscellaneous

- **New "Social" Menu**
  - Quick access to the OriginLab Forum, Blog, Webinars, YouTube channel, etc.

- **Copy and Paste Notes Windows**
  - Copy and paste the Notes window, in its entirety, to another folder or session.

- **Pre-define System Variables, etc. During Installation**
  - New methods are added for rolling out predefined system variables or for distribution of package files (opx/opk) during Origin software installation.

5.2.10 Programming

- **LabTalk**
  - Excel-like PRODUCT() function
  - Excel-like LET() function
  - **Command Window**: Mouse-wheel zoom, better autocomplete
  - New run -p commands to update pending operations
  - LabTalk access to **Dash Definition** at plot level
  - GetN supports dataset elements
  - LabTalk control of box plots
  - LabTalk support for sorting columns by **Long Name**, etc.
  - LabTalk control of plot label object (layer.plot.label), including show or hide label by row index

- **Python**
• There is a new **originpro** package for Python users. This package works on a higher level, providing easy access to workbooks, matrices, graphs, data frames and NumPy arrays with very little coding.

• Update pre-shipped Python version to **3.8.3**. Remove support for version 2.

• Sample Origin projects have been added to `<Origin Program>\Samples\Python`. Python code is attached to projects as `.py` files.

• Menu access: Open `.py` files directly in Code Builder from **Connectivity** menu by choosing **Open...** or **Open untitled.py**.

• Wrap text in Python Console: Allow wrapping for `dir` command output in Python Console

• Add new function for Python Object to call LabTalk, with a return value. **GetNumProp**, **GetStrProp**, **SetNumProp**, **SetStrProp**, **DoMethod** are added for PyOrigin and OriginExt.

• All pip commands are supported in LabTalk now (e.g. `pip install numpy;`).

• Code Builder **Tools** menu now has a **Python Packages** entry that opens a list of installed packages. Use the dialog to install or uninstall packages.

• Call Python functions from **Origin C**.

• Call Python functions from **Labtalk and Column Formula**.

• Allow immediate print for embedded Python

• LabTalk run command to allow ANSI `.py` file (e.g. `run -pyf test.py`)

• Add three **MatrixLayer** class functions to OriginExt and PyOrigin: **SetShape**(self, nRows, nCols, bKeepData=FALSE), **SetNumMats**(self, nMats), **GetNumMats**(self)

• **COM** improvements to allow calling a named template (workbook, matrixbook, analysis)

• Added **OrglabExt** for better **COM** connection to Origin from external Python

• Added Python Function tab in Set Values dialog.

**Origin C**

• New OC function to download color palette, with option to install: Scribus (.xml) (XML), Office Color Table (.soc) (XML), CorelDraw and Corel PhotoPaint (.xml) (XML), Adobe Color (.aco) (Binary), Adobe Color Table (.act) (Binary), Adobe Swatch Exchange (.ase) (binary), JASC PaintShopPro (.pal) (Text)

**Code Builder**

• Support Visual Studio shortcut keys for common actions (e.g. Ctrl+K, Ctrl+S for Debug: Execute Current Section)

• Support for debug of Python files.

**5.2.11 Apps**

• **Allow Manual Check for New Apps**
What's New in 2020b

- Previously, an automatic check was run on when the App Center was opened. This could delay usage by up to 15 sec. Now, checking is at the user’s discretion, after the App Center is opened.

- **Sort Apps by Most Recently Used**

  - Right-click in the Apps Gallery, Sort Apps > Recently Used.

5.2.11.1 New Apps for Origin 2021

- Neural Network Regression PRO
- Optimization Solver PRO
- Periodic Report PRO
- HTML Table Assistant
- Import PDF Tables
- Taylor Diagram
- Apparent Integration PRO
- Rank Models by Fitted Reports PRO
- Detrended Correspondence Analysis PRO
- 3D Polar Strain Map PRO
- TDMS Connector
- Yokogawa WDF Connector
6 The Origin Interface

6.1 The Origin Workspace

This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim this chapter.

6.1.1 Windows File Explorer Previews

While not part of the Origin interface, you can use Windows File Explorer (previously "Windows Explorer") to preview graphs in a project file.
• Windows Explorer’s **Large** or **Extra large icons** views (right-click in File Explorer and choose **View: Large Icons** or **Extra Large Icons** or select from the Explorer **View** menu) will show an image of the last active graph before the project file was saved.

• Open the **Preview Pane** (**ALT + P**) and scroll through all graphs in the project file.

• If you do NOT wish to save graph previews into the file (either in icon view or in the Explorer Preview Pane), you can set LabTalk system variable @PESS=0 or @PESS=-1. For information on changing the value of a system variable, see FAQ-708 How do I permanently change the value of a system variable?

### 6.1.2 Origin Menus and Menu Commands

• **Context-sensitivity of menu bar and menus**: The menu bar and menu commands are context-sensitive; they change as you change window type (from worksheet to graph to matrix, for instance). Only menus pertinent to the active window will display.

• **Menu bitmaps, toolbar buttons and shortcut keys**: Some menu commands also have bitmaps that display to the left of the command. Additionally, you may see a shortcut key combination listed to the right of a menu command. The button bitmap and the shortcut keys indicate alternate ways to access the same functionality.

• **Shortcut menu commands**: Many commands are available from shortcut menus. To open a shortcut menu, right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent menu commands will show.

• **Collapsible menus**: By default, main and shortcut menus in Origin are “collapsed”, meaning they display an abbreviated set of commands. When you use a menu item which isn’t included, it is added to the
menu. If you prefer to always see full menus, click Preferences: Options > Miscellaneous tab and clear the Enable Collapsible Menus box.

- **Most frequently used analysis menu commands**: Most-recently used menu commands will appear at the bottom of the analysis menus ([Worksheet, Analysis, Statistics, Image], etc.). This gives you quick access to tools when performing repeat operations.

- **Custom Menu Organizer**: Since Origin 8.1, Origin users have been able to use the Custom Menu Organizer to add or remove menu items. To learn more, see the chapter Customizing Origin, later in this Guide.

A new **Social** menu is added for **Origin 2021**. The menu provides quick access to the OriginLab website page with scheduled and recorded **Webinars**, the **Origin Blog**, the **Origin Forum**, OriginLab’s **YouTube** channel of tutorial and highlights videos, and OriginLab **social media pages**.

![Social Menu](image)

### 6.1.3 Origin Toolbars

Use the Customize Toolbar dialog box ([View: Toolbars]) to control toolbar display and reset or reinitialize toolbars.

- **Customize toolbar button appearance**: Use controls on the Options tab of the Customize Toolbars dialog box to modify button and toolbar appearance.

- **Dock/Float a toolbar**: Toolbars can be undocked and made to float on the workspace. To float a toolbar, hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar off of the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title bar.

- **Hide/Show a toolbar**: Clicking the Close button on a toolbar removes the toolbar from view. To restore a hidden toolbar, open the Customize Toolbars dialog box and select the toolbar.

- **Hide/Show a button**: Clicking the tiny arrow at the end of toolbar to turn on/off some buttons on a toolbar.

- **Move button location**: Alt+drag a button to move it to a new location within or among toolbars. Alt+drag to blank workspace to create a new toolbar. Alt+drag a button to child window til X shows to remove a button.
6.1.4 Mini Toolbars

Origin 2020 introduced context-sensitive **Mini Toolbars** for **graph** editing. OriginLab continues to improve Mini Toolbar support for common objects and tasks. Toolbars appear when the user selects an object or when the user clicks in certain key areas inside the page. Available controls depend on context (selected object, window type, etc).

- **When editing graphs,** select an object -- a data plot, a text label -- and a Mini Toolbar with relevant buttons will show. In addition, there are toolbars for page- and layer-level customizations. For more information, see the **Customizing Graphs** chapter.
- **When editing a worksheet,** some toolbar buttons will show when something is selected (e.g. a worksheet column). When you hover near the margins of the worksheet, you may see the mouse cursor change to something like this 🕰️, as a cue to click and perform other sheet-relevant actions. The same cursor will appear when you hover on certain regions in the matrixsheet.

- Most Mini Toolbars have a **Properties** button 🔄 that opens a dialog box to facilitate keyboard input, or to give access to more complex controls.
- If you move away or you do not act quickly enough, a Mini Toolbar will fade away. To restore a Mini Toolbar after it has faded, press the **SHIFT** key.

Customize a Mini Toolbar by clicking on the three dots at the bottom center of the toolbar. This opens the **Customize Mini Toolbar** dialog box where you can enable or disable buttons as needed.
6.1.5 Start Menu

Enter keywords and phrases into the Start menu to return relevant **Menu** entries, **Apps**, **FAQs**, **Videos** and **X-Functions**. Open recently-opened **Files**, **Menus** and **Apps**.

Open the **Start** menu by pressing **F1** (no dialogs open) or by clicking the red Origin icon at the bottom left corner of the Origin workspace.
To narrow your search, type the following letters in front of the search term(s):

- **m** = search only Menu entries
- **a** = search only Apps
- **h** = search only Help + FAQ
- **v** = search only Videos
- **x** = search only X-Functions
- **p** = search your recent projects
- **s** = search sample projects
- **e** = search Menus + Apps + X-Functions (only executable)

Alternately ...

Click the "gear" icon beside the search field to open the **Settings** box. Here you can restrict search results and tweak other search settings.
6.1.6 New Workbook Dialog

The workbook is central to most Origin tasks. It receives imported data, it contains data to be manipulated, plotted or analyzed and it can even be customized for batch analyses or for creating reports in PDF format. Each task often requires a unique set of data handling and format “instructions” -- a custom configuration set up by you, the user. Once so configured, a workbook window can be saved as a template file and reused any time you need to create the same or similar data handling and format instructions.

The primary purpose of the New Workbook dialog box is to help organize and access your workbook templates. Use the dialog to create workbook windows ...

- ... from built-in System Templates.
- ... from your own User Templates.
- ... on the fly, using controls on the Construct Columns tab.
There are two check boxes at the bottom of the dialog:

- **Set as Default Template**: The current default template shows with a green check mark in the upper-left corner of the template. To choose another default template, click on the template, check **Set as Default Template** and click **OK**. The dialog closes and a new instance of the default template is created.

- **Show on startup and new project**: Check this box to show the **New Workbook** dialog each time Origin runs or when closing an open project/opening a new project. If you do clear the box, you can open the dialog at any time by clicking **File: New: Workbook**.

The New Workbook dialog opens, by default, when you run Origin. If you later opt to hide the dialog on startup, you can open it at any time by choosing **File: New: Workbook**.

### 6.1.7 Learning Center

**Learning Center** is a "startup" dialog intended to give you quick access to graphing and analysis examples, plus learning resources (tutorials, videos, the OriginLab blog, etc.).

To open the dialog, choose **Help: Learning Center** or press F11.
• View and load sample graphs, including sample data and notes on re-creating the graph.
• Load analysis samples with data.
• Browse the Learning Resources tab for tutorials and videos and links to the Origin Blog, User Forum and Origin social media pages.
• Move files from your previous User Files Folder to your new User Files Folder.

To see new graphs in Origin 2021, open the Learning Center, click the Graph Samples tab, set the plot filter drop-down to All Plot Types and search on 2021.

6.1.8 Project Explorer

Project Explorer (PE) is a tool to help you organize the contents of your Origin project files (OPJ).
Project Explorer (PE) is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel shows windows contained in the folder that is highlighted in the primary panel.

Prior to 2018, the sub-panel listed sub-folders under the selected folder. If you would like to restore the old behavior, open the Script Window (Window: Script Window), type the following and press <Enter>:

@PEF = 1

To permanently change the behavior, see FAQ-708 How do I permanently change the value of a system variable?

**Using Project Explorer to manage your projects:**

- Right-click the PE title bar or click the drop-down menu to display the panels stacked (Vertical Alignment) or side-by-side (Horizontal Alignment).
- Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on what is selected or where you have right-clicked.
- Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your mouse).
- The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons, Extra Large Icons.
- In any view, mousing over a window icon shows a popup preview of the graph, worksheet, matrix or layout window. Notes window content is shown in a tooltip.
• When displaying windows as **Extra Large Icons**, the PE sub-panel displays a thumbnail of graphs, layout windows, workbooks and matrixbooks. Notes window content is shown in a tooltip.

You can right-click on PE folder (upper panel) and choose **Copy** -- or select the folder and do a **CTRL + C** and **CTRL + V** -- to copy and paste the folder structure and content to (a) another folder in the current project or (b) another project running in a second Origin session. To copy a single workbook window, right-click on the window (lower panel) and copy and then paste the window to (a) another folder in the same project, or (b) to a new project running in a second Origin session.

1. Select **Help: Open Folder: Program Folder**, click the **Samples** subfolder, then drag the file *Tutorial Data.opj* to your Origin workspace.

2. By default, Project Explorer is docked to the left side of the Origin workspace in auto-hide mode. Mouse over the **Project Explorer** tab to show the PE window.
3. Click on the "push pin" icon on the PE title bar to pin the window in the docked position.

4. By default the sub-panel is in Details view. In this view, window metadata such as Name, Size and Comments show below these column headings. Try dragging column headers to reorder them.

5. Right-click on the column headings and show or hide any of the headings by checking or unchecking the box beside each.
6. To add a comment in the **Comments** field, click once, pause briefly and click a second time. This puts you into edit mode. Enter a comment.

7. To change the Name of a window, right-click in the row and choose **Rename**. By default, the **Name** field displays the window **Short Name**; or if a window Long Name exists, the window **Long Name** (all windows must have a Short Name but Long Names are optional). Click the **SN** or **LN** button to the right-side of the editable **Name** field to edit the Short Name or Long Name. If the Long Name does not exist, you can enter one.

8. In the top panel of Project Explorer, scroll to the folder **3D Surface with Point Label** and click on it. The sub-panel shows that there are three windows in the folder. Note that the worksheet window `eastcali3053` is bold indicating that it is the "active" window - the window that is being acted upon as well as the window that determines what operations are available. There is also a Notes window, and a matrix window named `MBook4`. 
9. In the sub-panel, double-click on MBook4 and note that it is now bold and has a magenta "halo", indicating that it is the active window. You will also see that the whole window(in the workspace) displays with a halo which can be customized in color with the system variable @AWC-- another indicator that this is the "active" window. Double-click on this MBook4 icon again and note that the icon is now dimmed. Note also that the actual window disappears from the workspace. This is because MBook4 is now hidden. Double-click the MBook4 icon again and the window is restored and made active.

10. With MBook4 active, click **Plot > 3D: Surface: 3D Colormap**. This creates a 3D colormap surface graph (close the attention message). Note also that a new window -- **Graph1** -- has been added to the sub-panel of Project Explorer.

11. Right-click in an empty portion of the sub-panel and choose **View: Extra Large Icons**. Note that **Graph1** now displays a graph thumbnail.

12. Right-click again and choose **View: Large Icons**. Note that windows are now represented by icons but if you hover on them, you can see the window contents as a pop-up.
To disable PE previews, open the Script Window ([Window: Script Window](#)) and type one or both of the following, then highlight the text and press Enter:

```
@PESS=-1; //turn off window preview in PE, show window comments as tooltip

@PESH=0; //turn off window comments tooltip
```

When you set the value of a system variable using the Script Window, you are altering Origin’s behavior for the current session only. To set the value of a system variable across sessions, see [this FAQ](#).

### 6.1.9 Apps Gallery and App Center

**Apps** are add-on applications for Origin that perform specific graphing and/or analysis tasks. A small number of Apps that are broadly applicable to science and engineering fields are pre-installed with your Origin.
Use the **App Center** dialog for browsing, updating or downloading Origin Apps. This new dialog gives you direct access to all of the Apps on the OriginLab File Exchange without you having to open a browser and navigate there.

To launch the App Center, click the **Add Apps** button that appears on all tabs of the Apps Gallery, docked at the right-side of your Origin workspace. If you do not see the Apps Gallery, click **View: Apps** (or ALT + 9) and verify that there is a check mark beside **Apps**.

- Installed and **Up-to-date Apps** will appear in the App Center with a green check mark beside them.
- Installed Apps for which there is a newer version will appear with an **Update** icon beside them.
- Those not installed will appear with a clickable **Download and Install** icon beside them.

Origin’s **Statistics**, **Analysis: Fitting** and **Analysis: Peaks and Baseline** menus include a **Find Apps** entry. Clicking **Find Apps** opens the App Center to show only Apps that relate to the current menu (e.g. Statistics). You can download or update Apps directly from the App Center.
New Apps and App updates are continually made available to Origin and OriginPro users. Be sure to open your App Center occasionally (press F10) and if it displays the red Download Now button, click to get the latest list of available Apps.

For more information on Apps, please visit www.originlab.com/apps.

6.1.10 Object Manager

The Object Manager is a dockable panel that opens to the right side of the workspace, by default. Use the Object Manager for quick manipulation of the active graph or workbook window.

Graph Windows

- Select an element (layer, plot group, data plot or special point) in the Object Manager to select the corresponding element in the graph window and vice versa. Selection also (a) dims all other plots in the graph layer and (b) selects the source data in the worksheet.

- Hide or show plot elements by clearing or checking the corresponding box in the Object Manager.
- At the graph level, change Object Manager list order.
- At the layer level, change layer order.
- At the plot level, show labels, show or hide plots, reorder plots or create plot groups.
- Within a plot group (labeled as gN), ungroup plots, re-order plots by dragging or by shortcut menu command, change plot type.
• Remove a plot (permanently) from the graph window.
• Access the Plot Details, Layer Contents and Plot Setup dialog boxes.
• Right-click on the layer icon and Reverse Plot Order.

Previously, when the graph legend contained special characters, the associated formatting codes would display alongside the dataset in Object Manager. These format codes have been hidden in Origin 2021, giving the plot list a cleaner look.

**Workbook or Matrix Windows**

The Object Manager also supports certain actions for workbooks and matrices:

• List all sheets in the active workbook or matrix.
• Quickly select multiple sheets by pressing CTRL + Up/Down arrow.
• Click a sheet in Object Manager to activate the corresponding sheet in the workbook or matrix.
• Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add, Move, Copy, and Duplicate.
• Right-click on a matrix or virtual matrix in Object Manager to Rename.

6.1.11 Origin Child Windows
**Active windows** -- the window that will be acted upon by graphing and analysis operations -- display a colored frame to make the active window more obvious. You can customize the active window indicator properties (frame color, where the frame shows, frame line style) with "@ System Variables" @AWC (color) and @AWI (style).

- **Origin Workbooks**: The Origin workbook provides a framework for importing, organizing, analyzing, transforming, and plotting your data. The tabbed workbook contains between 1 and 1,024 sheets. Each sheet may contain more millions of rows and more than 65,000 columns of data. In addition to your data, workbook windows may also store graphs, annotations, column-based functions, scripts and programmable button objects, LabTalk variables and import filters.

- **Origin Matrixbooks**: Like the worksheet, a matrixsheet is a grid of cells, arranged in rows and columns. The primary difference is that in the worksheet, each column is a dataset and each dataset can be configured to contain various types of data (text, text & numeric, numeric (double), numeric (int), etc). In contrast, the matrix is a single, numerical dataset of Z values, related in the XY plane by row (Y) and column (X) index numbers. The matrixbook contains between 1 and 1,024 sheets. Each sheet can contain multiple matrix objects (up to 65,504).

- **Graphs**: The graph window is the primary container for your data plots. Origin supports over 100 chart types, chosen specifically for their applications in various technical fields. Each chart is created using a built-in, user-modifiable graph template that can be saved with your custom settings. In addition to data plots, the graph may also contain annotations (text and drawing objects) or button objects that, when triggered, perform some custom graphing or analysis task. Graph windows can be inserted into worksheet cells or "floated" on worksheets (outside the grid) in a workbook window.

- **Function Graphs**: The function graph is a specialized graph window that displays a curve described by a function. The function graph differs from other Origin graphs in that it is not produced from a dataset of discreet values (though you can generate data after plotting).

- **Layout Pages**: The layout window allows you to combine and arrange graph and worksheet windows and various annotations onto a single "display panel." It is used primarily for creating presentations.

- **Excel workbooks**: Excel workbooks can be opened or created in Origin. Workbooks can be saved separately or as part of your Origin project file.

- **Notes**: The Notes window is a text-only window used for recording analysis procedures, making notes to students and colleagues, and cutting and pasting text from other applications.
To save an Origin child window independently of the Origin project file:

- Select File: Save Window As... to save active window. File extensions OGW(U), OGG(U), OGM(U) are for Origin Workbook, Graph and Matrix windows, respectively.
- Right-click any window title bar and choose Save as... context menu.

Note: To save an Excel window as an external Excel file, right-click the Excel window title in Origin and choose Save Workbook as... context menu.

Origin 2018 added Unicode (UTF-8) support for Origin projects, child windows and templates. When you save a window file, you will have the option of saving a file with or without a "u" appended to the file type (*.opj or *.opju). If you intend to use the file only in the latest version of Origin, you should choose the Unicode-compliant (appended "u") option as it offers some performance advantages.

To open a worksheet, graph, matrix, or notes window that was saved to a file:

- Select File: Open or click the Open button on the Standard toolbar to open window files.
- Select File: Recent Books, File: Recent Graphs to open recently saved workbook and graph window files.

Note: Origin supports window Short Name, Long Name and Comments and the Short Name must be unique in the Origin project. The window Short Name will be renamed if such a name has already exists in the project. If you open window file in the current project, then save the project, the window will be included in the project.

To open an Excel workbook file:

- Select File: Open Excel menu to open a external Excel file. Or, you can click Import Excel button in the Standard toolbar or select Data: Import from File: Excel (XLS, XLSX, XLSM)... from the main menu to import the Excel file.

Note: If you choose Open Excel, the Excel file is opened as an Excel workbook, in an Excel session that runs inside Origin. In this mode, you have only limited access to Origin features. If you choose Import Excel, the Excel file is imported into an Origin workbook and all Origin features are available.

6.1.12 The Command Window and Script Window

The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped
command history that can be carried over from session to session, and intellisense which provides auto-
completion features when writing x-function command.

The Command Window is dockable and has two panels. The left-hand panel displays the command history,
while the right-hand panel provides the command line.

The Script Window provides some of the same functionality as the Command Window. It lacks some of the
Command Window’s features (no intellisense, no command prompt, no command history) but it is handy for
issuing LabTalk commands and running Python scripts. The window’s Tools menu also opens the LabTalk
Variables and Functions dialog box where you can view a list of Origin variables, functions, macros, loose
datasets, etc.

To open the Command Window:

- Click the Command Window button on the Standard toolbar. Alternately, select Window: Command Window menu or press ALT+3.

To open the Script Window:

- Select Window: Script Window menu or press SHIFT+ALT+3.

6.1.13 The Formula Bar

The Formula Bar, new for Origin 2021, is similar to formula bars in OpenOffice and Excel. While it is not necessary to use the Formula Bar to enter cell expressions, it does offer the advantages of function search, interactive range selection and improved visibility of expressions, particularly of long expressions that exceed cell width.

1. With a workbook active, toggle the Formula Bar on or off by clicking View: Formula Bar on the main menu.
2. To change font size, change the value of LabTalk system variable @FBFS (default is "130").

For more information, see the Workbooks, Worksheets and Columns chapter.
In Origin 2021, function brackets in places such as the Formula Bar, Set Column Values, Custom Scale option (Direct Formula and Inverse Formula), At Axis Value for Reference Lines and Scatter Size Formula now use Color-blind safe colors.

6.1.14 The Status Bar

The Status Bar is located at the bottom of the Origin workspace. It reports multiple parameters, including:

- Help messages and tool descriptions.
- Statistics on the current workbook, matrix or graph selection.
- Whether the AutoUpdate analysis feature is turned on.
- The name of the System Theme, if any.
- Information pertinent to the active window.
- Angular unit (radians, degrees, or gradians).
- Tool tips for functions listed in the Set Values $F(x)$ menu.

- **Notifications from OriginLab**, represented by a small red flag to the right side of the Status Bar.

**Note:** You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) items from the context menu. You can copy displayed statistical values by selecting Copy Statistics from the context menu. The copied data are TAB separated between quantity and values, with each key value pair separated by a CRLF delimiter.

6.1.15 Smart Hints and the Smart Hint Log

Smart Hints are triggered by user actions and are intended to give the user help with current task. These hints may appear briefly inside a dialog box, as in this example.
Alternately, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example.

Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking the "Do not show this message in the future" box at the bottom of a Smart Hint.

Hints are logged for the current Origin session and can be reviewed by clicking the Smart Hint Log tab, docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged).

To open (and close) the Smart Hint Log window:

1. From the Origin menu, select View: Smart Hint Log or press ALT+7.

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the Smart Hint Log window and check Do not show this hint again from the context menu. A message asks you to confirm that you do not want to show or log this message.

To turn off all Smart Hint display in the session, open the Script Window and type the following:

```@SHS = 0;```
To turn on Smart Hint display (including those were individually hidden), type @SHS = 1, and click Help: Reactivate All Hints.

You can customize general properties of Smart Hints by setting system variables @SHG and @SHO. See the system variable list for details.

When you set the value of a system variable using the Script Window, you are altering Origin’s behavior for the current session only. To set the value of a system variable across sessions, see this FAQ.

6.1.16 Code Builder

Origin integrated development environment (IDE) is called Code Builder. Code Builder provides tools for writing, compiling, and debugging your Origin C functions. Additionally, it can be used for running and debugging Python code.

To open Code Builder:

1. From the Origin menu, select View: Code Builder or click the Code Builder button on the Standard toolbar or press ALT+4.
2. Code Builder can also be opened by clicking Connectivity: Open untitled.py. In this mode, you can paste and run Python code by pressing CTRL + F5.

Origin 2021 improvements:

- Support Visual Studio shortcut keys for common actions (e.g. Ctrl+K, Ctrl+S to Debug-Execute Current Section).
- Support for debug of Python files.

6.1.17 Messages Log

The Messages Log window shows messages about operations including Output Information, Results and Errors. It displays messages that are not sent to the Script Window or the Command Window.

To open (and close) the Messages Log window:

1. From the Origin menu, select View: Messages Log or press ALT+6.

6.1.18 Results Log

Origin automatically types many analysis and fitting results to the Results Log. Each entry in the Results Log includes a date/time stamp, a window name, a numeric stamp which is the Julian day (see Dates below), the type of analysis performed, and the results.
In most cases, when results are reported to the **Results Log**, it opens automatically. Manually open (or close) the Results Log by doing one of the following:

1. Click the **Results Log** button on the Standard toolbar. Alternately, from the Origin menu, select **View: Results Log** or press ALT+2.

Right-click in the Results Log to open a shortcut menu with commands to **Copy**, **Print**, **Clear**, and **View Results**.

### 6.1.19 Float, Dock and Auto-Hide Windows

There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows include **Project Explorer**, **Results Log**, **Command Window** and **Messages Log**. This allows you to customize your Origin workspace so as to maximize utility and save screen space.

### 6.2 Numbers in Origin

- **Displayed vs. Actual Cell Value**: When you import or type your data into a workbook or matrixbook, Origin uses a combination of user-specified settings to determine how to display the data in each cell. What displays is a visual representation of the data value. The actual data values are stored with the full precision allowed by the dataset's Data Type (see table below). When you perform calculations, it is the actual data values that are used and not the displayed values.

- **When Contents Exceed Cell Width**: Prior to Origin 2020b, if the sequence of characters in a sheet cell exceeded what could be displayed at the current cell (column) width, Origin represented cell contents as a series of pound signs (**#####**). This has changed to mimic MS Excel's worksheet behavior:
  - Text strings will not trigger display of pound signs **#####** regardless of column width. To view the full string, you must increase column width.
  - Numeric values that exceed column width will first be rounded to the nearest decimal and only if that is not sufficient to display the full integer value, will pound signs **#####** display in place of the numeric value.
  - This rounding of numeric values affects the displayed value only. The internally-stored value does not change.
  - To restore the old behavior of displaying pound signs **#####** whenever cell contents were not fully displayed, set system variable **@WPE = 1**. For information on changing the value of a system variable, see [this FAQ](https://www.originlab.com/support/faq).

- **Missing Values in the Worksheet**: When spreadsheet programs first appeared it was recognized that there was a need for a special number that was "not a number" which would - when used in a calculation - generate itself. Origin has such a number and its internal value is **-1.23456789E-300**. Because Origin recognizes this value as a special value, it can be used to enter a missing value into a worksheet or matrix and it can be used in calculations or scripts (for instance, to return a missing value unless some condition
is met). Origin displays missing values in a worksheet or matrixsheet as "--". However, you shouldn’t confuse this display (output) with what you enter as a missing value (input).

- **Decimal, Scientific and Engineering Notation:** You can display workbook or matrixbook data in **Decimal:1000, Scientific:1E3, Engineering:1k, and Decimal:1,000 notations.** You can manually choose from these data display options but you can also pre-define thresholds for automatic display of scientific notation. By default, these thresholds are set to 6 (upper) and -3 (lower).

- **Dates and Times in Origin:** Origin's long-time mathematical system for dates and time is based on Astronomical Julian Day Numbers, with a 12 hour offset. This system defines January 1, -4712 (January 1, 4713 BCE), 12 hours Greenwich Mean Time as zero. Recently, two alternate time systems were added: (1) a true Julian Date value (0 is at noon instead of the following midnight) and (2) a "2018" system in which 0 is defined as 00:00 on January 1, 2018. The 2018 system supports greater precision when, for instance, importing data with the Import Wizard (e.g. **Custom Date Format** supports "MM'/'dd'/'yyyy HH':'mm':'ss'.'######"). Previously, precision was limited to 0.0001 seconds. For more information, see [Dates and Times in Origin](#).

**Note:** For more information on numbers, see [Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in Origin](#).

Origin workbooks and matrixbooks support the following **Data Types:**

<table>
<thead>
<tr>
<th>Workbook</th>
<th>Matrixbook</th>
<th>Bytes</th>
<th>Range of Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>double</td>
<td>double</td>
<td>8</td>
<td>±1.7E±308 (15 digits)</td>
</tr>
<tr>
<td>real</td>
<td>float</td>
<td>4</td>
<td>±3.4E±38 (7 digits)</td>
</tr>
<tr>
<td>short</td>
<td>short</td>
<td>2</td>
<td>-32,768 to 32,767</td>
</tr>
<tr>
<td>long</td>
<td>int</td>
<td>4</td>
<td>-2,147,483,648 to 2,147,483,647</td>
</tr>
<tr>
<td>char</td>
<td>char</td>
<td>1</td>
<td>-128 to 127</td>
</tr>
<tr>
<td>byte</td>
<td>char, unsigned</td>
<td>1</td>
<td>0 to 255</td>
</tr>
<tr>
<td>ushort</td>
<td>short, unsigned</td>
<td>2</td>
<td>0 to 65,535</td>
</tr>
<tr>
<td>ulong</td>
<td>int, unsigned</td>
<td>4</td>
<td>0 to 4,294,967,295</td>
</tr>
<tr>
<td>complex</td>
<td>complex</td>
<td>16</td>
<td>±1.7E±308 (15 digits), each 8 bytes</td>
</tr>
</tbody>
</table>
### 6.3 Topics for Further Reading

- Project Explorer
- The Object Manager
- Finding Data in your Origin Project
- Basic Child Window Operations
- Numbers in Origin
- Dates and Times in Origin
- FAQ: How do I turn off the collapsible menus and show full menus?
- Customizing Toolbars
- Setting Your Preferences
- The Numeric Format Tab of Preferences: Options
7 Origin File Types

7.1 Roundup of Origin File Types

A series of Unicode-compliant (UTF-8) file types was added for Origin 2018. Upgrade users may recognize that some of the old familiar file types now have a Unicode counterpart, denoted by an appended ‘u’ (e.g. *.opj => *.opju). Origin versions 2018 and later will read and write the older, non-Unicode file types. As the default is to save to the newer Unicode-type files, be sure to set the Save as type drop-down if you need to save to an older file type.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extension</th>
<th>Used As</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin Project Files</td>
<td>*.opj(u)</td>
<td>A container for all data.</td>
</tr>
<tr>
<td>Child Window Files</td>
<td><em>.ogw(u);</em>.ogg(u);<em>.ogm(u);</em>.txt</td>
<td>The child windows for workbooks (.ogw(u)), graph (.ogg(u)), matrix(.ogm(u)), notes (.txt).</td>
</tr>
<tr>
<td>Template Files</td>
<td><em>.otp(u);</em>.otw(u);*.otm(u)</td>
<td>A stored customizable suite of data-handling and format options: graphs(.otp(u)), worksheets (.otw(u)), matrix(.otm(u)).</td>
</tr>
<tr>
<td>Theme Files</td>
<td><em>.oth;</em>.ois;<em>.odt;</em>.ofp;</td>
<td>A saved suite of user-defined settings with multiple applications in Origin. A *.oth file applies to a graph, worksheet, matrixsheet or report table; A *.ois applies to analyses and dialogs; A *.odt applies to dialogs; A *.ofp applies to function plots.</td>
</tr>
<tr>
<td>Import Filter Files</td>
<td>*.oif</td>
<td>An external file which handles basic import file parsing and data extraction.</td>
</tr>
<tr>
<td>Fitting Function Files</td>
<td>*.fdf</td>
<td>A fitting function definition file.</td>
</tr>
<tr>
<td>LabTalk Script Files</td>
<td>*.ogs</td>
<td>A text file organized in sections of LabTalk script.</td>
</tr>
<tr>
<td>Origin C Files</td>
<td><em>.c;</em>.cpp;*.h;etc</td>
<td>A file used for developing Origin C programs.</td>
</tr>
<tr>
<td>X-Function Files</td>
<td><em>.oxf;</em>.xfc;</td>
<td>An Origin tool with a flexible mechanism for performing a wide variety of data manipulation</td>
</tr>
</tbody>
</table>
### Origin Package Files
- **Files**: *.opx
- **Description**: A package file created for distributing custom applications.

### Origin Menu Files
- **Files**: *.xml;*omc;
- **Description**: A file that contains Origin menu information. An *.xml can be edited outside of Origin for menu customization purposes. An *.omc file contains the configuration of customized menus.

### Initialization Files
- **Files**: *.ini
- **Description**: A file that controls the configuration of some Origin features on startup.

### Configuration Files
- **Files**: *.cnf
- **Description**: A text file that contains LabTalk script commands.

### Custom Plot Symbols
- **Files**: origin.uds
- **Description**: A binary file that holds the bitmap images of custom symbols.

## 7.2 Topics for Further Reading

- [Opening, Closing and Backing Up the Origin Project File](#)
- [Protecting Origin Projects](#)
- [Origin Template Files](#)
- [The Theme Organizer](#)
- [System Themes](#)
- [Import Wizard, Save Filters Page](#)
- [Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder](#)
- [OGS Files and Getting Started with LabTalk](#)
- [Running LabTalk Script from OGS Files](#)
- [Using X-Functions in LabTalk](#)
- [Packaging Multiple Files as an OPX File](#)
8 Import Data

A new generalized data import mechanism we call **Data Connectors** was added in Origin 2019b. As the name implies, Data Connectors create a link between your project and an external source file. The source file may be local, it can be on a company network; it can even be on a web-server. Data Connectors support options for excluding imported data when saving the project (smaller files, plus, maintain a live link to source data) and for protection of data against accidental alteration or deletion. Data Connectors also make possible import of previously-unavailable data sources, including **HTML Tables** and **JavaScript Object Notation (JSON)**. Data Connectors support **drag-and-drop** and **Auto Import on Project Open**. In addition, OriginLab continues to expand Connector support to new data formats. In Origin 2021, for instance, we have added new Connectors for **National Instruments TDMS** and **Bruker DQL/RAW** files.

**Other supported import mechanisms:**

- OriginLab continues support for Origin’s long-standing **X-Function + filter-based routines** for ASCII, CSV, Excel, binary files, and many third-party formats, including MATLAB, pClamp, NI TDM and NetCDF. If you are a long-time user and you have import filters and Themes that you have long relied on, they should still work as they always have.
- **Copy-paste** for quick import of simply-structured data (mostly useful for quickly adding data to worksheets).
- For complex ASCII, binary or User-defined file types, you can use the graphical interface of the **Import Wizard** to parse your file and save settings to an import filter file. The Import Wizard supports power features such as saving file metadata to variables and use of custom Origin C functions for data processing and import.
- If you work with **SQL** databases, you can use Origin’s **Database Connector** and **SQL Editor** interface to create connection strings and SQL queries.
8.1 A Note to Upgrade Users

Longtime Origin users who are upgrading from older versions should note that import routines have moved from the File menu to a new Data menu. Here, you will also find the new Data Connectors.

8.2 Data Connectors

Data Connectors are a general mechanism for importing data to your Origin projects from local or from web-based files and pages. Data Connectors support a number of common data formats, including:

- XML
- Text/CSV
- Excel
- HTML Table
- JavaScript Object Notation (JSON)
• **Origin File** (project, workbook, matrix)
• **MATLAB** (v7 .mat files)

To connect to SQL database, see **Database**.

**To import data with a Data Connector:**

1. With your workbook active, click the **Data** menu.
   - If you are connecting to a local or network file, click **Connect to File** and pick a file type.
   - To connect to multiple files, click **Connect Multiple Files**.
   - If you are connecting to web data, click **Connect to Web** and enter a URL.

**Data: Connect Multiple Files** now lets you pick **Files in a Specified Folder**, as opposed to having to select individual files.

8.2.1 **Things to Know about Data Connectors**

• By default, when import data file size exceeds 500kB, the imported data and graphs made from that data are NOT saved with the Origin file (see LabTalk system variable @FSE). All analysis output resulting from imported data ARE saved with the Origin file. Not saving raw data with your project file can significantly reduce file size and improve performance when working with large projects.

• **IMPORTANT**: Since, by default, connector-imported data is not saved with the project file, users should always ask themselves whether they need to preserve imported data. This is particularly true if the data source is web-based and stored in a place beyond your control. If you prefer to save all data imported via a Data Connector, with your Origin file, click the Data Connector icon and clear the check mark beside **Exclude Imported When Saving** prior to saving your file. Note that each Data Connector-containing book will have its own **Exclude...** check mark. Alternately, if you decide the Data Connectors are not needed, you can click the Data Connector icon and choose **Remove Data Connector** (from this book) or **Remove Data Connectors from All Books** (in the project).

• Data can be re-imported at any time by clicking the Data Connector icon ( or ) in the upper left corner of the workbook and choosing **Import (Ctrl+4)** or **Import All**.

• By default, imported via a Data Connector is locked from editing. You can graph it and analyze it but you cannot modify it. While this ensures against accidental modification, some users may find this too restrictive. See this FAQ for information on removing editing restrictions from Connector-imported data.

• A workbook can have only one type of Connector (e.g. Text/CSV). For files with a simple structure such as Text/CSV, you may have multiple sheets connecting to multiple files as long as they are of the same type.
For local Excel files with multiple sheets and MATLAB files containing multiple variables, you can connect to one sheet/variable, then use the Data Navigator’s Add and Connect Sheet(s) shortcut menu command to add other sheets/variables in the file, one-by-one. You can only connect a single Excel or MATLAB file to a single Origin workbook or matrixbook.

- Connectors to web files (Data: Connect to Web) do not support the Data Navigator panel.
- If you right-click on a sheet tab and add a new sheet, the sheet is added with an empty Connector. The unconnected state is denoted by a pale-yellow Connector icon. Click on the Connector icon to open a shortcut menu where you can connect the sheet to a data source.

- Data Connectors that you do not use can be hidden by choosing Data: Connect to File: Customize... and clearing the checkbox next to unused Connectors.
- Data Connectors for formats not shipped with Origin, are available by clicking Data: Connect to File: Add New.... New Data Connectors are added to the Data menu.
Note: The Data Connector icon appears in four states:

- When the data source is viable, whether data have been imported or not, the icon looks like this:

- When a data file that was previously imported via Connect to File is modified, the next time you open the Origin file, the icon will look like this:

- When a new sheet is added to a Data Connector-containing book, an empty Connector is added to the sheet. When the Connector is empty, the icon looks like this:

- When the data source is no longer viable (e.g. the data source has been deleted or renamed), the icon looks like this:

*Origin caches data imported by Data: Connect to Web, for a period of time determined by LabTalk system variable @CFDT, plus file size. By default, a 10MB file will use cached data for ~24 hrs. In other words, if you re-import (i.e. reconnect to the web file) within 24 hrs, you will be using data that was cached on first import. If you re-import to this 10MB file after 24 hrs passes, the cache is cleared and the data are freshly imported. To learn how to control this caching behavior see, these topics:

- LabTalk system variable @CFDT.
- The LabTalk delete -web command.

8.2.2 Data Source File Path

Data Connectors require a viable connection to the source data; if a file is renamed or deleted, the Connector will be broken and upon re-opening your project, you will see the red Connector icon.
In any state, you can click the Connector icon, then use the **Data Source File Path** and **Common Data Path** to help you maintain the connection between your Origin files and your source data.

- **Relative to Project Path**: If your data are stored in folders under the project file, you could set Data Source File Path to **Relative to Project path**. You can then move the project and data sources together, and their relative paths are preserved. No path corrections are then needed when re-opening the project file from a different location on your network.

- **Relative to Common Data Path**: If data sources are under some common path, you could set Data Source File Path to **Relative to Common Data Path**. If the files are subsequently moved, you can re-establish the **Common Data Path** and then **Import All Books**.

### 8.2.3 Data Navigator

The **Data Navigator** is a collapsible panel that is automatically added to the workbook when you connect to locally-stored, multi-page/multi-variable files such as Excel, MATLAB or Origin Projects.
Origin will import data from the first sheet and list other sheets in dimmed type.

- Right-click on a dimmed sheet -- or press CTRL or SHIFT and select multiple sheets -- then choose **Add and Connect Sheets**.
- The file name is assigned to the book **Long Name** and sheets are the original sheet name is assigned to **sheet Name**.
- Connected sheets can be deleted from the current Origin workbook.

### 8.2.4 Data Connectors and Drag-and-Drop

**Origin 2021** includes better drag-and-drop support for DAT file types when no import filter is specified. Previously, this would trigger a prompt to open the Import Wizard. Now, the file is imported using a Connector.

There is drag-and-drop support for the file types listed under **Data: Connect to File**. If you are using an older import filter for drag-and-drop import (see below), Origin will give priority to that filter as long as it is saved to the template, to the data folder or to the User Files\Filters folder (see this FAQ).

Note, however, that Data Connectors offer some advantages for drag-and-drop such as automatic column formatting of date-time data in CSV files and automatic import of MATLAB variables to Origin matrix objects and the addition of a slider control for viewing images in sequence.

For more information, see these topics:

- FAQ-412 How do I customize Drag-and-Drop for various import file types?

### 8.3 Text/CSV Import
ASCII files such as TXT, CSV and DAT can be imported by Data Connect to File or the older Data: Import from File methods. Data Connector import of CSV is easier, particularly when the file contains date-time data as date-time columns are automatically set to date-time Format. More details on filter-based ASCII import methods are covered below.

- The Text/CSV Connector (Data: Connect to File: Text/CSV) is supported by multi-threading.
- For large files, there is a checkbox to Import first 50 lines as preview.
- You can define a Data Block Marker (e.g. [Data], >>>Start<<<<, etc.) to mark the start and end of the data portion of your file that you wish to import.
- When you opt for partial file import, both Data: Connect to File and Data: Import from File share a flexible syntax for defining only those rows and columns that you wish to import. There is in-dialog assistance (expand the Partial Import branch) or you can visit this page in the Origin Help file.

**To import locally-stored Text or Comma-Separated (CSV) data:**

1. Choose Data: Connect to File: Text/CSV.

or

1. Choose Data: Import From File: Comma Delimited (CSV)...

**To import web-stored CSV data:**

1. Choose Data: Connect to Web, set File Type to Text/CSV (helpful for filtering URLs by file type) and either (a) click on Recent URL and pick from the list or (b) paste a copied link into the URL box.

![Recent URLs](image)

You can use the CSV Import Options dialog to specify a partial import of web-stored files just as you can for locally-stored files. Check the Partial Import box for guidance on the syntax used to define Column and Row import.

**8.4 Excel**

There are five basic options for working with Excel data in Origin:

- You can copy Excel data to the Clipboard and paste or paste link that data into Origin.
- You can import a local Excel file by clicking **Data: Import From File** (or click the button located in the **Standard** toolbar).
- You can use a **Data Connector** to import a local Excel file by clicking **Data: Connect to File: Excel** or by dropping your Excel file onto the Origin workspace.
- You can use a **Data Connector** to import Excel data from the web by clicking **Data: Connect to Web: Excel** (see below).
- You can also open your Excel workbook in Origin as an Excel workbook (must have MS Excel installed). To do this, use the **File: Open Excel...** menu command.

When you paste or import your Excel workbook data into an Origin workbook (including import by Data Connector), you have full access to Origin's powerful graphing and analysis features. When you open your Excel workbook as an Excel workbook, you are actually running an OLE instance of Excel inside of the Origin workspace. In this case, you have access to Excel's menus and features, but very limited access to Origin's graphing and analysis features. For most users, choosing one of the Excel import options (first four options) will be preferable to opening the Excel workbook in Origin as an Excel workbook.

**Things to know:**

- To open an Excel file in Origin as an Excel workbook, you need to have Office 97 or later installed on your computer. However, you can import an Excel file into Origin without having Excel installed.
- Origin imports files of type .xls, .xlsx or .xlsm.
- You can link your Origin project file to an external Excel file. That way, updates to the Excel file will trigger updates to dependent graphs etc. when you open the Origin project file.
- Origin does not support dynamically linking a formula in an Excel workbook to source data in another Excel workbook.
- Certain file import information is saved to the workbook on import. Having once imported an Excel file to an Origin workbook, you can use the **Re-import** feature to re-import an updated Excel file -- including those that contains multiple sheets -- to your Origin workbook.

**Note:** To learn more about working with Excel data, see the Origin Help:

**Help: Origin: Origin Help > Working with Microsoft Excel**

You can do partial import of your Excel data by delineating one or more row and column ranges. A flexible syntax is provided for including or excluding data ranges. For information, choose **Data: Import From File: Excel (XLS, XLSX, XLSM)**, check **Show Options Dialog** and choose a file for import. In the **ImpMSExcel** dialog, expand the **Partial Import** branch and note the in-dialog syntax hints under **Custom**.

### 8.4.1 Connecting to Excel Files

Click **Data: Connect to File** or **Connect to Web** to connect to local or web-stored Excel files.

- You can only connect one Excel file per Origin workbook.
• If the file is a multi-sheet file, you must first connect to a single sheet. This opens the Data Navigator panel (described above) where you can connect to additional pages, as needed.
• If all sheets are identically structured, taking the time to setup the connection to the first sheet, will allow you to easily connect additional sheets.

### 8.5 Connecting to MATLAB Files

While Origin continues to support older [X-Function based MAT file import](#), Data Connectors offer some distinct advantages for import of both locally-stored and web-stored MATLAB files:

- Connecting to a MATLAB file at the root level will add all variables as Origin matrix objects in the matrixsheet.
- A slider is added so that you can flip through Origin matrix objects in the sheet. You can toggle between slider and thumbnails using the **Slider or Thumbnails** Mini Toolbar button.
• The Connector also adds a collapsible Data Navigator panel to the window. If you wish to add variables as individual sheets, you can right-click on the Data Navigator list and add them.

**Origin 2021** includes these improvements to the MATLAB Connector:

- Support for opaque variables (Date, Time, Duration, Table, etc.) in v6/v7 files.
- Support for importing tables from .MAT files.

### 8.6 Import from File > ASCII

**Data Connectors** can handle import of ASCII file types, but some users may be invested in the older import methods (e.g. you use an import filter to import data and have no need for protecting data). In such cases, you may choose to import data using the **Data: Import From File** menu commands.

The **Data: Import From File: Single ASCII...** and **Data: Import From File: Multiple ASCII...** methods are generally satisfactory for importing text files having a simple structure. These methods are also accessible from the and buttons located in the **Standard** toolbar. These methods will typically handle files with commonly-used delimiters and a simple header structure, without adjustments.

If a file imports with only minor complications, select the **Show Options Dialog** checkbox when selecting your files in the **ASCII** dialog (**Data: Import From File: Single ASCII...** and **Data: Import From File: Multiple ASCII...**). This will open the **impASC** dialog box prior to file import, allowing you to tweak the way that the files are handled.
Once you've adjusted import settings, you can save them in one of two ways: (1) with the worksheet template (including saving for drag-and-drop) or (2) as a Theme file from within the impASC dialog box. Saving import settings with the worksheet template offers portability (e.g. templates are easily shared with colleagues). Saving import settings as a Theme offers the advantage of being able to recall any number of import options combinations when importing via the impASC dialog box.

For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide. Additionally, see topics listed under “Topics for Further Reading”, below.

**Note:** For a more in-depth discussion of simple ASCII import, see the help topic:

*Help: Origin: Origin Help > Importing and Exporting Data > Importing Simple ASCII Data Files*

For import of complex ASCII files -- those not satisfactorily handled by the methods previously mentioned -- you can use the interactive Origin Import Wizard (Data: Import From File: Import Wizard...). The Wizard is also accessible from the button located in the Standard toolbar. Apart from its advantages for import of complex files, the Wizard also offers the following:

- Using wildcards, you can create import filters that are targeted to a group of similarly-named data files. This filter can then be used for drag-and-drop import operations: When you drop the appropriate files onto the workspace, Origin looks at the file name, matches it with the correct custom import filter and imports the file according to your specifications.
- Import data from the web pages using the Clipboard.
- Extract variables from the import file name and header.
- Specify custom delimiters and date formats to parse your data.
- The ability to post-process your imported data using a custom LabTalk script.

**Note:** For more information, view the help topic:
Tutorial: Importing Multiple Files into Worksheets

1. Click on the New Workbook button on the Standard toolbar to open a new workbook.

2. With the new workbook active, click on the Import Multiple ASCII button on the same toolbar. This opens the ASCII dialog.

3. In the ASCII dialog, browse to the \Samples\Curve Fitting subfolder of your Origin Program Folder and select the files Sensor01.dat, Sensor02.dat, and Sensor03.dat. Click the Add File(s) button and then check the Show Options Dialog check box and press OK.

4. In the impASC dialog box, under the Import Options node change Multi-File (except 1st) Import Mode to Start New Sheets. Expand the Rename Sheets and Books node and clear Rename Book with (Partial) Filename.

5. Press the arrow button at the top right of the dialog box, then select Save As... from the shortcut menu. In the dialog box that opens, enter a name such as Import to sheets and press OK. This will save your settings as a Theme that you can later use with other files.

6. Press OK to close the impASC dialog.

The three files will be imported, each into a worksheet, and the sheets will be renamed with the file name.
You can quickly load your custom import theme from the list at the bottom of the **Data** menu. You can also use the **Data: Import from File: Add/Remove File Types** menu to open the **Import Menu Customization** dialog box where you can select and add **User Themes** to the **Data: Import From File** menu.

### 8.7 Third Party Formats

**Origin 2021** adds a couple of new Connectors for import of third-party files:

- New **TDMS Connector** for import of National Instruments **TDMS** files.
- New **DIFFRAC Connector** for Import of Bruker **DQL/RAW** files.

Origin imports many widely-used third party data formats, including pClamp, NI TDM, and NetCDF. As with ASCII import, you can customize third-party file import options and save your settings with the worksheet template or as a dialog Theme for later use.

As with other supported file types, you can import third party files by drag-and-drop.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Method</th>
<th>To Learn More, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermo (SPC, CGM)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pCLAMP (ABF, DAT, AB?)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Princeton Instruments (SPE)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound (WAV)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetCDF (NC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CDF (CDF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDF5 (HS, HE, HDF5)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NI DIAdem (DAT)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NI TDM (TDM, TDMS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Famos (DAT, RAW)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETAS INCA MDF (DAT, MDF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IgorPro (PXF, IBW)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prism (PZFX, XML)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MATLAB (Mat)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minitab (MTW, MPJ)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KaleidaGraph (QDA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SigmaPlot (JNB)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MZXML (mzData, mzXML, mzML, imzML)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EarthProbe (BPA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDF (EDF, BDF, REC, HYP)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Somat SIE (SIE)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JCAMP-DX (DX, DX1, JDX, JCM)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HEKA (DAT)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPSS (SAV)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BRUKER OPUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAS (sas7bdat)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tektronix (ISF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Translation (DCF, HPF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Binary 2D Array (IMG, B2D)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data: Import from File:</td>
<td></td>
<td>&gt; Importing Third Party Files</td>
</tr>
</tbody>
</table>

Help: Origin: Origin Help > Importing and Exporting Data
**Note:** Some of these 3rd party file formats are hidden by default. To add, choose **Data: Import From File: Add/Remove File Types**. This opens the **Import Menu Customization** dialog box where you can choose which file types to show in the **Import From File** menu. To insert a separator after a menu command, right-click on the command in the right-hand panel and choose **Add Separator**. To remove a separator, double-click on it in the right-hand panel.

Drag-and-drop support is managed by file extension, using the **Filter Manager** dialog. From the main menu, click **Preferences: Import Filters Manager**.

---

### 8.8 Binary Import

Files with an optional header section followed by a sequential binary structure, can be imported using the Origin Import Wizard (**Data: Import From File: Import Wizard**).

If the binary file format is commonly used in your field of work, please contact your Origin representative so we can consider adding support for such files in future versions.

### 8.9 Copy/Paste the Clipboard Data

One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook. However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your data into Origin. Here are some things you should know:

- Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the number of displayed decimal digits in Excel.
- When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin (not into the column label rows), then select a row and use the (right-click) shortcut key commands **Set as Long Name**, **Set as Units**, **Set as Comment**, etc. to tag your header information.
- Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the **Import Wizard**. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added benefit that you can save your procedure to an import filter file (.oif) for reuse with identically formatted data. For more information, see the tutorial **Using the Import Wizard to Import Clipboard Data**.
8.10 Selectively Import Data by Querying an Origin File

You can selectively import columns of data from an external Origin file by specifying an SQL-like Query in the Data Connector Browser prior to import.
To selectively query Origin files using the Origin Connector:

1. With the worksheet active, choose Data: Connect to File or Connect to Web.
2. Browse to your Origin file and click Open. This opens the Data Connector Browser.
3. Click the Select Query button.
4. Enter your Query in the Select Query dialog, then click OK.

Data will be selectively imported into the active workbook as specified by your query.

**Common Keywords:**

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_SName</td>
<td>short name, e.g. _SName, Sheet_SName</td>
</tr>
<tr>
<td>_LName</td>
<td>long name, e.g. _LName, Book_LName</td>
</tr>
<tr>
<td>_Comments</td>
<td>comments, e.g. _Comments, Sheet_Comments</td>
</tr>
<tr>
<td>Column_D1</td>
<td>column user-defined parameter, where 1 is the parameter index</td>
</tr>
<tr>
<td>Column_[Name]</td>
<td>column user-defined parameter, where [Name] is a parameter name containing spaces</td>
</tr>
</tbody>
</table>

**Examples:**

Select Column from Project where _SName == "A";

Select Column from Project where _Comments like "S*3";

Select Column from Project where (Column_P1 like "*y*" and Column_D1 > 3);

Select Column from Project where Sheet_SName like "Trial*";

Select Column from Project where (Book_SName like "Book*" or Book_LName like "*fit*")

*For more information, see* [Examples of using SQL query condition in Origin Connector](#).

### 8.11 Database

Origin supports connecting to databases by ODBC and OLE DB. Additionally, Origin includes a simple SQL Editor to add connection strings and generate SQL queries within Origin.

To import SQL data, start with the **Data: Connect to Database** menu command:

- **Open** lets you browse for and open a saved connection (ODS) or query (ODQ) file.
- **New** opens the **Database Connector** dialog.
- **Connection string**: Select this if you already have a text-based connection string for a given data source (ODBC or OLE DB).
- **ODBC data source**: Select this if you have defined an ODBC data source via the Windows ODBC Data Source Administrator applet.
- **ODBC driver**: Select this if you have an ODBC driver and want to create a data source applicable to this data connector instance.
- **Windows Data Link Properties dialog**: Select this if you are using an OLE DB-based data source such as some SQL Server or Access client libraries.

**Other things to note:**

- Use the LabTalk system variable `@IPDB` to control protection of imported range (0 = no protection, 1 = protected but allow reorder, 2 = protected).
- Similar to other Connectors, you can opt to **Exclude Imported (data) When Saving** as OPJU/OGWU.
8.12 Digitizer

At times, you may only have a graphic representation of some data that you would like to explore further. In such cases, Origin’s Digitizer tool may prove handy. Use the Digitizer to import an image file, then digitize the plots, converting your image to numeric data that you can study and re-plot using Origin’s analysis and graphing tools.

- Import most common image formats.
- Rotate the imported image, remove noise and calibrate scales by picking start and end values.
- Pick points on curves manually or automatically.
- Manually add curve inflection points, as needed.
- Interactively remove points that you do not want digitized.
- Support for Cartesian, polar and ternary coordinate systems.

To open the Digitizer:
1. Click the Digitize Image button on the Standard toolbar or choose Tools: Digitizer... from the main menu.

### 8.13 Saving Origin Files without Imported Data

Users have long had the option of saving Origin files without data. Save Template As..., Save Workbook As Analysis Template and Save Project without Data, were three options for saving Origin files without data while preserving settings and operations with the file.

Users now have the option to save Origin files without imported data. This is a particularly attractive option for those who work with large data files, where saving of that data with the file would hinder performance or waste disk space.

- By default, data imported using a Data Connector, will not be saved with the book when the import file size exceeds 500kB. Each book has its own Exclude Imported When Saving check mark and clearing the check mark on any page in the book will cause all imported data to be saved with the book.

- Any book in the project -- not only those with Data Connectors -- can be configured to exclude imported data by right-clicking on the window title bar, selecting Properties, then checking the Exclude imported data when saving project box at the bottom of the dialog.
The act of excluding data when saving differs from saving a template file in a couple of important ways:

- When you exclude imported data, you are still saving all output resulting from analysis operations on imported data -- fitting results, statistical analyses, Set Values calculations, etc. -- you just don’t save imported data or graphs of that imported data.
- Books which you have saved without imported data retain a "live" link to the original data source. For Data Connector-containing books, click the Data Connector icon and click Import (active sheet) or Import All (all sheets in book). For books used for standard file import, activate the empty book and click Data: Re-import Directly; or click the Re-Import no dialog button on the Import toolbar (see next).

### 8.14 Re-Importing Data Files

There are two import commands in the Data menu that are specifically intended for repeat import of the same file (i.e. the file path and name must be the same):

- **Re-Import Directly.** When you import a file into an Origin worksheet or matrixsheet, by default a number of parameters, including file path and name, are saved in the sheet. If you have an external data file that is periodically updated or you want to reload a standard file into the worksheet, you can re-import directly without opening an import dialog.

- **Re-Import...** This menu command opens the corresponding X-Function import dialog box for the file type so that you can adjust your import options before re-importing.

### Notes:

- Only one file can be re-imported at a time. When you use either of these two menu commands, only the file associated with the active worksheet or matrixsheet, will be imported. If the selected data are imported from multiple files, re-importing will fail.
- If you import an ASCII file via the Import Wizard and select Data: Re-Import..., the Import Single ASCII dialog will open instead of the Import Wizard.
- Re-import does not work for Binary or User Defined data types brought in using the Import
8.15 Clone Import

Clone import works by "modeling" an import -- and optionally, an associated analysis operation -- and then applying what was done to the initial file, to a series of similar files. As long as the active book contains imported data and associated operations, it can be cloned. In this sense, cloning is similar to creation of an Analysis Template but is somewhat more limited in power (e.g. cannot be used with the Batch Process tool).

Clone Import gets Data Connector support in Origin 2021.

Clone import is supported by both Data Connector and X-Function-based import methods. A brief tutorial will show you the basics of cloning import and analysis operations.

1. Click the New Workbook button to open a new workbook.
2. Using Window's File Explorer, browse to your <Origin Program>\Samples\Curve Fitting folder and find a file called Sensor01.dat. Drag-and-drop the file onto the new workbook. The .dat file is imported using the Text/CSV Connector.
3. Click the column B header to select the column, then click the Scatter button to create a scatter plot.
4. Click on the X or Y graph axis scale and in the Axis dialog box that opens, click the Scale tab, then press Ctrl and select both Horizontal and Vertical axis icons in the left panel. Set Rescale to Auto and click OK.
5. With the graph active, click Analysis: Fitting: Linear Fit and open the dialog box. Set Recalculate = Auto, accept other default settings and click OK. Answer No to the Reminder Message and click OK.
6. Right-click on one of your workbook tabs and click Add Graph as Sheet. This will add your scatter plot with the linear fit results, as a page in your workbook.
7. Make sure the sheet with data imported from Sensor01.dat is active and click the Clone Import button on the Import toolbar.
8. Browse, once again, to your <Origin Program>\Samples\Curve Fitting folder, press Ctrl or Shift and select files Sensor02.dat - Sensor07.dat. Click Add Files and then click OK. What you should see is that using the original book as a model for import and analysis operations, the Sensor files are imported using the Text/CSV Connector and, one-by-one, they are processed (it may take a few seconds for all operations to go to completion).

8.16 Topics for Further Reading

- Importing Simple ASCII Data Files
- Customizing the ASCII Import Options
- Import and Reimport Excel Data
- Importing Third Party Files
- Data Connectors
- Importing Data by Drag-and-Drop
- Tutorial: Updating Graphs by Re-importing Data from a Database
- Importing Data from a Database
- Drawing or Deleting Data Points
- Tutorial: The Digitizer
9  Workbooks Worksheets Columns

9.1  Workbook, Worksheet and Column Basics

The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing, organizing, analyzing, transforming, plotting and presenting your data. Each workbook is a collection of one or more worksheets. Each worksheet contains a collection of columns and each column contains rows of cells.
Beginning with **Origin 2021**, use Alt+Enter for line breaks when entering multi-line text into the worksheet cell. To revert to using Ctrl+Enter to insert a line break, set `@FCA=1`.

### 9.1.1 Naming Workbooks, Worksheets and Columns

**Workbooks**

- A Workbook has a **Short Name** and an optional **Long Name** and **Comments**. Origin uses the **Short Name** for internal operations.
- **Short Name** must be unique within the project file, can contain only alphanumeric characters (letters and numbers), must begin with a letter and are limited to 13 characters.
- A Workbook **Long Name** is optional, need not be unique within the project file, can use any characters in any order and has a limit of 5,506 characters.
<table>
<thead>
<tr>
<th>Workbooks Worksheets Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>(including spaces).</td>
</tr>
<tr>
<td>• To name a workbook, right-click on the window title bar and choose Properties. Here you can edit Long name, Short name and Comments. Use the Window Title drop-down to control which name(s) show on the window title bar.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Worksheets</th>
</tr>
</thead>
<tbody>
<tr>
<td>• A Worksheet has a Name and optional Label and Comments.</td>
</tr>
<tr>
<td>• The Name must be unique within a workbook.</td>
</tr>
</tbody>
</table>
| • A Worksheet Name has a 64 character limit, including spaces. These special characters are not allowed: {}|"<>![].
| • Worksheet Label and Comment are optional. They need not be unique within the project file, can use any characters in any order, and can be of any practical length. |
| • To name a worksheet, double-click on the sheet tab, or right-click on the tab and choose Name and Comments. More details are listed under Worksheets, below. |

<table>
<thead>
<tr>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>• A Column has a Short Name and an optional Long Name.</td>
</tr>
<tr>
<td>• The Short Name must be unique within the worksheet. When spreadsheet cell notation is enabled (default setting), you cannot edit the column Short Name (see Column Short Name Restriction). When cell notation is disabled, you can edit the column Short Name. When editing Short Names note that they must use only alphanumeric characters (no special characters), must begin with a letter or number, and cannot exceed 18 characters.</td>
</tr>
<tr>
<td>• A Column Long Name is optional, need not be unique within the project file, can use any characters in any order and has a limit of 30,000 characters. The Long Name can be edited directly by clicking in the Long Name cell or by right-clicking on the column header and choosing Properties from the shortcut menu.</td>
</tr>
<tr>
<td>• Dialog box and Status Bar references to data range will use Long Names, provided that (1) Long Name exists and (2) you have selected Use Long Names when available (Preferences: Options: Miscellaneous). Otherwise, Short Names are used.</td>
</tr>
</tbody>
</table>

### 9.1.2 Workbooks

By default, when you start an Origin session or open a new project, You are presented with the New Workbook dialog box.
If you click the OK button, the dialog box closes and, simultaneously, a new workbook window based on the Default Template is added to the workspace. This workbook will be the same one that is added to the workspace when you click the New Workbook button on the Standard toolbar. Each time you click this button, a copy of this template is added to the workspace. There is much more to say about templates. To read further, begin by looking over the section below on Workbook Templates.

By default, an added workbook window is assigned a Short Name of BookN, with N reflecting the order of window creation. You can rename the workbook with something more meaningful:

1. Right-click on the workbook window title bar and choose Properties....
2. Give your workbook a Long Name (optional) and/or a Short Name and choose to display either or Both in the window title bar. See the above table for rules on workbook naming.

The Properties dialog has a Comments box for entering text. These Comments display as a workbook window tooltip in Project Explorer and become searchable when using the Edit: Find in Project tool.

9.1.2.1 Spreadsheet Cell Notation (SCN)

Origin workbooks support Spreadsheet Cell Notation (SCN). Spreadsheet Cell Notation allows the sort of cell-level calculations that are familiar to users of spreadsheets (more details below).
Starting with Origin 2019b, SCN remains ON by default for all new workbooks but the SCN icon has been removed.

- By default, SCN is ON for all new workbooks.
- In Origin 2017 - 2019, when SCN was enabled in the workbook, you saw this icon in the upper-left corner of the worksheet, signaling that SCN was turned on.
- Beginning with Origin 2019b, the SCN icon is hidden (by default) but SCN remains enabled (also by default) to make room on the workbook window for the Data Connector icon.
- Most users will want to leave SCN enabled but in rare cases (e.g. you need to customize the column Short Name), you may want to turn SCN off. To disable SCN, right-click on the workbook title bar and choose Properties. Look for the Spreadsheet Cell Notation check box about half-way down the page.
- When SCN is turned off, you see this icon in the upper-left corner of the workbook.
- If you open a project or workbook window in Origin and SCN is turned OFF in a particular workbook, the SCN OFF button will display in the upper-left corner. This includes projects or workbooks that were created prior to Origin 2017. To enable SCN, right-click on the book title bar, choose Properties and check the Spreadsheet Cell Notation check box.

9.1.3 Worksheets

Prior to Origin 2018, an Origin workbook could contain a maximum of 255 worksheets. That number is now increased to 1024. When you have more than 255 sheets in a book, you will need to save your file to one of the Unicode-compliant formats (opju, oggu, otwu).

To add worksheets to the workbook, right-click on a worksheet's tab and choose one of the following:

- **Insert.** Inserts a single worksheet ahead of the active sheet.
- **Add.** Appends a single worksheet.
- **Duplicate Without Data.** Duplicates the active worksheet without duplicating the data.
- **Duplicate.** Duplicates the active sheet, including the data.

Each sheet in a workbook can have its own set of customizations. When you **Insert** or **Add** a worksheet, the new sheet is based on the ORIGIN.otwu file, specifically the version of ORIGIN.otwu that is saved to your User Files Folder (found in UFF if you have customized this file). To add a sheet that is based on another sheet in the workbook (including number of columns and special formatting), you would use the **Duplicate** or **Duplicate Without Data** shortcut command.

A sheet has a single **Name** which can contain spaces and special characters. Optionally, you can add a **Label** and/or a **Comment**.

To edit the sheet Name

1. Double-click on the sheet tab and enter a **Name**. Alternately, right-click on the sheet tab, choose **Name and Comments** and edit the **Name** field.
System variable @SSL can be used to modify sheet naming behavior. Look for @SSL in the LabTalk System Variable List.

When mousing over the worksheet tab, Name, Label and Comments appear as a tooltip.

9.1.3.1 Worksheet Properties

To open the Worksheet Properties dialog

1. Right-click in the gray area to the right of the worksheet grid (but inside the workbook window) and choose Properties.

You can use the Worksheet Properties dialog box to customize properties of the sheet, including...

- Display of row labels, header labels and grid lines (View tab).
- The number or rows and columns and other sheet dimensions such as column or row header height (Size tab).
- Enabling of rich text, text wrap, how to display truncated cell content, sheet font and color (Format tab).
- Auto add rows, ignore hidden rows in plotting and analysis, cell resizing (Miscellaneous tab).
- Printing/exporting of grid lines, headers and footers, background color (Print/Export tab).
- Script to run after import or upon data change (Script tab).
- Display and edit a user tree (e.g. the user adds some configuration info for use in the template) (User Tree tab).

Note that many of the sheet customizations can be applied at the cell level by right-clicking on a selected cell and choosing Format Cells.

For more information, see The Worksheet Properties dialog box.

9.1.3.2 Manipulating Sheets with Object Manager

Use the Object Manager’s shortcut menu commands to manipulate display of workbook content:

- List all sheets in the active workbook.
- Click a sheet in Object Manager to activate the corresponding sheet in the workbook.
- Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add, Move, Copy, and Rename.
Press CTRL + Up/Down arrow to select multiple sheets in workbooks. Also works for matrixbooks.

### 9.1.4 Worksheet Columns

- **To add a new column** to the right end of an existing worksheet, right-click in the gray area to the right of the worksheet columns and choose *Add New Column* or click the *Add New Column* button on the *Standard* toolbar.

- **To add multiple columns** to the worksheet, make the worksheet active then choose *Column: Add New Columns...* from the main menu. Specify the number of columns to add in the *Add New Columns* dialog box and click OK; or use the *Format: Worksheet...* menu item or the F4 hot key to open the *Worksheet Properties* dialog, then set the desired value for *Column Number* in the *Size* tab.

- **To insert a column** into the worksheet, highlight a column, then right-click and choose Insert. A column is inserted ahead of the selected column and column Short Names are adjusted accordingly.

*Worksheet columns can be renamed by:*

- Double-clicking on the column heading opens the *Column Properties* dialog box. Enter/edit *Short Name* and/or *Long Name*.
- Type a *Long Name* directly into the worksheet header cell by double-clicking in the cell.
- Import a data file and specify that the workbooks, worksheets, and columns be named upon import.
• Use the **Enumerate Labels** tab of the **Worksheet Properties** dialog to enumerate or duplicate column names and labels.

• Type names into a few columns (e.g. **Peak 1** and **Peak 2**), then highlight the cells and drag the bottom-right corner of the selection to auto fill and enumerate the names for other columns. This also works for other column label rows such as Comments.

See the above table for rules on worksheet column naming.

### 9.1.4.1 The Column Properties Dialog Box

The **Column Properties** dialog box is used to customize properties of the column including...

- **Long Name, Short Name, Units, Comments, etc.**
- **Format** (Numeric, Text, Time, Date, etc.).
- **Plot Designation**.

To open the ""Column Properties"" dialog box:

1. Double-click on the column header.
2. Right-click the selected column(s) and choose **Properties**....

Use the **Properties** tab to edit the column **Short Name**, if desired. Other properties -- **Long Name, Units** and **Comments** -- can be edited here or entered directly into the column label row cells.

### 9.1.4.2 Formatting Worksheet Data

Data in the Origin worksheet is treated as either **text** or **numeric** data. While the display of text data in the worksheet is fairly straightforward, the display of numeric data is more complicated.

Unless otherwise specified, all numbers in the worksheet are stored internally as floating point, double precision (**Double(8)**) numbers. This includes date and time, data which is formatted to display in degrees-minutes-seconds or numbers that are formatted to display a fixed number of decimal digits.

When dealing with numeric data, understand that what you see in the worksheet is a **representation** of a number that is stored internally. This is important for two reasons:

- Calculations involving worksheet values are always done on the double-precision number that is stored internally, not the value that is displayed in the worksheet.
- You can apply various **Format** and **Display** options to change the way that this stored number displays in the worksheet.

Origin supports custom formatting of worksheet data, to include date-time, percentages, degrees-minutes-seconds and hexadecimal numbers. For more information, see the table under **Other Custom Display Formats**, below.
Origin 2021 adds new **Mini Toolbar** buttons for modifying Display of numeric and date-time data. Note that the **Format** of selected columns must first be set as **Date** or **Numeric/Text & Numeric** for these buttons to be visible.

### 9.1.4.2.1 Numeric Display Formats

1. Double-click on a column heading to open the **Column Properties** dialog.
2. Click the **Properties** tab, then set **Format** = **Numeric**.
3. Set **Display** to **Decimal**: 1000, **Scientific**: 1E3, **Engineering**: 1K, **Decimal**: 1,000 or **Custom** (see below).

### 9.1.4.2.2 Date and Time Formats

By default, Origin stores date-time data as a modified Julian Day value and it uses this number for date-time calculations. Typically, however, you will prefer to display this Julian Day value in a more meaningful date-time format:

1. Double-click on a column heading to open the **Column Properties** dialog.
2. Click the **Properties** tab, then set **Format** = **Time**, **Date**, **Month** or **Day of Week**.
3. Set the **Display** list to one of the listed options.
4. If none of the listed options are appropriate you can choose **Custom Display** and construct your own custom date-time string using these date-time format specifiers.

When importing date-time data into the worksheet, Origin will sometimes treat this data as text (**Origin's CSV Connector** generally does a better job of recognizing date-time data). If your date-time data are left-aligned in the worksheet cell, Origin "sees" it as text. You will need to open the **Column Properties** dialog box and choose your **Format** and **Display** options. When you see that your date-time data are right-aligned in the cell, you know that Origin "sees" the data as numeric data, displaying in a date-time format.
Origin 2021 now automatically sets column or cell Format = Date in these cases:

- Previously, date-time data copied and pasted from Excel was right-aligned in the Origin worksheet, giving the impression that the data was properly formatted in Origin as Date even though it remained formatted as Text & Numeric.
- When inserting “info” variables of dates created on file import, into a worksheet cell.

Origin 2021 also does a better job of wrapping “time-only” data that goes past midnight by adding a Fix Time Wrap Around button to the Mini Toolbar when a Format = Time column is selected. Clicking the button will prompt the user to add a day component to the time value.

9.1.4.2.3 Color Format

Origin 2021 includes an all-new column and cell Format ↔ Color.
Setting a column **Format = Color** allows you to do a number of things:

- Supports direct entry of HTML color codes into the worksheet cell to set cell background color, with the option to display or hide the HTML codes in the **Color** cell.
- Use the `color()` function to calculate hex values and set colors from RGB values in other data columns using **Set Column Values** or **cell formula** (e.g. `color(A,B,C)` sets color using RGB values in columns A, B and C).
- Select a column in which **Format = Color** and use a **Mini Toolbar** button to **Save as Increment List** for use in your graphs.
- Alternately, from the **Custom** colors menu in the **Color Chooser**, choose **Create Color List from Column** and pick a **Color** worksheet column from the flyout.

9.1.4.2.4 Other Custom Display Formats

Origin can display numeric values in the worksheet in a variety of custom formats. This illustration shows various formats applied to the same set of numeric values (column **A(X)**).
The following is a sample listing of some supported custom format options (this just happens to be the pre-populated list that ships with Origin 2019). Note that you can enter custom formats directly into the **Custom Display** list and they will be saved to this list.

There are many other format options. For more information, see [Custom Numeric Formats](#).

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
<th>Example if cell value = 123.456</th>
</tr>
</thead>
<tbody>
<tr>
<td>*n</td>
<td>Display n significant digits.</td>
<td>*3 displays 123</td>
</tr>
<tr>
<td>.n</td>
<td>Display n decimal places.</td>
<td>.4 displays 123.4560</td>
</tr>
<tr>
<td>S.n</td>
<td>Display n decimal places, in scientific notation of the form 1E3.</td>
<td>S.4 displays 1.23456E+02</td>
</tr>
<tr>
<td>E.n</td>
<td>Display n decimal places, in engineering format.</td>
<td>E.2 displays 123.46</td>
</tr>
<tr>
<td>* &quot;pi&quot;</td>
<td>Display a number as a decimal, followed by the symbol π.</td>
<td>* &quot;pi&quot; displays 39.29727π</td>
</tr>
<tr>
<td>#/4 &quot;pi&quot;</td>
<td>Display a number as a fraction of π, with a denominator of &quot;4&quot;.</td>
<td>#/4 &quot;pi&quot; displays 157π/4</td>
</tr>
<tr>
<td>#/&quot;pi&quot;</td>
<td>Display a number as a fraction of π.</td>
<td>#/&quot;pi&quot; displays 275π/7</td>
</tr>
<tr>
<td>##+##</td>
<td>Display a number as two digits, a &quot;+&quot; separator, then two digits (e.g. surveying stations).</td>
<td>##+## displays 01+23</td>
</tr>
</tbody>
</table>
### 9.1.5 Column Label Rows

Column label rows store metadata — data that is used to describe other data. Typically, this metadata may be brought in as header information in imported files, or it may be manually entered. Display of column label rows is optional and the user can selectively show them or hide them, as needed.
Column label row information is often used in plotting operations (e.g. worksheet Long Names used as graph legend text or Axis titles). The $F(x) =$ row is used in performing math operations on columns of data (see below). Data stored in User-defined Parameter rows might be used in labeling or grouping of datasets in plotting, data manipulation, statistical analysis or math operations (see Tutorial 2, below).

![Book1 - automobile.dat](image)

You can copy a selected subrange of worksheet cells and include associated column label row information with the copy-paste operation. To copy label rows with data cells, right click on your subrange selection and choose Copy (including label rows).

9.1.5.1 Managing Display of Column Label Rows

Display (showing or hiding) of column label rows is controlled by shortcut menu commands:
1. Right-click here and choose View from the shortcut menu.
2. Right-click here and choose Edit Column Label Rows or other label row command.
3. Right-click here to control worksheet elements (display Row Label, Column Header, etc) or select a cell in this area, then right-click to Set Comments Style.

There is a new worksheet column label row Mini Toolbar for Origin 2021. Use it to do such things as hiding selected label rows, enabling Rich Text and changing row order.

9.1.5.2 Column List View

Origin 2019 introduced a new view mode for the worksheet called Column List View that is a transposed view of the column label row metadata. This view is potentially useful if your worksheets have many rows of metadata and you want to focus on some particular aspect of that metadata. With the worksheet active, choose View: Column List View or press Ctrl + W.
Users who accidentally shift to **Column List View** by Ctrl + W and who assume they have deleted their data, may try to “undo” to restore data. Therefore, support was added for returning to standard view using Ctrl + Z.

Further, you can apply a **data filter** to metadata in Column List View. When you return to the standard worksheet view (clear the mark beside View: **Column List View**), only data associated with the filtered metadata will show in the worksheet.

Column List View displays column index number ahead of column short name (+ column designation). In addition, you can hover on the left edge of column long name and a tooltip reports dataset size. To disable the display of column index, set @DSI=1.

### 9.1.5.3 Sparklines

Numeric data stored in a column will graphically display in the column header in a special label row called **Sparklines**. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent variable (Y) against the row number or the associated X column as independent variable (X). When importing data, Origin displays sparklines by default when the number of columns is less than 50.
To Show or Hide Sparklines:

- Show Sparklines by clicking **Column: Add or Update Sparklines**. This opens the sparklines dialog.
- Show Sparklines for selected columns by clicking the **Add Sparklines** button on the **Column** toolbar.
- Right-click on the worksheet’s **Sparklines** column label row and choose **Add or Update Sparklines**.
- Delete sparklines by right-clicking the **Sparklines** column label row and pressing the Delete key.
- In addition to the default line plot, Sparklines can display as Histogram or Box Charts. Highlight one or more columns by clicking on the column header, then choose **Column: Add or Update Sparklines**. In the dialog box that opens, set the **Plot Type** to **Histogram** or **Box**.

- Sparkline plot properties can be customized. Double-clicking on a sparkline pops open a graph window. Double-clicking on the pop-up window opens the Plot Details dialog box where you can customize the plot. When you close the pop-up window, your customizations are applied to sparkline.

### 9.1.6 The Workbook Organizer

As mentioned, the workbook commonly stores metadata, some of which is visible in the column label rows. Other metadata may be hidden in the workbook. Such hidden metadata might include things like import file path and name, date and time of data import, file header information not written to the column label rows, variable names and values, etc. This hidden metadata can be viewed in the **Workbook Organizer** panel.
To show a workbook's Organizer panel right-click on the workbook title bar and select Show Organizer (note that this action toggles the panel on or off). The Organizer provides a tree-view listing of metadata stored with a particular workbook.

9.1.7 Managing Workbooks with Mini Toolbars

A number of common book-, sheet- and column-level properties can be set or toggled ON/OFF with a Mini Toolbar button.

9.1.8 Some Workbook, Worksheet and Column Limits

<table>
<thead>
<tr>
<th>Maximum Number of...</th>
<th>32Bit OS</th>
<th>64Bit OS</th>
</tr>
</thead>
</table>

104
9.2 Workbook Templates

When you start an Origin session or open a new project, you are presented with the New Workbook dialog box. The dialog has three tabs -- System Templates, User Templates and Construct Columns:

- The **System Templates** tab lists built-in templates supplied by OriginLab.
- The **User Templates** tab lists your custom templates, with filters for Analysis Templates (*.OGWU + saved operations), workbook Templates (*.OTWU) and Workbook Files (*.OGWU).
- The **Construct Columns** tab has controls for constructing a workbook from pre-designated columns, by specifying a sequence of letters and numbers (in-dialog examples are given).

The default template is a simple, one sheet, two-column workbook created from the default ORIGIN.otwu workbook template, and located on the System Templates tab.
• Whether you keep this as your default template, or designate another default template on either the System or User Templates tabs, the default will be the template that opens when you click the New Workbook button on the Standard toolbar.

• When the New Workbook dialog is open, you can double-click on any template in the System or User Templates tabs, to open a window that is built from that template.

• To designate a template on either the System or User Templates tabs as the default template, (1) click once on the template to select it, (2) check the Set as Default Template box and (3) click OK to close the dialog box.

For more information on use of the New Workbook dialog box, see the New Workbook dialog box.

You can modify any file in the New Workbook dialog -- System Templates or User Templates -- and save your changes. When you modify System Templates and save, the modified file is written to your User Files Folder (you cannot overwrite the original system file) and the modified file then displays on the User Templates tab.

9.2.1 Saving a Modified Template

There are several types of files listed on the System Templates tab of the New Workbook dialog box:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description of File</th>
</tr>
</thead>
</table>


## Template
- These are of the basic Origin workbook template file type. They contain **no data and no analysis operations**.
- To save a modified Template, choose **File: Save Template As**. Specify a name, file path and optionally, a description\(^1\) and/or a preview image\(^2\).

## Workbook
- This type of file differs from a Template in that it **can be saved with data and operations**.
- To save a modified Workbook, choose **File: Save Window As**. Specify a file path, name and optionally, a comment\(^1\) and and/or a preview image\(^2\).

## Analysis Template
- This type of file saves **no data** but it **MUST store analysis operations**. If you open an Analysis Template, you will see little green lock icons on output data columns or report sheets.
- To save a modified Analysis Template choose **File: Save Workbook as Analysis Template**. Specify a file path, name and optionally, a comment\(^1\) and preview image\(^2\).

---

\(^1\)A comment or description produces a tooltip when you hover on a file in the New Workbook dialog box.

\(^2\)A preview image allows you to see an image of your saved file in the New Workbook dialog box.

When creating preview images of your customized templates, it works best to save your image (BMP, JPG, PNG) with dimensions of about 160 pixels wide by 130 pixels high. Use your image capture program to resize your image before saving and adding to your file as a preview image.

For more information see "What is Saved with the Workbook Template?"
Data are not saved with template files. There are other options for saving files without data. One is to "clone" the project; the other -- the default for any workbook that contains Data Connectors -- is to save the Origin file without imported data. For workbooks that do not contain Data Connectors, you can exclude imported data when saving, by opening the (workbook) Window Properties dialog (Format: Workbook) and checking the Exclude imported data when saving project box. Imported data and graphs of that data will be discarded when saving; but data that you have entered via the keyboard, plus any output resulting from analysis of imported data, are saved.

9.3 Simple Utilities for Filling Columns with Data

Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a menu command to fill a worksheet column with either row index numbers, uniform random numbers or normal random numbers. This is useful for generating quick datasets to test and try out other Origin features.

These simple procedures create a dataset in a pre-selected worksheet range or column(s):

<table>
<thead>
<tr>
<th>Action</th>
<th>Toolbar Button</th>
<th>Menu Command</th>
</tr>
</thead>
</table>
| Fill a range or column with row numbers | ![Row Numbers Icon] | • Column:Fill Column With:Row Numbers  
or  
• Right-click and select Fill Range/Column(s) With Row Numbers |
| Fill a column with uniformly distributed random numbers between 0 and 1 | ![Uniform Random Numbers Icon] | • Column:Fill Column With:Uniform Random Numbers  
or  
• Right-click and select Fill Range/Column(s) With Uniform Random Numbers |
| Fill a column with normally distributed random numbers | ![Normal Random Numbers Icon] | • Column:Fill Column With:Normal Random Numbers  
or  
• Right-click and select Fill Range/Column(s) With Normal Random Numbers |
The auto fill feature can be used in filling column label rows and the worksheet data cells:

To use auto fill to extend a pattern in the data across a range of cells (numeric data only):

1. Select a contiguous block of cells and move the mouse cursor to the bottom right corner of the selection.
2. When the cursor becomes a "+", hold down the ALT key and drag the mouse to the bottom or the right.

To use auto fill to repeat a pattern in the data across a range of cells (text or numeric data):

1. Select a contiguous block of cells and move the cursor to the bottom right corner of the selection.
2. When the cursor become a "+", hold down the CTRL key and drag the mouse toward the bottom or to the right.

Datasets can also be generated quickly using LabTalk script. As an example:

1. With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the following lines of script code into that window:
2. 

```plaintext
col(1)={0:0.01:4*pi};
col(2)=sin(col(1));
```
3. Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be filled with data.

9.4 Setting Column Values

The Set Values dialog box is used to set up a mathematical expression that creates or transforms one or more columns of worksheet data. The dialog box includes a menu bar, a control used to define output range, a tool for searching and inserting LabTalk functions into your expression, a column formula box used to define a one-line mathematical expressions, a Before Formula Scripts panel (usage optional) intended for data pre-processing and defining of variables used in your one-line expression and for Python users, a Python Function tab for defining and using Python functions which can also be used in your expressions.

Since Origin 2017, the column formula box (the upper box) in Set Values has supported a simplified spreadsheet cell notation like is used in MS Excel and Google Sheets. A cell is addressed using column Short Name + row index number (e.g. the first cell in column A -- formerly represented as "col(A)[1]" -- is now simply "A1").

In new workbooks, spreadsheet cell notation is enabled by default. Spreadsheet cell notation can only be used in defining the column formula. It cannot be used in the Before Formula Scripts panel of Set Values, nor can it be used in your LabTalk scripts. Note that the "old" column and cell notation will work in spreadsheet mode, so if you are an experienced user and you prefer to use the old notation, you may enter it as you always have. For an introduction to the spreadsheet cell notation syntax as well as a contrast with the "old" methods, see Column Formula Examples.

To open the Set Values dialog box for a single column:

1. Select a worksheet column or a range of cells in a worksheet column.
2. From the menu, choose Column: Set Column Values... or right-click on the worksheet column and choose Set Column Values... from the shortcut menu.
For convenience, a **Save Formula** button is added to the Set Values dialog box for **Origin 2021** (previously, you had to choose **File: Save** from the dialog menu).

To open the **Set Values** dialog box for multiple columns:

1. Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet.
2. From the menu, choose **Column: Set Multiple Column Values...** or right-click on the worksheet column and choose **Set Multiple Column Values...** from the shortcut menu.

### 9.4.1 Set Values Menu Commands

<table>
<thead>
<tr>
<th>Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Formula</strong></td>
<td>Load a saved formula into the column formula box. Formulas are saved using <strong>Formula: Save</strong> or <strong>Formula: Save As</strong>.</td>
</tr>
<tr>
<td><strong>wcol(1)</strong></td>
<td>Use the menu to include worksheet columns in either your column formula or your Before Formula Scripts (column reference is inserted at the cursor). A Column Browser is available to help in selecting the correct columns. Columns are listed by column index.</td>
</tr>
<tr>
<td><strong>Col(A)</strong></td>
<td>Similar to <strong>wcol(1)</strong> menu functionality but columns are listed by column index.</td>
</tr>
</tbody>
</table>
column name (including Long Name, if it exists).

- **Function**: Add LabTalk functions to your expressions (function name is inserted at the cursor). Note that when you hover over a function in the menu list, the function description will be shown in the Status Bar. When a function is selected, its description will be displayed in a pop-up Smart Hint.

- **Variables**: Add a variable or a constant to Column Formula or Before Formula Scripts; Add range variables (including by selection) or file metadata, to Before Formula Scripts.

- **Options**: Allow direct editing of column formula in worksheet Formula row; add a comment about the column formula; or preserve text in Set Values columns (do not treat as text as missing values).

### Column Formula

- Add a single line expression for generating data. Functions, conditional operators and variables can be used.

### Before Formula Scripts

- LabTalk scripts to be executed before the expression in the column formula box is executed.

### Python Function

- Define and use Python functions in your expression.

**New for Origin 2021**! See the Python section of the Programming chapter.

When you mouse over one of the functions listed in the Function menu in Set Values dialog, a one-line tooltip is displayed in the Status Bar. If you select the function, a Smart Hint appears with a more detailed explanation and a link to the full function description, syntax, examples, etc.

Additionally, you can click the Search and Insert Functions button to search for available functions by keyword and, once found, insert the function into your expression.

**Origin 2021** includes these additions and improvements to Origin's built-in functions:

- Excel-like PRODUCT() function.
- Excel-like LET() function.
- A "missing" parameter is added to movavg, tmovavg and movcoef statistical functions, allowing for more flexible handling of missing values in calculations.
(0=default)=omit missing values which is current behavior, 1=include missing, 2-omit missing but show missing in output).

For a list of Origin's built-in functions, see LabTalk-supported Functions.

Use the Before Formula Scripts panel to define variables, LabTalk functions, or run LabTalk scripts before the expression in the upper panel is evaluated.

To learn more, see Set Column Values - Quick Start

9.4.2 The "F(x)=" Worksheet Column Label Row

For simple expressions, you can use the F(x)= row to set column values. Any expression you enter here is directly entered into the Set Values dialog and vice versa. Note that the simplified spreadsheet cell notation that works in the formula box in Set Values also works in F(x)=:

1. Double-click in a cell in the F(x)= column label row.
2. Enter an expression to enter output in the data column below.

<table>
<thead>
<tr>
<th>A(X)</th>
<th>B(Y)</th>
<th>C(Y)</th>
<th>D(Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Name</td>
<td>Wavelength</td>
<td>Intensity</td>
<td>Wavelength</td>
</tr>
<tr>
<td>Units</td>
<td>nm</td>
<td>arb. unit</td>
<td>nm</td>
</tr>
<tr>
<td>F(x)=</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Correction Factor</td>
<td>5.30</td>
<td>-152.68</td>
<td>A + xcf</td>
</tr>
<tr>
<td>1</td>
<td>189.41</td>
<td>0</td>
<td>194.71</td>
</tr>
<tr>
<td>2</td>
<td>189.77</td>
<td>155.88</td>
<td>195.07</td>
</tr>
<tr>
<td>3</td>
<td>190.13</td>
<td>156.44</td>
<td>195.43</td>
</tr>
</tbody>
</table>

9.4.3 Set Column Values Tutorials

Tutorial 1: A Quick Units Conversion using F(x)=

1. Start with a new workbook and import the file \Samples\Graphing\WIND.DAT.
2. We will assume that column B contains Speed values in miles per hour (MPH). Click on the column heading for column C, then right-click and choose Insert. Origin inserts a new column C and moves Power values to column D.
3. Now, we'll convert the MPH values in column B to kilometers per hour (KPH).

Double-click in the F(x)= cell of column C and enter
and press Enter. Column C is filled with values in units of KPH.

**Tutorial 2: Computing Moving Average and Moving Standard Deviation**

1. Import the file `Samples\Signal Processing\fftfilter1.DAT`.
2. Add two more columns to the worksheet by clicking the button twice.
3. Click on the header of the 3rd column to select it, then right-click and select **Set Column Values...** from the context menu.
4. In the **Set Values** dialog, enter the following in the upper panel:

   \[
   \text{movavg}(B, 5, 5)
   \]

   and press **Apply**. Column 3 is filled with an 11-point moving average of the data from column B (note that you can insert functions such as **movavg** from the **Function** menu of the Set Values dialog box).

5. Click the >> button above the edit box to switch to the 4th column.
6. In the edit box for the 4th column, enter the formula:

   \[
   \text{movrms}(B, 5, 5)
   \]

   and press **OK**. This 4th column will be filled with root-mean-square (RMS) values, using a window size of 11 at each point.

**Tutorial 3: Set Values for Multiple Columns**

1. Create a new project by clicking the **New Project** button on the **Standard** toolbar.
2. Click the **Import Multiple ASCII** button to import the files `F1.dat` and `F2.dat` in the `<Origin Folder>\Samples\Import and Export\` path. In the **impASC** dialog, set **Multi_File (except 1st) Import Mode** to **Start New Books** and click **OK**.
3. Two workbooks are created, named as F1 and F2. Click the **New Workbook** button on the **Standard** toolbar to create another workbook.

4. With the 3rd workbook active, click the **Add New Columns** button to add a column. Highlight all columns and select **Column: Set Multiple Columns Values** from the main menu or right-click the columns and select **Set Multiple Columns Values** from the shortcut menu to open the **Set Values** dialog box.

5. Expand the bottom panel by clicking the **Show Scripts** button. Enter this script in the **Before Formula Scripts** edit box,

\[
\text{range } r1=\{F1\}F1!wcol(j); //"j" is the column index.
\]
\[
\text{range } r2=\{F2\}F2!wcol(j);
\]

6. Enter \((r1+r2)/2\) in the **Column Formula** edit box

7. Select **Options: Direct Edit Formula Cell** to clear this option.

8. Select **Options: Formula Text...** and enter \((F1+F2)/2\) in the **Formula Text** dialog, then click **OK**.

9. Click the **OK** button in the **Set Values** dialog box. You will see the results in the worksheet, and \((F1+F2)/2\) will display in the **F(x)** column label row instead of the formula.

### 9.5 Setting Cell Values

Beginning with version 2018, Origin supports cell-level expressions similar to those used by spreadsheet programs. Cell-level expressions which return a single value (numeric, string or date/time) can be entered into any worksheet data cell or into cells in a User-Defined Parameter row of the column label row area. When Edit Mode (**Edit: Edit Mode**) is toggled on, cell formulas display. When Edit Mode is toggled off, the formula result is displayed. Cell content can be edited regardless of Edit Mode state.
• To use cell formulas, **Spreadsheet Cell Notation** must be enabled (it is by default).
• Cell formulas begin with an equal sign (e.g. =B1 - C1).
• Cell formulas can return a numeric, a string or a date-time value.
• Cell formulas can incorporate cell references, variables, operators, LabTalk-supported functions and constants.
• Cell formulas can reference values in other sheets or books.
• Cell formulas can be extended to other cells by dragging with your mouse.

To learn more, see **Using a Formula to Set Cell Values**.

### 9.5.1 The Formula Bar

When creating cell or column formulas (using the F(x)= cell), the **Formula Bar** makes it easier to find and insert functions, select cell ranges and view and edit expressions, particularly long expressions that exceed cell width.

To enter an expression into a cell (data cell or F(x)=), click on the cell, then:

1. Enter an "=" and type your expression; or click the button to open the **Search and Insert Functions** dialog.
2. Search for the desired function then double-click on it to insert it into your Formula Bar expression.
3. Interactively select your data range going to the worksheet and (a) clicking on a column heading or (b) dragging to select a range of cells.
4. When your expression is complete, click the button or press Enter.

Note that you can drag the edge of the **Formula Bar** to resize it. You can also change the default font size by changing the value of LabTalk system variable @FBFS (default is "130").

### 9.5.2 Set Cell Values Tutorials
Tutorial 1: Extending a cell formula to other cells

1. Click the New Workbook button to open a new book.
2. Click on the column A heading to select, then right-click and choose Fill Column with Row Numbers.
3. Click on cell B1 and enter:

   \[=\text{A1+}\text{A1}\]

4. Press ENTER. This adds the value in A1 to the value in A1.
5. With the cell still selected, hover on the selection handle in the lower-right corner of the cell and when it looks like a "+", double-click to extend the cell formula to the bottom of the column.
6. Click the Add New Columns button to add column C.
7. Click on the Cell in C1 but this time enter (omitting the "$"):

   \[=\text{A1+A1}\]

8. Press ENTER. This adds the value in A1 to the value in A1.
9. With the cell still selected, hover on the selection handle in the lower-right corner of the cell and when it looks like a "+", double-click to extend the cell formula to the bottom of the column. Note that this time, the resulting values are different.
10. Click Edit: Edit Mode to display the underlying cell formulas. Note that the "$" in column B "locked" the second cell A1 reference so that it didn't change but that the A1 reference in column C changed with the row index number as we extended the cell calculation to other cells.
Tutorial 2: Quickly finding maximum values in multiple columns of data using special keyword "This"

The only place where you can use cell formulas in the worksheet column label rows (worksheet header rows), is in a User Parameter row.

1. Create a new workbook and then choose Data: Import From File: Single ASCII and import the file \Samples\Import and Export\S15-125-03.dat.
2. With your mouse, hover just to the left of the F(X)= row label and when the pointer becomes an arrow, right-click and Add User Parameters.
3. In the dialog box that opens, enter "MaxValue" and click OK.
4. In column A(X), in the MaxValue cell, enter:
   \[=\text{Max}(\text{This})\]
5. Click outside the cell and cell should now display "10".
6. Click back on this cell, then grab the selection handle in the lower right corner of the cell and drag to the right to extend the cell formula to MaxValue cells in columns B(Y), C(Y) and D(Y). All MaxValue cells should now display the maximum values in their respective columns.

There is now support keyword "This" when Cell Notation turned off. Use "This" in a User-defined Parameter row or in the last row of the column.

Tutorial 3: Use a column label row value in a cell calculation

All data in the worksheet column label rows, including User Parameter rows, is stored as string data. To use a "number" stored in a column label row in a cell calculation, you must convert the string to a numeric value. In the following example, we use the LabTalk value() function to convert column label row data to a numeric so that it can be used in a cell calculation:

1. Create a new workbook and then choose Data: Import From File: Single ASCII and import the file \Samples\Import and Export\S15-125-03.dat.
2. With your mouse, hover just to the left of the F(X)= row label and when the pointer becomes an arrow, right-click and Add User Parameters.
3. In the dialog box that opens, enter "Correction" and click OK.
4. In column D, enter the value "0.2" into the Correction cell.
5. Click the Add New Columns button to add column E.
6. In cell E1, enter:

   =D1+value(D[Correction]$)

7. Press ENTER. This converts the Correction value to a numeric and adds the numeric to the value in cell D1. The cell should display 101.9.

NOTE: The "$" in the above expression does not function to create an absolute cell reference as in the first example above. In this context, the "$" syntax is used to express a string variable stored in a user-parameter cell, before converting that string to a numeric value.

### 9.6 Processing Worksheet Data

Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the Worksheet menu while some are on the Edit, Column or Analysis menus (note that a worksheet must be active). Some utilities are available from a shortcut menu: select your data and right-click.

<table>
<thead>
<tr>
<th>Utility</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorting Data</td>
<td>Worksheet: Sort Range</td>
</tr>
<tr>
<td></td>
<td>Worksheet: Sort Columns</td>
</tr>
<tr>
<td></td>
<td>Worksheet: Sort Worksheet</td>
</tr>
<tr>
<td></td>
<td>Worksheet: Sort Columns by Label</td>
</tr>
<tr>
<td>Find</td>
<td>Edit: Find in Project</td>
</tr>
<tr>
<td>Replace</td>
<td>Edit: Find in Sheets</td>
</tr>
<tr>
<td></td>
<td>Edit: Replace</td>
</tr>
<tr>
<td></td>
<td>Edit: Go To</td>
</tr>
<tr>
<td>Hide Column</td>
<td>Column: Hide/Unhide Columns</td>
</tr>
<tr>
<td>Hide Rows</td>
<td>Hide/Unhide Rows (shortcut menu only)</td>
</tr>
<tr>
<td>Move Columns</td>
<td>Column: Move Columns or Column toolbar</td>
</tr>
<tr>
<td></td>
<td>Column: Swap Columns</td>
</tr>
<tr>
<td>Task</td>
<td>Worksheet:</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Swap Columns</td>
<td></td>
</tr>
<tr>
<td>Query Worksheet Data</td>
<td>Worksheet: Worksheet Query</td>
</tr>
<tr>
<td>Copy Columns to (new locations)</td>
<td>Worksheet: Copy Columns to</td>
</tr>
<tr>
<td>Append Worksheet</td>
<td>Worksheet: Append Worksheet</td>
</tr>
<tr>
<td>Split Columns</td>
<td>Worksheet: Split Columns</td>
</tr>
<tr>
<td>Split Worksheet</td>
<td>Worksheet: Split Worksheet</td>
</tr>
<tr>
<td>Split Workbook</td>
<td>Worksheet: Split Workbooks</td>
</tr>
<tr>
<td>Split Cell Strings to Multiple Columns</td>
<td>No menu access. To open the dialog box:</td>
</tr>
<tr>
<td></td>
<td>1. Click <strong>Window: Script Window</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. At the cursor, type <code>text2cols -d</code> and press Enter.</td>
</tr>
<tr>
<td></td>
<td>For more information, see this link</td>
</tr>
<tr>
<td>Worksheet Transpose</td>
<td>Worksheet: Transpose</td>
</tr>
<tr>
<td></td>
<td><strong>NEW</strong> The <strong>Transpose</strong> tool is improved for <strong>Origin 2021</strong>. It is no longer necessary to duplicate <code>wtranspose</code> output before using it as analysis input</td>
</tr>
<tr>
<td>Stack Multiple Columns into One with Grouping</td>
<td>Worksheet: Stack Columns</td>
</tr>
<tr>
<td>Unstack Grouped Data into Multiple Columns</td>
<td>Worksheet: Unstack Columns</td>
</tr>
<tr>
<td>Summarize Data with Pivot Table</td>
<td>Worksheet: Pivot Table</td>
</tr>
</tbody>
</table>
• Filter data by defining conditions on one or more columns
  
  **Column: Filter** menu, or **Worksheet Data** toolbar

  **See Also:** Data Masking

---

• Data Reduction
  
  **Worksheet: Remove/Combine Duplicated Rows**
  **Worksheet: Reduce Columns**
  **Worksheet: Reduce Rows**
  **Analysis: Data Manipulation: Reduce Duplicate X Data**
  **Analysis: Data Manipulation: Reduce by Group**
  **Analysis: Data Manipulation: Reduce to Evenly Spaced X**

---

• Apply Conditional Formatting to Worksheet Cells
  
  **Worksheet: Conditional Formatting: Highlight**
  **Worksheet: Conditional Formatting: Heatmap**
  **Worksheet: Conditional Formatting: Duplicates**

---

• Reverse Order
  
  **Column: Reverse Order**

---

### 9.7 Conditional Formatting of Worksheet Data

In addition to the above worksheet data utilities, the Origin worksheet supports **Conditional Formatting**. Conditional Formatting has three modes:

- **Highlight** mode opens a dialog box with controls to apply color to worksheet cells based on one or more conditions (e.g. "equal to", "not equal to", "text that contains", etc).
- **Duplicates** mode opens a dialog box with controls to apply to worksheet cells that contain duplicate values.
- **Heat Map** mode opens a dialog box with controls to apply a color map to cells based on worksheet values. The worksheet Heat Map is zoomable and scrollable, making it easy to get a "big picture" overview of data variation in three dimensions.

Manage conditional formatting in the active sheet using the ** Conditional Format Manager**.
When using 3-Color Limited Mixing to apply color to worksheet heatmaps, you can now precisely control where the middle color falls. Specify by Percentile, by Percent or by Value.

9.8 Workbooks for Analysis and Reporting

Apart from text and numeric data, the workbook can contain various other types of information -- graphs, notes and matrices; links to cell values in other books, project variables, documents or web pages; plus, import file metadata, variables and scripts -- making the workbook a flexible medium for collecting research data or for creating custom reports.

Another option for generating reports is to create HTML reports using Origin's Notes window. A Notes window can link to graphs, worksheet cells, etc., either directly or using a placeholder sheet. For more information, see HTML Reports from Notes Windows.

Further, as we will see, the workbook can "store" a complex sequence of analysis operations -- say, the application of a data filter and a fitting operation on the filtered data, combined with a customized plot of the results, into something that we call an Analysis Template. The Analysis Template makes it possible to automatically generate a custom report of results, simply by supplying new input data.

One attractive option for generating reports -- there are others, see the "New" button at the bottom of this section -- is to export data to a custom MS Word template, and optionally, a PDF file. This is done by running an output-generating analysis in Origin, then associating key results with bookmarks in a Word template, and, finally, saving the workbook as an Analysis Template. To generate your report, you open the Batch Processing tool, point to both your Analysis Template and your Word template, run the batch process and generate your reports.
• For information on generating custom reports using an MS Word Template, see the tutorial Batch Processing with Word Template for Reporting.

• For information on batch analysis and generating custom reports, see the Batch Analysis section of the "How to Handle Repetitive Tasks" chapter of this Guide.

9.9 Topics for Further Reading

• The User Files Folder
• Origin Template Files
• What is Saved with the Workbook Template?
• The New Workbook Dialog
• Arranging the Worksheet
- Displaying Supporting Data in the Worksheet Header Rows
- Controlling How Numeric Data Display
- Dates and Times in the Worksheet
- Generating Simple Worksheet Datasets
- Column Short Name Restriction
- Using Formulae to Set or Transform Worksheet Column Values
- Using a Formula to Set Cell Values
- Simple Manipulation of Worksheet Datasets
- Inserting Graphs, Images and other Objects into Worksheet Cells
- Inserting Links into Worksheet Cells
- Inserting Variables into Worksheets
- Conditional Formatting of Worksheet Cells
- Analysis Report Sheets and Columns
10 Matrix Book Matrix Sheet Matrix Objects

A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X and Y values. The following table summarizes some important matrixbook limits:

<table>
<thead>
<tr>
<th>Maximum Number of...</th>
<th>32Bit OS</th>
<th>64Bit OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matrixsheets in a matrixbook</td>
<td>1024†</td>
<td>1024†</td>
</tr>
<tr>
<td>Matrix objects in a matrixsheet</td>
<td>65,527</td>
<td>65,527</td>
</tr>
<tr>
<td>Cells in a matrix (Note)</td>
<td>90,000,000</td>
<td>90,000,000</td>
</tr>
</tbody>
</table>

† > 255 sheets requires saving file to Unicode (e.g. *.opj.u) file format. Unicode formats not compatible with Origin versions prior to Origin 2018 SR0.

**Note:** The product of any combination of rows and columns must not be greater than 90,000,000.

10.1.1 Naming Matrixbooks, Matrixsheets and Matrix Objects
The matrixbook has a Short Name whether you display it or not. Origin uses the Short Name for internal operations.

Short Names must be unique within the project file, cannot contain spaces, must begin with a letter, consist only of alphanumeric characters (A to Z and 0 to 9), and limited to 13 characters. You can use lowercase characters and the text will appear as such, but upper and lower case are not unique characters. (You cannot name one matrix MBOOK1 and another mbook1.)

Long Names are optional, need not be unique within the project file, can contain spaces, can begin with a letter, a number or a special character, and the length cannot exceed 520 characters, including spaces.

The sheet Name must be unique within the matrixbook and is limited to 32 characters.

Can contain spaces and numbers.

Can contain special characters except `!%$|()[]{}<>.

Can begin with a letter, number or allowed special character.
### Matrix Objects

- Optionally, sheet can have **Label** and **Comments**.
- By default, Origin assigns a matrix object index number to each object, as it is created. This index number cannot be changed.
- You can add a name to the object by clicking on the yellow object icon - [D] for a data matrix or [E] for an image matrix - in the upper right corner of the matrix sheet and choosing **Rename** from the menu. Alternately, you can double-click on the matrix object number/name below the thumbnail and enter a name.

You can now rename a matrix or virtual matrix in the **Object Manager**. Right-click on name in Object Manager and choose **Rename**.

## 10.1.2 Different Views of the Matrix

In the worksheet, a dataset is contained in a single column and the dataset may consist of **X, Y, Z, Error**, or **Label** data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The matrix contains a single dataset of **Z** values.

- Matrix columns are mapped to linearly-spaced **X** values.
- Matrix rows are mapped to linearly-spaced **Y** values.

Note that the matrix window has two column and row heading view modes:

- By default, matrix row and column headings display as row and column index numbers (**View: Show Column/Row** from the menu or press **Ctrl+Shift+C**).
- You can opt to view matrix row and column as **X** and **Y** values by choosing **View: Show X/Y** from the Origin menu (or press **Ctrl+Shift+X**). The displayed **X** and **Y** values are the **X** and **Y** coordinate values, calculated by linear interpolation of the axes **From** and **To** values by the number of columns and rows.

In addition to the two row and column heading view modes, there are **two matrix display modes**:

- In **Data Mode** (**View:Data Mode** from the menu or press **Ctrl+Shift+D**), the matrix object displays as raw numbers.
- In **Image Mode** (**View:Image Mode** from the menu or press **Ctrl+Shift+I**), the matrix object displays as either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of real numbers or complex numbers displays as a gray-scale image while RGB values will display as a color image.
An image in a matrix can be cropped within the existing window or it can be cropped and copied to create a new matrix window:

1. Make sure that there is a check mark beside Region of Interest Tools on the Tools menu. If this menu item is not checked, select it.
2. Click the Rectangle Tool button on the Tools toolbar.
3. Drag out a rectangular area on the image.
4. Right-click on the rectangle and select Crop from the shortcut menu.
**Note:** If the matrix object is an image, the object icon will display as regardless of whether you are viewing the matrix object as an image (View: Image Mode) or as numbers (View: Data Mode). Likewise, when the matrix object contains numbers, the object icon will display as regardless of view mode.

### 10.1.3 Matrixbooks

Like the workbook window, the matrixbook window is created from a customizable template (.otmu file). The matrix template stores such things as number of sheets in the book, the names of the matrixsheets, matrix dimensions, data type, math functions, data import handling instructions as well as various style and format options.

When you create a new matrixbook, the book is named MBook$N$, with $N$ reflecting the order of window creation. Appended to the book name, you will see something like "1/3" where the first integer denotes the active matrix object and the second denotes the number of matrix objects in the active matrixsheet. Following the above example, if you click the yellow object icon to the right side of the matrix, the menu shows three matrix objects with the first being the active one - the one with a check mark placed beside it (note that in our illustration, the objects are empty).
You can right-click on a worksheet tab and **Add Matrix as Sheet** and insert a matrixbook into a workbook. This is useful when building **Analysis Templates** that involve matrix-based operations such as 3D surface fitting or 3D plotting operations.

### 10.1.4 Matrixsheets

Prior to Origin 2018, an Origin matrixbook could a maximum of 255 sheets. That number is now increased to 1024. When you have more than 255 sheets in a book, you will need to save the file using one of the new Unicode-compliant formats (opju, ogmu, etc).

A matrixbook can have up to 1024 matrixsheets. The default matrixbook template - ORIGIN.otmu - has a single matrixsheet containing 32 rows and 32 columns. Each matrixsheet can differ in dimensions (number of rows and columns and X & Y range).

To specify the dimensions of the matrixsheet:
1. Click on a tab to activate the sheet and choose **Matrix: Set Dimensions/Labels**. This opens the **Matrix Dimensions and Labels** dialog box.

2. Specify a number of columns (X dimension) and rows (Y dimension).

3. Specify a **From** and **To** value for X (columns) and Y (rows).

**Note:** The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix column and the last X is mapped to the last matrix column. The X coordinates of other columns are interpolated. Matrix rows are similarly mapped using the **From Y** and **To Y** values. When plotting or analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y coordinate values (not column or row index) and the Z value contained in the cell intersected by the row and column.

### 10.1.5 Matrix Objects

A matrix sheet can contain up to 65,504 matrix objects, though the actual limit is likely to be far less (determined by system resources). Objects in a sheet share the same X/Y dimensions and column (X) and row (Y) headers, but every object can have its own **Z header**. Other matrix object properties include internal data type and numeric display options.

Matrix object properties are set in the user interface via the **Matrix Properties** dialog box. To open the dialog box:

1. Make sure that the matrix object is active (check mark shows beside it in **the object menu**).

2. Choose **Matrix: Set Properties...** from the main menu.

You can set properties for multiple matrix objects without closing the Matrix Properties dialog boxes by clicking the **<< Previous or Next >>** buttons at the top of the dialog box.
Apply settings of the active matrix object to all matrix objects to the right by checking the **Apply to matrices to the right** box.

10.1.5.1 **Show Image Thumbnails**

You can show image thumbnails for each object in the sheet:

1. Right-click on the matrix window title bar and place a check mark beside **Show Image Thumbnails**.
As an alternative to image thumbnails, you can use a slider to display images in the matrixsheet. If you are seeing thumbnail images at the top of the sheet, you can replace them with a slider by doing the following:

1. Hover in the gray area just to the right of your matrix image and just below the image thumbnails. When the cursor shows the Mini Toolbar prompt, click to show the toolbar, then click the **Slider or Thumbnails** button.
2. To revert to display of image thumbnails, click the button again.
Note that you can disable display of both thumbnails and slider by clicking the Image Selector button located just to the left of the Slider or Thumbnails button on the Mini Toolbar.

### 10.2 Virtual Matrix

Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour plots. The data can include a column or label row with the X or Y values. Unlike a regular matrix which only supports a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y coordinate values (provided those values are in ascending or descending order).

**Note:** You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced in the X and Y dimensions. This is not considered a "virtual matrix."
10.3 Matrix Templates

Matrix windows are created from a matrix template file (*.otmu). The template file saves such things as the number of sheets in the matrixbook, the number of rows and columns in each sheet, internal memory allocated for each sheet, mathematical formula used to fill the matrix with numbers and certain ASCII import and export options.

**Note:** Data are NOT saved with the matrix template file.

To save the active matrix window as a template:

1. With the matrix window active, choose **File: Save Template As** from the main menu. This opens the **template_saveas** X-Function dialog box.
2. Select a category from the **Category** drop-down list or enter a new category.
3. Select or type a file name in the **Template Name** box (the .otmu extension is automatically added).
4. Enter a description into the **Template Description** text box (optional).
5. Type the file path for the template or click the browse button to locate your folder. Typically, you would save your template to your **User Files** folder.

The following table lists some of the kinds of things that are saved with the matrix template file. It also tells you where to find these controls.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>What is Saved?</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>• The Organizer</td>
<td>Right-click on window title bar and choose:</td>
</tr>
<tr>
<td></td>
<td>• The Script Panel</td>
<td>• Show Organizer</td>
</tr>
<tr>
<td></td>
<td>• The Matrix Image Thumbnails</td>
<td>• Show Script Panel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Image Thumbnails</td>
</tr>
<tr>
<td>Matrix Properties</td>
<td>• Matrix Long Name, Units, Comments.</td>
<td><strong>Matrix:Set Properties</strong></td>
</tr>
<tr>
<td></td>
<td>• Column width settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Column number Display (decimal, scientific, engineering).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Column Digits and data storage requirements.</td>
<td></td>
</tr>
<tr>
<td>Matrix Dimensions and Labels</td>
<td>• Numbers of rows and columns in the matrix, xy coordinates, XYZ axis labels.</td>
<td><strong>Matrix:Set Dimensions/Labels...</strong></td>
</tr>
</tbody>
</table>
## 10.4 Simple Manipulation of Matrix Data

<table>
<thead>
<tr>
<th>Utility</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Flip or Rotate</td>
<td>Matrix: Rotate90</td>
</tr>
<tr>
<td></td>
<td>Matrix: Flip: Vertical</td>
</tr>
<tr>
<td></td>
<td>Matrix: Flip: Horizontal</td>
</tr>
<tr>
<td>• Expand (by interpolation)</td>
<td>Matrix: Expand</td>
</tr>
<tr>
<td>• Shrink</td>
<td>Matrix: Shrink</td>
</tr>
<tr>
<td>• Transpose</td>
<td>Matrix: Transpose</td>
</tr>
<tr>
<td>• Convert to Worksheet</td>
<td>Matrix: Convert to Worksheet</td>
</tr>
</tbody>
</table>

## 10.5 Setting Matrix Values

The **Set Values** dialog box is used to generate or transform data in a matrix object.

To open the **Set Values** dialog box, make sure that the matrix object is active, then:

1. From the menu, choose **Matrix: Set Values**.

   or

1. Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix icon/name), then right-click on the matrix and choose **Set Matrix Values** from the shortcut menu.
Matrix Book Matrix Sheet Matrix Objects

<table>
<thead>
<tr>
<th>Menu Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Formula</strong>: Load a saved formula into the matrix formula box. Formula are saved using <strong>Formula: Save</strong> or <strong>Formula: Save As</strong>.</td>
</tr>
<tr>
<td><strong>Mat(1)</strong>: Use the menu to include matrix objects in either your matrix formula or your Before Formula Scripts (matrix object reference is inserted at the cursor). A Matrix Browser is available to help in selecting the correct objects. Objects are listed by object index.</td>
</tr>
<tr>
<td><strong>Mat(A)</strong>: Similar to Mat(1) menu functionality but matrix objects are listed by object Long Name, if one exists.</td>
</tr>
<tr>
<td><strong>Function</strong>: Add LabTalk functions to your expressions (function name is inserted at the cursor).</td>
</tr>
<tr>
<td><strong>Variables</strong>: Add a variable or a constant to <strong>Matrix Formula</strong> or <strong>Before Formula Scripts</strong>; Add range variables (including by selection) or file metadata, to Before Formula Scripts.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Matrix Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a single line expression for generating data. Functions, conditional operators and variables can be used.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Before Formula Scripts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter one or more lines of LabTalk script to be executed before the expression in the Matrix formula box is executed.</td>
</tr>
</tbody>
</table>
Use the **Before Formula Scripts** panel at the bottom of the **Set Values** dialog box to define variables or LabTalk functions that you wish to use in your matrix formula.

Click the **Search and Insert Functions** button to search for built-in LabTalk functions.

### 10.6 Extracting Matrix Data

You are allowed to extract a block of matrix data you are interested from an image-viewing matrix object, using the ROI tool.

To extract a block of matrix data from a matrix object:

1. Activate the matrix window and select the target matrix object.
2. Select **View: Image Mode** to show the matrix image. Click on the **Rectangle tool** button at the **Tools** toolbar docked at the left side of Origin workspace.
3. Draw a rectangle box on the matrix image to select the block of matrix data you want to extract. Right-click on the rectangle box you just drawn, select **Create New** from the context menu to extract the selected block to a new matrix window.
You can also select **Copy** context menu to copy the selected area and paste it into another matrix worksheet/workbook.

For **Origin 2021**, Origin supports various shapes for ROI box when extracting data from a matrix while viewing in image mode (**View: Image Mode**).

### 10.7 Converting Worksheets to Matrixes

There are four methods for converting worksheet data to matrix data.

<table>
<thead>
<tr>
<th>Method</th>
<th>Conversion Type</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Direct | • X across columns  
• Y across columns  
• No X and Y  | Ideal for spreadsheet data that conforms to the following:  
• X data values in the 1st column, Y data values in the 1st row and Z values in columns 2 to N and rows 2 to M.  
• Y data values in the 1st column, X data values in the 1st row and Z values in columns 2 to N and rows 2 to M. |
| Expand | • Row  
• Column  | Some ASCII files have an upper limit for characters allowed on a single line. Use this method when your file breaks a single line of data across multiple lines.  
• Expand by **Row**: specifies |
| XYZ Gridding                      | the number of ASCII file rows comprising one matrix row.  
|----------------------------------|---
| • Expand by **Column**:          | specifies the number of ASCII file columns comprising one matrix column.  
| • Expand by **Column**:          |  

| XYZ Log Gridding                 | Conversion Type depends upon XY spacing:  
|----------------------------------|---
| • Regular                        |  
| • Sparse                         |  
| • Random (Renka Cline)           |  
| • Random (Shepard)               |  
| • Random (Thin Plate Spline)     |  
| • Random (Kriging Correlation)   |  
| • Random (Weighted Average)      |  

| **XYZ Log Gridding**             | **Conversion Type** depends upon **XY** spacing:  
|----------------------------------|---
| **Methods same as** **XYZ Gridding** |  
| • Choose **Regular** applied for data that are regularly spaced in XY.  
| • Choose **Sparse** when you have missing values.  
| • Choose **Renka-Cline**, **Shepard**, **TPS**, **Kriging** or **Weighted Average** methods for data that are irregularly spaced in XY.  

| **XYZ Log Gridding**             | **Calculates logarithmic values** for **X** and **Y**, then performs **XYZ Gridding**.  
|----------------------------------|---
| **Methods same as** **XYZ Gridding** |  
| **Calculates logarithmic values** for **X** and **Y**, then performs **XYZ Gridding**.  

### 10.8 Converting Matrixes to Worksheets

There are two methods for converting matrix data to worksheet data:

<table>
<thead>
<tr>
<th><strong>MBook1 :1/1</strong></th>
<th><strong>X</strong> 1</th>
<th>3.25</th>
<th>5.5</th>
<th>7.75</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Y</strong></td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1.12</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>1.24</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>1.36</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>1.48</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>1.6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
</tbody>
</table>

![Worksheet Image]
- **Direct**: This copies the Z values in the matrix to a worksheet with no reordering. If the matrix consists of M rows by N columns of Z values, this method produces a worksheet which has M rows and N columns. By default, the X and Y coordinates of the matrix Z values are not copied to the worksheet. You can opt to copy X coordinates to the 1st worksheet row or a parameter row and the Y coordinates to the 1st worksheet column.

- **XYZ Columns**: This method produces a worksheet with three columns: an X, a Y and a Z column. The X and Y columns contain the X and Y coordinate values of the matrix Z values. The matrix Z values are contained in the worksheet Z column.
10.9 Profiling Matrix Data

Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section.

1. Activate the matrix object and choose **Plot > 2D: Profile: Image Profiles** from the main menu.

This creates an image plot and opens the **Image/Contour Profile** dialog box. Use the dialog box to specify X and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the configuration or the appearance of the plots -- without closing the dialog box. After closed the dialog box, a button **Profiles...** will appear at the right-top corner of graph window, which can be used to reopen the **Image/Contour Profiles** dialog.

10.10 Topics for Further Reading

- Matrixbooks, Matrixsheets and Matrix Objects
- Matrixbook and Matrixsheet Operations
- What is Saved with the Matrix Template?
- Matrix Dimensions and XY Coordinates
• Matrix Object Data Properties
• Setting Matrix Values
• Matrix Conversion and Gridding
• Creating 3D and Contour Graphs from a Virtual Matrix
• Viewing and Profiling Matrix Data
11 Graphing

11.1 Creating a Graph

Graphs can be created from both hard data and from mathematical functions. With Origin, you can create over 100 graph types using Origin’s built-in graph templates. Each of these graphs has been specifically chosen for its applications in various technical fields.

All graph types are accessible from the Plot menu. Note that while most graph types also have a corresponding 2D Graphs or 3D and Contour Graphs toolbar button, some do not. Until you’ve had time to familiarize yourself with available toolbar buttons, the Plot menu should be your “go to” place for creating graphs.

Creating most graphs involves just two steps.

1. Select your data.
2. Select the plot type.

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple data arrangements. See the Origin Graph Types section for specific requirements.

11.1.1 Creating Graphs from Worksheet Data

Origin’s most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and creating a simple graph.

**Tutorial: One click to create graph with selected data**

1. Open a new workbook and select Data: Import from File: Single ASCII... from the main menu.
2. Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open.
3. Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across the four column headings.
4. Click Plot > Basic 2D: Line & Symbol: Line & Symbol. A graph window is created with four line and symbol plots. Note that the plots differ by line color and by symbol type.
5. Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y).
6. This time, select the Plot > Multi-Panel/Axis: 4 Panel menu item. Note that a very different plot is created using the same datasets.

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs discusses customizing graphs and saving templates in more depth.

We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a 3D surface plot, then overlaying it with a 3D scatter plot.


**Tutorial: 3D Surface Plot from XYZ Data**

1. Create a new, empty workbook window and import the file `\Samples\Matrix Conversion and Gridding\XYZ Random Gaussian.dat`.
2. Highlight column C and right click. Select *Set As: Z* from the fly-out menu.
3. Select *Plot > 3D: 3D Colormap Surface* to create a 3D Colormap Surface plot.
4. Select the *Graph: Layer Contents...* menu item or right click the layer icon on the left-top of the graph to open the *Layer Contents* dialog. In this dialog, click on drop-down next to the button and select *3D Scatter/Trajectory/Vector* from the fly-out menu.
5. Select column C from the left panel and click on the button to add the 3D scatter plot to the graph. Click *OK* to close the dialog.
6. Double-click on the plot to open the *Plot Details* dialog. In the left panel, expand the *Layer1* node and then expand the 2nd node which represents the scatter plot. Click and select the branch named *Original*. Be sure to leave the node-level check box selected, otherwise this plot will be hidden.
7. In the *Symbol* tab on the right side, set *Shape* to *Ball*, *Size* to *12* and *Color* to *Color Mapping: Col(C)*.
8. In the *Drop Lines* tab, clear the *Parallel to Z Axis* check box.
9. Select *Layer1* from the left panel of the *Plot Details* dialog. In the *Lighting* tab, under *Mode*, select *Directional*. Click *OK* to close the dialog.
10. Click on the scatter plot in the graph to select this plot, then in the *Style* toolbar, click on the button and select the *Rainbow* palette.

Your graph should look like this:

![Graph Example](image-url)
You can hold down the **R** key on your keyboard and use the mouse to freely rotate the 3D surface. With the pointer tool active, click on the layer for additional controls to move, stretch and rotate the surface.

11.1.1.1 **Worksheet Column Plot Designations**

The labels \((X), (Y), (Z), \text{ etc.}\) in column headings are referred to as the **Column Plot Designation**. Columns can also be designated as **Label**, **Disregard**, **Y Error** or **X Error**. Each plot type has certain data requirements (e.g. a simple line plot requires one \(X\) and one \(Y\) dataset) and column plot designations work in concert with settings saved in the graph template, to allow you to quickly create a graph.

To set the Column Plot Designation, select a column or multiple columns, then from the menu choose **Column: Set as:<option>;** or right-click and choose an option from the **Set As:** context menu.

In the 1st tutorial above, we plotted 2D graphs, which require \(Y\) data from one or more worksheet columns. The \(Y\) data were automatically plotted against the \(X\) column data to their left. In 2nd tutorial, we plotted a 3D graph using \(Z\) data. The \(Z\) data were plotted against \(X\) and \(Y\) data columns to the left of the \(Z\) data column.

**Note:** For more information on Column Plot Designations and how they affect plotting behavior, see **Plot Designation**, in documentation for the Column Properties Dialog Box.

11.1.1.2 **Selecting Worksheet Data**
Various ways to select data for plotting:

- **Single column**: Click on the column heading, e.g., B(Y).
- **Multiple columns**: To select a small number of contiguous columns, click on the first column heading and drag the pointer to the last column heading. To select a large number of contiguous columns, click on the first column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then press the SHIFT key and click on the last column heading. To select non-contiguous columns, press the CTRL key while clicking on the desired column heading.
- **A range in a column**: Click on the first cell of the range and drag to the last cell of the range.
- **Multiple ranges within a column**: Select one range. Press the CTRL key while selecting each range. When plotting, each range will be treated as a separate data plot in a plot group.
- **Ranges across multiple columns**: If cells are contiguous, click on the first cell and drag to the last cell. If cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be treated as a separate data plot in a plot group.
- **Range(s) across all columns**: Click on the first row heading and drag to the last row heading, to select multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot group.
- **Entire worksheet**: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner of the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downward-pointing arrow, click to select the entire worksheet.
- **Specific columns**: To select columns by data in column label rows (header rows); or to select columns using a pattern, choose Edit: Select.

As noted in the **Worksheet Column Plot Designations** section just above, if you select Y or Z columns, Origin defaults to plotting the Y column against the nearest X column to the left; or to plot the Z column against the nearest Y and X columns to the left. But if you In the case of simple XY 2D plots (line, line+symbol, etc.), you can ignore this rule and plot with selected XY columns not matter the selected X is on the left or right side of Y.

11.1.2 Creating a Graph from Matrix Data
As discussed in the Matrixbook, Matrixsheets and Matrix Objects chapter, a matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix data is used to create 3D, contour and heatmap graphs -- all of which require require "3D" data. In earlier versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case (see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars still require matrix data.

There are still many situations in which you will be creating 3D plots from matrix data. If data are stored in a worksheet and for one reason or another, you need to convert it into a matrix form, see Converting Worksheets to Matrixes.

Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Since you cannot plot only a portion of the matrix, data selection isn't necessary. You can, however, choose a subset of the data plot to display once the graph is created. See Editing Plot Range in the Manipulating Data Plots section of this chapter.

### 11.1.2.1 The Virtual Matrix

The Virtual Matrix concept was covered in the Matrixbook, Matrixsheet and Matrix Object chapter of this Guide. To recap, a virtual matrix is a block of worksheet cells which contain Z values, with X and Y coordinates in the first row or column label row, and first column. X and Y coordinates don't have to be evenly spaced and can even contain text or date/time data.

When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, the worksheet's Column Plot Designations are ignored. Instead, a dialog box is opened where you designate your X and Y coordinates. The intersecting data points are then treated as Z values.

#### Tutorial: Contour Plot from Virtual Matrix

1. With a new workbook active, use the Data: Import from File: Import Wizard... menu to open the Import Wizard dialog.
2. Press the browse button in the dialog and select the file Waterfall.dat from the Samples\Graphing subfolder.
3. This file has an import filter already associated with it. Press the Finish button to import the file.
4. With the workbook active, press CTRL+A to select the entire sheet.
5. Now select the Plot > Contour: Contour - Color Fill menu item. The plotvm dialog will open.
6. In the dialog, set the Y Values in drop-down to Column Label, and then set the Column Label drop-down to Excitation Wavelength(nm).
7. Set the X Values in drop-down to 1st column in selection, then press OK to close this dialog.
8. The contour plot will be created.
9. Use the Graph: Speed Mode... menu item, then in the dialog that opens, set the Speed Mode drop-down to Off and press OK. This will turn off speed mode so that all data points are plotted (see the discussion of Speed Mode, below).
10. Click on the contour plot to select this data plot, then from the Style toolbar, click the Palette button and then select the Pumpkin Patch palette. Your graph should look similar to the image below: 
Once you customize your contour levels and colors, you can save your settings as a Theme, or simply copy-paste your customizations from one graph to another. To save a Theme, right-click on the graph and choose Save Format as Theme; or use the Colormap Theme controls on the Colormap/Contours tab of the Plot Details dialog box.

### 11.1.32D and 3D Function Plots

To create function plots and parametric function plots, select File: New: Function Plot menu. There are four options to choose from:

<table>
<thead>
<tr>
<th>Type</th>
<th>Function Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Function Plot</td>
<td>$y = f(x)$</td>
</tr>
</tbody>
</table>
| 2D Parametric Function Plot | $x = f_1(t)$
|                          | $y = f_2(t)$    |
| 3D Function Plot         | $z = f(x, y)$ |
| 3D Parametric Function Plot | $x = f_1(u, v)$
|                          | $y = f_2(u, v)$
|                          | $z = f_3(u, v)$    |

These plot types are also accessible from the function plot buttons on the Standard toolbar.
Tutorial: 3D Function and 3D Parametric Function in Same Layer

1. From the menu, choose **File: New: Function Plot: 3D Parametric Function Plot**...

2. In the dialog that opens, click on the arrow button at the top right side of the dialog, and from the fly-out menu select the built-in example **Partial Torus (System)** and press **OK** to close the dialog. The function plot will be created.

3. With the function plot window active, invoke the menu **File: New: Function Plot: 3D Function Plot**....

4. In the dialog that opens, enter -5 and 5 for the **From** and **To** edit boxes for x and y scale.

5. In the **Z(x,y)** edit box, enter **0**.

6. Set the drop-down at the bottom left corner of the dialog to **Add to Active Graph** and press **OK** to close dialog.

7. The **Z=0** plane will be added to the graph, and the plane will properly intersect the parametric surface plot. You can hold down the **R** key and use the mouse to freely rotate the plot.
Some function plot dialogs provide sample formulas. Click the arrow button beside Theme at the top of the dialog box to access them. You can download more examples at http://originlab.com/3dfunctions.

For 2D parametric, 3D, and 3D parametric function plots, data is generated when the function plot is created. To create data for 2D function plots, right-click the plot and choose Make dataset copy of Function or if on the Function tab in Plot Details, click the Workbook button.

Besides function plots, you can also create graphs with all built-in and user-defined nonlinear curve-fitting or surface-fitting functions. From the menu, choose Analysis: Fitting: Simulate Curve... or Simulate Surface.... You can even add noise to the plot. Corresponding data is created as well.

11.2 Plotting without Using Column Plot Designations

While Column Plot Designations remain an important concept, they are no longer required by many Origin graphing and analysis operations. For instance, the Plot Setup dialog box allows you to freely specify which column is used as X, Y, etc. when plotting, thereby overriding the Column Plot Designations.

In order to make full use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of objects contained in the Origin graph window.

11.2.1 Pages, Layers, Plots and the Active Plot

Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the white area inside the graph window. Anything that lies outside the page is not printed or exported. By default, the dimensions of the graph page are defined by the printable area of your default printer driver; without adjusting settings, a printed graph should fill the printed page.
The graph page must contain at least one, and may contain as many as 1024, graph layers.

Each graph layer generally contains one or more data plots (graphical depictions of datasets). Note that the graph in the image above contains three graph layers, represented by the three non-printing layer icons in the upper-left corner of the graph page. Note that there is one layer icon which is highlighted, indicating that this is the active layer.

Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is the first plot in the active layer. To verify which plot is active, click on the Data menu while the graph is active. The active plot will have a check mark beside it.

The hierarchical structure of the graph page can be seen in these places:

- The Plot Details Dialog Box (Format: Page ...)
- The Object Manager (View: Object Manager)
The Plot Setup Dialog Box (Graph: Plot Setup...)

11.2.2 The Plot Setup Dialog Box

The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data plots in an existing graph.

- Creating graphs without regard to Column Plot Designations
- Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrixbooks, loose datasets, etc.
- Creating graphs combining multiple plot types.
- Adding, removing, replacing data plots.
- Grouping or ungrouping data plots.
- Reordering data plots in a layer or moving data plots to another layer.
To create a graph with the Plot Setup dialog, make sure no data is selected in the active worksheet and choose the plot type that you want to create (from the Plot menu or by clicking on a toolbar button).

To open the Plot Setup dialog for an existing graph window, right-click on any layer icon in the upper left corner of the graph window and select Plot Setup..., or choose menu Graph: Plot Setup....

Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box

1. Click the New Workbook button on the Standard toolbar.
2. Click Data: Import From File: Single ASCII, browse to the Origin installation folder and import the file \Samples\Curve Fitting\Step01.dat. Starting from column B, columns are actually paired - X data and Y data -- but by default all columns are assigned a "Y" Column Plot Designation on import.
3. Without selecting any data, click Plot > Basic 2D: Line. This opens the Plot Setup dialog box.
4. Click the two "double-arrow" buttons to show all three dialog box panels.
5. In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for Column C (Sensor Ay), then click the Add button to add the plot to Layer 1 in the bottom panel.
6. Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor By), then click Add.
7. Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor Cy), then click Add. Three plots are added to Layer 1.
8. Press CTRL and click on each plot in the bottom panel to select all three, then right-click and choose **Group**.

9. Click **OK** to create a grouped line plot.

![Plot Setup: Configure Data Plots in Layer](image)

**Tutorial: Creating a Graph with Data from Multiple Worksheets**

1. Click the **New Workbook** button on the **Standard** toolbar.

2. Click **Data: Import From File: Multiple ASCII**, browse to the Origin installation folder and select Sensor01.dat, Sensor02.dat and Sensor03.dat under \Samples\Curve Fitting\ to import. After Import, 3 workbooks are created.

3. Without selecting any data, click **Plot > Basic 2D: Line+Symbol**. This opens the Plot Setup dialog box.

4. Expand the top panel if it is hidden. From the **Available Data** list, choose **Worksheets in Folder**.

5. Select Sensor01, Sensor02 and Sensor03 sheets in the top panel.

6. In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box for Column B (Sensor Output), then click the **Add** button.

7. Click **OK** to create a grouped Line+Symbol plot using Sensor Output columns from 3 worksheets.
• The Plot Setup middle panel only allows choosing one X column at a time.
• If your worksheet is set up with the correct Column Plot Designations (e.g. XXY) but you only want columns with same Long Name, click the toggle in the upper-right corner of middle panel so that only plottable columns show (e.g. for 2D plot types, X columns are not shown). Then you can sort the columns and select all columns with same Long Name and plot them together. The Y columns will be plotted against corresponding X columns.
• To change a data plot’s type, choose the corresponding plot in bottom panel. Corresponding X and Y columns will show in middle panel. Choose a new plot type in middle panel and click the Replace button.
• All data plots in a group share the same plot type. If you want to change the plot type of a single plot in a group, right-click the Group node in bottom panel and Ungroup first.
• Drag and drop data plots in the bottom panel to move them to different layers.
• If the bottom panel is hidden and you have selected columns in the middle panel, you can directly click the OK button to create your graph.
11.3 Manipulating Data Plots

The following sections discuss higher level modifications to existing graphs such as changing plot type, adding or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed plot customizations, including those involving such things as changing plot symbols, colors, and legend customizations, see the Customizing Graphs chapter.

The following methods of manipulating data plots in the graph window are fairly easy to use. Thus, you may want to choose File: Open Template and pick your template to create a blank graph window. Then, using the methods below you can add and group data plots in the graph.

11.3.1 Changing Plot Type

Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing plot with a few other select plot types. Some examples:

- Scatter, line, line+symbol, column/bar are interchangeable.
- 3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable.

To change the plot type of an existing plot:

- Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu.
- Click on the data plot and choose Format: Plot... and in Plot Details choose from the Plot Type dropdown list.
- Click on the data plot, then click one of the supported graph toolbar buttons.

Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are switched.

A word of caution: This is an old Origin feature, and for a quick change of plot types in a single-layer graph it works well. Changing plot types in a multi-panel, multi-layer graph can lead to unwanted outcomes. When working with more complex graphs, it is better to create a graph directly using the specified Plot menu command or toolbar button.

11.3.2 Exchanging Data Plots

You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands. Right-click on a data plot, then select one of these options:

- Change X/Y/Z. These menu items allow you to swap the current X,Y or Z data with data from any column in the project.
- Select Columns. This opens the Column Browser where you can select another column in the Current Folder, in the Current Folder (recursive) (includes subfolders) or in Current Project.
• **Change Worksheet.** This menu item allows you to replace both X and Y with data from another worksheet. The selected worksheet must have the same Short Names, the same Column Plot Designations and the same row index range as the current worksheet.

If you have a grouped data plot, then clicking once on any of the plots in the group will select the entire group. Click a second time to select a particular member of the group. The context menu options to change worksheet, X, or Y are available only when a single data plot is selected.

**Tutorial: Changing X and Y assignment of a data plot**

1. Start with a new workbook and import the file `automobile.dat` from the `Samples\Statistics` sub-folder of the Origin installation folder.
2. Select the Gas Mileage column and select the Plot: Basic 2D: Scatter menu item. The Gas Mileage column is plotted against the default X column Year.
3. Right-click on the data plot and select Change X: Engine Displacement. The Gas Mileage column is now plotted against Engine Displacement.

**Note:** If new data is significantly outside of the current range for X or Y axes, you will be asked if the graph should be rescaled. If data are not significantly different, you may want to manually rescale the graph (Hot key: CTRL+R).

If you perform analysis on the data plot (e.g. linear regression with Recalculate set to Auto), the fit results will automatically update when you change X/Y or the worksheet.

### 11.3.3 Adding, Removing and Hiding Data Plots

Use the following methods to add or remove data plots from a graph.

#### 11.3.3.1 Adding Data by Drag and Drop

You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet Column Plot Designations to create the plot.

1. Select the worksheet data (one or more columns or a range of one or more columns).
2. Move the mouse over the left or right edge of the selected range.
3. When the pointer looks like this 🗒️, hold down the left mouse button and drag the data to the graph window. Release the mouse.
4. If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse.
Usually the current plot type is used when plotting by drag-and-drop. To change the global plot type to use when drag and drop, choose Preferences: Options... from the main menu. Go to the Graph tab and change the Drag and drop plot type.

11.3.3.2 Adding Data with Insert: Plot to Layer

Use the Insert menu to insert some types of plots to the active graph layer. Choice of plot type depends on the active graph window and the last-activated data source (worksheet or matrix). For instance, if you create a 2D graph, select data in a workbook window, then return to graph window and click Insert: Plot to Layer, your insert choices will be Line, Scatter, Line + Symbol, Column..., Area and Contour....

To use the Insert menu command, you should have an existing graph window:

1. Go to the worksheet or matrix window and select your dataset(s).
2. Return to the graph window, make sure that the target layer is active layer, then choose Insert: Plot to Layer: Plot Type.

11.3.3.3 Adding and Removing Data with the Layer Contents Dialog Box

Open the Layer Contents dialog box by double-clicking or right-clicking on the layer icon(s) in the top left corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right panel lists datasets that are plotted in the active layer.

Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the layer.
11.3.3.4 Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box

Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph.

1. To add plots to the graph, use the top panel of Plot Setup to identify your source data.
2. Use the controls in the middle panel to specify the plot type and how the data selection should be treated (as X, Y, yError or Label).
3. In the bottom panel, choose the Layer to which you want to add plots, then click the Add button.
4. To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove.
5. To hide a plot, uncheck the Show check box for the plot.
6. To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in middle panel and click the Replace button.

11.3.3.5 Adding Data by Direct ASCII Import

You can import ASCII files directly into the active graph window using the the Import ASCII toolbar button. Note that this method works only with files having a simple structure and it supports only the simplest of graph types - Line, Scatter, Line + Symbol, Column and Bar charts.

1. Click the Import ASCII button. This opens the Import ASCII dialog box.
2. Choose a file.
3. Click Open.

The file is imported and plotted in the active graph window.

11.3.3.6 Adding Data by Copying and Pasting a Plot

With many Basic 2D graphs (e.g. Scatter, Line, Line + Symbol, Bubble, etc.), you can copy a plot from an existing graph layer and paste it to another layer in the same window or into a separate graph window. Prior to Origin 2020, this would only produce a black line plot. Origin 2020 expanded copy-paste of plots to other plot types, while preserving plot properties (symbol size, color, etc.).

1. Click on the plot to select it and press CTRL+C.
2. Click on the target graph and press CTRL+V.
You can also copy a plot by selecting the plot in the graph and clicking on the **Copy Plot** button on the **Mini Toolbar**.

Previous versions also allowed you to select and copy a simple plot (Line, Scatter, Line + Symbol, 2D Column/Bar) and paste underlying data into a worksheet. The default settings no longer support this but you can reverse this by setting LabTalk system variable @CPNP=1.

### 11.3.3.7 Removing or Hiding Plots with the Object Manager

The **Object Manager** is a dockable panel that allows for easy manipulation of graph layers and data plots. See the section on **The Object Manager** in this Guide.

To hide or remove plots, right-click on a plot and choose from the shortcut menu:
Graphing

- Show or hide plots of the same Long Name.
- Show all plots.
- Remove a plot from the graph window (hidden plots can be quickly shown again; removed plots must be added back using one of the above methods).
- If the plot is part of a group, you can right-click on an individual plot and remove just that plot or you can right-click on the group icon and remove the entire plot group.
- When you right-click on a plot, you can use **Hide Plots with Same Name** and **Hide All Plots** shortcut menu items to quickly hide selected plots in the window without removing them entirely (restore plots by enabling their display in the Object Manager or in Plot Details).

11.3.3.8 Removing or Hiding Data with Plot Details

In the left panel of the Plot Details dialog box (**Format: Plot...**), right-click on a plot and choose **Remove** or **Hide** from the context menu. **Remove** will delete the data plot from the graph so if you just want to temporarily hide a plot, choose **Hide**. Neither of them will delete data from worksheet or matrix.

11.3.3.9 Deleting Plots using the Delete Key

Click on a data plot (either in the graph window or Object Manager) and press the **Delete** key. If the selected plot is part of a group, the entire group is deleted.

Note that this is more sweeping than the **Remove** shortcut menu command in that it will remove an entire plot group from the graph window. This action does not delete worksheet or matrix data.

To restore the deleted plots, choose **Edit: Undo Remove Plot** from the main menu.

11.3.3.10 Editing Plot Range

Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data:

- Right-click on the plot and choose the **Edit Range...** shortcut menu command. Edit the **From** and **To** values.
- In the right panel of the Layer Contents dialog box (**Graph: Layer Contents**), turn on the **Range** column by right-clicking on the column headings and choosing **Range**. Click on a plot's range values, then click the ... button that appears to the right side of that column.
- In the bottom panel of Plot Setup (**Graph: Plot Setup**), click on the plot range in the **Range** column and click the ... button that appears to the right side of that column.
Choose **Graph: Rescale to Show All** to rescale the graph after editing the plot range.

### 11.3.4 Grouping Data Plots

When you make multiple range or column selections, then create a graph, Origin *groups* the resulting data plots in the graph layer. This applies to most **1D** (statistical) and **2D** graphs, plus **3D XYY** (XYY 3D bar, 3D ribbon, 3D wall, and 3D waterfall plots) and **3D XYZ** (3D scatter, 3D bar) graphs.

Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, triangle...; etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list of styles. For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot might be denoted by a red line (the second color in the color list), the third plot by a green line (the third color in the color list), and so on.

#### Tutorial: Creating a simple grouped data plot

1. Open a fresh worksheet and click the **Import Single ASCII** button on the Standard toolbar.
2. Browse to the Samples\Graphing subfolder in the Origin software folder and **Open** GROUP.DAT.
3. Select **B(Y)**, **C(Y)**, and **D(Y)** columns
4. Click the **Line & Symbol** button on the 2D Graphs toolbar. Note that line and symbol color and symbol type are automatically differentiated for each plot.

#### Tutorial: Grouping (or ungrouping) plots manually

- **Via the Layer Contents dialog box**

  1. To open the **Layer Contents dialog box**, double-click on the **layer n** icon in upper-left corner of the graph window.
  2. To create a group, select the desired data sets from the **Layer Contents** list (use CTRL + select, SHIFT + select, or simply drag the mouse to select multiple data sets).
  3. Click **Group**. Note that each plot in Layer Contents is now preceded by a **gn** (for "group1", "group2", etc.).
  4. To ungroup, click on one of the grouped data plots in the **Layer Contents** list and click **Ungroup**.
• **Via the Plot Setup dialog box**

1. To open the **Plot Setup** dialog box, ALT + double-click on the **layer n** icon in upper-left corner of the graph window.
2. To create a group, select the desired plots from the **Plot List** (use the CTRL or SHIFT keys to select multiple data sets).
3. Right-click and select **Group**. Note that a **Group** icon now precedes the selected plots in the Plot List.
4. To ungroup, right-click on the **Group** icon and choose **Ungroup** from the shortcut menu.

**11.3.5 Speed Mode**

With **Speed Mode**, you can control the number of data points displayed in a graph layer. This option is most used when working with large data sets, though note that there have been improvements in this area and Origin now has **Density Dots** and **Color Dots** graph templates specifically for creating scatter plots of large datasets.

Speed Mode can be turned on for any 2D or 3D graph. When Speed Mode is enabled, the layer icon displays in red and a **Speed Mode is On** watermark appears in the layer. The watermark is *not included when printing, copying, or exporting the graph.*

To adjust Speed Mode settings:

1. With your graph active, select **Format: Layer...** from the Origin menu.
2. Select the **Display/Speed** tab.
3. For plots created from worksheet data, Select the **Worksheet Data, Maximum Points Per Curve** check box to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type the desired value \( n \) in the associated text box. If the number of data points in a data plot exceeds \( n \), Origin displays a subset of the data plot containing \( n \) points, drawn by extracting values at regular intervals from the data set.

4. For 3D data plots created from a matrix or for contour data in the layer, Select the **Matrix Data, Maximum Points Per Dimension** check box to enable Speed Mode. Type the desired value \( (n, m) \) in the X and Y text boxes. If the number of data points in a data plot exceeds \( n \) or \( m \), Origin displays a subset of the data plot composed of -- at maximum -- \( n \) by \( m \) points. This subset is drawn by extracting values at regular intervals from the matrix columns (X) and rows (Y).

For broad control, you can select **Speed Mode** from the **Graph** menu. This opens the speedmode **X-Function** dialog. The dialog lets you specify which windows the settings should apply to (**Target**) and also, offers several levels of data plot thinning from **Off** to **High**, plus **Custom**.

Click the **Enable/Disable Speed Mode** button on the Graph toolbar, to toggle Speed Mode on/off for all layers in the graph window.

To turn off the **Speed Mode is On** watermark:

1. Select **Preferences: Options** to open the Options dialog box.
2. Select the **Graph** tab and clear the **Speed Mode Show Watermark** check box and refresh the graph, if needed. Note that this only disables the watermark; it does not disable Speed Mode.

11.3.5.1 Notes on Speed Mode

- **Skip Points** and **Speed Mode** plot the last data point, by default, but this is controlled by system variable **@SMEP**.
- The Speed Mode controls on the **Display/Speed** tab of the layer’s Plot Details only apply to what you see on screen. They do not apply to graphs that are printed or exported, by default.
- If you wish to **skip points** in printouts, use controls in the **Print** dialog. See the discussion of the **Skip Points** feature as it applies to some graph windows in the Origin Help file.
- If you wish to apply Speed Mode settings to graphic export, please see this discussion of **Performance Group** controls on the **Miscellaneous** tab of the Plot Details dialog box or use controls under **the Export Settings node** in the **Graph Export** dialog.
- Speed Mode settings are saved with the graph template. If you make changes to Speed Mode settings for a particular graph type, you will have to resave the graph template to make those changes permanent.
- Always exercise judgement when using Speed Mode. Since Speed Mode systematically weeds out a portion of your data points, any graph in which Speed Mode is turned on, may -- or may not -- accurately represent your data, to your satisfaction. Always familiarize yourself with your data and adjust and compare Speed Mode settings to ensure that trends in your data are accurately depicted.
11.4 Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and Printing

There are a number of ways to present your finished graph.

- Copy a graph page and paste it in other applications such as Word, Powerpoint, etc.
- Export the graph page as an image file (raster or vector).
- Send Graphs to PowerPoint.
- Printout.
- Slideshow within Origin.
- Create Movies.

Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading" there.

11.5 Origin Graph Types

Origin supports over 100 plot types. Origin's 2D graphs are plotted from Worksheet data. Origin's 3D graphs are plotted from Worksheet data (XY, XYZ), a worksheet arrangement we refer to as a Virtual Matrix or from Matrix data.

Origin Graph Samples of most 2D and 3D graph types are included with your Origin software. To view graphs, supporting data and guidelines for making the graphs, choose Help: Origin Central; or click on the Origin workspace to activate Origin and press F11 on your keyboard.

The tables below list all Origin graph types, grouped by Plot menu category:

- The Plot menu icon for each graph type precedes the graph name.
- The Notes column provides basic information on data requirements. For more specific data requirements, click on the graph name beside the Plot menu icon.

11.5.1 Plot Menu Graphs by Category

Origin 2021 adds these new plot types: Lollipop Plots, Polar Vector θr θr and Compass Plots, Chord Diagrams and a Stack variant for Browser Graphs.
You can modify the size of the Plot menu icons using the LabTalk system variable @PPS. To find out how to change the value of a system variable, see Customizing Origin Using System Variables.

### 11.5.1.1 Basic 2D

<table>
<thead>
<tr>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scatter</td>
<td>- Start with a Worksheet.</td>
</tr>
<tr>
<td>Scatter Central</td>
<td>- If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.</td>
</tr>
<tr>
<td>Column Scatter</td>
<td>- For specific data requirements, follow links in the Graph Types column.</td>
</tr>
<tr>
<td>Y Error</td>
<td>- Overlapped Points Offset Plotting: You can now offset overlapping scatter points horizontally or vertically. Double-click on the plot to open Plot Details, click on the Symbol tab, check the Overlapped Points box and choose Arrangement = Horizontal or Vertical.</td>
</tr>
<tr>
<td>XY Error</td>
<td></td>
</tr>
<tr>
<td>Error Band</td>
<td></td>
</tr>
<tr>
<td>Scatter + Rug</td>
<td></td>
</tr>
<tr>
<td>Bubble</td>
<td></td>
</tr>
<tr>
<td>Color Mapped</td>
<td></td>
</tr>
<tr>
<td>Bubble + Color Mapped</td>
<td></td>
</tr>
<tr>
<td>Mapped</td>
<td></td>
</tr>
</tbody>
</table>

- Start with a Worksheet.
- Select one or more Y columns or at least a portion of one Y column.
- Multiple Y columns are grouped in layer.
- If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.
- For specific data requirements, follow links in the Graph Types column.
- Start with a **Worksheet**.
- Select one or more Y columns or at least a portion of one Y column.
- Multiple Y columns are grouped in the graph layer (except Line Series).
- For Line Series graph, select 2 or 3 Y columns.
- If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.
- For specific data requirements, follow links in the **Graph Types** column.

You can hide line segments in a Line + Symbol graph. Hold down the CTRL key and double-click on the data point where you want to break your line. With your "special point" highlighted in the left panel of Plot Details, click on the **Line** tab and set **Connect** to **No Line**.

<table>
<thead>
<tr>
<th>Graph Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line + Symbol</td>
</tr>
<tr>
<td>Line Series</td>
</tr>
<tr>
<td>Before and After</td>
</tr>
<tr>
<td>2 Point Segment</td>
</tr>
<tr>
<td>3 Point Segment</td>
</tr>
<tr>
<td>Spline Connected</td>
</tr>
</tbody>
</table>

- Start with a **Worksheet**.
- For Bar, Column or Column + Label, select one or more Y columns (multiple Y columns are grouped in layer).
- For Floating Bar/Column, select two Y columns.
- For Stack graphs and Lollipop plots, select two or more Y columns.
- If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.
- For specific data requirements, follow links in the **Graph Types** column.

**Lollipop plots** are new for **Origin 2021**.

<table>
<thead>
<tr>
<th>Graph Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
</tr>
<tr>
<td>Column + Label</td>
</tr>
<tr>
<td>Bar</td>
</tr>
<tr>
<td>Stacked Column</td>
</tr>
<tr>
<td>Stacked Bar</td>
</tr>
<tr>
<td>100% Stacked Column</td>
</tr>
<tr>
<td>100% Stacked Bar</td>
</tr>
<tr>
<td>Floating Column</td>
</tr>
<tr>
<td>Floating Bar</td>
</tr>
<tr>
<td>Lollipop Plot</td>
</tr>
<tr>
<td>Vertical Drop Line</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>![Density Dots]</td>
</tr>
</tbody>
</table>

- Start with a **Worksheet**.
- Select exactly one Y column or a range from one Y column.
- If there is an associated X column, the X data are used in the graph legend; otherwise row number is used.
- For specific data requirements, follow links in the **Graph Types** column.

- Start with a **Worksheet**.
- Select one Y (Density Dots) or two Y (Color Dots) columns.
- For more information, follow links in the **Graph Types** column.

- Start with a **Worksheet**.
- If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.
- For specific data requirements, follow links in the **Graph Types** column.
**11.5.1.2 Multi-Panel/Axis**

<table>
<thead>
<tr>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Double-Y Column Graph** | • Start with a **Worksheet**.  
• Select two Y columns.  
• If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.  
• For specific data requirements, follow links in the **Graph Types** column. |
| **Double-Y** | When two layers are linked by a common X axis (Double-Y), you can now more-easily swap layer drawing order by right-clicking on the "front" layer in Object Manager (OM) and choosing **Push to Back**. Previously, swapping layers in OM would prompt to break layer linking. |
| **2Ys, Column-Line&Symbol** | |
**Multiple Y Axes...**

- **Vertical 2 Panel**
- **Horizontal 2 Panel**
- **4 Panel**
- **9 Panel**
- **Stack...**
- **Multiple Panels by Label...**

- Start with a **Worksheet**.
- Select one Y column (or range) per panel.
- If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.
- For specific data requirements, follow links in the **Graph Types** column.

**Zoom**

- Start with a **Worksheet**.
- Select at least one Y column or a range from at least one Y column.
- If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.
- For specific data requirements, follow the link in the **Graph Types** column.

11.5.1.3 **Statistical**

<table>
<thead>
<tr>
<th><strong>Graph Types</strong></th>
<th><strong>Notes</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Box Chart</strong></td>
<td>• Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td><strong>Interval Plot</strong></td>
<td>• Select at least one Y column or a range from at least one Y column.</td>
</tr>
<tr>
<td><strong>Bar Chart</strong></td>
<td>• For specific data requirements, follow the link in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td><strong>Box Overlap</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Box Normal</strong></td>
<td></td>
</tr>
<tr>
<td>Graph Types</td>
<td>Instructions</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Half Box</td>
<td>Start with a Worksheet.</td>
</tr>
<tr>
<td>Bar Overlap</td>
<td>Select at least one Y column or a range from at</td>
</tr>
<tr>
<td></td>
<td>least one Y column.</td>
</tr>
<tr>
<td>Bar Normal</td>
<td>For specific data requirements, follow links in</td>
</tr>
<tr>
<td></td>
<td>the Graph Types column.</td>
</tr>
<tr>
<td>Scatter Interval</td>
<td></td>
</tr>
<tr>
<td>Marginal Box Charts</td>
<td></td>
</tr>
<tr>
<td>Beeswarm Plot</td>
<td></td>
</tr>
<tr>
<td>Histogram</td>
<td></td>
</tr>
<tr>
<td>Histogram + Rug</td>
<td></td>
</tr>
<tr>
<td>Histogram + Probabilities</td>
<td></td>
</tr>
<tr>
<td>Multi-Panel Histograms</td>
<td></td>
</tr>
<tr>
<td>Distribution</td>
<td></td>
</tr>
<tr>
<td>Distribution + Rug</td>
<td></td>
</tr>
<tr>
<td>Histogram with Labels</td>
<td></td>
</tr>
<tr>
<td>Stacked Histograms</td>
<td></td>
</tr>
<tr>
<td>Population Pyramid</td>
<td></td>
</tr>
<tr>
<td>Marginal Histograms</td>
<td></td>
</tr>
<tr>
<td>Scatter Matrix</td>
<td></td>
</tr>
</tbody>
</table>

- Start with a **Worksheet**.
- Select at least one Y column or a range from at least one Y column.
- For specific data requirements, follow links in the **Graph Types** column.
Improved for **Origin 2021**:

- New page-level **Layer** tab check boxes for **Independent Layer Control** and **Independent Binning Control**.
- Axis scale of the upper-left layer now displays for scatter plots instead of histogram.

<table>
<thead>
<tr>
<th>Violin Plot</th>
<th>Violin with Box</th>
<th>Violin with Point</th>
<th>Violin with Quartile</th>
<th>Violin with Stick</th>
<th>Split Plot</th>
<th>Half Violin</th>
</tr>
</thead>
</table>

- Start with a **Worksheet**.
- Select at least one Y column (or a range from at least one Y column).
- Split violin requires exactly 2 data columns, plus a third grouping column.
- For data requirements and other information on plot variations, see [Violin Plot](#).

<table>
<thead>
<tr>
<th>Pareto Chart - Binned Data</th>
<th>Pareto Chart - Raw Data</th>
</tr>
</thead>
</table>

- Start with a **Worksheet**.
- Select one Y columns or a range from one Y column (Raw), or a Y column of Binned results.
- For specific data requirements, follow the link in the **Graph Types** column.

<table>
<thead>
<tr>
<th>QC (X-bar R) Chart</th>
</tr>
</thead>
</table>

- Start with a **Worksheet**.
- Select at least one Y column or a range from at least one Y column.
- For specific data requirements, follow the link in
<table>
<thead>
<tr>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bridge Chart</td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td>Stacked Bridge Chart</td>
<td>• Select one or more Y columns (or a range of one or more Y columns). If there is an X column to the left of the Y column(s), this X column is treated as categorical data; otherwise, the worksheet’s row indices will be used.</td>
</tr>
<tr>
<td>Stacked Total Bridge Chart</td>
<td>• Origin Bridge Charts are variants of one basic chart type. For more information, see Bridge Charts.</td>
</tr>
<tr>
<td>Horiz-Bridge Chart</td>
<td></td>
</tr>
<tr>
<td>Double Y Box</td>
<td></td>
</tr>
<tr>
<td>Probability Plot</td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td>Q-Q Plot</td>
<td>• Select one Y column or a range from one Y column.</td>
</tr>
<tr>
<td></td>
<td>• For specific data requirements, follow the link in the Graph Types column.</td>
</tr>
<tr>
<td>Bland-Altman Plot</td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td></td>
<td>• Select two Method columns and one Subject column (optional).</td>
</tr>
<tr>
<td></td>
<td>Bland-Altman plots get two more output parameters for Origin 2021:</td>
</tr>
<tr>
<td></td>
<td>• Mean of Pairwise Means</td>
</tr>
<tr>
<td></td>
<td>• Bland-Altman Ratio (0.5*(upper LoA - lower LoA)/Mean of Pairwise Means)</td>
</tr>
</tbody>
</table>

11.5.1.4 Contour
<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contour - Color Fill</td>
<td>• Contour Color Fill, B/W Lines + Labels, Gray Scale Map, Contour Profiles: XYZ, Virtual Matrix, Matrix.</td>
</tr>
<tr>
<td>Contour B/W Lines + Labels</td>
<td>• Contour - Categorical Z: XYZ, Virtual Matrix.</td>
</tr>
<tr>
<td>Gray Scale Map</td>
<td>• For specific data requirements, follow links in the Graph Types column.</td>
</tr>
<tr>
<td>Contour - Categorical Z</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Heatmap</td>
<td>• Heatmap and Heatmap with Labels start with a Worksheet (XY, XYZ), Virtual Matrix or Matrix.</td>
</tr>
<tr>
<td>Heatmap with Labels</td>
<td>• Split Heatmap starts from a Worksheet.</td>
</tr>
<tr>
<td>Split Heatmap</td>
<td>• For specific data requirements, follow links in the Graph Types column.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Contour Profiles</td>
<td>• Start with a Worksheet, Virtual Matrix or Matrix (Image Profiles, Matrix only).</td>
</tr>
<tr>
<td>Image Profiles</td>
<td>• For specific data requirements, follow links in the Graph Types column.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Polar Contour theta(X), r(Y)</td>
<td>• Start with a Worksheet or Matrix.</td>
</tr>
<tr>
<td>Polar Contour r(X), theta(Y)</td>
<td>• For data requirements and other information on polar contour graphs from worksheet data, see Polar Contour from XYZ Data.</td>
</tr>
<tr>
<td></td>
<td>• For data requirements and other information on polar contour graphs from matrix data, see Polar Contour from Matrix Data.</td>
</tr>
<tr>
<td>Ternary Contour</td>
<td>• Start with a Worksheet.</td>
</tr>
<tr>
<td></td>
<td>• Columns should be designated as XYZZ.</td>
</tr>
<tr>
<td></td>
<td>• For specific data requirements, follow the link in the Graph Types column.</td>
</tr>
</tbody>
</table>

Rescale control (Fixed, Normal, Auto, etc.) is added to Ternary coordinate axes for **Origin 2021**
- Start with a **Worksheet**.
- Select at least one Y column or a range from at least one Y column.
- For specific data requirements, follow the link in the **Graph Types** column.

### 2D Kernel Density

- Start with a **Matrix**.
- Z values are from an imported raster image.

You can now customize head and tail colors for Image Plots.

**NEW**

You can use a **Color List** for colormapping. For more information, see **Editing Fills** on the Plot Details **Color Map/Contours** tab.

#### 11.5.1.5 Specialized

**NEW**

*For Origin 2021, Perpendicular and Parallel options have been added to **Axis** dialog **Tick Labels > Format > Rotate (deg.)** for radial plot types.*

<table>
<thead>
<tr>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Vector XYAM**              | - Start with a **Worksheet**.  
- For XYAM Vector, select three Y columns (or a range of the three Y columns).  
- For XYYX Vector, select two X columns and 2 Y columns (or a range of two X and two Y columns).  
- For specific data requirements, follow links in the **Graph Types** column. |
| **Vector XYXY**              | **NEW**  
- Start with a **Matrixsheet** with two matrix objects. The two matrix objects are the derivatives of the |

**Streamline Vector Plot**
plotted curve in the (x,y) directions, respectively.

- Start with a **Worksheet**.
- For specific data requirements, follow links in the **Graph Types** column.

**Rescale control** *(Fixed, Normal, Auto, etc.)* is added to Ternary coordinate axes for **Origin 2021**.

You can move axis titles to ternary plot vertices by setting **Rotate (deg.) = 0** (double-click on the axis to open the **Axis** dialog), then dragging the axis title into position.

- **Ternary**
- **Ternary, Line+Symbol**
- **Ternary, Line**
- **Piper**

**Radar**
- **Line Fill**
- **Line**
- **Symbol**

- Start with a **Worksheet**.
- Select at least one Y column (or a range from at least one Y column). The X column displays as the title of the radial axis around the chart. If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.
- **Radar Charts and Spider Charts** are created from the same basic Origin plot type.
- For more information, see **Spider Charts**.

**Polar**
- **Polar theta(X) r(Y)**
- **Polar r(X) theta(Y)**
- **Bar theta, r**
- **Bar r, theta**
- **Line + Symbol theta, r**
- **Line + Symbol r, theta**

- Start with a **Worksheet**.
- Select one or more Y columns or a range from one or more Y columns. If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.
- For data requirements and other information on polar graphs, see **Polar Graph**.
<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol theta, r</td>
<td>Start with a Worksheet. Select at least one Y column of values (or a range from at least one column). If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.</td>
</tr>
<tr>
<td>Symbol r, theta</td>
<td>For more information, see <a href="#">Radial Bar and Radial Stacked Bar Plot</a>.</td>
</tr>
<tr>
<td>Wind Rose - Binned Data</td>
<td></td>
</tr>
<tr>
<td>Wind Rose - Raw Data</td>
<td></td>
</tr>
<tr>
<td>Stacked Radial</td>
<td>Start with a Worksheet. For Compass, Select at least one Y column of values (or a range from at least one column). If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used. For Polar Vector θr θr, select two pairs of XY columns in the order θr θr.</td>
</tr>
<tr>
<td>Radial Bar Plot</td>
<td></td>
</tr>
<tr>
<td>Radial Stacked Bar</td>
<td></td>
</tr>
<tr>
<td>Polar Vector θr θr</td>
<td></td>
</tr>
<tr>
<td>Compass Plot</td>
<td>These plot types are new for Origin 2021.</td>
</tr>
<tr>
<td>Smith Chart</td>
<td>Start with a Worksheet. Select at least one Y column of values (or a range from at least one column). If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used. For more information, follow the link in the Graph.</td>
</tr>
</tbody>
</table>
11.5.1.6 Categorical

**Mini Toolbar** additions useful for editing Categorical graph types in Origin 2021:

- Mini Toolbar button to **Show Table Row Title** at either end of tick label table.
- Buttons for configuring **Parallel Plot** axes.

<table>
<thead>
<tr>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grouped Scatter - Indexed Data</td>
<td>• Start with a <a href="#">Worksheet</a>.</td>
</tr>
<tr>
<td></td>
<td>• Select at least one Y column as input data.</td>
</tr>
<tr>
<td></td>
<td>• One or more column(s) of categorical data provide grouping information.</td>
</tr>
<tr>
<td></td>
<td>• For more information, see the link in the <a href="#">Graph Types</a> column.</td>
</tr>
<tr>
<td>Graph Type</td>
<td>Data Type</td>
</tr>
<tr>
<td>------------</td>
<td>-----------</td>
</tr>
</tbody>
</table>
| Color Mapped | Bubble + Color Mapped | 1. Start with a **Worksheet**.  
2. If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.  
3. For specific data requirements, follow links in the **Graph Types** column. |
| Grouped Columns - Indexed Data | | 1. Start with a **Worksheet**.  
2. If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.  
3. An additional column supplies the Group information. |
| Grouped Box Charts - Indexed Data | | 1. Start with a **Worksheet**.  
2. Select at least one Y column (or a range from at least one Y column), plus a second column with grouping information. If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.  
3. Plots of **Indexed Data** are all style variations of the **Grouped Box**.  
4. For more information, follow the links in the **Graph Types** column. |
| Grouped Column Scatter - Indexed Data | | 1. Start with a **Worksheet**.  
2. Select at least one Y column as input data. Optionally, you can have an additional associated Y error column for each Y column. Other column(s) |
| Grouped Interval Plot - Indexed Data | | 1. Start with a **Worksheet**.  
2. Select at least one Y column as input data. Optionally, you can have an additional associated Y error column for each Y column. Other column(s) |
<table>
<thead>
<tr>
<th>Plot Type</th>
<th>Instructions</th>
</tr>
</thead>
</table>
| **Double Y Trellis Plot**  | - Start with a **Worksheet**.  
- Select two Y columns as input data. Optionally, you can have an additional associated Y error column for each Y column. Other column(s) generally contain grouping information.  
- For more information, see the link in the **Graph Types** column. |
| **Cluster Plot**           | - Start with a **Worksheet**.  
- You need at least two Y columns, one of which should contain grouping information.  
- Grouping columns can be used to create separate panels in the horizontal and/or vertical directions and/or to modify plotted points (color, scatter point size, scatter point shape, etc.). |
| **Parallel Plot**          | - Start with a **Worksheet**.  
- Select at least one (ideally, two or more) column(s) or a range from one or more columns. Column designation does not matter. Each column will be treated as data on a single variable.  
- Variables may be numeric (Parallel Plot or Parallel Index) or they may be categorical (Parallel Sets).  
- Parallel Sets plots have a "curvature" option that is sometimes seen in plots termed "Alluvial Plots".  
- For more information, follow links in the **Graph Types** column. |
| **Sankey Diagrams**        | - Start with a **Worksheet**.  
- For Sankey Diagrams, select exactly two columns of categorical data + 1 column of numeric data. Column designation is ignored  
- For Alluvial Diagrams, select two or more columns of categorical data. Column designation is ignored. |
For more information, follow links in the **Graph Types** column.

A new **Node** tab check box **Order by Data** lets you order categories by list order in the column.

**Chord Diagrams** are new for **Origin 2021**.

---

**Start with a Worksheet or Virtual Matrix.**

- Select at least three columns of values (worksheet) or a block of values (virtual matrix) from at least three columns. * The first column will be treated as X and should be monotonic.

- For more information, see [Chord Diagram and Chord Diagram with Ratio Layout](#).

**Origin 2021** supports **data masking** in XYZ 3D plots. You can mask data using buttons on the **Mask** toolbar (worksheet active) or the **Tools** toolbar (graph active).

---

<table>
<thead>
<tr>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="3D Scatter" /></td>
<td>Data requirements vary by plot type. See links in the <strong>Graph Types</strong> column.</td>
</tr>
<tr>
<td><img src="#" alt="3D Scatter + Error Bar" /></td>
<td>You can use the <strong>Data Highlighter</strong> on the Tools toolbar to select a region of data points in a 3D graph (e.g. 3D Scatter). The plotted data, plus the worksheet data are highlighted.</td>
</tr>
<tr>
<td><img src="#" alt="3D Line" /></td>
<td></td>
</tr>
<tr>
<td><img src="#" alt="3D Trajectory" /></td>
<td></td>
</tr>
<tr>
<td>Graph Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 3D Vector XYZ XYZ                  | • Start with a **Worksheet**.  
• Select 6 worksheet columns, designated as XYZ XYZ.  
• For more information, see links in the **Graph Types** column. |
|                                   | 3D Vector XYZ dXdYdZ                                                                                                                     |
| 3D Bar Graph                       | • Start with a **Worksheet** (XYZ) or a **Virtual Matrix** or **Matrix** of Z values.  
• For specific data requirements, follow links in the **Graph Types** column. |
| 3D Stacked Bars Graph              |                                                                                                                                               |
| 3D 100% Stacked Bar Graph          |                                                                                                                                               |
| Color Fill Surface                 | • Start with a **Worksheet** or **Matrix**.  
• For specific data requirements, follow links in the **Graph Types** column. |
| X Constant with Base Surface       |                                                                                                                                               |
| Y Constant with Base Surface       |                                                                                                                                               |
| Color Map Surface                  |                                                                                                                                               |
| Color Map Surface with Projection  |                                                                                                                                               |
| Wire Frame                         |                                                                                                                                               |
| Wire Surface                       |                                                                                                                                               |
| 3D Ternary Colormap Surface        | • Start with a **Worksheet**.  
• Select two Z columns (XYZZ) or a range of data from two Z columns (Z columns may be multiples of 2).  
• For more information, follow links in the **Graph Types** column. |
| 3D Ternary Symbol                  |                                                                                                                                               |
### Graphing

<table>
<thead>
<tr>
<th>3D Tetrahedral</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NEW</strong></td>
<td>Rescale control (Fixed, Normal, Auto, etc.) is added to Ternary coordinate axes for Origin 2021.</td>
</tr>
</tbody>
</table>

- Start with a **Worksheet**.
- Select two Z columns (XYZZ) or a range of data from two Z columns (Z columns may be multiples of 2).
- For more information, follow links in the **Graph Types** column.

<table>
<thead>
<tr>
<th>Waterfall</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Waterfall</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Waterfall: Y Color Mapping</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Waterfall: Z Color Mapping</strong></td>
<td></td>
</tr>
<tr>
<td><strong>3D Waterfall</strong></td>
<td></td>
</tr>
<tr>
<td><strong>3D Waterfall: Y Color Mapping</strong></td>
<td></td>
</tr>
<tr>
<td><strong>3D Waterfall: Z Color Mapping</strong></td>
<td></td>
</tr>
</tbody>
</table>

- Start with a **Worksheet**.
- Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.
- For more information, see the links in the **Graph Types** column.

- You can add labels at specified indices for Waterfall graphs (all types). To add labels, activate the graph and from the menu, choose **Format: Plot**. In **Plot Details**, click on the **Label** tab and check **Enable, Show at Specified Indices Only** and provide a space-separated list of index numbers; or choose a dataset with index numbers from the drop-down.

<table>
<thead>
<tr>
<th>XYY 3D Bars</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>XYY 3D Side by Side Bars</strong></td>
<td></td>
</tr>
<tr>
<td><strong>XYY 3D Stacked Bars</strong></td>
<td></td>
</tr>
<tr>
<td><strong>XYY 3D 100% Stacked</strong></td>
<td></td>
</tr>
</tbody>
</table>

- Start with a **Worksheet**.
- Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y **sampling interval** or row number is used.
- For more information, see the links in the **Graph**
### Bars

<table>
<thead>
<tr>
<th>Types column.</th>
</tr>
</thead>
</table>

- Start with a **Worksheet**.
- Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.
- For more information, see the link in the **Graph Types** column.

---

### 3D Ribbons

![3D Ribbons](image)

- Start with a **Worksheet**.
- Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.
- For more information, see the link in the **Graph Types** column.

---

### 3D Wall Graph

- **3D Stacked Wall Graph**
- **3D 100% Stacked Wall Graph**

- Start with a **Worksheet**.
- Select at least one Y column (or a range from at least one Y column). Ideally, select at least two Y columns (or a range of at least two Y columns). If there is an associated X column, X column supplies X values; otherwise, Y sampling interval or row number is used.
- For more information, see the link in the **Graph Types** column.

---

**For an overview of Origin’s 3D graph types and their source data requirements, see these topics:**

- [Creating 3D Graphs](#)
- [3D and Contour Graphing](#)
- [Creating Contour Graphs](#)
- [Creating 3D and Contour Graphs from Virtual Matrix](#)

---

11.5.1.8 **Browser Graph**
Browser graphs are useful for selectively plotting data from worksheets containing many columns (and rows), into a single graph layer:

- Select a single plot or every $N$th column for plotting.
- Easily change column selection.
- Stretch the window in either dimension to obtain the best view.
- Specify automatic rescale and/or common display range for all plots.
- Works with other Origin tools including Gadgets.
- Plots can be further customized via Plot Details dialog box.

Browser graph improvements for **Origin 2021**:

- The 2D graph Mini Toolbar includes an Add Browser button so that you can add a Browser panel to any graph page.
- A Flip Through function has been added to the Browser panel menu. Specify Move By to view, in sequence, every $N$th plot.

<table>
<thead>
<tr>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Black Lines | - Starts with a Worksheet.  
- Plot selected Y columns, plot every $n$th column or plot all columns. |
| Color Lines | - Stack plots by Long Name, Units, etc.  
- Selecting plots on Browser panel will select plots with the same name in each |
| Histogram | |
| Stack | |
11.5.1.9 Function Plot

<table>
<thead>
<tr>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New 2D Plot</strong></td>
<td>• Function plots are not created from physical data.</td>
</tr>
<tr>
<td><strong>New 2D Parametric Plot</strong></td>
<td>• Once a function plot is created, you can obtain the derived dataset.</td>
</tr>
<tr>
<td><strong>New 3D Plot</strong></td>
<td>• Function plots are not created from physical data.</td>
</tr>
<tr>
<td><strong>New 3D Parametric Plot</strong></td>
<td>• When a 3D Function is plotted, a matrix of Z values is simultaneously generated.</td>
</tr>
<tr>
<td><strong>For more information on function plots</strong>, follow links in the <strong>Graph Types</strong> column.</td>
<td></td>
</tr>
</tbody>
</table>

11.5.1.10 My Templates

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>My Templates</strong></td>
<td>• This Category lists and gives direct access to the custom templates in your <strong>User Files Folder</strong>.</td>
</tr>
</tbody>
</table>

11.5.1.11 Other Graphing Tools

<table>
<thead>
<tr>
<th>App</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graph Maker App</strong></td>
<td>• The <strong>Graph Maker</strong> app is pre-installed in your Origin software.</td>
</tr>
<tr>
<td></td>
<td>• Launch the App from the <strong>Plot</strong> menu or from the Graph Maker app icon in the Apps Gallery to the</td>
</tr>
</tbody>
</table>
right side of your Origin workspace.

- Use the **Graph Maker** app with Preview pane, to interactively plot grouped data.
- Choose from line, scatter, line+symbol, column, box and histogram chart types.
- Supports fitting for scatter plots.
- Drag-and-drop worksheet columns to set up the graph.
- Graph settings are saved and can be re-loaded.

**Template Library**

- Use this dialog to organize your custom graphing templates.

### 11.6 Topics for Further Reading

- [The Page-Layer-Plot Hierarchy](#)
- [Page Viewing Modes](#)
- [Graph Axes](#)
- [Creating Graphs from Graph Templates](#)
- [Creating Multi Layered Graphs](#)
- [Adding Data Plots to the Graph Layer](#)
- [The Layer Contents Dialog Box](#)
- [The Object Manager](#)
- [Graph Layers](#)
- [Linking Layers](#)
- [3D and Contour Graphing](#)
- [Plotting Mathematical Functions](#)
- [Appendix 2 - Complete Listing of Origin Graph Types](#)
12 Customizing Graphs

12.1 Introduction

This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph template. If the graph you are making is fairly standard for its type, the options that were stored in the graph template may be entirely adequate to produce a polished-looking graph. The business of basic graph creation was covered in the last chapter, Graphing.

Sooner or later, however, you are going to want to add annotations, modify axis scales, or change plot colors. Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and techniques, as well as to point you toward resources that will help you manage more complex graph customization tasks.

We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are commonly used for quick modifications of graph elements.

12.2 Mini Toolbars
Most 2D and Contour plots now support a set of “quick editing” tools for interactively modifying common graph object properties. Tools are context-sensitive so that -- (1) depending on where you click inside the graph window, (2) what the selected object is and (3) whether you have selected an individual plot or a plot group -- you will have a different set of tools available to edit your selection.

- There are five levels -- i.e. five groupings of graph properties -- that can be edited with Mini Toolbars: page, layer, plot, text or drawn objects and graph axes.
- When editing grouped plots, a single click will select a single plot. The Mini Toolbar displays two tabs -- one for the customizing the group, the other for customizing the single plot.

- Most Mini Toolbars have a “properties” button that opens a related Origin dialog box where you will find the full range of available controls.

Unless you have changed your selection, you can do a one-time restore of a Mini Toolbar after it has faded by pressing the SHIFT key.
A number of object properties -- font size, symbol size, rotation angle, etc. -- are incremented by clicking a **Mini Toolbar** button. *Origin 2021* lets you modify the increment by **changing the value of a specific LabTalk system variable**.

<table>
<thead>
<tr>
<th>Object</th>
<th>Mini Toolbar Buttons</th>
<th>System Variable</th>
<th>Default Increment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol Size</td>
<td><img src="image" alt="Symbol Size" /></td>
<td>@INCSS</td>
<td>1</td>
</tr>
<tr>
<td>Line Thickness</td>
<td><img src="image" alt="Line Thickness" /></td>
<td>@INCLT</td>
<td>1</td>
</tr>
<tr>
<td>Font Size</td>
<td><img src="image" alt="Font Size" /></td>
<td>@INCFS</td>
<td>1</td>
</tr>
<tr>
<td>Tick Label Rotation</td>
<td><img src="image" alt="Tick Label Rotation" /></td>
<td>@INCTLR</td>
<td>15</td>
</tr>
<tr>
<td>Text Object Rotation</td>
<td><img src="image" alt="Text Object Rotation" /></td>
<td>@INCTOR</td>
<td>90</td>
</tr>
<tr>
<td>Graph Object Rotation</td>
<td><img src="image" alt="Graph Object Rotation" /></td>
<td>@INCGOR</td>
<td>45</td>
</tr>
<tr>
<td>Tick Length</td>
<td><img src="image" alt="Tick Length" /></td>
<td>@INCTL</td>
<td>1</td>
</tr>
</tbody>
</table>
### 12.3 Toolbars

Toolbar buttons useful for graph-customization tasks:

<table>
<thead>
<tr>
<th>Description</th>
<th>Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pie Rotation</td>
<td>@INCPR 10</td>
</tr>
<tr>
<td>Doughnut Hole Size</td>
<td>@INCDHS 5</td>
</tr>
<tr>
<td>Break Length</td>
<td>@INCBL 1</td>
</tr>
<tr>
<td>Break Gap</td>
<td>@INCBG 15</td>
</tr>
<tr>
<td>Spacing Gap (column, doughnut, box)</td>
<td>@INCSG 5</td>
</tr>
</tbody>
</table>

You can check the increment value of a particular button by hovering on it. The **Status Bar** reports the current increment and the LabTalk system variable that you can modify to change the increment.

Larger Gap, increment=5, change increment by setting @INCSG to other value.

For information on changing the value of a LabTalk system variable see [FAQ-708 How do I permanently change the value of a system variable?](#).
<table>
<thead>
<tr>
<th><strong>Format toolbar buttons:</strong></th>
<th><strong>(default configuration)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Creating and customizing text objects.</td>
<td><img src="image" alt="Format Toolbar" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Style toolbar buttons:</strong></th>
<th><strong>(default configuration)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Editing colors, line thickness, fill patterns.</td>
<td><img src="image" alt="Style Toolbar" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Tools toolbar buttons:</strong></th>
<th><strong>(default configuration)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Add text objects, lines, curves, arrows, rectangles/circles/polygons.</td>
<td><img src="image" alt="Tools Toolbar" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Graph toolbar buttons:</strong></th>
<th><strong>(default configuration)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Add graph layers incl. inset graphs, merging or extracting graphs; exchanging axes; anti-aliasing and Speed Mode.</td>
<td><img src="image" alt="Graph Toolbar" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Add Object to Graph toolbar buttons:</strong></th>
<th><strong>(default configuration)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Add Object to Graph Toolbar" /></td>
</tr>
</tbody>
</table>
• Add legends/color scales/bubble scales; date & time and project path stamps; XY scale; table objects.

**Object Edit toolbar buttons:**

• Arranging and aligning objects and layers on the page.

### 12.4 Menus, Dialogs and Buttons Used in Graph Customization

Many quick graph customizations can be done using Origin’s graphing **Mini Toolbars**. More complex customization options can be accessed from commands on the **Format** or **Graph** menus. The following table lists key menu commands and dialog boxes plus a few toolbar buttons, used in customizing graphs.

<table>
<thead>
<tr>
<th>Task</th>
<th>Dialog Name</th>
<th>Method</th>
</tr>
</thead>
</table>
| Customize the graph Page, Layer, or Data Plot | **Plot Details** dialog | • Double-click on Page, Layer or Data Plot  
• **Format**: Page... menu  
• **Format**: Layer... menu  
• **Format**: Plot... menu  

See, [Customizing Page, Layer and Data Plots](#) |
| Customize Axes                | **Axis Dialog**   | • Double-click on axes or tick labels  
• **Format**: Axes... menu  
• **Format**: Axis Tick Labels... menu  
• **Format**: Axis Titles... menu  

See, [Customizing Graph Axes](#) |
| Add a Default Legend (most)   | N/A               | • Click the **Reconstruct Legend** |
| Customizing Graphs | 2D graphs) | (CTRL+L) button on the Add Object to Graph toolbar  
• Right-click on the legend object and choose Legend: Reconstruct Legend  
• Choose Graph: Reconstruct Legend from the main menu  
See, Graph Legends |
|---|---|---|
| | Text Object -) Legend dialog | Ctrl + double-click on the legend object text  
See, The (Text Object Properties) Text tab |
| | Update Legend dialog | Right-click legend and choose Legend: Update Legend or choose Graph: Legend: Update Legend...  
See, The legendupdate Dialog Box |
| Customize the Legend | Legends/Titles tab at Page level of Plot Details dialog | Double-click in the white area just inside graph window frame (but outside of the data plot), then click on the Legends/Titles tab  
Choose Format: Page and click on the Legends/Titles tab  
See, The (Plot Details) Legends/Titles tab |
| Add a Color Scale (color-mapped plots) | N/A | Click the Add Color Scale button on the Add Object to Graph toolbar  
See, Color Scales |
| Add a Bubble Scale (symbol-size mapped plots) | N/A | Click the Add Bubble Scale button on the Add Object to Graph toolbar  
See Bubble Scale |
| Merge multiple graph windows into one graph window | Merge Graphs dialog | Graph: Merge Graph Windows... menu  
See, Merge and Arrange Graphs (tutorial) and The |
<table>
<thead>
<tr>
<th>Feature Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer level customizations: resize, move, swap, align, or add layers</td>
<td><strong>Layer Management</strong> dialog. For clarity, the label on the control that opens the dialog from which you pick your graphs-to-merge -- the <strong>Graph Browser</strong> -- has been changed from an ellipsis (&quot;...&quot;) to &quot;Graph Browser&quot;.</td>
</tr>
<tr>
<td>Save settings as graph template</td>
<td><strong>Save Template As</strong> dialog. <strong>File: Save Template As</strong>... menu. Right-click graph window title and choose <strong>Save Template As</strong>... See, <strong>Graph Template Basics</strong></td>
</tr>
<tr>
<td>Manage graph templates, add plots to a template</td>
<td><strong>Template Library</strong> (custom graph templates) <strong>File: New: From Template</strong> menu then click the <strong>Graph</strong> radio button and set <strong>Path</strong> = <strong>Origin Program Folder</strong> See, <strong>System Templates</strong></td>
</tr>
<tr>
<td>Save settings as graph Theme</td>
<td><strong>Save Format as Theme</strong> dialog. Right-click and choose <strong>Save Format as Theme</strong>... context menu (graph is active) See, <strong>Saving Formats to a Theme</strong></td>
</tr>
<tr>
<td>Manage Graph Themes: edit, combine, apply Theme, set as System Theme</td>
<td><strong>Theme Organizer</strong> dialog. <strong>Preferences: Theme Organizer</strong>.. &gt; <strong>Graph</strong> tab. <strong>F7</strong> hotkey. See, <strong>Theme Organizer</strong></td>
</tr>
</tbody>
</table>
12.5 Customizing Page, Layer and Data Plots

A graph window is a collection of objects, organized in a hierarchical structure. As we shall see, there are editable properties at the page, layer and data plot levels.

Quick formatting of some graph properties can be done using toolbar buttons, as mentioned above. However, the vast majority of properties are customized via Origin’s Plot Details dialog box. To open Plot Details, (1) double-click on your plot or (2) click the Format menu, then choose Page..., Layer... or Plot...

The figure below shows an example of the Plot Details dialog box:

- The left panel depicts the Page > Layer > Plot hierarchy as an expandable/collapsible tree.
- The right panel contains controls, organized by tabs, that pertain to the object that is currently selected in the left panel.

- To customize an object, select it in left panel and modify the corresponding properties that appear on the various tabs in the right panel.

![Plot Details dialog box diagram](image-url)
<table>
<thead>
<tr>
<th>Panel Object</th>
<th>Page</th>
<th>Settings that pertain to the whole page -- Print/Dimensions, layer drawing orders, page display color, legends/titles, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Layer</td>
<td>Settings that are specific to the graph layer -- Layer background colors, layer size and speed mode settings, layer display settings, stack settings for applicable plot types. Some plot types will include extra tabs/controls specific to the plot type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image.png" alt="Layer Background Image Control" /> <strong>Layer Background Image Control for Google Maps App</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Support drawing background image before layer <strong>Background</strong> (set layer.bib=1;).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mini Toolbar buttons for layer <strong>Background Color</strong> and <strong>Transparency</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• When <strong>Background Color</strong> enabled and layer.bib=1;, adjust <strong>Transparency</strong> from Mini Toolbar.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mini Toolbar buttons also work to set <strong>Background Color</strong> and <strong>Transparency</strong> when no background image exists and layer.bib=0; (default).</td>
</tr>
<tr>
<td></td>
<td>Plot</td>
<td>Plot-specific properties. The tabs and controls vary by plot type (e.g. Scatter plots have a Symbol tab with controls pertaining to scatter symbols, Line plots a Line tab with controls pertaining to line plots). Anything to do with a particular data plot -- color, fill patterns, colormapping, labeling -- will be found at this level in Plot Details.</td>
</tr>
<tr>
<td></td>
<td>Data point</td>
<td>Properties that apply to user-specified &quot;special points&quot;. Available for any plot for which plots discrete points (scatter, line + symbol, column/bar, etc.). The tabs and controls are generally similar to those available at the Plot level but any property that you set at the level of a special point, will apply only to that point.</td>
</tr>
</tbody>
</table>
You can UNDO customizations made in the Plot Details dialog box. Click OK to close Plot Details and choose Edit: Undo Modify Page or press CTRL + Z.

Prevent text and label objects from scaling when resizing layer, by going to the Size tab of Plot Details (Layer level) and setting Fixed Factor to 1.

There is a Layers tab at the Page Level in Plot Details. You can use these controls to apply customizations made to a graph layer and contained plots, to other layers and plots in the graph page. This feature is particularly useful for modifying stack or panel graphs. Previously, for instance, if you wanted to customize a 9-panel graph you had to customize each panel individually. Now, you can apply multiple customizations to all plots, simultaneously. For more information, see The (Plot Details) Layer Tab.
12.5.1 Customizing Grouped Plots

Beginning with Origin 2020, there was a change in selection behavior that affects grouped plots. Now, a single-click on a plot selects the plot. A second click (or CTRL+click) selects a single point. SHIFT+click selects the entire group. Note that when using the new mini toolbars, a single click on a plot group displays tools for editing the plot group or the single, selected plot. To revert to the old plot selection behavior, set @GSM=0.

When you select and plot multiple data ranges to a single graph layer, the plots are grouped in the layer. Generally speaking, plots within a group are automatically differentiated by assigning styles built from one or more customizable "increment lists", one for each plot property (symbol shape, symbol color, line style, etc.).

By default, some properties are configured to increment "by one" (e.g. line color is assigned according to the "Candy" color list and each successive plot is assigned the next color in the list) and some will be configured not to increment (e.g. line style is solid for every plot), though this is ultimately controlled by the user. In any case, the increment lists for each property are saved with the graph template (.oggu) or Theme file (.oth) so that you can easily use them later to create graphs with the same look.
The above image shows the Plot Details Group tab settings for a line + symbol plot in the upper-left. On this Group tab, the first column lists Line Color, Symbol Type, Line Style Symbol Edge Color and Symbol Interior properties. The properties are set to increment by one between subgroups (subgrouping occurs using the column Comments), while Line Style and Symbol Interior are set to increment by None (they do not vary).

As previously mentioned, this arrangement is completely customizable and you can save customizations with the graph template:

- To find out more about customizing of grouped and subgrouped plots, see The Plot Details Group Tab Controls.
- To find out more about saving graphs as templates, see Graph Template Basics.

12.5.1.1 Using Object Manager with Grouped Plots

- To highlight a single plot and dim others (grouped or ungrouped) in the layer, click once on the plot in Object Manager. Conversely, clicking once on a plot in the Object Manager, highlights the plot in the graph window, while dimming others.
• To reorder plots in the layer, drag a plot icon within the group; or right-click on the plot (in Object Manager) and choose Move Up or Move Down.

• To group or ungroup data plots in the layer, right-click on the group icon ("gN") and choose Ungroup. To group plots in the layer, right-click on a plot and choose Set as Group Begin.

• To move a plot from one group to another, drag the plot to the other group.
• To move a series of plots out of the group, right-click the last plot that you want to keep in the group and choose Set as Group End.
• To remove a plot from the layer (and the graph), right-click on the plot and choose Remove.
• To move a plot to a second Y axis, or move the plot to another layer, right-click on the plot in Object Manager and choose Move Plot to Second Y Axis or Move Plot(s) to Other Layer ....

**Improved Handling of Properties When Grouping Plots with Object Manager:**
When you group a collection of plots by Set as Group Begin/End, Origin will create increment lists on the fly and display them on the Group tab of Plot Details. From this tab, you can right-click on any list (e.g. Fill Color) and Save Increment List.

If all plots share a common property (e.g. colors from the same color list), the no incrementing is done (i.e. the current color of each plot is kept).

12.5.2 Customizing Multi-layer Graphs

The graph layer is a fundamental concept in Origin and it is a primary building-block of most complex Origin graphs (e.g. a graph with both left and right Y axes is constructed by overlaying one layer on another, and sharing a common X axis between the two layers). While the graph layer is, fundamentally, a self-contained unit it is, at times, desirable to create dependencies between layers:

- One type of dependency is what we call "linking" of layers, which involves establishing spatial relationships or relationships between axis scale values. You can read more about linking graph layers, below.
- Another type of dependency is based on what we call "common display" and this is most useful in a situation where we have multiple similar panels in a graph and we want to do something like change the background color of each graph, or perhaps the change plot colors used in each layer.

At the graph page level in Plot Details, you will find a Layers tab that has controls that affect all layers within a given graph page. The Common Display controls can be used to enable simultaneous editing of layer, plot and axis properties of multi-layer graphs. For instance, in the following example, we have a two-layer trellis plot -- the two layers being necessitated by there being a left-Y axis and a right-Y axis with two completely different scales -- and as a simple illustration, we have used the Common Display controls to simultaneously add a background color to both layers. We could have accomplished the same thing without using the Common Display controls but this would have required twice the work -- set the background color of layer 1, then set the background color of layer 2.
This was a simple illustration but we can use the Common Display controls for application of more complex mix of layer, plot and axis properties. Some of Origin's built-in multi-layer graph templates have Common Display elements turned on by default. When working with multi-panel graphs, you may want to choose Format: Page, click the Layers tab in Plot Details, and check the Common Display settings. See Common Display for more information.

The Common Display Apply to control supports including or excluding certain layers from common display customizations. For instance, you might have a 4 panel graph, each with an inset layer and using this control, you could apply a common background color to the inset layers without applying the same background color to the 4 primary layers (panels). See Common Display for more information.

12.5.3 Special Points: Customizing a Single Data Point

For some plot types such as scatter, column or pie, you can modify the display properties of a single data point.

To edit a single point:

1. Click twice (slowly) or press CTRL + click on a data point to select it. Use the Mini Toolbars to edit properties of the data point; or click available buttons on the Style or Format toolbars.
2. For access to a wider range of customization options, (a) double-click on the selected point or (b) CTRL + double-click on an unselected data point. This opens the Plot Details dialog box with the focus set to edit the data point (identified in the left-panel of Plot Details by its row index number). Then use controls on
the tabs in the right panel to modify the appearance of the data point, add drop lines, data label, etc. Changes you make to the special point will not affect the appearance of other points in the same plot.

**Note:** When the Custom Construction box is checked, you can use these controls to customize the plot symbol of the selected point. Custom Construction can be applied to any plot symbol -- not simply those that are designated as special points.

Beginning with Origin 2021, you can use Unicode characters as plot symbols when Custom Construction is enabled.
To remove customizations made to a single data point:

- Right-click the single point in the left panel of the Plot Details dialog and choose Delete.
- In the graph window, click on the single point to select it, then press DELETE on the keyboard.

The point itself is not deleted; only the custom style is removed, with the point reverting to the style of the containing data plot.

Adding a special point at the beginning or end of a plot is not always easy, as for instance with a line plot of many data points. To help with this, Origin 2021 adds a simple, foolproof technique:

1. Select a special point anywhere on the plot, then double-click on the point to open Plot Details.

2. In the left-hand panel of Plot Details, click once on on the point index number and wait until the index number becomes editable.

3. To add the special point to the first point in the plot, type Begin; to add to the last point type End. If you know the index number of the first or last point, you can type that instead.

4. Click outside the edit box. Make other special point customizations as needed, the click Apply or click OK to close Plot Details. The special point will be added to the beginning or end of your plot.
12.6 Customizing Graph Axes

Many common edits to axis properties can be done quickly from Mini Toolbar buttons. For more complex edits of axis properties, use controls in the Axis Dialog.

Two zero control check boxes were added and turned on by default for Origin 2020b:

- Zero is '0'
- No Trailing Zero

Beginning with Origin 2021, these options are turned OFF by default.

12.6.1 Customizing Axes with Mini Toolbars and Dialogs

For quick and simple adjustments to axes properties, you can use Origin’s graph-editing Mini Toolbars. As with all Mini Toolbars, available tools will vary by plot type and selected object.

This image shows buttons available for editing of a selected graph axis in a contour plot.

Note that for graph axes, clicking the settings button (the "gear") produces a popup menu with simplified "Mini Dialogs" for Grid Lines, Reference Lines, Special Ticks and Axis Breaks. For full access to axis controls, click on Axes Dialog.

12.6.2 Customizing Axes with the Axis Dialog Box

All graph axis customizations can be made in the Axis Dialog box. Double-click on the graph axis or tick labels to open the Axis Dialog - Layer N dialog box.

Rug Plots are a one-dimensional density plot. You can add "rug marks" to the graph axes of many 2D graphs by double-click on the graph axis, clicking on the Rug tab and checking the Show box.
This image shows the tab-based axis dialog used by most 2D and 3D graphs.

In the left panel, you can select one or more icons (hold the **CTRL** key to select multiple icons) to specify the axis or axes to be customized, then select the desired tab and choose your options.
<table>
<thead>
<tr>
<th><strong>Scale</strong></th>
<th>Scale range of values, scale type, rescale mode and margin, reverse scale, major and minor ticks.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tick Labels</strong></td>
<td>Display and Format options for major and minor tick labels, including custom labeling using LabTalk substitution or mathematical expression. For information on custom formatting of numeric data including display of percentages, fractions, pi, and geographic (Lat/Lon) formats, see <a href="#">Origin Custom Formats</a>. Origin 2021 supports aligning tick labels to the left, right or center of the tick label block.</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>Axis title (often set using variable notation) and font options. Note that you can directly edit by double-clicking the text object in the graph.</td>
</tr>
<tr>
<td><strong>Grids</strong></td>
<td>Control display and properties of grid lines at major and minor ticks.</td>
</tr>
<tr>
<td><strong>Line and Ticks</strong></td>
<td>Global axis line and tick display options for all axes.</td>
</tr>
<tr>
<td><strong>Special Ticks</strong></td>
<td>Placement of special tick labels.</td>
</tr>
<tr>
<td><strong>Reference Lines</strong></td>
<td>Reference lines are optional lines that you add to your graph, either for emphasis or to mark some key statistic. Additionally, they can be paired to add fill color to some portion of your graph (e.g. &quot;recession bars&quot; in plots of financial data).</td>
</tr>
<tr>
<td><strong>Breaks</strong></td>
<td>Enable line breaks and configure each break.</td>
</tr>
</tbody>
</table>

Click the **Apply To...** button to apply the axis format settings of the currently selected axis to another axis.

**Note:** For more information on axis customization and for axis controls for specialized graph types (e.g. polar, ternary, radar chart, etc), refer to:

**Help:** Origin: Origin Help > Graphing > [Graph Axes](#)

### 12.7 Customizing Data Plot Colors
Origin ships with a number of installed color lists or palettes. If you prefer to create your own color lists or you have a standard set of palettes and want to port them over to Origin, there are a number of tools available in the software for doing that (see the **Color Manager** for more information).

**Origin 2021** simplifies defining of custom colors:

- A "+" symbol on empty well in the custom colors popup cues the user to click on it to define a color.
- The custom color popup supports direct entry of **HTML codes** to create custom colors. This applies to both the **Custom Colors** popup that is part of the **Color Chooser** and to the **Build Color List** dialog in **Color Manager** (see #4, next).

### 12.7.1 Color Manager
The Color Manager is a new dialog for importing, creating and organizing the color lists and palettes that you use in Origin:

1. Click these radio buttons to display installed Color Lists or Palettes
2. Click Import from Web to open a dialog where you can specify a URL to install palettes. Support for Scribus (.xml), Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch Exchange (.ase) and JASC PaintShopPro (.pal).
3. Click to install locally-stored palettes. Support for Scribus (.xml), Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch Exchange (.ase) and JASC PaintShopPro (.pal).
4. Click to open the Build Color List dialog where you can build a color using a number of tools: using standard color controls, direct entry of HTML codes or use an eye-dropper tool to pick onscreen colors.
5. Right-click on the Available list to Delete or Rename lists (you can also rename by clicking directly on the name). Lists that are dimmed have already been Selected for GUI. Those that are Selected for GUI appear from drop-down lists throughout the user-interface -- in Plot Details, from the Fill Color button on the Style toolbar and from the Mini Toolbar Fill Color button when a plot or special point is selected.
6. Use the list control to set Category = Undefined, Sequential, Diverging or Qualitative.
7. Use these controls to add or remove color lists and palettes from the user-interface (GUI).
8. Use these controls to move a selected list or palette up or down in the various GUI color lists.
9. Click Set Default Plot Colors to open the Theme Organizer’s System Increment Lists tab, where you can set default colors for use in your plots.
10. Drag list-number icons to rearrange GUI color list order.

12.7.2 Applying Color to Your Graphs

There are many options for applying color to your graphs. We will try and cover the basics here, pointing you to other resources for more in-depth discussion.

List of key topics on the subject of plot color:

- Customizing Data Plot Colors
- Using a Dataset to Control Plot Color
- The Plot Details Color Map/Contours Tab Controls for 3D and Contour Plots

12.7.2.1 Applying Colors Singly

Applying colors singly simply means applying a single color to a plot as opposed to applying color from a color list to a series of plots. It is the most basic way to apply color to a single plot or special point. Simply select a color well from anywhere on the Single tab -- from the LabTalk colors at the top, from a selected color list, or from a custom or recently used color.

- Select a plot (e.g. scatter plot) and click the Fill Color button on the Mini Toolbar that appears.
- Select a plot and click the Fill Color button on the Style toolbar.
- Double-click on a plot to open the Plot Details dialog box where you can click on a tab to the right side (e.g. Symbol tab for a scatter plot) and set color for the element.
- To create a special point -- i.e. to assign special characteristics to one data point in your plot -- press Ctrl+click to select the point, then use the Mini Toolbar, Style toolbar or Plot Details controls to customize color for that point.
12.7.2.2 Applying Colors By Points

Applying colors By Points generally means applying a color to each point in a plot by one of several schemes. The simplest involves picking an **Increment From** color from a predefined color list and assigning colors, in sequence, to each point in the plot.

As in the case of applying a single color, you can apply these settings using controls in Plot Details; or by selecting the plot and using the **Fill Color** buttons on the floating **Mini Toolbar** or **Style** toolbar docked to the top of your workspace.

Other schemes typically make use of a column of values to assign color to points:

- **Indexing** assigns point color by associating an integer or text string (categorical value) to different colors in a list.
- **Direct RGB** assigns color using a value derived from columns of RGB values.
- **Color Mapping** -- used for 2D, Contour and 3D plots -- assigns colors in a list or palette, to values across the range of the plot's Y or Z values.

There are several other schemes which are specific to a certain plot type (or family of plots), but the list above covers most of what you will use. For more information see Using a Dataset to Control Plot Color.
A new Flip Colormap Mini Toolbar button is added for 2D colormapped and contour plots.

12.7.2.3 Applying Colors By Plots

You apply color By Plots when you want to assign differentiating colors to a series of plots. Typically, this series of plots comprises a “plot group.” In a plot group, plot attributes including color, are assigned to each plot by incrementing through a style list -- color, line-style, symbol shape, etc.

12.7.2.4 Applying Colormaps to 2D, 3D and Contour Plots

Origin’s Color List and Palette popup menus are now more dynamic. Previously, the list was read only at startup. Now, newly-added lists and palettes display and can be used immediately.

While you can use a color list with a contour or 3D plot, it is probably more common that you will use a color palette. This allows a wider range of color variation and can add realism to to 3D surfaces and 3D function plots.
In Origin 2021, you can add new color palettes to Origin by drag-and-drop. Support for Scribus (.xml), Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch Exchange (.ase) and JASC PaintShopPro (.pal).

Colormapping can also be applied to 2D plots. This allows you apply a greater range of color variation to data points than would be possible with incrementing or indexing. A good example of applying a color map to a scatter plot would be Origin’s Density Dots plot in which, typically, thousands of scatter points are plotted and an algorithm is used to calculate point density and assign color to ranges of point densities.

Applying a colormap to a 3D or contour plot is much the same as applying color singly, by points or by plots. You select a plot -- then using the Palette button on the floating Mini Toolbar (contour only) or the Style toolbar. You pick a palette.
You can also use the controls on the Colormap/Contours tab of Plot Details. This tab gives many more options beyond simply picking and applying a colormap.

For more information on applying color to colormapped plots, including contour and 3D surfaces, see these topics:
12.8 Graph Legends

12.8.1 How the Default Legend is Created

A graph legend is automatically created when you plot data. For most 2D and some 3D graph templates, the default legend combines (A) **plot style information** stored with the graph template, with (B) **dataset information stored in the worksheet column label rows**, and places the resulting legend object on the graph page.

![Graph Example](image)

Note that the default legend object is not created with literal text and plot symbols but instead is created from LabTalk script.

- This allows the legend object to be dynamically linked to plotted data and worksheet metadata, so that the legend can be updated when data or plot metadata change.
- Because construction of the legend object relies on scripting rather than literal information, you can save customizations to a graph template and recreate the graph with its accompanying legend object using new data, as often as is needed.

The legend script relies on "substitution notation" to convert variable values to readable symbols and text. You can see this notation when you double-click inside of the legend object (as if to edit it).
• You control which dataset metadata are used in constructing the default legend text by setting the Translation mode of \%(1), \%(2) list in the Legends/Titles tab of the Plot Details dialog box (Format: Page...).

• Custom strings can be constructed using LabTalk substitution. Customizations can be saved to the graph template for repeat use.

Origin has a Fit Layers to Page tool that is useful for arranging a graph and a large, text-wrapped legend on the page.

12.8.2 Tips for Quick Legend Edits


• Mini Toolbar for legend symbols.
• Mini Toolbar for color scales (does not apply to 3D OpenGL graphs such as colormapped surfaces).
• Mini Toolbar for bubble scales.

To format your legends using a Mini Toolbar:

1. Select a legend or legend component (e.g. legend symbol). A Mini Toolbar with context-specific buttons will show.
2. If the toolbar fades, you can restore it by pressing the Shift key.

Other legend editing tips:
• Select the legend object, then right-click and choose **Legend** to open a shortcut menu with some useful commands including **Text Color Follows Plot, Reverse Order, and Show Legend for Visible Plots Only** (the same menu commands are available from **Graph: Legend**).

• The same shortcut menu also has an **Arrange in Vertical/Horizontal** command for changing the legend aspect; or you can modify it interactively by selecting the legend object, then pressing CTRL while dragging a selection handle (e.g. drag horizontally to create a legend that is all on one line).

• Double-click on the legend text to enter in-place edit mode (where you can manually overwrite the legend text).

• CTRL + double-click the legend text to open the **Legend** dialog box. Here you can modify all aspects of the legend.

• Double-click a legend symbol to open the **Plot Details** dialog box.

• If you do not want a legend object added to your graph each time you create the graph, delete the legend object and re-save the graph template.

### 12.8.3 Adding and Updating the Default Legend

The table below lists tasks associated with adding or updating the graph legend, and where to find editing controls for each legend type. Before proceeding, we should point out that there are two legend refresh modes:

• **Updating** a legend will preserve any customizations that you might have made to the existing legend, including size and position adjustments and legend symbol and text customizations.

• **Reconstructing** a legend will overwrite any customizations. When you add or reconstruct the legend, you are creating a copy of the legend that is stored in the graph template.

In addition, the graph template stores a **Legend Update Mode** setting that determines how the legend is refreshed when adding or removing data plots from the graph. See **Controlling Legend Update**, below.

<table>
<thead>
<tr>
<th>Task</th>
<th>Method (graph is active)</th>
</tr>
</thead>
</table>
| Add or reconstruct legend | • **Graph: Legend: Reconstruct Legend** menu.  
• **Reconstruct Legend** button (Add Object to Graph toolbar).  
• CTRL+L.  

⚠️ Legend customizations not saved with the template, will be lost when you reconstruct. |
<p>| Update legend | Open the <strong>legendupdate</strong> dialog box: |</p>
<table>
<thead>
<tr>
<th>Customizing special legends</th>
<th>Right-clicking on these special legends opens a dialog box with customization options specific to each legend type:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- <strong>Categorical legends.</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Box chart legends.</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Point-by-point legends.</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add color scale</th>
<th>Only available for <strong>color-mapped</strong> plots (e.g Contour Plots).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Click the <strong>Add Color Scale</strong> button (Add Object to Graph toolbar).</td>
</tr>
<tr>
<td></td>
<td>- Right-click in the layer and select <strong>New Color Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Insert: Color Scale</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>- When you have multiple color-mapped plots in a single graph window, you can click on each plot to select it, then add a corresponding color scale.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Control color scale</th>
<th>Available when a color scale object has been added to a graph. To open the <strong>Color Scale Control</strong> dialog:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Double-click on the color scale object.</td>
</tr>
<tr>
<td></td>
<td>- Right-click on the color scale object and choose <strong>Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>Display of color scale head and tail levels can now be controlled independently, using check boxes on the <strong>Properties &gt; Levels</strong> tab.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add bubble scale</th>
<th>Available for bubble plot, or when <strong>symbol size is controlled by a dataset</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Select <strong>Insert: Bubble Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Right-click in the layer and select <strong>New Bubble Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Click the <strong>Add Bubble Scale</strong> button in the Add Object to Graph toolbar.</td>
</tr>
</tbody>
</table>
Right-click the legend to select **Add Bubble Scale** from the context menu.

### Control bubble scale

Available when bubble scale object has been added to a graph. To open the **Bubble Scale Control** dialog:

- Double click on the bubble scale object.
- Right-click on the bubble scale object and choose **Properties**.

The **legendupdate** dialog box and the **Legend/Titles** tab at page level of **Plot Details** both have an **Auto Legend Translation Mode** drop-down that determines which worksheet metadata (e.g. column **Long Name**, **Comments**, etc.) is used to generate the legend text. For a list of **Custom** options, see **Legend Substitution Notation**.

Origin 2018 added an interface tool to manually **Add Legend Symbols** to the graph legend. Right-click on the legend object and choose **Properties**. Click the **Add Legend Symbol** button in the lower-right corner of the dialog box.

![Add Legend Symbol](image)

**Note:** For more information on creating and customizing graph legends, see:

**Help:** Origin: Origin Help > Graphing > **Graph Legends and Color Scales**

## 12.8.4 Controlling Legend Update

When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The **Legend/Titles** tab at the graph page level in the **Plot Details** provides a **Legend Update Mode** drop-down to control this behavior.

The default setting **Update when Adding** only affects the legend display of data plots that are added or removed. Previous legend customizations to existing plots, such as literal text entered manually, will be maintained.

**Tutorial: Customize legend and add data plots**

1. Start with a new project in Origin.
2. Open Windows Explorer and navigate to the subfolder `<Origin EXE folder>\Samples\Import and Export\`
3. Shift-select the files **S15-125-03.dat**, **S21-235-07.dat**, **S32-014-04.dat** and
then drag-and-drop the files onto an empty Origin workbook. The three files will be imported into three separate workbooks.

4. Click on one of the workbooks, select the column B, and create a line plot.

5. Right-click on the legend and select **Legend: Update Legend...** to open the **legendupdate** dialog.

6. Change the **Auto Legend Translation Mode** drop-down to **Custom**, and in the edit box that appears below, enter the string:
   
   @WS, @LD3

   and then press **OK** to close the dialog box. The legend updates, displaying the sheet name and the third user parameter.

7. Click on the second workbook, select column B, move the mouse over the right-edge of the column until it changes to , and then drag-and-drop this data onto the graph to create a 2nd data plot.

8. Repeat the procedure with column B from the third workbook. The graph will now display three data plots, and the legend will automatically update to display the identifier for all three plots.

9. Click on each individual curve and use the **Style** toolbar to set a different line color for each. The legend will automatically update and display the new line color.

**12.8.5 Special Legend Types**

As mentioned, Origin supports these specialized legends for use with specific graph types. These legends can be customized and updated similarly to the Data Plot legend used by most 2D graph types.
### Legend Types

<table>
<thead>
<tr>
<th>Legend Type</th>
<th>Menu to Create</th>
<th>Used in situations where ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend for Categorical Values</td>
<td>Graph:Legend:Categorical Values</td>
<td>At least one plot attribute (e.g. color, symbol shape, etc.) is controlled by data indexing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See the <a href="#">Legend for Categorical Values</a> help page.</td>
</tr>
<tr>
<td>Point by Point Legend</td>
<td>Graph:Legend:Point by Point</td>
<td>The plot symbol style is controlled by data indexing, an increment list, or color mapping.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See the <a href="#">Point by Point Legend</a> help page.</td>
</tr>
<tr>
<td>Legend for Box Chart Components</td>
<td>Graph:Legend:Box Chart Components</td>
<td>The graph is a box chart, or a grouped box chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See the <a href="#">Legend for Box Chart Components</a> help page.</td>
</tr>
</tbody>
</table>

### 12.9 Annotating Your Graph

When we speak of "annotating" a graph, we are talking about adding text or drawing objects to the graph. Generally, these "annotations" help to enhance the graph in some way -- add a page title, add an arrow to draw attention to some graph feature, label data points, add a date-time stamp to note the time of graph creation, etc.

Annotating a graph can be as simple as adding a static text object and formatting it with **Format** toolbar buttons. Or you might add a more complex object that is dynamically linked to a variable value or to some **LabTalk script** that is executed whenever some user-specified event occurs.

**Origin 2021** adds these improvements to data labeling:

- More flexible data labeling of grouped **3D** plots. Previously, grouped plot labels followed settings of the first plot in the layer. Now, you can specify a different **Label Form** for each plot in the group.

- Mini Toolbar button to apply customized formatting (**Color**, **Font**, **Font and Size**) of selected labels to **This Layer** or **This Window**.
• Mini Toolbar button for **Leader Lines** opens a mini dialog for showing leader lines and setting line to label gaps.

• Support for the `%1`, `%?` and `%(@X)` *legend and axis title syntax* (e.g. `%(@L)` for custom data labels, making it easier to do such things as label a curve using a legend-type entry. For more information, see *Notations and syntax used in labeling plotted data* and *Text Label Substitution*. 
The following table lists some common graph annotation tasks and available tools for accomplishing those tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
</table>
| Label Data Points and Plots | • Choose **Format: Plot** …, then click the **Label** tab and select **Enable** (not available for all plot types).  
  • Alternately, select a plot and click the **Show Data Labels** button on the **Mini Toolbar** that pops up.  
  • Format labels using controls on the **Label** tab of Plot Details; or select enabled labels on the plot and use **Mini Toolbar** buttons to format. |
| Add Text Objects            | • Click the **Text Tool** button, then click on the graph to place the object.  
  • Right-click on the graph and choose **Add Text** from the shortcut menu.  
  • Double-click on text to do rich text editing.  
  The **Mini Toolbars** for formatting text objects, including graph legends, now have a **Wrap Text** button for wrapping longer lines of text:  
  1. Select the text object and click the **Wrap Text** button so that a red check mark appears on the button. The check mark indicates that the function is enabled.  
  2. Resize your text object using the selection handles and text should wrap.  
  3. To place text on a single line, simply click the **Wrap Text** button again.  
| Add Layer Title             | • Right-click on graph and choose **Add/Modify Layer Title** from the shortcut menu to add/modify layer title in active layer. |
| Add Vertical/H Horizontal Line | • With a 2D graph active, use the **Insert: Straight Line...** menu item. |
This tool now supports using a simple LabTalk expression in the **At Value** field (e.g. "mean(plotdata(1,Y))" which translates to "mean of 1st plot's Y dataset") for positioning the line object. For more information see the discussion of **At Axis Value**.

### Annotate a Data Point
- Click the **Annotation** tool on the **Tools** toolbar. See [The Annotation Tool](#).

### Add Drawing Objects
Use the corresponding toolbar buttons on **Tools** toolbar. Origin supports:
- Arrow, Curved Arrow.
- Line, Polyline, Curve, Freehand Draw.
- Rectangle, Circle, Polygon, Region.

### Insert Equation, Word Object, Excel Object, Other OLE Object
- Insert Equation group on the **Tools** toolbar.

You can download a free App from the OriginLab File Exchange, for adding [LaTeX objects](#) to worksheets and graphs.

### Insert Image
- Right click on the graph and choose **Insert Images From Files**.

### Add Table
- Click the **New Link Table** button on the **Add Object to Graph** toolbar and then click on the graph.
- From the main menu, choose **Insert: Table**.
- To edit the table, double-click the table object.

**Origin 2021** adds a new Mini Toolbar for formatting table objects on graphs.
### Customizing Graphs

<table>
<thead>
<tr>
<th>Insert Date &amp; Time Stamp</th>
<th>• Date &amp; Time button on the Add Object to Graph toolbar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Project Path</td>
<td>• Project Path button on the Add Object to Graph toolbar.</td>
</tr>
<tr>
<td>Add Bracket with Asterisk</td>
<td>• To indicate statistical groupings, click the Add Asterisk Bracket button on the Add Object to Graph toolbar. Manually adjust the size and placement of brackets by dragging handles on the object.</td>
</tr>
<tr>
<td>Add XY Scale</td>
<td>This is useful when using a nonlinear xy scale.</td>
</tr>
<tr>
<td></td>
<td>• New XY Scale button and click on a graph layer.</td>
</tr>
<tr>
<td></td>
<td>• Select Insert: XY Scaler.</td>
</tr>
</tbody>
</table>

#### 12.9.1 Tips for Editing Your Graph Annotations

Beginning with **Origin 2021**, use Alt+Enter when creating multi-line text objects. To revert to using Ctrl+Enter to insert a line break, set @FCA=1.
• Pressing CTRL when drawing with the **Rectangle** or **Circle** tools, will draw a square or circle (as opposed to a rectangle or ellipse).

• Use **Mini Toolbar** buttons for quick edits to selected objects. For more complex edits, right-click an object and choose **Properties** to edit object properties and set defaults.

• For text objects, including the axis titles, you can edit text objects directly in "In-place Edit" mode. Double-click on a text object to edit. Use the **Format** toolbar buttons to add superscript, subscript, and Greek characters.

• Do NOT set font size while in "In-place Edit Mode" unless you need to mix font sizes. The correct way to change font size is to click the text object once so that the green selection handles appear, then select font size from the **Format** toolbar. If you set while in In-place Edit mode, Origin will not indicate the proper font size when you hover on the text object.

• When you are in In-place Edit mode, you can right-click and choose **Symbol Map** to insert special characters into your text object.

• You can insert the contents of a worksheet cell into a text object by copying and pasting the cell contents. While in In-place Edit mode in the text object, right-click and choose **Paste** or **Paste Link** from the shortcut menu. Pasted data is static; Paste Linked data is dynamic and will change if data in the linked cell changes.

• Also, when in In-place Edit mode, you can right click and choose **Insert Info. Variable...** to insert information related to plotted data, into the text object. Since the pasted information is linked to a LabTalk variable value, the inserted data updates if the variable value changes.

• You can insert variable values into a text object using the LabTalk %, and $ substitution notation by setting the **Link to (%,$), Substitution Level** to 1 in the text object’s **Properties** dialog box, **Programming** tab. Right-click on the text object and choose **Properties** from the shortcut menu.

• You can use controls on the Programming tab to associate LabTalk script with a text or drawing object (for instance, see Linking Text Labels to Data and Variables). Enter your script in the text box and specify a **Script, Run After** condition for running the script. Use the **Apply to** drop-down to set the scope for the script.

• You can copy a range (of cells) from a workbook and paste it into a graph as a **table object**. The table object is editable.

You can now add text formatting (e.g. super-/subscripting) to non-consecutive characters via the text object’s **Properties** dialog:

1. Right-click on the text object and choose **Properties**.
2. On the **Text** tab, press CTRL and in the text box, highlight multiple characters by dragging with your mouse.
3. Click the desired text formatting button above the text box and click **OK** to close.
Better position control of text and graphic objects in **Origin 2021**:

- A **Rotate** combo box has been added to the Properties dialog **Dimension** tab of graphic objects (lines, arrows, polygons, etc. Use it for precisely rotating the object.
- Mini Toolbar buttons have been added for rotating selected graphic objects in 45 degree increments in clockwise or counter-clockwise directions.
- Press the Shift key while moving a selected text or graphic object to confine movement to the horizontal or vertical directions.

### 12.9.2 Grouping, Aligning and Arranging with the Object Edit Toolbar

You can group text labels and drawn objects so that they move or resize as a unit:

1. To select objects, press **SHIFT** + click; or drag out a box around objects using the **Pointer** tool.
2. To group the selected objects, click the **Group** button on the **Object Edit** toolbar.
3. To ungroup objects, click the **Ungroup** button on the **Object Edit** toolbar.

You can align multiple text labels and/or drawn objects with one another using the tools on the Object Edit toolbar:

1. Select objects to be aligned by holding the **SHIFT** key while selecting (or drag out a selection box using the **Pointer** tool), then click one of the align objects buttons on the toolbar. Note that objects will be aligned with respect to the first-selected object.

You can bring overlapping objects to the front or send them to the back:

1. Select the objects that you want to move to the front or the back.
2. Click the **Front** button or the **Back** button on the **Object Edit** toolbar.

**Note:** For more information on graph annotations, see your Origin User Guide:

**Help:** Origin: Origin Help > Graphing > **Adding Text and Drawing Objects**
You can also use the Object Edit Toolbar to manipulate graph layers. Use buttons to align and set a uniform size for multiple graph layers or to swap layer order.

12.9.3 Object Attachment and Scaling in Graphs

There are two settings that you should know something about, particularly if you subsequently modify axis scales or resize the graph layer after adding annotations: One is the object’s Attach to method, the other is the layer’s Scale Elements behavior.

12.9.3.1 Object Attachment

When you add a text or drawing object to an Origin graph window, the object becomes part of the active graph layer. Thus, if you resize or delete that graph layer, you will resize or delete the added object.

In addition to being part of the graph layer that was active at the time of object creation, note also that objects are attached to the graph in one of three ways, depending upon the type of object and where it is created on the page.

To view the "Attach to" setting for any object:

1. Right-click on a text or drawing object and choose Properties....
2. Click on the Programming tab and note the object’s Attach to setting.

Though objects remain a part of the layer that was active at the time of their creation, you can manage some object behaviors by changing the object attachment method. An object is attached in one of three ways:

- **Page.** When attached to the page, objects are not affected by moving or resizing the graph layer, nor are they affected by a change in axis scales. These objects are still associated with a particular graph layer and they will be hidden or deleted if the layer is hidden or deleted.

- **Layer Frame.** Objects that are attached to the layer frame, are resized and moved with respect to the layer frame. However, they are not tied to axis scales and are not affected by changes in the layer’s axis scale values. Objects are hidden or deleted if the associated layer is hidden or deleted.
• **Layer and Scales.** Objects are linked to a particular range of axis scale values. If you resize the layer, the object is resized accordingly. If you rescale the axes, the object moves in relation to the visible scale and will disappear from view if the linked axis scale range is not displayed. These objects are hidden or deleted if the associated layer is hidden or deleted.

To briefly illustrate why object attachment is important, let’s look at the following graph. After the graph was created, arrows and text objects that point to their respective data plots, were added to the graph. Both arrows and text objects are attached to the graph **Layer Frame.**

![Graph with objects](image)

Now, consider what happens to these objects when we modify the graph’s X axis scale (recall that objects attached to the Layer Frame “are unaffected by changes in the layer’s axis scale values”). Note that by changing the axis scale display range, we have shifted the data plots but the text objects and arrows did not move with them.

![Objects attached to Layer Frame](image) ![Objects attached to Layer and Scales](image)

The remedy for this is to change the text and drawing objects’ **Attach to** method to be **Layer and Scales** because “if you rescale the axes, the object moves in relation to the visible scale.” Sometimes we may want an object to move with scale changes; at other times we may not. You can force either behavior if you keep in mind the **Attach to** setting.
12.9.3.2 Object Scaling

Object scaling often comes up when manually resizing the graph layer or when merging separate graphs into a single multi-panel graph (Graph: Merge Graph Windows). By default, added objects are set to Scale with Layer Frame — that is, when the graph layer is resized, associated objects such as text objects, axis lines and ticks, and axis titles -- will be scaled proportionally. In the case where you merge four single layer graphs into a single, four layer multi-panel graph, these objects will be scaled down with the reduction in size of the layer frame.

However, this is another default behavior that you may want to change (e.g. you have set your font size to 10 pt. and you want to preserve that size), and you can do this using the Scale Elements control on the Size tab (Layer level) of Plot Details. If our goal is to keep objects at their current size when merging graphs, for instance, we can open the Plot Details dialog box and at the layer level (Format: Layer...), click on the Size tab, choose the Fixed Factor radio button and set the scaling factor to 1.

If you have resized the graph layer, either by merging multiple graphs into a single graph or by manually resizing the layer, you will find that the font sizes do not display at their "correct" size (i.e. if you select a text object, the Font Size list on the Format toolbar shows the original font size). Further, if select a text object, the Status bar will report two font size numbers -- "size" and "actual". You can reset font size so that they are shown as actual size, not scaled size, by choosing Graph: Fix Scale Factors. For more information, see FAQ-441 How do I export graphs with exact size and resolution as specified by publishers?

12.10 Arranging Graphs and Layers

A Center Layer(s) to Page button is added to the page-level Mini Toolbar for centering all layers on the graph page without changing relative positions.
<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
</table>
| **Merge multiple graph windows into a single graph window.** | - Graph: Merge Graph Windows... menu command  
  or  
  - Merge Graph Windows button on the Graph toolbar.  
  Origin has two dialog boxes -- **Fitting Layers to Page** and **Fit Page to Layers** -- that are useful for arranging multiple graph panels on the page and for adjusting graph margins. |
| **Extract data plots in one layer to multiple layers.** | - Extract to Layers button on the Graph toolbar.  
  **Hint**: to preserve your original graph, click the Duplicate button before extracting to layers. |
| **Extract multiple layers in a single graph to multiple graph windows** | - Graph: Extract to Graphs  
  or  
  - Click the Extract to Graphs button on the Graph toolbar.  
  All layers are extracted to individual graph windows, even if a layer is linked to another layer.  
  By default, the layextract dialog box has Extracted Layers set to 1:0, which specifies that all layers be extracted. To extract only certain layers, clear Auto and use the layextract X-Function's comma/colon notation to control which layers are extracted. The notation 1:0 means starting with layer 1, extract all layers to graphs (0 denotes all). Specifying 1,3:4, for example, tells Origin to extract only the first, third and the fourth layer. Note that you can enable Keep Source Graph to preserve the original graph. |
| Add, arrange, resize, position, | - Graph: Layer Management... menu.  
  - Position selected layers using Object Edit toolbar buttons. Hold SHIFT + click to select |
<table>
<thead>
<tr>
<th>swap, align, or link layers</th>
<th>multiple layers and Align Left, Right, Top, Bottom, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can use the Layer Management tool's <strong>Swap</strong> control (<strong>Graph: Layer Management, Size/Position</strong> tab) to physically swap layer positions without reassigning layer numbers. Before doing so, set each linked layer's <strong>Units</strong> to <strong>% of Page</strong> (<strong>Size/Speed</strong> tab of Plot Details).</td>
</tr>
</tbody>
</table>

**Link graph layers**

- **Linked Axes Scales** tab, layer level of **Plot Details** dialog box.
- **Link** tab of the **Layer Management** dialog box.

When linking layers, the child layer must have a higher layer number than the parent layer. Linked layers can be moved and resized together.

You can **link layers' axis scale values** to be **Straight (1:1)** or you can specify a **Custom** mathematical relationship.

**Reorder layers**

There are several ways to reorder graph layers (reassign Layer number for each Layer). Learn more about reassigning layer numbers in the **mini tutorial** below this table.

- **Method 1**: Open the **Layer Management** dialog and click the row header (shown in image below) and drag it up or down to change the Layer order.

For more information, see the **Layer Management tool**.

- **Method 2**: Enter the following LabTalk script in the **Command Window** (**Window:Command Window**), then press **Enter** to execute.

    ```labtalk
def page.reorder(n,m)
the command changes the nth Layer to the mth Layer.
```

- **Method 3**: Use the **Front** and **Back** buttons on the **Object Edit** toolbar (these buttons work on the *active* layer as indicated by the graph layer icon). Alternately, right-click on the graph layer icon and change layer order using shortcut menu commands.
Customizing Graphs

When two layers are linked by a common X axis (Double-Y), you can now more-easily swap layer drawing order by right-clicking on the "front" layer in Object Manager (OM) and choosing **Push to Back**. Previously, swapping layers in OM would prompt to break layer linking.

**Note:** Reordering layers may break layer linking relationships.

**A Note on Inset Graphs:** In certain situations (see Tutorial, below), the order in which the layers are drawn on the screen becomes an issue. In this image, we have added an inset graph using the **Add Inset Graph with Data** button (Graph toolbar). The problem is that the data plot of the parent layer (red symbols) shows through the inset layer (small, black symbols). To fix this, we do two things:

- Set the inset layer background **Color** = **White** -- by default, it is **None** (Format: Layer, then **Background tab**).
- Set the layer **Drawing order** to **Draw layer by layer** (Format: Page then **Layers tab**).

By default, an inset layer is added "on top of" the parent layer but if needed, you can click on the inset layer to select it, right-click and choose **Bring to Front**.

**Exchange X-Y Axes**

- **Graph**: Exchange X-Y Axes menu command
- **Exchange Axes** button on the Graph toolbar.

**Move a plot(s) to**

- **Method 1**: Open Plot Setup dialog(by selecting Graph:Plot Setup), expand the bottom panel, select a plot and drag it from a layer to another layer.
**Method 2:** Run `laymplot -d` (e.g. open the Script Window, type the command and press <Enter>) to open the **Move Plot** dialog to specify plot(s) to move and a target layer.

You can move a plot by Copying (CTRL+C or **Copy Range** context menu) and Pasting (CTRL+V or **Paste** context menu) operations, between different layers or different graphs. Please note, the pasted plot won’t be associated with the source data of copied plot, but exists as a loose dataset.

In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted and then 2nd layer is plotted on top of it, and so on. The layer with higher number is drawn on top of the layer with lower number. This is important when plots in one layer overlay plots in another layer. When necessary, you can change layer order to change plot drawing order.

This mini tutorial shows you how layer reassignment works. Use the preview window to see how layer number reassignment affects your graph.

1. Click **Help: Origin Central** or press F11.

2. Click on the **Graph Sample** tab, set the **Samples in** drop-down list to **Area Plots** and double-click on this graph:

3. Activate the graph **Area Plot With Horizontal Color Gradient**, then click the **Extract to Layers** button on the **Graph** toolbar. Set both number of rows and columns to 1, click OK, then, click OK again for the page spacing. The green layer is on the top of the yellow layer in the figure. The purpose of this last step was simply to create a two layer graph in which the data in one layer partially hides the data in the other layer. What we will do now is to reorder the layers and set the yellow layer on the top, giving you a better view of the two plots.
4. Choose **Graph: Layer Management**... menu, then drag the row header "1" of the Layer1 in the **Layer Selection** downward under the Layer2 (indicated by a blue line), and click **OK**.

5. You can see the yellow layer is on the top now.
Alternate Method: You can use the Front or Back toolbar buttons (located in the Object Edit toolbar, or at the top of Layer Selection box in the Layer Management dialog) to bring a layer forward or push it backwards. As happens when you rearrange layer order with the Layer Management dialog, this method swaps layer numbers.

You can easily add an inset layer with data by clicking the Add Inset Graph With Data button on the Graph toolbar or Insert: New Layer(Axes): Inset With Data (Linked Dimension).

You can copy a layer from one graph window to another graph window. Click to select the layer first (a frame shows around the layer). Then press Ctrl+C or right-click and choose Copy. Click on the target graph window, then right-click to Paste.

Note: For more information on merging graphs, see your Origin User Guide:

Help: Origin: Tutorials > Graphing > Layers > Merging and Arranging Graph Layers
Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box

12.11 Templates and Themes
Origin's flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a couple of ways -- either with templates or with Themes. These concepts are introduced below.

**Note:** For detailed information please refer to Origin Help file, see:

- Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates
- Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes

### 12.11.1 Templates

Customizations to your graph can be saved to template files for repeat use. For example, you can customize a graph page to add multiple layers, set relationships between layers, modify data plot properties, and then save all of these attributes as a graph template (.otpu) file. You can further specify that the graph template be "cloneable" allowing you to link these graph customizations to dataset Long Name, Short Name or worksheet column index number and quickly re-create fairly complex graphs using new data.

**A few things to note:**

- In a fresh Origin installation, each one of Origin's 100+ built-in graph types uses a specific "system" template when creating a particular graph type. When you click on a **Plot** menu graph or graphing toolbar button (e.g. Area ), one of these templates is used to plot the selected data.
- System templates are installed to the Origin Program Folder. They are completely customizable but you cannot overwrite the template files in your Program Folder (see next).
- When you customize and save a system template, it is saved by default to your User Files Folder (UFF). If you save the customized template to the same system template name, the customized template replaces the system template as the template associated with the **Plot** menu command or toolbar button used to create that plot type. Additionally, the customized template is added to the user's Template Library.
- To view customized graph templates, click **Plot** (workbook or matrix should be active) and click Category = MyTemplates. To view System Templates (built-in, not customized), click **File: New: From Template. Set Type = Graph and Path = Origin Program Folder**.
- You can save a graph template anywhere (and with any name) that you like -- it does not need to be saved to your UFF. However, by saving customized templates to your UFF, they will be collected in one, easily-remembered place and they will be readily available when you upgrade your Origin software.
Use the **Switch List Mode** button to toggle between preview and list view.

- For an overview of graph templates, see [Graph Template Basics](#).
- For information on the Template Library, see [The Graph Template Library](#).
- For information on “cloneable” templates, see [Cloneable Templates](#).

### 12.11.2 Themes and Copy/Paste Format

An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin: graph Themes, worksheet Themes, dialog Themes and function plot Themes.

Graph Themes are a collection of properties of different elements in a graph window. A graph Theme can be very simple (e.g. graph axis major and minor tick direction settings) or it could be something more complex (e.g. a combination of page dimensions, layer background, axis scales, and color palettes). Whether simple or complex, the purpose of graph Themes is to allow you to quickly change one or more object properties in an existing graph, or to apply a consistent set of properties to a selection of graph windows, without having to recreate a suite of settings, or to apply those settings one-by-one to individual graph windows.
All graph objects have a customizable set of properties that are specific to the object type. Therefore, it follows that the properties that can be saved as a Theme differ depending upon the selected object. You can (1) copy a Theme from one object and "paste" it to another object of the same type or (2) you can save a Theme from one object as a named Theme and apply that named Theme to other like objects at a later time.

1. Right-click on an object in a graph window (e.g. a plot) and choose **Copy Format**. Depending on what you click on, there may be sub-menu items under the **Copy Format** shortcut menu, which give you the option as to what exact format to copy.
   - To apply the copied formats to a single object, right-click on your target graph and choose **Paste Format To**. Again, this shortcut menu might have some sub-items that limit what to paste. In this way, the formatting option(s) from your source object should be applied to your target object.
   - To apply the copied formats to multiple windows in the project, keep the source graph window active and select **Edit: Paste Format(Advanced)...** from the Origin menu. This opens the **Apply Formats** dialog box. Here you have the option of editing or selectively applying formats to one or more graph windows in the Origin Project.

2. If you would prefer to save formats to a named Theme file that you can re-apply at a later time, choose the **Save Format As a Theme...** shortcut menu item, then use **Preferences: Theme Organizer** to apply the Theme when needed.

### 12.11.2.1 Theme Organizer

Use the **Theme Organizer** (**Preferences: Theme Organizer**) to organize and apply Themes to graphs. With this dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file.

To combine multiple Themes in the Theme Organizer dialog box:

1. Press the **CTRL** key while selecting multiple Themes, then right-click and choose **Combine** from the shortcut menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to add/delete properties from an existing Theme.
The Theme Organizer has separate tabs for managing graph, increment list, worksheet, dialog boxes and plotted mathematical function Themes.

If you right-click on a graph Theme and save it as your System Theme, then each time you plot a new graph, this System Theme will be applied regardless of the settings that were saved with the graph template†.

Use the System Increment Lists tab to manage increment lists and selectively apply them to project graphs.

You can load a graph Theme in the Export Graph dialog and the Theme will be applied to the exported image file.

† If you don't want a System Theme to be applied automatically to the graph, save the graph as a template (File: Save Template As) and clear the Apply System Theme to Override check box.

12.12 Topics for Further Reading

- Plot Details: Customizing Graph Page Elements
- Plot Details: Customizing Graph Layer Elements
Customizing Graphs

- Plot Details: Customizing Plot Elements
- The Preferences: Options: Axis tab Settings
- The Preferences: Options: Graph tab Settings
- Graph Axes
- Controlling the Graph Axis Display Range
- Adding Text and Drawing Objects
- Hiding Labels, Data and Layers
- Graph Template Basics
- Graph Template Library
- System Templates
- System Themes
Origin includes a number of tools for graphically exploring your data including those for zooming and panning data plots, reading XY coordinate values and other data point metadata, or highlighting or masking selected data points.
With Origin 2016, OriginLab began releasing add-on tools called Apps. Many exploratory and analysis-related tools have been added to OriginLab’s File Exchange since that time. If you find you need some exploratory or analysis tool that is not a standard part of Origin, you might check to see if the tool exists as an App. If it does not, request it!

13.1 Zooming, Panning and Rescaling

This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of your 2D graph. We have split these tools and commands into two groups:

- Page-level zoom and pan operations that do not change axis scales.
- Axis rescale operations which zoom and pan the graph by changing axis From and To values.

Page level zoom and pan do not alter the graph; they only determine which portion of the graph page is visible within the graph window. You can read the current zoom level in the Zoom dropdown list of the Standard toolbar. Page-level zoom and pan will not affect the printout or export of the graph. On the other hand, axis rescaling tools (e.g. and ) do alter the graph and, thus, will affect the printout and export of the graph.

13.1.1 Page-level Zoom and Pan

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Menu</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom-Panning: Zoom and pan the graph page.</td>
<td><img src="image" alt="Zoom-Panning" /></td>
<td>A +/- keys (zoom) or arrow keys (pan)</td>
<td></td>
<td>Click the toolbar button; or with the Pointer tool active, place the cursor on the graph page and press &quot;A&quot;, then ...</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Use +/- keys or mouse wheel to zoom in or out.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Use the arrow keys to pan horizontally or</td>
</tr>
</tbody>
</table>

248
Graphical Exploration of Data

| Stepped Zoom-Pan\(^1\):  
| Zoom graph in or out, by increment. |  |  |  
| • Stepped zoom.  
| • CTRL+I activates zoom in; click on the graph to establish the focal point.  
| • CTRL+M zooms out; clicking on graph not needed. |

| Whole Page: Show the whole graph page. |  |  |  
| • Reset the view of the page after using the Zoom-Panning tools, above. |

| Zoom All: All objects in the window are shown. |  |  |  
| • Can be used to locate "lost" objects lying outside the graph page. |

\(^1\)Notes: These are older tools and methods that have been deprecated. Toolbar buttons are not shown by default. To add them to the workspace, use the Customize Toolbars dialog box (View: Toolbars > Graph button group).

### 13.1.2 Axis Rescaling

New Hotkey support for Rescaling of 3D Graphs:

- D + mouse wheel: rescale in Z direction
- Z + mouse wheel: rescale in X direction
- SHIFT + Z + mouse wheel: rescale in Y direction
- Enable clipping on Miscellaneous tab of Plot Details (layer level) hides plots outside of frame.

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Menu</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rescale: Rescale and pan the graph in both X</td>
<td></td>
<td>--</td>
<td>--</td>
<td>• Scroll mouse wheel to rescale X.</td>
</tr>
</tbody>
</table>
and Y dimensions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Control</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rescale the graph in the X dimension.</td>
<td>--</td>
<td>• <strong>SHIFT</strong> + scroll to rescale Y.</td>
</tr>
<tr>
<td></td>
<td><strong>Z</strong> + scroll wheel or <strong>Z</strong> +</td>
<td>• Drag with the left mouse button to pan (will rescale both X and Y).</td>
</tr>
<tr>
<td></td>
<td>+/- keys</td>
<td>• Select the <strong>Pointer</strong> tool to exit Rescale mode.</td>
</tr>
<tr>
<td>Pan the graph in the X dimension.</td>
<td>--</td>
<td>• Rescales X.</td>
</tr>
<tr>
<td></td>
<td><strong>X</strong> + scroll wheel or <strong>X</strong> +</td>
<td>• Does not rescale Y.</td>
</tr>
<tr>
<td></td>
<td>+/- keys</td>
<td></td>
</tr>
<tr>
<td><strong>Rescale X</strong>: Rescale the graph in</td>
<td><img src="image" alt="Rescale X" /></td>
<td>• Rescales (Resets) X to full X range + some padding factor.</td>
</tr>
<tr>
<td>the X dimension.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rescale the graph in the Y dimension.</td>
<td>--</td>
<td>• Rescale the graph in the Y dimension without limits.</td>
</tr>
<tr>
<td></td>
<td><strong>SHIFT</strong> + <strong>Z</strong> + scroll</td>
<td></td>
</tr>
<tr>
<td></td>
<td>wheel or <strong>SHIFT</strong> + <strong>Z</strong> +</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+/- keys</td>
<td></td>
</tr>
<tr>
<td>Pan the graph in the Y dimension.</td>
<td>--</td>
<td>• Rescales Y.</td>
</tr>
<tr>
<td></td>
<td><strong>SHIFT</strong> + <strong>X</strong> + scroll</td>
<td>• Does not rescale X.</td>
</tr>
<tr>
<td></td>
<td>wheel or <strong>SHIFT</strong> + <strong>X</strong> +</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+/- keys</td>
<td></td>
</tr>
</tbody>
</table>
### Graphical Exploration of Data

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rescale Y</strong></td>
<td>Rescale the graph in the Y dimension.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Rescale Y" /></td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> Rescales (Resets) Y to full Y range + some padding factor.</td>
</tr>
<tr>
<td><strong>Rescale XY</strong></td>
<td>Rescale the graph in both X and Y dimensions.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Rescale XY" /></td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> Rescales (Resets) X and Y to full range + some padding factor.</td>
</tr>
<tr>
<td><strong>Rescale Z</strong></td>
<td>Rescale the graph in the Z dimension.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Rescale Z" /></td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> Rescales (Resets) Z to full range + some padding factor.</td>
</tr>
<tr>
<td><strong>Scale In/Scale Out</strong></td>
<td>Rescale the graph in X and Y dimensions.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Scale In/Scale Out" /></td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> Select <strong>Scale In</strong> button, then drag out rectangle(s) to define axis scale range desired.</td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> Reset by clicking on the <strong>Scale Out</strong> button (no need to drag) several times.</td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> Rescales both X and Y.</td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> Press ESC (or select another tool) to quit magnifying mode.</td>
</tr>
<tr>
<td><strong>Rescale</strong></td>
<td>Rescale the graph in the all dimensions.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Rescale" /></td>
</tr>
<tr>
<td></td>
<td><strong>CTRL + R</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Graph: Rescale to Show All</strong></td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> Rescales (Resets) all axes to display all data in the layer (+ some padding factor).</td>
</tr>
</tbody>
</table>

You can use the **Scale In** button 
![Scale In](image) to copy an enlarged portion of your 2D graph to a new window. This will also work on any graph that has multiple linked layers as long as the layers are overlapped and share a common axis (% of Linked Layer has Left/Top set to 0 and Width/Height set to 100, plus Straight (1 to 1) linking to the parent layer). With a graph active, press Ctrl then click the **Scale In** button 
![Scale In](image) (Tools.
toolbar) and drag out a rectangle on your 2D graph. Note that this **Enlarged** graph is dynamic. Move or resize the rectangle on your original graph and the **Enlarged** graph is updated.

If you do not see a toolbar button, it may be turned off. To add or remove buttons from a toolbar, see **The Customize Toolbar Dialog Box**.

To prevent an axis from rescaling when using one of the axis rescaling tools, set **Rescale** = **Fixed**. If both X and Y axes are set to **Fixed** and you pick one of these axis rescaling tools, you are reminded that X and Y axes are in "Manual Rescale mode" and are prompted to proceed. Answering Yes will allow you to override and manually rescale in one or both dimensions. If you need to block such manual overrides of **Fixed** axis scales, set **@nrm = 1**.

### 13.2 Rotation of 3D openGL Graphs

You can interactively rotate your 3D graphs for to obtain a better view of your plots. When you click on an empty portion of a 3D graph, a floating toolbar displays. You can use the floating buttons to rotate the graph; or you can use your keyboard and mouse.

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Menu/Action</th>
<th>Context</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rotate 3D graphs with the 3D floating buttons</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X + Arrow key</td>
<td>Rotate the 3D graph around the X axis.</td>
<td>With graph layer active and with <strong>Rotate</strong> button selected in the 3D floating button group.</td>
</tr>
<tr>
<td>Y + Arrow key</td>
<td>Rotate the 3D graph around the Y axis.</td>
<td></td>
</tr>
<tr>
<td>Z + Arrow key</td>
<td>Rotate the 3D graph around the Z axis.</td>
<td></td>
</tr>
<tr>
<td>Q + Arrow key</td>
<td>Rotate the 3D graph in screen.</td>
<td></td>
</tr>
<tr>
<td>W + Arrow key</td>
<td>Rotate the 3D graph around any axes.</td>
<td></td>
</tr>
</tbody>
</table>

**Rotate 3D graphs using R key**

| R + Mouse     | Drag to rotate the 3D graph in an arbitrary direction. | Press "R" before pressing other keys.                                                      |
13.3 Reading Coordinate Values and Distances

Origin provides several tools to aid in labeling and graphical exploration of your data plots. Most of these tools are available from the Tools toolbar (View: Toolbars). There is a related tool -- Vertical Cursor -- available from the Gadgets menu.

13.3.1 Data Point Tooltip

Most 2D plot types support a floating, customizable tooltip that reads data point values when you hover on a data point.

**Tooltip Shortcut Menu**

For tooltip customization and other options, right-click directly on the data point tooltip.
- **Go to Sheet** pops up the worksheet and highlights the row that contains the source data for the data point.
- **Show Data Plot Tooltip** toggles display of a non-customizable data plot tooltip in place of the customizable data point tooltip (see, below).
- **Pick Data Points** puts the cursor into data reading mode and opens a Pick Points dialog. Double-click on points in the graph and when finished, click Done. This generates summary data (source, X-Y coordinates, etc.) for your picked points.
- **Copy** copies data point tooltip information to the Clipboard.
- **Preferences** opens the Data Point Tooltip dialog allowing you to customize tooltip content and formatting.

The Data Point Tooltip dialog is a slightly simpler version of the Data Info window's preferences dialog (Data Info Report Settings). See The Data Info Window for help with customizing your Data Point Tooltip.

By default, the Data Point Tooltip displays with a moderate degree of transparency. You can affect tooltip transparency by changing the value of LabTalk System Variable @TDT. For information on changing the value of a LabTalk System Variable, see this FAQ.

### 13.3.2 Data Plot Tooltip

There is a second tooltip that can be displayed in place of the Data Point Tooltips and this we refer to as the Data Plot Tooltips. This non-customizable tooltip displays the source book, worksheet and coordinate datasets, on hover.
The Data Point Tooltip displays by default. If you prefer to use the Data Plot Tooltip, right-click on the Data Point Tooltip and choose to **Show Data Plot Tooltip**. Conversely, right-click on the Data Plot Tooltip and choose **Show Data Point Tooltip**.

### 13.3.3 Managing Tooltip Display

You can turn off display of data tooltips by activating the graph window, clicking on the **View** menu and clearing the check mark beside **Data Tooltips**.

There is a second way to control tooltip display that is more complicated but allows a greater degree of control. This entails changing the value of LabTalk system variables `@PT` and `@PTI`.

```
@PT=0; //Disable both data plot and data point tooltips

@PT=1; //Enable data plot tooltips for 2D graph (default)

@PT=2; //Enable data plot tooltips for 3D OpenGL graph

@PT=3; //Enable data plot tooltips for both 2D graph and 3D OpenGL graph

@PTI=0; //Disable only data point tooltips

@PTI=1; //Enable data point tooltips (default)
```

### 13.3.4 The Annotation Tool

Use the **Annotation** tool to label a data point. The tool works with Symbol/Line+Symbol and Column/Bar plots. Choose from several standard data point labels or create your own custom label using LabTalk script.

To annotate a data point:
1. Click the **Annotation** button on the **Tools** toolbar and move the cursor to the desired data point. The **cursor** and the **Status Bar** will display the current label form.

   ![Cursor and Status Bar Diagram]

   *double click = add an annotation, TAB = toggle annotation label, current label = Custom (this point’s x location is $x$)*

2. Use the TAB to toggle between the following standard annotation forms: (X coordinate value, Y coordinate value); (X coordinate value, Y coordinate value)[index number]; X coordinate value; Y coordinate value; index number (row number); or Custom (see Tutorial, next).

3. When you’ve selected your label form, double-click to add a label to the data point; or single-click on the point and press Enter.

   **Tutorial: Customizing the Annotation String**

   The annotation string can be customized by combining literal characters with the X and Y coordinate values:

   1. Start with a graph of your data
   2. Open the **Script Window** (**Window:Script Window**) and type the following command, then press Enter:

   ```
   system.annotation.customlabel$="X value: $(x,.2), Y value: $(y,*5)
   ```

   3. Click the **Annotation** button, hover on your graph, then press the **Tab** key several times to cycle through the annotation choices until the custom string format specified above is displayed in the Status Bar. The cursor will display the word "Custom".

   4. Start double-clicking on data points (or single-click and press Enter) to add the custom annotation string. The X values will be displayed with two decimal places and the Y values will be displayed with 5 significant digits, as specified by your script.

   **Adjustments using the Pointer Tool:**
Graphical Exploration of Data

- To move a label to another data point, click the **Pointer** tool, press the ALT key and drag the label.
- To re-position overlapping labels, drag the label. A leader line is automatically added.
- To copy a label to another data point, press CTRL + SHIFT and drag the label to a new data point.

**Note:** Please view more information on string formatting in the Programming help file:

Help: Programming: LabTalk > Language Reference > Object Reference > Alphabetical Listing of Objects > **String**

### 13.3.5 The Screen Reader Tool

The **Screen Reader** uses the **Data Display** window to report the XY(Z) coordinates of the cursor on the graph page. Note that the Screen Reader is not reading *data point coordinates*; rather it is reading *page coordinates* relative to the graph axes.

The Data Display window opens automatically when you select the Screen Reader tool from the **Tools** toolbar (by default, the Data Display window is docked at the bottom of your Origin workspace).

You can alter basic properties of the Data Display window by right-clicking on the window title bar or by right-clicking inside the window.

To use the **Screen Reader**:

1. Click the **Screen Reader** button on the **Tools** toolbar. This opens the **Data Display** tool.
2. Click on a location in the graph page to read its X,Y, and Z coordinates (ternary and contour only). Coordinate values show in the Data Display window.
3. To increase cross-hair size, press the space bar.
4. Click the **Pointer** button on the **Tools** toolbar to exit screen reading mode.

### 13.3.6 The Data Reader Tool

The **Data Reader** is used to read information associated with a data point in your plot. This could be coordinate values or it could be more complex information including metadata or even images that relate to the data point. The Data Reader works in concert with the customizable **Data Info** window.

The Data Reader tool is grouped with two related tools -- the **Data Cursor** and the **Data Highlighter**. Only one of these toolbar buttons will show at any given time. To select a hidden tool, click on the small arrow to the right of the button and select a tool from the pop-up menu.
To use the Data Reader tool:

1. Click the **Data Reader** button on the **Tools** toolbar. This opens the **Data Info** window.
2. Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the Data Info window (and Data Display window).
3. To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or click on the data point using your mouse. If you have multiple plots in a layer, use the UP and DOWN arrow keys to move to a data point on another plot or use your mouse to click on the point.
4. To change the vertical and horizontal cross-hair size, click on a point and press the spacebar.
5. Click the **Pointer** button on the **Tools** toolbar or **Esc** key to exit the Data Reader tool.

### 13.3.7 The Data Cursor Tool

The **Data Cursor** tool -- grouped on the Tools toolbar with the **Data Reader** tool -- allows you to place one or more cursors on a data plot and (using the **Data Info** window) read the cursor coordinates or measure the X and Y distance between two cursors, or the distance between a cursor and a point selected with the **Data Reader**.

**Tutorial: Using the Cursor Tool to Measure Relative Distance**

1. Import the file `Samples\Spectroscopy\Sample Pulses.dat` and create a line plot.
2. Click and select the **Data Cursor** button from the **Tools** toolbar.
3. Double-click on one of the peaks or click once on a data point and press ENTER, to add a cursor object.
4. Repeat to place a second cursor object on another peak.

5. Double click in the Data Info. window to open the Data Info. Report Settings dialog. If this window is not visible, select the View: Show Data Info menu item to open the Data Info. window.

6. Switch to the Columns tab and then right-click in the gray area to the right of the columns and choose Add Column.

7. In the new column that is added, click on the source row of new column, and select Relative (Cursor2 - Cursor1) from the drop-down, and then press OK to close the dialog.

8. Now you can drag and move the cursor objects and the third column in the Data Info window will display the X and Y distances between the two cursors.
13.3.8 The Data Highlighter Tool

The **Data Highlighter** is grouped on the Tools toolbar with the **Data Reader** and **Data Cursor** tools. Use the Data Highlighter to pick one or more points in the your graph and simultaneously highlight the corresponding data row in the worksheet. Unselected points are dimmed in the graph and the worksheet.

While in Data Highlighter mode ...

- CTRL+click to select multiple points in the graph.
- Drag out a rectangle on the graph to select multiple points.
- Use SPACE to toggle between rectangle and freehand selection modes.
• Use left/right arrow keys to highlight individual points in sequence by row index.
• In the worksheet (still in Highlight mode), CTRL+click multiple rows or SHIFT+select blocks of rows, and highlight corresponding points in the graph.
• Press ESC to exit Highlight mode in the graph while keeping highlighted rows selected in the worksheet.

13.3.9 The Data Info Window

The Data Info window opens when you choose either the Data Reader, the Annotation or the Data Cursor tools. When you click on a plotted data point with one of these tools, the Data Info window displays information about this particular data point.

In its default configuration, the Data Info window reports only a column short name, plot designation (e.g. "X") and the XY coordinate values of a data point. However, the window is capable of displaying any of the worksheet-contained information that is associated with a data point including metadata and images.

To customize the Data Info window:

1. Double-click on the Data Info window; or right-click and choose Preferences....
2. Use the controls in the Data Info Report Settings dialog box to customize the display of the Data Info window:
The **Data Info** window can report any information in the source data worksheet. You are not limited to displaying plotted data.

- The window can display anything that can be inserted into the worksheet cell, including inserted graphs and images.
- The window can be customized with a **Window Title** and **Report Title**.
- Window configurations can be saved as Themes, including **Save to <Graph>**, **Save to <Layer>** and **Save to <DataPlot>**. This allows, for instance, all graph windows in your project or all graph layers in your multi-panel graph to have a unique Data Info window. Saved Themes can loaded and applied to the current Data Info window.

![Data Info window](image)

If you save your **Data Info** Theme settings in the graph, then save the graph window as a standalone graph window file (OGG, OGGU), know that the OGG/OGGU file travels only with the data that are plotted in the graph. Therefore, if your Data Info Theme uses data in other columns in your worksheet, the Data Info display will be incomplete if, for instance, you reopen the window file in a new project.

![Save Themes dialog](image)

For more information on customizing the **Data Info** window, see:

- [The Data Info Window](#).
- [Tutorial: The Data Reader Tool](#) (discussion on customizing the Data Info window).
13.3.10 Gadgets

Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration:

- **Vertical Cursor**
- **Statistics**
- **Cluster** (OriginPro)

The **Vertical Cursor** gadget is especially useful for reading XY coordinate values for data points in stacked panel plots or multi-plot graphs, where plots share a common X scale.

To open the Vertical Cursor:

1. With a graph window active, choose **Gadgets: Vertical Cursor...** from the main menu. This opens the **Vertical Cursor** dialog box.

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label font size, hide labels, etc.

When labeling plots with the Vertical Cursor, you can opt to combine separate data labels into a single label by clicking the gadget's **Show All Info in One Label** button.
The **Statistics** gadget returns basic statistics on data points falling inside a rectangular region-of-interest (ROI) on the graph.

- Display basic statistics for data inside the ROI.
- Display mean and $n$th Standard Deviation lines inside the ROI.
- Update results dynamically as ROI is moved or resized.

The **Cluster** gadget (available in **OriginPro**) provides the following features:

- Display basic statistics for data inside a region of interest (ROI).
- Switch between rectangular or elliptical ROI.
• View statistics for points inside and outside of the ROI.
• Edit, copy, mask, delete or group data points.
• Update results dynamically as ROI is moved/re-sized.
• Output results to a worksheet.

When you use the Cluster gadget to define a category (points within a ROI on a plot), you can apply a differentiating color to points within the ROI.
Note: To learn more about these gadgets, see:

Help: Origin: Origin Help > Gadgets

13.4 Topics for Further Reading

- Gadgets
- The Data Analysis chapter of this User Guide
- The Cluster Gadget (OriginPro)
- The Vertical Cursor Gadget
- The Digitizer
- The Statistics Gadget
- Masking Data
- Data Filtering
- Drawing or Deleting Data Points in the Graph
- List of Origin Built-in Toolbars and Buttons
14 Gadgets

Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple: While each Gadget has a specific purpose, each is built around applying a set of customizable analysis operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object.

You can drag to modify the ROI at any time, then change your analysis options and recalculate results by clicking the arrow button in the upper-right corner of the ROI and choosing one of the menu options. For general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file.

Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI.

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new exploratory and analysis-related tools have been added to OriginLab’s File Exchange and more tools are being released all the time. Please visit the File Exchange to review available tools.

14.1 Origin Gadgets

The Gadgets main menu is available when a graph window is active. There are 14 gadgets available in Origin.
Gadgets are meant to be interactive. Any time you make an adjustment (to the region-of-interest, for example), you can generate new output to your results sheet by pressing "O" on the keyboard.

<table>
<thead>
<tr>
<th>Gadget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Gadget†</td>
<td>View statistics on points inside/outside a rectangular or elliptical ROI. PRO</td>
</tr>
<tr>
<td>Differentiate Gadget</td>
<td>Calculate and plot the nth-order derivative of selected data.</td>
</tr>
<tr>
<td>FFT Gadget</td>
<td>View FFT spectrum of selected data.</td>
</tr>
<tr>
<td>Integration Gadget</td>
<td>Calculate the area under a curve, or between two curves.</td>
</tr>
<tr>
<td>2D Integration Gadget</td>
<td>Calculate the 2D integration for a contour or image graph created from matrix or XYZ worksheet data. PRO</td>
</tr>
<tr>
<td>Interpolate Gadget</td>
<td>Perform linear, spline, b-spline or Akima spline interpolation of selected data.</td>
</tr>
<tr>
<td>Intersect Gadget</td>
<td>Calculate the intersection points of two or more data plots.</td>
</tr>
<tr>
<td>Quick Fit Gadget</td>
<td>Perform linear, polynomial, or nonlinear fitting of selected data.</td>
</tr>
<tr>
<td>Quick Peaks Gadget</td>
<td>Locate peaks, and compute area and other peak properties.</td>
</tr>
<tr>
<td>Quick Sigmoidal Fit Gadget</td>
<td>Perform Sigmoidal fit of selected data.</td>
</tr>
<tr>
<td>Rise Time Gadget</td>
<td>Analyzes rise/fall time for the step-like signal. PRO</td>
</tr>
<tr>
<td>Statistics Gadget</td>
<td>Compute and display simple descriptive statistics of selected data on the graph.</td>
</tr>
<tr>
<td>Vertical Cursor Gadget</td>
<td>Read and tag X, Y coordinate values for data plots across multiple graphs that share the same X axis.</td>
</tr>
</tbody>
</table>
The **Vertical Cursor Gadget** now supports a horizontal layer arrangement. A **Linked Cursor for Each Layer** button is added to the dialog to place a cursor at the same X position for all layers.

<table>
<thead>
<tr>
<th>Image/Contour Profile</th>
<th>Analyze the image or contour from matrix data and generate profiles.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curve Translate Gadget</td>
<td>Drag a curve in the vertical or horizontal direction, adjusting source data in the process.</td>
</tr>
</tbody>
</table>

**Note:** To learn more about these gadgets, see:

**Help:** Origin: Origin Help > **Gadgets**

**Help:** Origin: Origin Help > Matrixbooks Matrixsheets and Matrix Objects > **Viewing and Profiling Matrix Data**

† When you use the **Cluster** gadget to graphically define a category (within an ROI), you can apply a differentiating color to points within the ROI.

**Tutorial: Using the Integrate Gadget to Output Results to a Worksheet**

1. With a new workbook active, import the file **Peaks on Exponential Baseline.dat** located in the Samples\Spectroscopy subfolder under the Origin installation folder.
2. Create a line plot of the data in column B.
3. With the graph active, go to the main menu and click **Gadgets: Integrate**...
4. In the dialog box that opens, click the **Baseline** tab and select **Straight Line** from the **Mode** drop-down list.
5. Click the **Output** tab, and under the **Output Quantities to** node, select **Append to Worksheet** and clear the other check boxes.

6. Expand the **Quantities** node, select **None** from the **Dataset Identifier** drop-down list and enable **Beginning X** and **Ending X**.

7. Press **OK** to close the dialog box. The Region-of-Interest (ROI) rectangle object is added to the graph.

8. Resize and move the ROI object to cover just the first peak in the data plot, then press the arrow button located at the top-right of the ROI and select **New Output**; or press "O" on your keyboard. This will write the parameters for the first peak to a worksheet.

9. Drag and move the ROI to cover the second peak, and repeat the steps above to generate output for the second peak.

10. Press the arrow button again and this time select **Go to Report Worksheet**. A worksheet with the integration results will open.
Click the arrow button in the top right corner of the ROI and you can opt to output results for all curves in the current layer (New Output for all Curves (N)) or for all layers of the graph page (New Output for All Layers (L)) or press the corresponding N or L hotkey. This allows for batch analysis of multiple curves in a graph.

14.2 Topics for Further Reading

- Gadgets
- The Image/Contour Profile tool
- Tutorial: Using Multiple Gadgets
- Tutorials for Individual Gadgets
- Peak Analyzer
- Digitizer
15 Data Analysis

15.1 Introduction

Origin contains powerful tools for all of your data analysis needs, including curve fitting, statistics, peak analysis and signal processing. Most of Origin’s analysis tools can make use of a stored collection of settings -- something known as a Dialog Theme -- that makes repeat analyses a snap. Furthermore, the output from one operation can become the input for another operation, thus allowing you to set up a chain of operations, with results that update whenever there are changes to source data, as would happen when importing a series of data files.

The following sections cover (1) selecting the data that you wish to analyze and (2) the Origin and OriginPro tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User Guide for more information on Analysis Templates, Dialog Themes and other time-saving features.

Apps are add-on tools that extend Origin's graphing and analysis capabilities. Many analysis-related tools are available free-of-charge from OriginLab's File Exchange. To find out more about Apps in Origin, see the Apps for Origin chapter of this User Guide.

15.2 Data Input

Origin's analysis tools will work with workbook and/or graph data, depending upon the tool. By default, analyses will be on done on selected data in the worksheet or graph window. You may want to restrict your analysis to a subset of the data -- say, a certain range of rows or columns in a worksheet or a certain X range in a graph -- and we cover that here.

Data selections can be made before or after opening an analysis dialog. Most of Origin's X-Function based analysis tools have a Input branch with a range selection control that you can use to interactively select your data (as explained below).

15.2.1 Selecting Data in the Worksheet

When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would include nearly all of those that open from the Analysis or Statistics menus -- you will see your range selection already entered into the dialog box Input branch. Most will find that selecting worksheet data prior to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to analyze.
If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do upon opening the dialog is to select data in **Input** branch:

1. Click the range selection control next to **Input** (or **Input Data**). The dialog box will roll up.

2. Go to worksheet and highlight your worksheet data, then click the button at the right end of the rolled up dialog box. The **Input** branch will now show the selected range.

Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only supports one dataset, you may be able to select multiple ranges in the worksheet, but only the 1st range will be picked in the analysis.
The **Input Data** branch has a hierarchical structure. If the analysis supports multiple datasets, you can add multiple ranges under **Input Data** and they will show as **Range 1**, **Range 2**, etc., each with its corresponding **X**, **Y**, **Error** and **Row** controls.

- Mousing over each level will show a tooltip indicating where the data on that level is from (i.e. book, sheet and column).

- A **Rows** control under each range node lets you set range by row index or X value. If you want to apply the same row range to all ranges under **Input Data**, click the arrow button to the right of the range node and choose **Apply Row Range to All**.

- Depending on where you are in the **Input Data** hierarchy, the range selection button may have some limitations (e.g. if you click range selection control next to **Y**, though you could select multiple columns in a worksheet, only the 1st column is accepted).

- Clicking the **arrow** button to the right of the range selection control will show more selection options, including individual worksheet columns that can be quickly added to your data selection.

- Depending on which level you are in, the selection options when clicking the **arrow** button may vary. For instance, clicking the “arrow” button next to **Input Data** and clicking the Select Columns... menu item, will open the **Column Browser** allowing you to select multiple columns from different worksheets.
1. Use the **List Datasets** drop-down list to filter which sheets you want to pick from. The top panel list can be sorted by clicking any of the column headings, making it easy to select, for example, all columns that share the same **LName** or **Comments**.

2. Then click the **Add** button to add the column to your selection list in bottom panel.

3. To modify the data input range of any dataset, click the range button to the right of any dataset added to the bottom panel and edit the **From** and **To** values.

### 15.2.2 Selecting Data in the Graph

When a graph window is active and you select one of the **Analysis** menu tools, the default behavior is for the analysis dialog box to open showing the selected range of the active dataset as your **Input Data** (note that analysis dialogs include an **Input Data** node that allows adjustments -- adding more datasets with the interactive range selector button, changing a data range, etc.).

#### 15.2.2.1 The Data List and the Active Data Plot

The active data plot is the one that shows in the data list (bottom of the **Data** menu) with a check mark next to it. If the active graph layer contains a **plot group**, the default behavior is to make the first plot in the group the active data plot (note the "g1" beside each range in the following image, indicating that all are members of plot **group 1**). You can activate a different plot by clicking on another of the data plots listed at the bottom of the **Data** menu. Subsequently, when you open an analysis dialog box, this newly-selected plot will be listed as your input data.
However, for most purposes, you can ignore the data list and select your plot data directly in the graph window or using the Object Manager:

- If your data plots are part of a plot group, select the entire group by pressing SHIFT + clicking on a plot. Alternately, click on the group icon in the Object Manager. Either will set Input Range to all plots in the group.
- To select just a single plot -- whether it be an independent plot or part of a group -- click once on the plot. Alternately, click on the plot icon in the Object Manager. Either will set Input Range to only the selected plot.
You can also indicate the active dataset by placing a red box around the plot's legend entry. In the case of grouped plots, the red box shows on the first plot in the group.

To turn this feature on or off:

- Click on your graph window, select Format: Page..., click on the Legends/Titles tab and enable or clear the Indicate Active Dataset box.
- Select the graph legend, then right-click on it and choose Legend, then select/deselect the Indicate Active Dataset menu entry.
- Select the graph legend, then right-click on it and choose Legend: Update Legend and enable or clear the Indicate Active Dataset box.

15.2.2.2 Customizing X scale range using Analysis Dialog "Rows" controls

You can adjust data range using the Rows controls under the Input Data branch of most analysis dialogs. If you have an analysis dialog box open:

1. Click on Input Data branch to expand.
2. Change the Rows drop-down list to By Row or By X and enter your From and To values. Note that each Range N will have its own Rows controls.

15.2.2.3 Customizing X scale range using Axis Scale Mini Dialog

Before opening an analysis dialog...

1. Click on an axis then click the Mini Toolbar Axis Scale button to open the Axis Scale dialog box.
2. Adjust the X axis scale to your desired range.

3. Now open your analysis dialog (e.g., Linear Fit) and click the arrow button beside the Input Data box and select **Use X Scale Range** from the context menu:

As you can see, the customized scale range of X axis on the graph has been used to specify the input data range for your analysis (Rows = By X).

**15.2.2.4 Selecting data graphically using The Regional Data Selector**

You can graphically select a range of data using the **Regional Data Selector** tool:
1. With a graph window active, click and hold on the **Regional Data Selector** button on the **Tools** toolbar, and then choose either the **Selection on Active Plot** or **Selection on All Plots** button.

2. Drag out a rectangle or freehand object to select an area of the plot(s). Note that you can press **Space** to toggle between rectangle and freehand modes.

When you make your selection, **Data Markers** are placed on the graph to mark the selected range(s). You can now use Origin’s analysis tools (e.g., Linear Fit) to perform an analysis on the selection, but note that some analysis dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (**Analysis: Signal Processing: Smooth...**) will only smooth data in the active dataset or a single, selected plot.

There is a new Mini Toolbar for controlling X scale range when using **Data Markers**. Click on a Data Marker and use the buttons to **Set Display Range** or **Reset to Full Range**.

**Tutorial: Linear Regression on Partial X Range**

1. Import the file `\Samples\Curve Fitting\Exponential Decay.dat` into a new workbook.
2. Select all Y columns and create a line plot.
3. Click and hold the **Regional Data Selector** button on the **Tools** toolbar, and then choose the **Selection on All Plots** button.
4. Drag out a rectangle to select the tail-end of the three curves between values of approximately 0.6 and 1.0 along the X axis.
5. Use the **Analysis:Fitting:Linear Fit** menu to open the **Linear Fit** dialog.
6. **Input Data** branch is filled with three ranges. Mouse over Input Data branch will show tooltip which shows 1X,1Y, ...3X and 3Y.
7. If you want to change the data selection, click the arrow button in **Input Data**.
and choose **Reselect All Data from Graph**. The dialog will roll up. Drag out a rectangle in graph again to make your selection and then click the ![button at the right end of the rolled up dialog box. The new data selection will show in **Input Data** branch.

8. Accept default Linear Fit settings and press **OK** to close the dialog. Linear fitting will be performed on all three curves over the selected range.

In addition to the data selection and data masking methods discussed in this section, Origin offers data filtering and data reduction tools. Please visit the linked pages for details.

### 15.2.2.5 Editing a Data Marker

To edit a **Data Marker**:

- To modify a data range, right-click a data marker and choose **Edit**; or double-click on the data marker. The red marker changes to a dark color with arrows on both ends and the cursor changes into a cross-hair. Drag the beginning or ending marker to a new position or use one of the keyboard shortcuts listed below and modify the data range. To escape edit mode, double-click on the marker or press the Enter key.

- There are other options when right-clicking the data marker such as **Delete Marker**, **Delete Data**, etc.
Note: If you have used the Regional Data Selector tool to place markers on multiple plots (Selection on All Plots), be aware that moving markers will affect the data range of the active plot only; the ranges of other selected plots will not follow that of the active plot. This is a limitation of the Regional Data Selector.

Alternately, you can use these keyboard shortcuts to select and edit data markers:

1. Select data markers using these keys ...

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>s</td>
<td>Select the first pair of data markers on the graph (those marked with &quot;1&quot;).</td>
</tr>
<tr>
<td>Tab</td>
<td>Select the next pair of data markers (not in edit mode) or the other data marker of the pair (in marker edit mode).</td>
</tr>
<tr>
<td>Home</td>
<td>Return to the first data marker.</td>
</tr>
<tr>
<td>End</td>
<td>Go to the last data marker.</td>
</tr>
</tbody>
</table>

2. ... then activate and edit the data marker using these key combinations:

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Activate the selected data marker for editing. (Press Enter again to exit data selection mode.)</td>
</tr>
<tr>
<td>Arrow</td>
<td>Move the active data marker exactly one data point.</td>
</tr>
<tr>
<td>Ctrl/Shift + Arrow</td>
<td>Move the active data marker multiple data points.</td>
</tr>
</tbody>
</table>
15.2.2.6 Difference between Data Markers and Analysis Markers

- **Data Markers** define a sub-range that you select using the **Data Selector** tool.
  
  If you want to remove the data markers from a graph, you can select **Data: Clear Data Markers** from the main menu, or click the **Clear Data Markers** button on the **Markers and Locks** toolbar.

- When the analysis routine is completed, Data Markers are replaced with **Analysis Markers**. By default, Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange, Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun your analysis, you must right-click an analysis marker and choose **Change Parameters**.... Change the Input Data range and rerun the analysis.
1. If you set **Recalculate** to **None** in the analysis dialog box, then no analysis markers are generated.
2. Data markers and analysis markers are not exported when you choose **File: Export Graphs**.
3. To select the exact same range again for another analysis, click the green lock and choose **Plot Input Data with Data Markers** to create a new graph and do analysis on it.
4. There is a **Markers and Locks** toolbar to control analysis markers and locks, such as **Marker Show** to toggle analysis markers on or off, etc. There is also an **Analysis Markers** submenu, available from the **Data** menu; or when you right-click on an analysis marker or green lock and choose **Analysis Markers**.

**15.2.2.7 The Pick Points Tool**

You can also pick the data points in the graph using the **Pick Data Points** tool. This works best for scatter or line + symbol plots of smaller datasets.

1. Select **Data: Pick Data Points**. The **Pick Points** dialog will pop up.
2. With the square cross-hair, you can read the coordinate of current data points in the **Pick Points** dialog (also the Data Source). Double-click on the point you want to pick until the cross-hair cursor became round, the actual X&Y values will be recorded and the total number of picked points will be counted up.
3. Once you finished the picking, click the **Done** button to output the results to a new workbook.

### 15.2.2.8 The Data Highlighter

In some cases, the **Data Highlighter** on the **Tools** toolbar, can be useful for selecting some portion of your data for further analysis. For instance, you have a 2D scatter plot and you are interested in data points in a particular region of the graph.

1. Click the **Data Highlighter** button on the **Tools** toolbar.
2. Highlight the desired group of data points. Note that you can toggle between rectangular and freehand selection modes by pressing the spacebar while the Highlighter is active. Selection points in the graph simultaneously highlights selected rows in the source worksheet.
3. Go the source worksheet, right-click on it and choose **Create Subset Sheet**.

You now have a secondary worksheet named as `wcopyN`, that contains only the data points that you selected in the graph.

For more information, see [The Data Highlighter Tool](#).

### 15.3 Data Output

Origin's analysis tools typically have an **Output** branch (the exact name varies by tool), in which you can specify the output that you wish to generate and where you would like that output to go. This happens to be the output branch of the Integration tool.

Output can be directed to various places -- a range of worksheet cells or columns, or possibly to a worksheet, a workbook, a matrixsheet, or a graph layer. Output options depend upon the target object as well as the type of window that was active when the tool was opened. You can determine your output target by:

- Typing directly in the associated text box, using a standard **range notation**
- Selecting data with the **interactive range control**.
- Type or select your target using a set of predefined **range strings**.

This being an introductory manual, we will stick with the simplest to use -- using **predefined range strings**. For information on other options, follow the links above.

### 15.3.1 Specifying Output Using Range Strings
Referring to the image above, note that range strings are enclosed by `< >` characters. Valid strings will differ from dialog to dialog (e.g. `<source>` is available from the Book list under the Output Fitted Values To branch of the Fit Linear dialog, but it is not used to specify Output in the Smooth dialog).

The most common strings:

- `<none>`: Generate no output.
- `<new>`: Create a new Origin object -- a column, a worksheet, a graph, etc.
- `<input>`: Use the input object for output.

You can type these strings directly into the edit box but the easiest thing to do is to just select them from the flyout menu (options will vary by tool). Alternately, you can click the Custom button and open the Range String Builder. Despite the intimidating name, it is just a way to step through the process of specifying your output target. For more information on range strings and Range String Builder, see Output Results in the Origin Help file.

For Origin 2021, changes were made to clarify labeling and presentation of the Range String Builder dialog, plus better context labeling of controls (e.g. Range String Builder is now Custom for custom range string, in the Output flyout menu).

### 15.4 Data Masking

Masking is another technique that you can use when you want to analyze only a subset of your data, or when you have spurious data points that you do not want included in your analysis. Masking or unmasking data will trigger recalculation of linked operations.

- You can mask data points in both worksheets and graphs.
- When data exist in both the worksheet and the graph, masking data in one will mask (and mark) the corresponding data in the other.
- Mask toolbar buttons work on both graphs and worksheets.
- Tools toolbar buttons work on graphs.
- When data are selected in the worksheet, a Mini Toolbar Mask Data button becomes available.
- Additionally, you can mask worksheet data by mathematical condition.

**Origin 2021** supports data masking in XYZ 3D plots. You can mask data using buttons on the Mask toolbar (worksheet active) or the Tools toolbar (graph active).

### 15.4.1 Masking with the Mask Toolbar (worksheet, graph)

These toolbar buttons are used to mask and manipulate masking of selected data. Note that this includes graphs, once data have been selected (see the next section on Tools toolbar buttons for graph selection).
### Masking with the Tools Toolbar (graph)

For **Origin 2021**, there is a change to the default masking mode:

- Default is changed from mask by *row index number* to mask by *rectangular region*.
- Otherwise, behavior remains as before: toggle between masking modes (see next) by pressing Spacebar.
- You can use system variable `@MTI=1` (persistent) to revert mask by row index as default.

**To mask points, click on the graph window to activate it:**

1. Choose **Data: Mask Data Points** from the main menu or click the **Mask Points on Active Plot** button or **Mask Points on All Plots** button on the **Tools** toolbar, then hover on the graph.
2. To mask a single point, double click on the point. To mask a region of points, press the Space bar to toggle among masking by *row index number*, by *rectangular region* or by *freehand region* (differences explained below), then drag out a region.
3. Once data are masked in the graph, you can use the **Mask** toolbar buttons, described above.
Mask Points on Active Plot | Mask Points on All Plots of Active Layer | Purpose
--- | --- | ---
| | | Mask data points by rectangular region. Only the data points inside the rectangle that you drag out, will be masked.
| | | Mask data points by freehand region. Only the data points inside the region that you drag out, will be masked.
| | | Mask data points by row index number. All data points between the lowest and highest selected index numbers are masked regardless of whether they lie inside your rectangle.

To remove the mask from data points in the graph window:

1. Choose either the Unmask Points on the Active Plot tool or the Unmask Points on All Plots of Active Layer tool on the Tools toolbar.
2. Use the space bar, as needed, to choose points by index, rectangular region or by freehand region, then drag to unmask your data points. The tool will be active until press ESC or click the Pointer tool.

### 15.4.3 Mask Mini Toolbar Button (worksheet)

When worksheet data are selected -- cells or entire columns -- A Mini Toolbar Mask Data button becomes available. The button works as a toggle to mask or unmask data within the selection.

### 15.4.4 Mask Cells by Condition (worksheet)

There is a tool for masking worksheet data values by condition (e.g. <= 0).

1. With the data selected (cells or one or more columns), choose Column: Mask Cells by Condition. This opens the colmask dialog.
2. Choose your Condition and Value, plus other options as needed and click OK.

For Origin 2021, a new cell mask Condition = Outliers by IQR (interquartile range) has been added.

### 15.5 Drawing or Moving, or Deleting Data Points in the Graph
This collection of tools and menu-driven operations is helpful in exploring certain "what if" scenarios, or to quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D scatter plots.

1. Activate the graph window.
2. Click on the Draw Data Tool.
3. Make sure that the correct graph layer is active and place the cursor on the graph.
4. Double-click to create data points. The Data Display tool opens (if not already open) and displays the X and Y values for each created data point.
5. When you have finished adding data points, click on another tool (on the Tools toolbar) to exit drawing mode.

When you use the Draw Data tool, you simultaneously create a hidden worksheet named Drawn (worksheets are automatically enumerated, with \( n = 1, 2, 3, 4, \) etc.).

### 15.5.1 Opening the hidden Drawn Worksheet

Right-click on the data plot and select Go to Drawn from the shortcut menu or in Plot Details dialog, with data plot selected on left panel, click the Workbook button.

A Drawn workbook will appear with A(X) and B(Y) columns with coordinate values of your drawn data plot.

### 15.5.2 Deleting a Data Point

You can delete individual data points from your graph:

1. Select Data: Remove Bad Data Points.
2. Double-click on the data point, or click to select the data point and press ENTER key.
3. Click Arrow button on Tools toolbar or press ESC key to exit the Remove Bad Data Points mode.

The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell for the Y value will be cleared and shown as missing value.

### 15.5.3 Moving a Data Point

You can move individual data points in the graph. Understand that when you do this, you are changing the plot and the underlying data:

1. Select Data: Move Data Points (you'll be warned that you are about to change your data).
2. Click on the point you want to move (change X and Y coordinates). Place crosshairs on the point and drag; or use the arrow keys.
3. Click the Pointer button on the Tools toolbar or press ESC to exit the Move Data Points mode.

The data point is moved in the plot and the X and Y coordinates are changed in the worksheet cell.

### 15.6 Mathematics

Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume calculations.
## 15.6.1 Basic Math

When averaging multiple curves with a different X range, a **No Extrapolation** checkbox is added when **Averaged X = Full X Range, Custom or Follow Curve Trace.**

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Column Math/Simple Curve</td>
<td>Perform basic calculations on worksheet columns or XY data plots</td>
<td>Analysis:Mathematics</td>
</tr>
<tr>
<td>Math</td>
<td></td>
<td>(workbook, graph)</td>
</tr>
<tr>
<td>Normalize Columns/Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Multiple Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Differentiate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subtract Reference Data</td>
<td>Subtract one dataset from another</td>
<td>Analysis:Data Manipulation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(workbook, graph)</td>
</tr>
<tr>
<td>Subtract Straight Line</td>
<td>Subtract a straight line defined graphically by clicking in the graph.</td>
<td>Analysis:Data Manipulation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(graph)</td>
</tr>
<tr>
<td>Vertical Translate</td>
<td>Use a Gadget to graphically translate curve(s) in vertical or horizontal.</td>
<td>Analysis:Data Manipulation</td>
</tr>
<tr>
<td>Horizontal Translate</td>
<td></td>
<td>(graph)</td>
</tr>
<tr>
<td>Differentiate Gadget</td>
<td>Perform differentiation over a region of interest in a graph</td>
<td>Gadgets:Differentiate...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(graph)</td>
</tr>
<tr>
<td>Intersect Gadget</td>
<td>Calculate the intersection points of two or more data plots.</td>
<td>Gadgets:Intersect...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(graph)</td>
</tr>
<tr>
<td>Tool Name</td>
<td>Description</td>
<td>Menu Entry</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>• Vertical Cursor</td>
<td>• Read and tag X, Y coordinate values for data plots across multiple graphs that share the same X axis.</td>
<td>Gadgets:Vertical Cursor... (graph)</td>
</tr>
<tr>
<td>• Set Column Values</td>
<td>• Use formulae to set/transform worksheet column values</td>
<td>Analysis:Mathematics (workbook)</td>
</tr>
<tr>
<td>• Inverse</td>
<td>• Generate pseudo inverse of a matrix</td>
<td>Analysis:Mathematics (matrix)</td>
</tr>
<tr>
<td>• Median Filter</td>
<td>• Apply median/special/custom filter to a matrix</td>
<td>Analysis:Mathematics (matrix)</td>
</tr>
<tr>
<td>• Special Filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Custom Filter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 15.6.2 Interpolation

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Interpolate Gadget</td>
<td>• Perform interpolation over a region of interest</td>
<td>Gadgets:Interpolate... (graph)</td>
</tr>
<tr>
<td>• Interpolate/Extrapolate</td>
<td>• Perform interpolation/extrapolation on a group of XY data.</td>
<td></td>
</tr>
<tr>
<td>• XYZ Trace Interpolation(3D Graph)</td>
<td>• Perform periodic interpolation on XYZ worksheet data</td>
<td></td>
</tr>
<tr>
<td>• Trace Interpolation(2D Graph)</td>
<td>• Perform interpolation on cycle or periodic curves</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis:Mathematics (workbook, graph)</td>
</tr>
</tbody>
</table>
### Interpolate/Extrapolate Y from X

- **3D Interpolation**
  - Perform interpolation/extrapolation on a group of XY data to find Y at given X values.
  - Perform 2D interpolation on a group of XYZ data to find Z at given XY values with choice of 8 methods.
  - Perform interpolation with a 3D function on XYZ dataset.

### 2D Interpolate/Extrapolate

- **2D Interpolate/Extrapolate**
  - Perform 2D interpolation/extrapolation for a matrix

### Analysis: Mathematics

- Workbook
- Matrix, graph from matrix

### 15.6.3 Area/Volume Calculation

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Integrate Gadget</td>
<td>Perform integration over a region of interest in a 2D Graph</td>
<td>Gadgets: Integrate... (graph)</td>
</tr>
<tr>
<td>• 2D Integrate Gadget PRO</td>
<td>Calculate max height, volume, FWHM (X,Y) for a contour or image graph created from matrix or XYZ worksheet data (OriginPro Only).</td>
<td>Gadgets: 2D Integrate... (graph)</td>
</tr>
<tr>
<td>• Integrate(2D Graph)</td>
<td>Perform integration on input data</td>
<td>Analysis: Mathematics</td>
</tr>
<tr>
<td>• Polygon Area(2D Graph)</td>
<td>Calculate the area of</td>
<td>(workbook, graph)</td>
</tr>
</tbody>
</table>
### 15.7 Curve Fitting

A number of free Apps designed for various curve-fitting operations are available from the OriginLab File Exchange. To find and install these Apps click **Analysis: Fitting: Find Apps**. The App Center will open, displaying only fitting-related Apps. Browse available Apps and click the **Download and Install** button to install an App.

#### 15.7.1 Linear and Polynomial Fit

Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. The menu entries of these tools are listed in the table below. All are available for both workbook or plotted data.

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Linear Fit</td>
<td><strong>Analysis:Fitting:Linear Fit</strong> or <strong>Gadgets:Quick Fit</strong> (graph)</td>
</tr>
<tr>
<td>• Fit Linear with X Error</td>
<td><strong>Analysis:Fitting:Fit Linear with X Error</strong></td>
</tr>
<tr>
<td>• Multiple Linear Regression</td>
<td><strong>Analysis:Fitting:Multiple Linear Regression</strong></td>
</tr>
<tr>
<td>• Polynomial Regression</td>
<td><strong>Analysis:Fitting:Polynomial Fit</strong> or <strong>Gadgets:Quick Fit</strong> (graph)</td>
</tr>
</tbody>
</table>

#### 15.7.2 Nonlinear Curve Fit
You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a user-defined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some tools are available only in OriginPro.

The table below summarizes available nonlinear curve fitting tools:

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Features</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Quick Fit Gadget</td>
<td>• Fit a region of interest in a graph interactively</td>
<td>Gadget:Quick Fit (graph)</td>
</tr>
<tr>
<td></td>
<td>• Fit with built-in or user-defined fitting functions</td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>• Fit one or multiple datasets</td>
<td>Gadgets:Quick Sigmoidal Fit (graph)</td>
</tr>
<tr>
<td></td>
<td>• Choose from a number of pre-defined analyses (incl. Linear, Cubic, Peak</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and Sigmoidal).</td>
<td></td>
</tr>
<tr>
<td>• Nonlinear Curve Fitting</td>
<td>• Fit with built-in or user-defined fitting functions</td>
<td>Analysis:Fitting:Nonlinear Curve Fit (workbook,</td>
</tr>
<tr>
<td></td>
<td>• Fit one or multiple datasets</td>
<td>graph)</td>
</tr>
<tr>
<td></td>
<td>• Compare fit, multiple parameter sets</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Global fit with parameter sharing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Global fit, parameter sharing with multiple functions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Fit with replicas</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Advanced options including bounds, constraints, fit control</td>
<td></td>
</tr>
<tr>
<td>• Implicit Curve Fitting</td>
<td>• Fit with implicit functions</td>
<td>Analysis:Fitting:Nonlinear Implicit Curve Fit</td>
</tr>
<tr>
<td>PRO</td>
<td>• Orthogonal Distance Regression (ODR) algorithm</td>
<td>(workbook, graph)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Command</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Surface Fit</td>
<td>Fit data from a matrix or worksheet XYZ columns</td>
<td>Analysis:Fitting:Nonlinear Surface Fit (workbook, graph) or Analysis:Nonlinear Matrix Fit (matrix)</td>
</tr>
<tr>
<td>Fitting Function Builder</td>
<td>Create or edit user-defined fitting functions</td>
<td>Tools:Fitting Function Builder</td>
</tr>
<tr>
<td>Fitting Function Organizer</td>
<td>Manage fitting functions by categories</td>
<td>Tools:Fitting Function Organizer</td>
</tr>
<tr>
<td>Fitting Function Library App</td>
<td>Download fitting functions from originlab.com</td>
<td>Click the Fitting Function Library icon in the Apps Gallery</td>
</tr>
<tr>
<td>Fitting Function Library App</td>
<td>Request or Share a Function with OriginLab</td>
<td></td>
</tr>
<tr>
<td>Simulate</td>
<td>Simulate a curve from a given function</td>
<td>Analysis:Fitting:Simulate Curve or Analysis:Fitting:Simulate Surface</td>
</tr>
<tr>
<td>Fit Comparison</td>
<td>Compare fit results from two datasets using one function function</td>
<td>Analysis:Fitting:Compare Datasets or Analysis:Fitting:Compare</td>
</tr>
</tbody>
</table>

For Origin 2021, the Fitting Function Library App is new.

New for Origin 2021:
- Download fitting functions from originlab.com
- Request or Share a Function with OriginLab
• Compare fitting results for one dataset using two fitting functions

Models (workbook, graph)

• Compare fit results of two or more functions for a single dataset

Analysis:Fitting:Rank Models (workbook, graph)

**15.8 Peak Analysis**

**Origin 2021** includes two changes that affect peak fitting operations:

- A change to the Peak Analyzer Theme: Enable Linear Constraints Status and Constraints are now enabled by default.
- The Gram-Chartier peak function (GCAS) is simplified by elimination of the abs( ) function from the equation.

Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro.

The table below summarizes various built-in tools available for peak analysis:

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Features</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Quick Peaks Gadget</td>
<td>• Perform peak analysis over a region of interest</td>
<td>Gadget:Quick Peaks (graph)</td>
</tr>
<tr>
<td></td>
<td>• Create baseline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Subtract baseline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Find peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Integrate peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Fit peaks</td>
<td></td>
</tr>
<tr>
<td>• Multiple Peak Fit</td>
<td>• Pick multiple peaks</td>
<td>Analysis:Peaks and Baseline:Multiple Peak Fit (graph, workbook)</td>
</tr>
<tr>
<td></td>
<td>• Fit peaks</td>
<td></td>
</tr>
<tr>
<td>• Peak Analyzer</td>
<td>• Create baseline</td>
<td>Analysis:Peaks and Baseline:Peak Analyzer</td>
</tr>
<tr>
<td></td>
<td>• Subtract baseline</td>
<td></td>
</tr>
</tbody>
</table>
15.9 Signal Processing

Origin provides signal processing tools for many tasks, including producing signal transforms, smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro.

You may refer to the tables below for the signal processing tools and their menu entry.

### 15.9.1 Signal Transforms

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• FFT Gadget</td>
<td>Gadgets:FFT... (graph)</td>
</tr>
<tr>
<td>• Fast Fourier Transform (FFT)</td>
<td>Analysis:Signal Processing:FFT (workbook, graph)</td>
</tr>
<tr>
<td>• Inverse Fast Fourier Transform (IFFT)</td>
<td></td>
</tr>
</tbody>
</table>
### 15.9.2 Filtering

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>FFT Filter</td>
<td>Analysis:Signal Processing:FFT Filters (workbook, graph)</td>
</tr>
<tr>
<td>2D FFT Filter PRO</td>
<td>Analysis:Signal Processing:2D FFT Filters (matrix)</td>
</tr>
<tr>
<td>IIR Filter Design PRO</td>
<td>Analysis:Signal Processing:IIR Filter (workbook, graph)</td>
</tr>
</tbody>
</table>

### 15.9.3 Smoothing

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smooth</td>
<td>Analysis:Signal Processing:Smooth (workbook, graph, matrix)</td>
</tr>
</tbody>
</table>

### 15.9.4 Correlation

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 15.9.5 Convolution

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convolution</td>
<td>Analysis:Signal Processing:Convolution (workbook, graph)</td>
</tr>
</tbody>
</table>

### 15.9.6 Wavelet Analysis *(Pro Only)*

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous Wavelet Transform</td>
<td>Analysis:Signal Processing:Wavelet Analysis (workbook, graph)</td>
</tr>
<tr>
<td>Discrete Wavelet Transform</td>
<td></td>
</tr>
<tr>
<td>(Decomposition)</td>
<td></td>
</tr>
<tr>
<td>Inverse Discrete Wavelet</td>
<td></td>
</tr>
<tr>
<td>Transform (Reconstruction)</td>
<td></td>
</tr>
<tr>
<td>Multi-Scale Wavelet</td>
<td></td>
</tr>
<tr>
<td>Decomposition</td>
<td></td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td>Noise Removal</td>
<td></td>
</tr>
<tr>
<td>2D Wavelet Decomposition</td>
<td>Analysis:Signal Processing:Wavelet Analysis (matrix)</td>
</tr>
<tr>
<td>2D Wavelet Reconstruction</td>
<td></td>
</tr>
</tbody>
</table>

### 15.9.7 Other Advanced Tools *(Pro Only)*

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Wavelet Decomposition</td>
<td></td>
</tr>
<tr>
<td>2D Wavelet Reconstruction</td>
<td></td>
</tr>
</tbody>
</table>
• Rise Time Gadget
  Gadget:Rise Time (graph)

• Decimation
  Analysis:Signal Processing:Decimation (workbook, graph)

• Coherence
  Analysis:Signal Processing:Coherence (workbook, graph)

• Envelope Curves
  Analysis:Signal Processing:Envelope (workbook, graph)

15.10 Image Processing

Origin provides a collection of tools for basic image processing. These tools are accessible from the Image menu when a matrixbook is active. Some tools are only.

The tools are organized in the following sub-menus:

• Image:Adjustments
• Image:Arithmetic Transforms
• Image:Conversion
• Image:Geometric Transforms
• Image:Spatial Filters

15.11 Topics for Further Reading

• Analysis Dialog Boxes: Specifying Your Input Data
• Outputting Analysis Results
• Recalculation of Analysis Results
• Generating Analysis Report Sheets
• Performing Math Operations on Datasets
• Linear/Polynomial Regression
• Nonlinear Curve Fitting
• Peak Analysis using Origin
• Signal Processing
• Image Processing and Analysis
16 Statistics

16.1.1 Apps for Statistics

Origin 2016 introduced add-on tools called Apps. Since being introduced, a number of statistics-related graphing and analysis Apps have been added to OriginLab’s File Exchange and more tools are being released all the time.

A few Apps are installed with your Origin software. Note that as of the fall of 2019, all Apps are available at no extra cost and they are easily added to Origin. Click Statistics: Find Apps. This opens the App Center to show only statistics-related Apps. Browse available Apps and click the Download and Install button to install an App.

Origin includes a pre-installed App called Stats Advisor. This App uses an interactive "wizard" interface to help you choose appropriate statistical tests and to tell you where to find them in your Origin software, or -- if the test is available from another add-on App -- where to find it on the OriginLab File Exchange.

16.2 Basic Statistics

Many of Origin’s advanced statistical tests are available only in OriginPro. Users of standard Origin will see these Pro-only tests marked as (Pro) in the main menu. If you own the standard version of Origin but find that you need features of OriginPro, you can upgrade by contacting your Origin representative.

If you wish to continue using standard Origin without seeing (Pro) menu commands, click Preferences: System Variables and enter the following in the Set System Variables dialog box and click OK (Comment is optional):
16.2.1 Basic Statistics on Worksheet

<table>
<thead>
<tr>
<th>Descriptive Statistics</th>
<th>Menu entry with worksheet active</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Statistics on Columns</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>• Statistics on Rows</td>
<td></td>
</tr>
<tr>
<td>• Statistics on Y by X Bin</td>
<td>Statistics on Rows now supports input ranges from multiple sheets.</td>
</tr>
<tr>
<td>• Cross Tabulation and Chi-Square PRO</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
</tbody>
</table>

Frequencies/Counts

<table>
<thead>
<tr>
<th>Discrete Frequency</th>
<th>Frequency Counts</th>
<th>2D Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Statistics:Descriptive Statistics</td>
<td></td>
</tr>
</tbody>
</table>
### Statistics

<table>
<thead>
<tr>
<th>Counts/Binning</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Distribution Fit PRO</td>
</tr>
<tr>
<td></td>
<td>• Normality Test</td>
</tr>
</tbody>
</table>

### Distribution

<table>
<thead>
<tr>
<th>Relationship</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Correlation Coefficient PRO</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>• Partial Correlation Coefficient PRO</td>
<td></td>
</tr>
</tbody>
</table>

### Detecting Outliers

<table>
<thead>
<tr>
<th>Detecting Outliers</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Grubbs Test</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>• Dixon's Q-test</td>
<td></td>
</tr>
</tbody>
</table>

You can apply **Conditional Formatting** to a worksheet by applying mathematical expressions or statistics to cell values. For more information, see [Conditional Formatting](#).

#### 16.2.2 Descriptive Statistics on Graph

![Conditional Formatting Image]

---

303
Origin provides a couple of gadgets to explore and summarize data plotted in graphs.

<table>
<thead>
<tr>
<th>Descriptive Statistics</th>
<th>Menu entry with graph active</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Cluster Gadget PRO</td>
<td>Gadgets:Cluster...</td>
</tr>
<tr>
<td>• Statistics Gadget</td>
<td>Gadgets:Statistics...</td>
</tr>
</tbody>
</table>

### 16.2.3 Statistics on Selected Range

Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data plot(s) in a graph.

#### 16.2.3.1 Status Bar

Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and you can use the CTRL key to select non-contiguous groups of cells.

Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar. Right click on the status bar to customize what quantities to display.

#### 16.2.3.2 Command or Script Window

Statistics, Report to Script/Command Window
1. Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in a graph.

2. Open the Command Window or the Script Window from the Windows menu, and type one of these commands, then press ENTER:

```
stats
moments
quantiles
```

With the Command Window, the results are typed out below the command line. With the Script Window, you will need to issue an additional command to return your results:

```
stats;
stats.=;
```

Note: For more information, please refer to the:

Help: X-Function > X-Function Reference > Statistics

16.3 Statistical Graphs

Origin provides numerous statistical graph types. All graphs can be easily customized and saved as a template for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information.

<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Plot Menu Category</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Box Charts</strong>: Box, Interval Plot, Bar Charts, Box Overlap, Box Normal, Half Box, Bar Overlap, Bar Normal, Scatter Interval, Double-Y Box, Marginal Box Charts.</td>
<td>Statistical</td>
</tr>
<tr>
<td><strong>Box Charts, Violin Plots, etc., Grouped</strong>: Grouped Scatter - Indexed Data, Grouped Box Charts - Indexed Data, Grouped Box Charts - Raw Data, Grouped Column Scatter - Indexed Data, Grouped Interval Plot - Indexed Data, Grouped Mean Bar - Indexed Data, Grouped Violin - Indexed Data, Grouped Half Violin - Indexed Data, Grouped Half Box - Indexed Data.</td>
<td>Categorical</td>
</tr>
<tr>
<td><strong>Violin Plots</strong>: Violin Plot, Violin with Box, Violin with Point, Violin with Quartile,</td>
<td>Statistical</td>
</tr>
<tr>
<td>Violin with Stick, Split Violin, Half Violin.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Histograms:</strong> Histogram, Histogram + Rug, Histogram + Probabilities, Multi-Panel Histogram, Distribution, Distribution + Rug, Histogram with Labels, Stacked Histograms, Marginal Histograms.</td>
<td>Statistical</td>
</tr>
<tr>
<td><strong>Population Pyramid</strong></td>
<td>Statistical</td>
</tr>
<tr>
<td><strong>2D Kernel Density</strong></td>
<td>Contour</td>
</tr>
<tr>
<td><strong>Heatmap:</strong> Heatmap, Heatmap with Labels, Split Heatmap</td>
<td>Contour</td>
</tr>
<tr>
<td><strong>Contour - Categorical Z</strong></td>
<td>Contour</td>
</tr>
<tr>
<td><strong>Cluster Plots</strong></td>
<td>Categorical</td>
</tr>
<tr>
<td><strong>Probability:</strong> Probability Plot, Q-Q Plot.</td>
<td>Statistical</td>
</tr>
<tr>
<td><strong>Pareto and QC Chart:</strong> Pareto Chart - Binned Data, Pareto Chart - Raw Data, QC (X-bar R) Chart.</td>
<td>Statistical</td>
</tr>
</tbody>
</table>
| **Bland-Altman Plot** *(Tukey mean-difference)*  
  Bland-Altman plots get two more output parameters for **Origin 2021**:
  - **Mean of Pairwise Means**
  - **Bland-Altman Ratio** \(0.5 \times \text{(upper LoA - lower LoA)}/\text{Mean of Pairwise Means}\) | Statistical |
| **Scatter Matrix**  
  Improved for **Origin 2021**:
  - New page-level **Layer** tab check boxes for **Independent Layer Control** and **Independent Binning Control**.
  - Axis scale of the upper-left layer now displays for scatter plots instead of histogram. | Statistical |
### Trellis Plot
- Trellis Plot, Double-Y Trellis Plot, Double-Y Trellis Plot

### Parallel Plot
- Parallel Plot, Parallel Sets, Parallel Index.

The following statistical graphs are only available within the **Plots** branch of the statistical analysis dialogs.

<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Means Plot</td>
<td>Statistics: ANOVA: One-Way ANOVA, Two-Way ANOVA</td>
</tr>
<tr>
<td>• Means Comparison Plot</td>
<td>Statistics: ANOVA: One-Way Repeated Measure ANOVA PRO</td>
</tr>
<tr>
<td>• Survival Curve</td>
<td>Statistics: Survival Analysis: Kaplan-Meier Estimator PRO</td>
</tr>
<tr>
<td>• One Minus Survival Curve</td>
<td></td>
</tr>
<tr>
<td>• Hazard Curve</td>
<td></td>
</tr>
<tr>
<td>• Log Survival Curve</td>
<td></td>
</tr>
<tr>
<td>• Scree Plot</td>
<td>Statistics: Multivariate Analysis: Principal Component Analysis PRO</td>
</tr>
<tr>
<td>• Component Plot</td>
<td></td>
</tr>
<tr>
<td>• Dendrogram</td>
<td>Statistics: Multivariate Analysis: Hierarchical Cluster Analysis PRO</td>
</tr>
<tr>
<td>• Classification Summary Plot</td>
<td></td>
</tr>
<tr>
<td>• Classification Fit Plot</td>
<td>Statistics: Multivariate Analysis: Discriminant Analysis PRO</td>
</tr>
<tr>
<td>• Canonical Score Plot</td>
<td></td>
</tr>
<tr>
<td>• ROC Curve</td>
<td>Statistics: ROC Curve PRO</td>
</tr>
</tbody>
</table>

### 16.4 Comparing One, Two or More Groups
Origin provides parametric and non-parametric tests to compare one, two, three or more groups.
# 16.4.1 Parametric Hypothesis Tests

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• One-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>• Two-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>• Pair-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>• One-Sample Test for Variance</td>
<td>PRO</td>
</tr>
<tr>
<td>• Two-Sample Test for Variance</td>
<td>PRO</td>
</tr>
</tbody>
</table>

Statistics: Hypothesis Testing

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• One-Sample Proportion Test</td>
<td>PRO</td>
</tr>
<tr>
<td>• Two-Sample Proportion Test</td>
<td>PRO</td>
</tr>
</tbody>
</table>

Statistics: Hypothesis Testing

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Two-Sample t-Test on Rows</td>
<td>PRO</td>
</tr>
<tr>
<td>• Pair-Sample t-Test on Rows</td>
<td>PRO</td>
</tr>
</tbody>
</table>

Statistics: Hypothesis Testing

# 16.4.2 ANOVA

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• One-Way ANOVA</td>
<td></td>
</tr>
<tr>
<td>• Two-Way ANOVA</td>
<td></td>
</tr>
<tr>
<td>• Three-Way ANOVA</td>
<td></td>
</tr>
<tr>
<td>• One-Way Repeated-Measures ANOVA</td>
<td>PRO</td>
</tr>
<tr>
<td>• Two-Way Repeated-Measures ANOVA</td>
<td>PRO</td>
</tr>
</tbody>
</table>

(Supports both Balanced and Unbalanced data)

Statistics: ANOVA

# 16.4.3 Non-parametric Tests

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
</table>
### Notes:
Multiple nonparametric tests can be run simultaneously. (Accessible from the Statistics:Nonparametric Tests menu) Available options are:

- **(NPH) K Independent Samples**: Kruskal-Wallis ANOVA and Mood's Median Test
- **(NPH) Paired Samples**: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test
- **(NPH) Two Independent Samples**: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov Test

### 16.5 Advanced Statistics
Several additional tools are available in OriginPro.

#### 16.5.1 Multivariate Analysis
Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from your data.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Principal Component Analysis</td>
<td></td>
</tr>
<tr>
<td>K-Means Cluster</td>
<td></td>
</tr>
<tr>
<td>Hierarchical Cluster</td>
<td></td>
</tr>
<tr>
<td>Discriminant Analysis</td>
<td></td>
</tr>
<tr>
<td>Canonical Discriminant Analysis</td>
<td></td>
</tr>
<tr>
<td>Partial Least Squares</td>
<td></td>
</tr>
</tbody>
</table>

**Notes:** Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the Statistics:Multivariate Analysis:Discriminant Analysis: Canonical Discriminant Analysis(System) menu.
16.5.2 Survival Analysis

OriginPro includes widely used survival tests to quantify survivorship in a population.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Kaplan-Meier Product-limit Estimator</td>
<td></td>
</tr>
<tr>
<td>• Comparing Survival Curves</td>
<td></td>
</tr>
<tr>
<td>• Cox Proportional Hazards Model</td>
<td></td>
</tr>
<tr>
<td>• Weibull Fit Model</td>
<td>Statistics: Survival Analysis</td>
</tr>
</tbody>
</table>

Notes: Comparing Survival Curves is accessible in the Kaplan-Meier Product-limit Estimator feature.

16.5.3 Power and Sample Size

Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in designing experiments. Origin can compute the power of the experiment for a given sample size and can also compute the required sample size for given power values.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• One-Proportion Test</td>
<td></td>
</tr>
<tr>
<td>• Two-Proportion Test</td>
<td></td>
</tr>
<tr>
<td>• One-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>• Two-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>• Paired-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>• One-Variance Test</td>
<td></td>
</tr>
<tr>
<td>• Two-Variance Test</td>
<td></td>
</tr>
<tr>
<td>• One-Way ANOVA</td>
<td>Statistics: Power and Sample Size</td>
</tr>
</tbody>
</table>

16.5.4 ROC Curve

ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two methods that are used to discriminate between diseased and healthy cases.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• ROC Curve</td>
<td>Statistics: ROC Curve</td>
</tr>
</tbody>
</table>

16.6 Topics for Further Reading
- **Statistics on Worksheet Columns**
- **Statistics on Worksheet Rows**
- **Descriptive Statistics**
- **Statistics Charts, General**
- **Appendix 2 - Origin Graph Types**
- **Appendix: Statistical Graph Types by Template**
- **Normality Testing**
- **Distribution Fit**
- **Parametric Hypothesis Testing**
- **ANOVA**
- **Nonparametric Tests**
- **Multivariate Analysis**
- **Survival Analysis**
- **ROC Curves**
- **Power and Sample Size Tests**
- **LabTalk Supported X-Functions: Statistics**
17 How to Handle Repetitive Tasks

17.1 Analysis Report Sheets

Analysis operations, such as those performed with the tools listed in the Analysis chapter or in the Statistics chapter, create detailed Analysis Report Sheets.

- Analysis Report Sheets contain tables that are organized in a tree structure.
- Expand or collapse each branch to show or hide table contents.
- Tables are not static reports. They are constructed using placeholders linked to particular analysis results and thus, results can be recalculated with changes to input or analysis parameters.
- You can add comments to the sheet or copy tables and paste or paste-link them to other windows in your project.
- Analysis Report Sheets often contain embedded graphs such as fit curves or residual plots. To customize these plots, double-click on them. This opens the embedded graph in a separate window where -- as with any Origin graph -- you can customize it using Mini Toolbar buttons or Plot Details controls. When you are done customizing, click the Close button and re-insert the customized graph back into the report sheet.
For more information on **Analysis Report Sheets**, see the [Origin Help File](#).

## 17.2 Recalculation

All Analysis and most data processing dialog boxes in Origin include a **Recalculate** control. This control allows you to tie output operations to the source data. When Recalculate is set to **Auto** or **Manual**, changes to the source data will trigger an update of the output (pending, in the case of **Manual**). This allows you to analyze multiple datasets by, for instance, serial import of a new data file to replace existing data. This feature is also the basis for creating **Analysis Templates**. The Analysis Template concept is explained below.

### The Recalculate control has three modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| **None** | - No lock is displayed in the output.  
- Changes to the input data will not result in an update of the output. |
| **Auto** | - An *auto* green lock displays on the output columns and graphs of the output data.  
The main operation lock displays on the left-most column as ![green_lock]( ), while any related operations columns to right of the main operation display the "+" icon ![green_plus]( ).  
- The output will be automatically updated when input data is changed.  
- You can also click on a lock icon and open the dialog to make changes to the analysis settings, including changing the **Recalculate** mode. |
| **Manual** | - A *manual* green lock ![green_lock]( ) is displayed in up-to-date output columns, and graphs that |
contain plots of the output data. Any related operations columns to right of the main operation display the “+” icon.

- A yellow lock indicates that input data have changed and recalculation operations are pending. You can trigger updates individually by clicking on a yellow lock and selecting Recalculate from the shortcut menu; or you can update all pending operations by clicking the yellow Recalculate button on the Standard toolbar.
- You can also click on a lock icon and open the dialog to make changes to the analysis settings, including changing the Recalculate mode.

**Tips for Managing Recalculation Operations**

- A left-click on the lock displays a menu that provides multiple options including changing analysis parameters, opening source data sheet, switching to result sheets, and controlling the status of the operation such as switching from manual update to auto update.
- The Standard toolbar displays a Recalculate button that shows green when all project operations are up-to-date and yellow when there are recalculation operations pending. If you have opened a project and you see that the Recalculate button is yellow, understand that calculations are pending and that the data and data plots you see in the project may not be up-to-date.
- If a lock icon appears dark gray in color, this indicates that the associated operation was performed in OriginPro and the window or project has been opened in standard Origin. The operation is not supported by standard Origin and to modify or re-run the analysis, you will need to locate a computer with an OriginPro license.
- If a lock icon appears red, something has occurred which makes recalculation operations impossible. Such conditions are rare but would occur if, for instance, you passed a project file that included a user-defined curve fitting operation to a colleague but failed to pass along your user-defined fitting function.
- Having many recalculation operations in your project file can slow down your work. You can block recalculation -- both Manual and Auto recalculation -- by clicking on a lock icon and choosing Block Recalculation from the popup menu. Placing a block on pending recalculations places a yellow “block” icon on each associated operation in the chain. Placing a block on up-to-date calculations places a green “block” icon on each operation in the chain. To remove the block, click on the “block” icon and clear the check mark (Note that clicking the yellow Recalculate button on the Standard toolbar does not update blocked operations).
- You can hide the lock icons on your graph window by clicking on the graph and, from the main menu, choosing View: Show and clearing the check mark beside Lock Icons. This does not remove associated operations from the graph window. To re-display the icons, repeat the procedure.
The **operation lock tooltip** has been improved for **Origin 2021**:

- Show better data range information
- Higher-contrast background color
- For **Set Values** operations, show formula, input range and **Before Formula Script**, if it exists

You can now set a **sampling interval** (Column: **Set Sampling Interval**) on locked columns.

### 17.3 Dialog Themes

Settings in analysis dialogs and most other data processing dialogs can be saved as a **Dialog Theme** file. Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different settings.

Last used dialog box settings are automatically saved as a **<last used>** Theme. Origin also allows you to save your custom settings as the **<default>** Theme. The default Theme, last used Theme, and any named Theme that you have saved, can all be accessed from the Dialog Theme fly-out menu that opens from the dialog box. The same Themes are also available from the main menu item associated with the analysis dialog box.
Dialog Themes are managed with the **Theme Organizer** tool, available from the **Tools** menu.

**Tutorial: Saving and Re-using a Dialog Theme**

1. Import the file **Linear Fit.dat** from the **Samples\Curve Fitting\** subfolder.
2. Highlight column B and select **Analysis: Fitting: Linear Fit...**
3. In the **Linear Fit** dialog that opens, check the **Fix Intercept** checkbox (under **Fit Options**) and set the **Fix Intercept at** edit box to **0**.
4. Click the **button next to the Dialog Theme control and select Save as ....** In the **Theme Name** box, enter **Zero Intercept** and press **OK**. Press **OK** again to close the Linear Fit dialog box and perform the analysis. **FitLinear1** and **FitLinearCurve1** result sheets are added to the workbook.
5. Return to the source data and highlight column C. Select **Analysis: Fitting: Linear Fit** from the menu. You will see a fly-out menu with multiple Theme options including the **Zero Intercept** Theme you saved in the previous step.
6. Select your saved Theme. The analysis is automatically performed on Column C using the settings saved in the Theme. Note that the dialog box does not open.

**Tips for Working with Themes:**

- Hold the **SHIFT** key while clicking on your Theme in the main menu and the associated dialog box will open with settings from the selected Theme loaded into
the dialog box.

- The default Theme Origin shipped for an analysis is called System Default. Click the fly-out menu in the analysis dialog and choose System Default to load it.
- Click the fly-out menu in the analysis dialog and choose Delete to delete Themes you have created, including any customized <default> Theme.
- The customized <default> Themes for all analysis dialogs are saved in Defaults.xml in the User Files Folder. Deleting this file restores system default settings of all analysis dialogs.

17.4 Workbook and Project Templates

There are a number of reasons for saving a single workbook or an entire project, as a "template" file. Here are a few typical scenarios.

- You might import data files that always have a fixed number of columns with a repeating pattern of column designations (e.g. XYyError, XYyError, etc.) so you create a custom workbook just for importing these files (File: Save Template As).
- You regularly import data files of similar structure and you perform some routine graphing and analysis operations on the data, then generate a report using a worksheet or a workbook embedded Notes window. This would be a typical example of an Analysis Template (File: Save Workbook As Analysis Template).
- You perform some operations similar to those described in the previous example but you can't save your workbook as an Analysis Template because all data are cleared from the workbook on saving and that would destroy a sheet of reference values that you rely on for your analysis. Instead, you could opt to clear only the imported data and save your workbook as a window file (File: Save Window As). This preserves the sheet of reference data and like the Analysis Template, saves analysis and graphing operations with the workbook.
- You routinely import data, do some analysis and generate a report and would like to make use of the Analysis Template concept (as in the second bullet point), but you have multiple windows in your project, including Layout windows that cannot be embedded in the workbook. So, a single workbook Analysis Template won't do the job. In this case, you could save the project without data by "cloning" it (File: Clone current Project).

17.4.1 The Workbook as Template

The workbook can contain worksheets with data, metadata, floating or embedded graphs, embedded matrices and notes, plus scripts, variables and other supporting data.

You can save a workbook as a template for repetitive graphing and/or analysis tasks. Depending on your needs, there are three options for saving your workbooks -- as a workbook (OGWU), as a template (OTWU) or as an Analysis Template (OGWU):

- Workbook (OGWU): Choosing File: Save Window As saves all workbook content.
How to Handle Repetitive Tasks

- **Analysis Template (OGWU):** Choosing File: Save Workbook as Analysis Template clears all data columns that are used in analysis operations in the workbook before saving. Operations are preserved as are data that are not associated with analysis operations.

- **Template (OTWU):** Choosing File: Save Template As saves the structure of the workbook, plus any analysis operations that exist in the workbook, but all data including data that are not associated with these analysis operations, are cleared.

A collection of workbook templates can be opened using the New Workbook dialog box, that opens when you start Origin. You can customize existing templates and save them as your default workbook template.

**Tutorial: Creating an Analysis Template**

1. Start with a new workbook and import the file Samples\Curve Fitting\Sensor01.dat.
2. Select column B and use the Analysis: Fitting: Linear Fit and open the Linear Fit dialog.
3. Change the Recalculate drop-down to Auto.
4. Click the Fit Control tab, check the Fix Intercept check box and enter 0 in the Fix Intercept at edit box.
5. Click OK to close the dialog and perform the linear regression.
6. Answer "Yes" to the prompt and switch to the FitLinear1 report sheet to view results including plots of the best-fit line and residuals.
7. Now switch back to the original data sheet and import the file Samples\Curve Fitting\Sensor02.dat. The analysis results will be automatically updated with this new data. Note that you could continue to use this workbook for importing other data; or you could right-click the workbook window title and choose Duplicate without Data to create a new workbook with the linear fitting operation saved into it. This allows you to import new data into the new workbook and thus save a project with multiple such workbooks, if desired.
8. With the workbook active, select the menu File: Save Workbook as Analysis Template..., and in the dialog that opens, give a name such as Linear Fit of Sensor Data and click Save.
9. Choose File: Recent Books and select the template that was saved in the previous step. The workbook will open and the data sheet will be empty.
10. Import the file Samples\Curve Fitting\Sensor3.dat into the empty data sheet (1st sheet). The analysis results will be automatically generated upon data import.

**Analysis Templates** can include summary sheets and custom report sheets (worksheet-based or HTML), making them an ideal medium for importing, analyzing, plotting and reporting the results of your routine analyses. When used in combination with the Batch Processing tool, you can repeat a set of analyses and graphing operations for any number of data files and create a PDF summary report for each one, as it is processed. View the Batch Plotting and Batch Analysis sections of this chapter for examples of using the workbook as a template for handling repetitive tasks.
Notes windows now support HTML. Notes windows can be added to the workbook (right-click on sheet tab and Add Notes as Sheet) making it easy to incorporate HTML reports into your Analysis Templates. For more information, see HTML Reports From Notes Windows.

17.4.2 The Project as Template

The Origin project file can also be used as a "template" for carrying out repetitive graphing and analysis tasks -- particularly when your analyses and graphing tasks can't be resolved within a single workbook.

The basis steps of creating a "project template" are as follows:

1. Create the desired graphs and/or analysis results from data in your workbook(s) and save the project.

2. After saving the project, choose File: Clone current Project. A small dialog opens for configuring your cloned project:

   ![Clone dialog](image)

   - **Add Data Connectors**: Check this box to add Data Connectors from the cloned project to your saved project. Each cloned worksheet will have a connection to the original worksheet in the saved project. If you plan to import data from other similar files in your cloned project, you should CLEAR this box.
   - **Clear All**: Clear imported data only. Analysis operations are preserved in the cloned project.
   - **Clear Imported Data and Delete Calculations**: Clears imported data and analysis operations.

3. Click OK to to create your cloned project. Selected data are cleared and the cloned project named UNTITLED is added to the workspace.

4. Name and save the cloned project and when you are ready to process more data files, you can open it and import new data:
   - If your analysis and graphing operations are linked to a particular set of data files that are periodically updated, you don't necessarily need to use Connectors. You can simply re-import the files (Data: Re-import... or Re-import Directly).
   - If your operations are linked using Data Connectors, click the Connector icon and from the popup menu choose Import (this Connector only) or Import All (all Connectors in the book).
   - One possible scenario is that you store all of your data in a single Origin project file. If you have added Data Connectors from your cloned project, to your original project then you can selectively...
import just the data that you need to perform your graphing and analysis operations. When you have finished, you can save the file to a new name, preserving your cloned project for re-use.

17.5 Batch Plotting

Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two sections outline how to create multiple graphs from (1) data that is already in worksheets, or (2) multiple data files. In addition to these two procedures, batch plotting can also be performed programmatically using LabTalk script or Origin C.

When Batch Plot with source = Book or Sheet, an Exact check box is shown and checked by default:

- When Exact is selected, batch data should exactly match column, sheet and modifier of current graph (same as previously).
- When Exact is cleared, any book or sheet with at least one matching column will be available for selection.
- Only group plots support Exact.

17.5.1 Duplicating Graphs with Data from Other Books/Sheets/Columns

If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot the graph, you can have Origin clone that graph via Window: Duplicate (Batch Plotting) menu with new data. There are two cases:

- If you have plotted a graph with a single dataset and customized it, and want to clone the graph with other data in the same worksheet: Choose Window: Duplicate (Batch Plotting): Duplicate with New Columns. Pick other data (columns) that you want to plot. Each column will be plotted as a new graph.
- If you have plotted a graph with data in one worksheet or workbook and customized the graph, and you want to clone the graph with other worksheets or workbooks with a similar data structure: Choose Window: Duplicate (Batch Plotting): Duplicate with New Sheets/Duplicate with New Books. Origin will list all worksheets or workbooks with a similar data structure. Pick the worksheet or workbook you want to plot from. Each worksheet or workbook will be plotted as a new graph.

Tutorial: Duplicating a graph with data from other books/sheets

1. Press the New Project button on the Standard toolbar.
2. Press the Import Wizard button on the same toolbar. This opens the Import Wizard dialog box.
3. Click the browse button to the right of the File box. Browse to the Import and Export folder and select the files S15-125-03.dat, S21-235-07.dat, and S32-014-04.dat. Click Add File(s), then press OK. In the Import Wizard dialog box, press Finish. The files are imported into three separate workbooks.
4. Drag and select all three Y columns in one of the workbooks, then select the menu item \texttt{Plot>2D: Multi-Y: 3Ys Y-YY} to create a graph with multiple Y axes and one shared X axis. Make any desired customizations to the graph.

5. Right-click on the title bar of the graph window then select \texttt{Duplicate (Batch Plotting)} shortcut menu.

6. In the dialog box that opens, press Ctrl and select the other two workbooks/worksheets then press \texttt{OK}. Two more graphs are created with data from the other two workbooks/worksheets.

### 17.5.2 The Workbook as a Template for Processing Multiple Files

If you want to plot graphs from many data files but don't want to import all files to workbooks before plotting, you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your workbook and save the workbook as a template. Using this template you can process multiple files, creating a workbook for each file and its corresponding graph.

#### Tutorial: Creating graphs from multiple data files

1. With a new workbook active, choose \texttt{Data: Import From File: Single ASCII} and import the file \texttt{Sensor01.dat} from the \texttt{Samples\Curve Fitting} subfolder of the Origin installation folder.

2. Highlight column B and create a line+symbol graph of the data.

3. Double click on the X axis to open the Axis dialog. Make sure Scale tab is active.

4. Set both \texttt{Horizontal} and \texttt{Vertical} on the left panel and set Rescale to be \texttt{Auto} and click \texttt{OK}. This will ensure that the graph scale will update automatically on data change.

5. In the workbook, right-click on the worksheet tab and select \texttt{Add Graph as Sheet}, then select the graph created above and click \texttt{Done}. This will add a new workbook sheet containing an embedded graph.

6. Switch to the data sheet, double-click on the tab rename the sheet as \texttt{Data}.

7. Select the \texttt{Worksheet: Clear Worksheet} menu item to clear the data in this sheet. Note that this step is optional. Clearing the data will reduce the size of the template saved in the next step.

8. Select the \texttt{File: Save Window As...} menu item, assign a name such as \texttt{Sensor Data and Graph} and press \texttt{Save}.

9. Now we can use this template to process multiple files. Select the \texttt{File: Batch Processing...} menu item.

10. In the dialog box that opens set the \texttt{Batch Processing Mode} to \texttt{Load Analysis Template}, then set the \texttt{Analysis Template} control to point to your saved template.

11. Set \texttt{Data Source} to \texttt{Import from Files} and select the three files \texttt{Sensor01.dat}, \texttt{Sensor02.dat}, and \texttt{Sensor03.dat} from the \texttt{Samples\Curve Fitting} subfolder.

12. Set the \texttt{Data Sheet(s)} to \texttt{Data} and set \texttt{Result Sheet} to \texttt{<none>}.
12. Press **OK** to close the dialog box. You should get three workbooks with the data imported into the first sheet and the graphs updated in the 2nd sheet. To further edit any of the graphs, double-click on the graph to pop up an editable page.

If processing of your data requires some custom import settings, those settings will be saved to the data sheet by default. Settings thus saved to the sheet will be used for import when batch processing of multiple files using the workbook as a template.

### 17.6 Batch Analysis

Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots.

#### 17.6.1 Analyzing Multiple Datasets in Dialogs

Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets. Report sheets created by these dialog boxes include a summary table listing the parameter values for each dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an external sheet for further processing.

**Tutorial: Fitting Multiple Datasets**

1. Open a new workbook and import the file `Samples\Curve Fitting\Multiple Gaussians.dat` from the Origin installation folder.
2. Set the Long Names of the four Y columns as **Peak 1**, **Peak 2**, **Peak 3** and **Peak 4**.
3. Select all four Y columns, and use the **Analysis: Fitting: Nonlinear Curve Fit**... menu item to open the **NLFit** dialog box.
4. Select **Gauss** from the **Function** drop-down list, then press the **Fit** button to perform fitting and close the dialog box.
5. Switch to the **FitNL1** report sheet. You will see a table named **Summary** which lists the fit parameters and fit statistics for each dataset.

<table>
<thead>
<tr>
<th>Summary</th>
<th>y0</th>
<th>xc</th>
<th>w</th>
<th>A</th>
<th>sigma</th>
<th>FWHM</th>
<th>Height</th>
<th>Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak 1</td>
<td>1.933</td>
<td>0.166</td>
<td>24.086</td>
<td>0.247</td>
<td>12.724</td>
<td>0.643</td>
<td>115.121</td>
<td>6.803</td>
</tr>
<tr>
<td>Peak 2</td>
<td>4.954</td>
<td>0.057</td>
<td>20.046</td>
<td>0.144</td>
<td>8.621</td>
<td>0.325</td>
<td>49.182</td>
<td>1.929</td>
</tr>
<tr>
<td>Peak 3</td>
<td>0.147</td>
<td>0.016</td>
<td>24.973</td>
<td>0.242</td>
<td>12.393</td>
<td>0.620</td>
<td>11.116</td>
<td>0.643</td>
</tr>
<tr>
<td>Peak 4</td>
<td>-2.033</td>
<td>0.046</td>
<td>20.015</td>
<td>0.053</td>
<td>4.611</td>
<td>0.112</td>
<td>51.452</td>
<td>1.188</td>
</tr>
</tbody>
</table>

In the NLFit report sheet, click on the downward-pointing arrow button next to the table named **Summary** and select **Create Copy as New Sheet**. This will create a copy of the table in which all cells are linked to the report. Any updates/changes to the fit will automatically update the values in this copied sheet. This sheet can then be used to plot or to perform secondary analysis on the fit parameters.
When enumerating something like a column Long Name, as you did in step 2 above, enter the string in the first cell (e.g. "Peak 1"), select the cell and hover over the lower-right corner. When the cursor becomes a "+", drag across the other cells and the contents of the first cell will be extended to those cells.

<table>
<thead>
<tr>
<th>B(Y)</th>
<th>C(Y)</th>
<th>D(Y)</th>
<th>E(Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak 1</td>
<td>Peak 2</td>
<td>Peak 3</td>
<td>Peak 4</td>
</tr>
</tbody>
</table>

17.6.2 Using Gadgets for Analyzing Multiple Curves

Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets allow selecting a data range of interest, switching from one dataset to another, and setting various preferences specific to the analysis being carried out.

Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings, and generating a table of results across all datasets.

**Tutorial: Using the Integrate Gadget to Integrate Multiple Curves**

1. Open the project "Samples\Spectroscopy\Absorbance Spectra.opj".
2. With the graph window active, choose Gadgets: Integrate from the main menu.
3. In the dialog that opens, click the Baseline tab and set the Mode drop-down to Straight Line.
4. Click the Output tab, expand the Output Quantities to node, and check Append to Worksheet. Press OK to close the dialog box.
5. A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI and resize this object to cover the entire data range plotted in the graph. The integrated area will be displayed as a shaded region.
6. Click the arrow button at the top right of the ROI object, then choose Change Data from the context menu and switch to another plot in the layer. Check that the current baseline setting works for other curves in the layer.
7. Click the arrow button again, select New Output for All Curves (N) or simply press the "N" key. Integration is performed on all curves.
8. Click the arrow button again and select Go to Report Worksheet. Expand the report worksheet to view the integration results from all curves.
17.6.3 Batch Analysis Using an Analysis Template

The Batch Processing tool allows you to process multiple files or datasets using an Analysis Template. Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook, and save that workbook as an Analysis Template. The Batch Processing tool then uses the Analysis Template to process multiple files/datasets. You have the option to retain one workbook for each file/dataset, and additionally, to create a summary table with select analysis parameters and other metadata that you have pre-configured in your analysis template.

Tutorial: Batch Analysis of Multiple Files using an Analysis Template

1. From the main menu, choose File: Batch Processing.... This opens the Batch Processing dialog box.
2. Set Batch Processing Mode to Load Analysis Template.
3. Press the browse button to the right of the Analysis Template box and browse to and select the file `<Origin Program Folder>\Samples\Batch Processing\Sensor Analysis.OGW`. This Analysis Template contains multiple sheets set up for linear regression analysis, reporting, and summary tables.
4. Set **Data Source** = **Import From Files**, then click the browse button to the right of the **File List** and from the **Samples\Curve Fitting** folder, select files **Sensor01.dat**, **Sensor02.dat** and **Sensor03.dat**.

5. Set **Dataset Identifier** to **File Name**, **Data Sheet(s)** to **Data**, and **Result Sheet** to **Result**. Note that these are the names of existing sheets in the Analysis Template.

6. Uncheck **Delete Intermediate Workbook**.

7. Click **OK** to close the dialog box and process the three files (you can answer "No" to the prompt). You will obtain three books with the data, analysis results, and report for each file, and a fourth book containing the summary table of analysis results from all files.

Prior to **Origin 2021**, **Open Book(s)**, **Reprocess** and **Update** buttons were only added to the Summary sheet when **Data Source** was **Import from Files**. Now, these buttons are added when you specify use of existing data.
How to Handle Repetitive Tasks

Saving the initial workbook as an Analysis Template is optional. You can simply save the Origin project (.opj) and next time replace the data in your workbook to update all results and graphs. The Batch Processing tool also has an option to repeatedly import files into the active window, allowing you to simply re-use an existing book within a project (which contains all desired analysis and graphs) as an on-the-fly template for the batch analysis.

You can batch generate analysis reports using a custom MS Word template, with the option of outputting a PDF and/or an MS Word file for each report. Additionally, you can opt to combine reports into a single file. For information on Batch Processing with a Word Template for Reporting, see this tutorial.

17.7 Repeating Analysis on Other Datasets or Data Plots

For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the lock associated with the operation.

- In worksheet columns or reports, clicking the lock will show the menu command Repeat this for All Y columns. Selecting this will repeat the analysis on all other Y columns in the source data sheet.
- In a graph, clicking the lock will show the menu command Repeat this for All Plots. Selecting this will repeat the analysis for all other data plots in the graph page, even if the plots are in different layers.

This is particularly useful for such analysis dialog boxes as smoothing or interpolation that support input of only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the analysis can be repeated on all other datasets.

Tutorial: Smoothing Multiple Columns in a Worksheet

1. Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty workbook.
2. Select column B and click Analysis: Signal Processing: Smooth to open the smooth dialog box.
3. Accept the defaults and press OK to perform smoothing. A new column will be added with the smoothed data.
4. Click on the lock in the output column and select Repeat this for All Y columns. Three more columns of smoothed data with same settings will be
generated from the data in columns C thru E.

17.8 Repeating Analysis Using Data Filters

Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This Data Filter feature can also be used in conjunction with the colcopy (column copy) X-Function to produce multiple graphs from the same source data using different filtering conditions. The filtered data can also be analyzed, allowing you to compare graphs and analysis results across multiple filter conditions.

Selected columns from the source data sheet can be copied to create child sheets where the filter condition stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is updated, all child sheets, associated graphs and analysis results will automatically update using their respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to the parent sheet at any time.

The image below displays the source workbook with data for several makes of automobiles. Two books were created with a subset of columns and a data filter to restrict the data to a particular make of automobile. Linear regression analysis of the filtered data was performed, allowing comparison of the results across the two filters.
Tutorial: Locking a Filter Condition on Copied Columns

1. Import the file Samples\Statistics\Automobile.dat

2. Click on the Make column, then click the Add/Remove Data Filter button on the Worksheet Data toolbar.

3. Click on the filter icon that was added to the column, and uncheck all makes but Honda (Hint: Clear the check mark beside Select All, then check Honda and click OK).

4. Hold down the CTRL key and click and select the Make, Power and Engine Displacement columns. Next, right-click and select Copy Columns to... from the shortcut menu.

5. In the dialog that opens, expand Copy Labels and place a check mark beside Long Name and Units, then click OK. A new worksheet will be added to the workbook and it will contain only the Honda data, for Power and Engine Displacement.

6. Click and hold the tab of the new worksheet and drag it to an empty spot in the Origin workspace to create a separate workbook.

7. Click on any of the locks in the columns of this copied sheet, and select Worksheet Filters: Lock. The filter conditions will be locked to this sheet. If you change the filter condition in the original data sheet, this copied sheet will not be affected.

8. You can now return to the original automobile book, click the filter icon and change the filter condition to Toyota, then use Copy Columns to to create another worksheet.

9. Highlight column B in your Honda workbook, then right-click and choose Set As: X. Do the same for the Toyota book.

10. Highlight column C in your Honda workbook and click the Scatter button on the 2D Graphs toolbar. Do the same for the Toyota book. This gives you two plots of Power vs Engine Displacement, one for Honda, one for Toyota.

11. Click on the Honda graph and choose Analysis: Fitting: Linear Fit. Accept the dialog defaults and click OK. Do the same for the Toyota graph. A linear fit is performed for both datasets and an Analysis Report Sheet is generated for each.

12. Compare the fitting results for the two automobile makes.

By default, when there is a data filter on a column that is input for an analysis operation, filtered data (hidden rows) are ignored in the analysis. To include hidden rows, click on an analysis lock icon and set Ignore Hidden Rows = No.
17.9 Automating Tasks Using Programming

In addition to the above mentioned methods for automating tasks using the interface, graphing and analysis features can also be accessed programmatically from either the **LabTalk** scripting language or from **Origin C**. Access to Graph Themes and templates, and Analysis Templates can be programmed. You can set up some of the procedure manually by first creating the templates using the graphical user interface, and then write your code to call the templates as needed.

You can get a broad look at what programming options are available in Origin by browsing the **Programming Chapter** of this User Guide. More in-depth programming-related information is linked to from that chapter.

17.10 Topics for Further Reading

- [Recalculation of Analysis Results on Data or Parameter Change](#)
- [Saving Analysis Dialog Settings as a Theme](#)
- [The Theme Organizer, Dialog Themes](#)
- [Analysis Templates](#)
- [Batch Processing and Analysis Templates](#)
- [Copy and Paste Operations](#)
- [Using Data Filters to Obtain Different Views of Your Data](#)
- [Analysis Report Sheets and Columns](#)
- [Tutorials: Batch Processing](#)
- [Video: Batch Processing](#)
• Tutorial: Combine Quick Peaks Gadget with Peak Analyzer
18 Publishing and Export

- Click on the Standard toolbar
- Paste or CTRL+V
- Edit: Copy Page or Copy Graph as Picture
- File: Export Graphs to image files: EPS, PNG, JPG, TIF, BMP, WMF, etc.
- Send Graphs to PowerPoint (add-on App) or Slide Show of Graphs (runs in Origin)
- Embed in HTML Report
18.1 The Master Page

The **Master Page** feature is used to add one or more common objects to exported or printed graphs. Use the master page to add a set of properties and objects -- a custom background, a company logo, text labels, images, etc. -- to selected graph windows in your project.

To make use of this feature, you must first create your Master Page. The Master Page should contain only the properties and objects that you want to display on your selected graph windows:

1. From the menu, choose **File: New: Master Page**. If you are not in the project root folder when selecting this menu item, you will be asked to switch to the project root folder.
2. Customize the Master Template. Note that the comments that show beneath the **Save Master Template** button are "hidden" and will not be applied to your graph windows.
3. Click the **Save Master Template** button. When you save, the **Master Template** will be saved to the **User Files Folder** as "name of active window".otpu (e.g. "C:\Users\YourName\Documents\OriginLab\User Files\Master.otpu").

**Things to know about the Master Page:**

- Master items will only show in graphs pages of the same dimensions as the template. **Apply Dimension to All Graphs** applies Master Template page dimensions to all graphs of the same aspect ratio.
- If you create a graph and modify page size, then choose **File: New: Master Page** and load a Master Template into the workspace, the Master Template will be loaded with the page dimensions of your modified graph page.
- The **Rotate** button swaps the Master Template page dimensions (toggles orientation between landscape and portrait).
- When you click **Apply Dimension to All Graphs** you are prompted to apply dimensions only to graphs of the same aspect ratio, or to all graphs of the same orientation (portrait or landscape).
- Master Page items on a graph with portrait orientation will not show on a graph with landscape orientation and vice versa.
- **Edit: Copy Page** normally copies an Origin graph object to the Clipboard. When the object is pasted into an MS Word document and the user subsequently double-clicks on the graph object, the graph opens in an OLE instance of Origin, where it can be edited. When Master Items are present on the graph, **Edit: Copy Page** places an image object (EMF) on the Clipboard, not the usual graph object.
- **Send Graphs to PowerPoint** does not support **Insert Graphs as Embedded Object** if the graph contains Master Items (see previous bullet). **Insert Graphs as Picture** does support Master Items.
- There is a mechanism for selectively excluding Master Items in your exported or printed page. _Any object_ that you do not want to appear in the exported or printed page should begin with "NoExport" (e.g. open an arrow object's Properties dialog and on the Programming tab, rename "Arrow" to "NoExport_Arrow").
- When you customize and save your Master Page to the User Files Folder, the next time you choose **File: New: Master Page**, you load your customized template.
- If you don't want to show Master Items in the workspace, click **View: Show: Master Items** and remove the check mark. The exported graph will still contain the Master Items (they just won't show in the workspace).
- If you want to remove Master Items from a graph in both the workspace and exported images, click **Format: Page...**, Display tab and clear the **Use Master Items** check box.

You could use the Text tool to add project and system information to your Master Template as static text objects, but since the idea is to build a template for re-use, consider "soft-coding" information in your text labels. To learn more, see these topics:

- [Substituting Variable Values in Text Labels](#)
- [LabTalk String Registers](#)

### 18.2 The Export Margin Offsets Dialog Box

By default, the margins of your copied or exported graph are determined by the **Margin Control** in **Copy Page Settings** group of **Preferences: Options** (Copy actions) or the **Export Settings** branch of **Export Graphs** (Export actions). You can interactively modify the default margins using the **Export Margin Offsets Dialog Box**.
1. Click on the graph window (to activate) and choose **Edit: Export Margin Offsets**. This opens the **Export Margin Offsets** dialog.
2. Drag the green selection handles that appear at the page margins; or enter values into the dialog edit boxes and click **Apply**.

### 18.3 Fit Page to Layer and Layer to Page

There are two small dialog boxes -- one new, one that has been part of Origin for some time -- that are also helpful for removing white space or placing a margin around your graph before exporting:

- **Fit Page to Layers**: Choose Graph: Fit Page to Layers to open the `pfit2l` dialog box.
- **Fit Layers to Page**: Choose Graph: Fit Layers to Page to open the `gfitp` dialog box.
Both dialogs can be used to remove white space. Both can perform resizing, with or without changing graph aspect ratio. You can view the documentation for both to decide which might work best for you but basically it boils down to whether you need to keep a particular page size (Fit Layers to Page); if not, either tool should do the job.

18.4 Copying and Pasting Graphs to Other Applications

There are two ways you can include Origin graphs in another application’s files (e.g. Microsoft Word): as a Picture, or as an Origin Graph Object.

1. Click on your Origin graph to activate it, then ...
   - To copy the graph as a picture, choose Edit: Copy Graph as Picture.
   - To copy the graph as an editable Origin graph object, choose Edit: Copy Page.
2. In your target application choose Paste or press CTRL+V.

When you paste as a picture, the graph is inserted as an image. In MS Word, for instance, double-clicking on the image launches Word’s picture-editing tools, but this method does not allow for further graph edits in your Origin software.

When you paste as a graph object, you can later double-click on the object in the target application to launch a new instance of Origin. The graph, and any associated data sheets, will be available for editing. After editing, use Origin’s File: Exit and Return to... menu item to update the embedded object, close Origin and return to the host application.

There are several settings in the Options dialog (Preferences: Options, Page tab) that determine how the graph page is copied. These settings work with the newer Export Margin Offset dialog, to determine such things as graph copied size and page margins. Please review the Copy Page Settings and the Export Margin Offset dialog box.
Note: For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Pasting or Embedding Graphs in Other Applications

18.5 Organizing Your Graphs for Presentation or Export

If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder and arranging them there:

- Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph window, to a new Favorites subfolder (visible in Project Explorer).
- When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the corresponding dialog box or (2) set slide order following this procedure.

If you are preparing a manuscript for publication, you may want to see FAQ-441 How do I export graphs with exact size and resolution as specified by publishers?

18.6 Exporting Graphs and Layout Pages to an Image File

To export a graph or a layout page as an image file, select the menu File: Export Graphs. This will open the expGraph dialog box. The expGraph dialog offers options for customizing the output size by scaling the height or width of the page, various settings that are specific to the chosen file format, options for naming the output file, and options to perform batch exporting of multiple pages.

Origin supports 14 export file formats:

<table>
<thead>
<tr>
<th>Raster Formats</th>
<th>BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vector Formats</td>
<td>CGM, DXF, EPS, EMF, PDF, WMF</td>
</tr>
</tbody>
</table>

As is the case with most Origin dialog boxes, you can save your custom settings to a Theme for repeat use. Once you have customized your settings:

- Click the arrow to the right of Dialog Theme and choose one of the Theme save options.
- Using any group of custom settings creates a temporary default Theme called <Last used>. This Theme then becomes available for loading your last used settings and you can access it from the expGraph dialog box or from the File: Recent Exports menu item.
To save export settings to the graph page, choose **Save to <Graph>**. This provides portability for those sharing graphs and makes it easy to recall your settings at a later time. The next time you activate this graph and choose **File: Export Graphs** to open the **expGraph** dialog, simply choose **<Graph>** from the **Dialog Theme** flyout menu. The graph will be exported using settings store in the window.

**Note:** For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or Layout Page to an Image File

Exporting to raster formats such as TIFF and specifying a high resolution (e.g. 600 DPI or above) can produce a very large output file size, depending on the page size. To reduce the file size, consider reducing the size of the page before export. Consult with your publisher to determine the actual width of a print column in your journal.
18.7 Send Graphs to PowerPoint

You can send a group of Origin graphs to MS PowerPoint as pictures or as embedded objects (see limitations of embedded objects and Master Items, explained above). Graphs inserted as an embedded objects can be edited, as needed, in your Origin software. Double-click on the graph in PowerPoint to open the graph in an OLE instance of Origin.

There are two Send Graphs to PowerPoint tools in Origin -- the older, built-in tool and a newer Send Graphs to PowerPoint App that is installed with more recent versions of the Origin software. As most users favor the App, it will be discussed here. Documentation of the older, built-in tool, is found here and here.

To launch the App, click the Send Graphs to PowerPoint icon in the Apps Gallery, docked to the right-side or your Origin workspace. If you do not see the Apps Gallery, click View: Apps or press ALT + 9.

Tutorial: Send Graphs to PowerPoint

1. Run Origin and open the sample file <Origin EXE Folder>\Samples\Graphing\Column and Bar.opju.
2. Click on the Send Graphs to PowerPoint App icon to run the App.
3. Click the Select Graphs button and choose Specified.
4. Select all except Graph5B in the left panel and move them to the right panel by clicking the in the middle of the dialog box. Click OK. A scrollable list of graphs is added to the left panel in the App.
5. Set Insert Graph as = Picture.
6. Set the Slide Margin top dimension as 8% and leave the others as 0.
7. Set Title Line = Top of Slide, and Title = Window Long Name.
8. Set Starting Slide Index = 3 and Slide Mode = Start New.
9. Use the browse button beside Load File/Template (optional) to load the file <Origin EXE Folder>\Samples\Import and Export\Column_Plots_in_Sample_OPJ.pptx.
10. Specify a **Save File as (optional)** output path for the resulting PPTX file.

There is also a **Send Graphs to Word** App that is available free-of-charge from the OriginLab File Exchange. This App is particularly useful for **batch export of graphs to a book-marked MS Word document**.

### 18.8 Slide Show of Graphs

Origin has a built-in slideshow utility for viewing or presenting your graphs while running Origin. The slide show can be started in two ways:

- Right-click on any folder in **Project Explorer** and select **Slide Show of Graphs...**

  or

- Click the **Slide Show of Graphs** button on the **Standard** toolbar.

A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub folders, etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph window of the currently displayed slide).

**Tutorial: Slide Show of Graphs**

1. Use the **File: Open Sample Projects: 2D and Contour Graphs** menu to open the sample project.
2. Click on the **Slide Show of Graphs** button in the **Standard Toolbar**.
3. Accept default settings in the dialog that opens, and press **OK** to start the slide show.
4. You can use the up/down arrow keys or the mouse wheel to flip thru the slides.

### 18.9 Creating Movies

Origin provides a **Video Builder** tool, accessible from the **Open Video Builder** button on the **Standard Toolbar**. This tool can be used to manually capture a series of graph windows, and write one frame at a time to a video (.AVI) file.

Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data and then writing out the graph as a frame in the video, at each step during the computation.

**Note:** For more information, please refer to the:

**Help: Origin: Origin Help > Exporting and Publishing Graphs > Creating Graph Animation**
For specific examples of programmatically created movies, including Origin Projects and code, please visit www.originlab.com/animation.

18.10 Exporting Worksheets and Matrices

18.10.1 Exporting Worksheets

With a worksheet active, the File: Export menu item provides the following options:

- **ASCII, NI TDM (TDM, TDMS), and Sound (WAV)**
  This option is available only for sheets containing data columns, and is not available when report sheets such as those created by the Nonlinear Fitting tool are active. The exported file will contain only data from the worksheet columns. Floating or embedded graphs placed in the worksheet will be ignored.

- **Excel**
  Export books of worksheet columns with text and numeric data to an MS Excel file (XLS, XSLX, XSLM). Note that analysis report sheets with their hierarchical tables, and things such as embedded graphs and images, are not exported to the Excel file. Analysis results that are output to regular Origin worksheets are exported.

  For information on copying analysis report sheets and pasting to MS Office applications, see FAQ-815 How do I copy report sheet tables and paste them into Word, Excel or PowerPoint?

- **As Multipage PDF File**
  This option is available only on sheets with data columns, and not for report sheets. Use the View: Page Break Preview Lines menu item to view the vertical and horizontal page break lines that determine which columns and rows will be included in each page of the export. Floating or embedded graphs placed in the worksheet will be included in the exported image.

- **As Image File**
  This option is available on both data and report sheets. In the dialog that opens, you can select whether to export the entire sheet, visible area, or selection. Image file formats including PDF are supported. Floating or embedded graphs placed in the worksheet will be included in the exported image.

- **As PDF File†**
This option is available for both data and report sheets. In the dialog that opens, you can opt for exporting the entire sheet, the visible area, or a selection. Floating or embedded graphs are included in the exported PDF.

When creating a custom report from a worksheet that combines data, numeric results and graphs, the best option is to export the entire sheet as a PDF file, or export the sheet as a multi-page PDF file.

18.10.2 Exporting a Matrix

Origin matrix data can be exported in these two formats:

- **ASCII**
  This will create an ASCII file of the data contained in the active matrix object.

- **Image**
  This option will export the image view of the active matrix object, as a raster file.

**Note:** For more information, please refer to the:

Help: Origin: Origin Help > Importing and Exporting Data > Exporting Worksheets and Matrices

18.11 HTML Reports from Notes Windows

You can now copy and paste Notes window content within or between Origin sessions:

- Right-click on the Notes window title bar and choose Copy.
- Right-click on the Notes window icon in Project Explorer and Copy.
- Press Ctrl+V to paste the window to a new Project Explorer folder or Origin session.

You can create HTML reports using Notes windows. Build your HTML report using placeholders that link to report sheet elements such as metadata, statistical results or graphs. The resulting HTML report can be printed or exported; or it can be incorporated into your Analysis Template.

Reports can also be created using Markdown syntax instead of HTML. If Markdown syntax is used, optional HTML syntax can be also included for advanced customization.

To use this feature, the user should have some basic familiarity with HTML or Markdown, and as with most things, the more proficient the user is, the easier it will be to create professional-looking output. However, the skill needed to generate a basic report can be easily mastered. See this OriginLab blog post for guidance.
The basic steps of creating reports using an Origin Notes window, are as follows:

1. Create your project to include graphing and analysis results.

2. Click the **New Notes** button to add a Notes window.

3. From the menu, choose **HTML: Syntax**, then choose **HTML or Markdown** (*Hint*: You can toggle between text/view and markup modes by pressing **CTRL+M** and you can choose the default syntax by setting LabTalk System Variable [@NPS](#)).

4. You can write your code in the Notes window’s markup mode or you can use a text editor such as Notepad++, then copy and paste it to your Notes window. If you have no experience with HTML or Markdown, you may want to load samples by activating your Notes window and clicking **HTML: Load Samples** (**HTML = ".html"**, **Markdown = ".md"**).

5. You will likely want to incorporate graphing and analysis results from the current project, into your report. The simplest way to do this is to insert “placeholders” for each Origin object that you intend to include in your report, into your code. These placeholders can be named using any string that makes sense to you and they should be enclosed in double-curly braces (e.g. `{{MyR-SquareValue}}`).

6. Right-click on the Notes window title bar and choose **Edit Placeholders**. Placeholders that you have incorporated into your code will be picked up and added to a **Placeholders** worksheet in the workbook. The sheet will list, in column A, all of the placeholders found in your code. A second column -- Column B -- is blank and is reserved for adding the associated Origin objects (i.e. the variables, analysis and graphing results, etc.) that you want to include in your report.

7. For each placeholder in column A, find the associated Origin object and copy it to the Clipboard (e.g. if it is a numeric quantity in a sheet resulting from some statistical analysis, select the cell quantity, right-click and choose **Copy**, or press **CTRL+C** on your keyboard).

8. Return to the **Placeholders** sheet, right-click in column B, beside the associated placeholder and choose **Paste-Link**. This associates your placeholder with the intended Origin object.

9. If you intend to include your HTML report in an Analysis Template, you can right-click on a workbook tab in your Analysis Template and choose **Add Notes as Sheet**. This inserts your Notes window into workbook and you can now choose **File: Save Workbook as Analysis Template**.
Publishing and Export

When a Notes window is active, you can click the HTML menu and load a sample HTML file into the Notes window.

18.11.1 Using Your HTML Report

As you fill in your Placeholders sheet, you should see your HTML report take shape in the Notes window. Once completed, you can do various things with your HTML report, including:

- Print to hard-copy or to PDF (File: Print).
- Export the window as a webpage (HTML: Export to Webpage).
- Click the embed button in the upper-right corner of the Notes window to embed the content into your workbook, then save the workbook as an Analysis Template (File: Save Workbook As Analysis Template).

18.12 Topics for Further Reading

- The Preferences: Options Page Settings
- Pasting or Embedding Graphs in Other Applications
- Exporting Your Graph or Layout Page to an Image File
- Which Image Format Should I Choose?
- The Export Graph Dialog Box
- Send Graphs to PowerPoint
- Send Graphs to PowerPoint Dialog Box Settings
- View Graphs as a Slide Show
- The Slide Show of Graphs Dialog Box Settings
- Creating Graph Animations
- Printing Graphs, Layout Pages and Analytical Results
- The Print Dialog Box
- The Print Options Dialog Box
- Copying and Pasting Graphs inside Origin
- Inserting Graphs and Images into Worksheet Cells
- Tutorial: Creating a Custom Report Sheet
Using the Layout Page Window
Creating a Master Page Layout for Graphs
19 Apps for Origin

Origin 2016 introduced Origin Apps -- tools that you could easily add to your Origin installation by dropping them onto your Origin workspace. This ever-expanding collection of add-on tools is extending Origin's already-powerful graphing and analysis capabilities.

Because an App is a self-contained, easily-distributed tool aimed at solving a particular problem, it can be developed and deployed quickly, sidestepping the need to wait for a new Origin product release. In addition, an App can be developed by anyone with a basic knowledge of programming in Origin, making it attractive as a means to create and distribute tools for your company or user-community.

At present, all Apps can be downloaded for free. Note that some Apps require OriginPro; these are denoted in the App description by the PRO symbol.

19.1 Where Do I Find Apps?

Apps are listed on the OriginLab File Exchange. While you can download Apps from the File Exchange using your web browser, it easier to obtain and manage your Apps using the App Center.

The App Center provides "one stop" App installation and maintenance: Browse and download new and popular Apps, search for Apps, update existing Apps, request an App or submit an App via the OriginLab website.

To open the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery.

What to look for in the App Center:

- Installed Apps with an Up-to-date Version icon beside them are up-to-date.
- Apps with a clickable Download and Install icon beside them are not installed. Click this icon to install.
- Apps with an Update icon beside them have an available update that you can install. Click this icon to update.
- Click the New and Popular tab for a quick look at what's available. Download and update Apps.
- Click the Search tab to find Apps by Category and Minimum Version. Download and update Apps.
- The Updates tab will display a red circle icon when there is an update to one or more installed Apps. Improvements and bug fixes are listed for each.
New Apps and App updates are continually made available to Origin and OriginPro users. Be sure to open your App Center occasionally (press F10) and if it displays the red **Download Now** button, click to get the latest list of available Apps.

### 19.1.1 Finding Apps from Analysis and Statistics Menus

You can find Apps for these specific applications by clicking **Find Apps...** from Origin's main menu:

- **Analysis: Fitting**
- **Analysis: Peaks and Baseline**
- **Statistics**

These menu commands open the App Center **Search** tab to show only relevant Apps that are currently available from OriginLab's File Exchange. Click the **Download and Install** button † beside an App, to install the App.

### 19.2 How Do I Install Apps?

If you install your Apps using the **Download and Install** button † in the **App Center** dialog, you don't need to do anything else. The App is automatically downloaded and installed. When App updates become available, you can use the **Update** button ⌁ to update an installed App.
If your workstation does not have internet access:

If your workstation does not have internet access, you will need to find a computer that does (does not need to have Origin installed), download the App from the OriginLab File Exchange to a thumb-drive and bring it back to your workstation.

1. On the internet-connected computer, open a browser window and browse to originlab.com/fileExchange.
2. Browse the list of Apps, go to the App’s description and download page, then click the Download File button and copy the file to your thumb-drive.
3. Return to your Origin workstation, plug in your thumb-drive and run Origin. Open Windows Explorer, browse to your thumb-drive and once you locate the App (it will have a .opx file extension), drag the App file to an empty portion of the Origin workspace. Make sure you are not running Origin as administrator or drag-and-drop operations will fail. The App will be installed and the App icon will appear in the Apps Gallery, docked to the right side of your Origin workspace.

If you have questions, click the How to Install link below the Download File button on the File Exchange App description and download page.

19.3 How Do I Run an App?

- Upon installation, an App icon is placed in the Apps Gallery, docked to the right side of the Origin workspace.
- App operations may be window-specific. If the App is dimmed (grayed out), the active window cannot be operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps Gallery).
- If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by double-clicking on it in the Apps Gallery.
- If you prefer to launch the App from a toolbar button, open the Customize (Toolbars) dialog box (View: Toolbars), click the Button Groups tab, locate the App’s toolbar button and drag the button to the OriginLab workspace or to an existing toolbar. Close the dialog box.
- Specific usage information is available on the description and download page for each App.

19.4 Managing Your Apps

You can now sort Apps by most recently-used, making it easier to find your "go-to" Apps (see Sort Apps, second bullet).
You can use the **App Center** in combination with the **Apps Gallery**, to manage your Apps:

- Use the **App Center** (discussed above) to add and update Apps, search for Apps, request an App or submit a review of an App.

To launch the App Center, click the **Add Apps** button in the Apps Gallery.

- Organize your Apps by adding tabs to the Gallery. Right-click in an empty portion of the Gallery and choose **New Tab**, then double-click on the default tab name and give the tab a meaningful name. Additionally, you can **Sort Apps > Alphabetically**, by **Newest Install** or by **Recently Used**.

- A number of App-specific actions can be performed by right-clicking directly on the App icon in the Gallery and choosing from the shortcut menu.
- **Show in Folder**: Opens the user’s \AppData\Local\OriginLab\Apps\ folder to the App installation folder.
- **Uninstall**: Uninstalls the selected App.
- **Send Feedback...**: Opens a Rate App dialog box to provide feedback.
- **Show All** (user-added tabs only): Shows Apps from all Gallery tabs on the active tab.
- **Refresh**: Refreshes the tab view.
- **Tab Views**: Place or remove the check mark beside the App to determine on which Gallery tab(s) the App shows.

### 19.5 Will I be Notified When Updates are Available?

Several things will indicate when an App update is available:

- A red dot appears in the upper-right corner of the *Add Apps* icon in your *Apps Gallery* (docked to the right side of your workspace). Additionally, the red dot shows on individual Apps when an update is available.
• In the **App Center**, the App will appear with a clickable "update" icon beside it.

![App Center](image)

• The App Center **Updates** tab will show a red dot with a number indicating how many App updates are available. The tab will list updated Apps and allow you to apply updates for individual Apps or all Apps.

![Updates Tab](image)

**To update an App:**

- Click the **Update** icon that appears next to the App in the App Center.
- Right-click on the App in the Apps Gallery and choose **Download and Install Update**
- Click the **Update All Compatible** button that appears on the **Updates** tab in the App Center; or click the "update" icon beside each App.
- Right-click on the **Add Apps** icon in the Apps Gallery and choose **Update All**.

You can verify the version of an installed App by hovering on the App in your Apps Gallery.

**19.6 How Do I Uninstall an App?**

Uninstalling an App is easy. Right-click on the App icon in the Apps Gallery and choose **Uninstall** from the shortcut menu.
19.7 How Do I Give Feedback on an App?

OriginLab relies heavily on customer input to improve our software products. We encourage you to give feedback on Apps by right-clicking on the App icon in the Apps Gallery and choosing Send Feedback.... It takes just a few seconds!

19.8 Can I Request an App?

As previously mentioned, Apps can be developed by anyone with Origin programming knowledge. However, if you do not program but you find that you need some particular functionality that is not currently a part of the Origin product, you can request an App through the OriginLab website. OriginLab is continually building and posting new Apps to the File Exchange.

1. To request an App, open the App Center and click the Request App button in the lower-left corner of the dialog box. This opens a web page on www.originlab.com.
2. Verify that the Your Reason for Contacting Us drop down is set to Request an App.
3. Fill out the remaining required fields and click the **Submit Inquiry** button at the bottom of the form.
As you gain experience with Origin, you may want to access Origin features programmatically, add your own custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic programming options available in Origin. For more detailed information, see the following Origin programming-related resources:

- Programming documentation including guides, language references, and examples are available from the Help menu in the product.
- Online programming documentation is available at [www.originlab.com/doc](http://www.originlab.com/doc).
- You can typically locate online programming pages by performing a web search from your browser using phrases such as: labtalk importing, originc interpolate, or labview origin send data.
- Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your Origin software.

## 20.1 LabTalk
LabTalk is a scripting language that provides access to most of Origin’s functionality. With LabTalk you can access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots. LabTalk script can include calls to X-Functions to perform advanced data processing and analysis.

There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections in a file, and those individual sections can be executed from the user-interface at the command prompt in the Script Window or Command Window; from buttons added to worksheets and graphs; from included or custom-made toolbar buttons; or from custom menu commands.

The following "mini-tutorial" will demonstrate adding a button object to a worksheet, associating a short LabTalk script with the button, then using the button to execute the script and perform a basic statistical calculation while writing the results to the worksheet.

1. Run Origin and start a new project by clicking the New Project button on the Standard toolbar.
2. Click Data: Import from File: Single ASCII and browse to the file \Samples\Graphing\Box Chart.dat. Select the file and click Open. The file is imported into the active worksheet window.
3. With the worksheet window active, click Format: Worksheet. In the Worksheet Properties dialog, click the Size tab and set Gap from Top to 25, then click OK. A gap is added to worksheet window.
4. Click the Text Tool on the Tools toolbar. Click inside the gap that you just added and type "Add Mean Label Row" into the text object. Click outside the text object to exit edit mode.
5. Right-click on the text label and select Properties…. Choose Programming Control tab, set Script Run After to Button Up. Copy and paste the following script into the text box:

```labtalk
wks.userParam1 = 1;

wks.userParam1$ = "Mean";

for (int ii = 2; ii <= wks.ncols; ii++)
{
    range rr = $(ii);
    Col($(ii))[D1]$ = $(mean(rr),.2*)
}
```
7. Click OK to apply settings and close the Text Object dialog box. Note that your text object now looks like a button.

8. Click the button. Note that a new header row labelled "Mean" is added to the worksheet and the mean value of each column of data is written to the Mean row cell above the corresponding column.

LabTalk additions for Origin 2021:

- Excel-like PRODUCT() function (ORG-20778)
- Excel-like LET() function (ORG-21992)
- Command Window: Mouse-wheel zoom, better autocomplete (ORG-13898)
- New run -p commands to update pending operations (ORG-21926)
- LabTalk access to Dash Definition at plot level (ORG-21587)
- GetN supports dataset elements (ORG-19233)
- LabTalk control of box plots (ORG-22214)
- LabTalk support for sorting columns by Long Name, etc. (ORG-18101)
- LabTalk control of plot label object (layer.plot.label), including show or hide label by row index (ORG-21874)

Note: For more information on LabTalk, Origin’s built-in scripting language, please consult your product documentation at Help: Programming: LabTalk.

Sample files can be found in the \Samples\LabTalk Script Examples folder of your Origin software.

20.2 Python

Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports command line execution of Python code from the Python Console or Origin’s Code Builder IDE. The current embedded Python version is version 3.8.3.

Considerable effort has gone into improving Origin’s embedded Python environment for Origin 2021:

- Support for debugging and executing Python code in Origin’s Code Builder IDE.
- Much-improved package management. You can install packages via Code Builder (Tools: Python Packages) or from the Script Window with pip commands (e.g. pip install numpy;).
- Python Function tab added to the Set Values dialog: define and use Python functions in column formulas.
• Access Python functions from LabTalk.
• Access Python functions from Origin C.

In addition, both Origin and OriginPro include a new originpro module that, with minimal coding, provides access to Origin workbooks, matrices and graphs, plus data frames and NumPy arrays.

**Note:** For more information on integrated usage of Origin and Python, see the Python book in the Origin Help Files.

Sample files can be found in the \Samples\Python folder of your Origin software.

There is an API for calling Origin from Python. See note under Automation Server, below.

### 20.3 R

Origin supports running R commands in the Origin environment. You can issue R commands in the Script Window or from the built-in R Console, or you can run .R files. All releases of R are supported up through version 3.6.

From Origin, you can connect with R in two ways:

• **R.** Installed on your local computer.
• **Rserve.** Installed on a remote PC.

**Note:** For more information on integrating Origin and R, refer to the Origin Help file (R Console and Rserve Console) and the LabTalk Scripting Guide (Running R in Origin, R Objects, Rserve Objects).

Sample files can be found in the \Samples\R folder of your Origin software.

### 20.4 MATLAB

The MATLAB Console allows Origin users to issue MATLAB commands from Origin, and to transfer data between the two applications either using a graphical interface or using a command line.

• The Console requires both Origin and MATLAB be installed on the same computer.
• Origin also supports importing MATLAB (MAT) files from disk. There are two import routines, the older Data: Import from File and the new Connector-based Data : Connect to File: MATLAB. Importing MAT files does not require that MATLAB be installed.

**Note:** For more information on the MATLAB Console, refer to the Origin Help file (MATLAB Console).
The `<Origin Program Folder>\Samples\COM Server and Client\MATLAB` subfolder contains an example (CreatePlotInOrigin.m, CreatePlotInOrigin.OPJ) that illustrates how to connect to an Origin COM server from a MATLAB client (requires MATLAB).

### 20.5 Origin C

**Origin C** is a full-featured high-level programming language based on the ANSI C programming language syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script.

Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and manageability for developing and debugging code of greater scope and complexity.

Origin C also provides access to the **NAG Numerical Library** functions included in your Origin installation. NAG functions provide you with a large selection of algorithms for performing computations ranging from simple statistics and Fourier transforms to linear algebra and multivariate analysis. Origin currently supports NAG Library Version **Mark 26.1**.

For **Origin 2021**, there is a new Origin C function to download color palettes, with the option to install: Scribus (.xml) (XML), Office Color Table (.soc) (XML), CorelDraw and Corel PhotoPaint (.xml) (XML), Adobe Color (.aco) (Binary), Adobe Color Table (.act) (Binary), Adobe Swatch Exchange (.ase) (binary), JASC PaintShopPro (.pal) (Text).

**Note:** For more information on Origin C, please refer to the Origin C documentation:

**Help:** Programming: **Origin C**

There you will find usage information, a language reference, developer notes, examples, etc.

Sample files can be found in the `\Samples\Origin C Examples` folder of your Origin software.

### 20.6 X-Function

An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function. Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-Functions. Once an X-Function has been created, it can be accessed from anywhere in the interface that allows for script execution, such as the script window, toolbar buttons, or custom menu items.

**Note:** For more information on X-Functions, please refer to your product documentation that is installed with your software:

**Help:** Programming: **X-Functions**

There, you will find information on creating and using X-Functions, a language reference, and tutorials.

### 20.7 Automation Server
Origin can be used as an **Automation Server**. Client applications such as National Instruments™ LabVIEW™, Microsoft Excel, Python, or custom VB/VC/C# applications can exchange data with Origin, and can also send commands to be executed within Origin.

**Note:** For more information on Origin's Automation Server functionality, refer to the product documentation installed with your Origin software:

**Help:** Programming: [Automation Server](#).

There you will find examples and language reference information. Sample files can be found in the `\Samples\COM Server and Client` folder of your Origin software.

### 20.8 LabVIEW

National Instruments™ LabVIEW™ is widely used for data collection. For example, many instrument and sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of post-acquisition analysis and presentation.

Origin ships with a collection of LabVIEW sub-VIs. LabVIEW users can simply incorporate these custom sub-VIs in their main LabVIEW application to communicate seamlessly with Origin.

**Note:** For more information on Origin-LabVIEW connectivity, see the product documentation installed with your Origin software:

**Help:** [LabVIEW VI](#).

Examples and tutorials are provided.

### 20.9 Orglab

Orglab is a freely distributed component DLL for directly creating or reading Origin Project (.opj) and other Origin file types (.ogg, .ogw and .ogm). It is available as a free download. An Origin license is not required to use Orglab. Typical use of Orglab is for instrument manufacturers and other third-party vendors to allow their frontend software to output data as Origin files.

The Orglab module is available for both 64-bit and 32-bit systems. To find out more about Orglab and to download the Orglab module, go to the **Products > Orglab** page of [www.originlab.com](http://www.originlab.com).
21 Customizing Origin

21.1 Customizing Default Settings

21.1.1 Setting Preferences with the Options Dialog Box

The multi-tabbed Options dialog box has controls for Origin global settings pertaining to numeric display, file and system paths, text fonts, Origin program opening and closing behaviors, etc.

To open the Options dialog box:

- Choose Preferences: Options (any Origin window is active)
- If you opened an Excel file inside Origin, choose Window: Origin Options (Excel workbook is active)

<table>
<thead>
<tr>
<th>Controls For</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Axis Tab</strong></td>
<td></td>
</tr>
</tbody>
</table>
| • Max number of ticks for numeric and date/time scales  
• Distances from the tick labels to tick marks, axis titles  
• Display of zeros and scientific notation in tick labels, units display in axis titles  |

**Origin 2021** adds new display options for Scientific Notation. A **Scientific: 1x10^3 Display as** drop down list is added with options 1x10^3, 1 x 10^3 and 1⋅10^3

Two zero control check boxes were added and turned on by default for **Origin 2020b**:

- Zero is '0'
- No Trailing Zero

Beginning with **Origin 2021**, these options are turned OFF by default.

<table>
<thead>
<tr>
<th><strong>Excel Tab</strong></th>
<th></th>
</tr>
</thead>
</table>
| • Use of default plot assignments  
• Scan datasets for legend text  
• Prompt before opening Excel files by drag-and-drop or saving Excel workbooks |

<table>
<thead>
<tr>
<th><strong>File Locations Tab</strong></th>
<th></th>
</tr>
</thead>
</table>
| • Set file paths to track last opened, last saved, last exported file  
• Set default path and file extension for importing different file types |
<table>
<thead>
<tr>
<th>Tab</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graph Tab</strong></td>
<td>• Define applicable file types for ASCII import dialogs</td>
</tr>
<tr>
<td></td>
<td>• Dash lines definitions, line to symbol gap, user-defined symbols, etc.</td>
</tr>
<tr>
<td></td>
<td>• 2D graph anti-aliasing</td>
</tr>
<tr>
<td></td>
<td>• Enable in-place editing of linked and embedded graphs in another application</td>
</tr>
<tr>
<td></td>
<td>• Speed mode reminder watermark</td>
</tr>
<tr>
<td><strong>Miscellaneous Tab</strong></td>
<td>• Proxy server configuration</td>
</tr>
<tr>
<td></td>
<td>• Default templates for ASCII import</td>
</tr>
<tr>
<td></td>
<td>• Custom date/time formats</td>
</tr>
<tr>
<td></td>
<td>• Enable collapsible menus</td>
</tr>
<tr>
<td></td>
<td>• Use of dataset names in the Origin workspace</td>
</tr>
<tr>
<td><strong>Numeric Format Tab</strong></td>
<td>• Thresholds for displaying numbers in scientific notation</td>
</tr>
<tr>
<td></td>
<td>• Defaults for displayed digits in data and report sheets</td>
</tr>
<tr>
<td></td>
<td>• Radians, degrees or gradians</td>
</tr>
<tr>
<td></td>
<td>• Separators for decimal places</td>
</tr>
<tr>
<td><strong>Open/Close Tab</strong></td>
<td>• Default window closing behaviors</td>
</tr>
<tr>
<td></td>
<td>• Project startup, backup and autosave options</td>
</tr>
<tr>
<td></td>
<td>• Options dialog save options</td>
</tr>
<tr>
<td><strong>Page Tab</strong></td>
<td>• Defaults for page size of copy/paste or exported graphs</td>
</tr>
<tr>
<td><strong>Text Fonts Tab</strong></td>
<td>• Default fonts for text objects</td>
</tr>
<tr>
<td></td>
<td>• WYSIWYG and in-place editing mode behaviors</td>
</tr>
<tr>
<td></td>
<td>• Size and positioning of superscripts/subscripts</td>
</tr>
<tr>
<td></td>
<td>• Footnote size, analysis report sheets</td>
</tr>
<tr>
<td><strong>System Path Tab</strong></td>
<td>• View/Change the location of the User Files, Autosave, Backup, Unsaved and Group folders</td>
</tr>
<tr>
<td></td>
<td>• View locations of system folders (Program, License and Application Data)</td>
</tr>
</tbody>
</table>
21.1.2 System Variables Dialog

System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors. Origin's Set Systems Variables dialog box (Preferences: System Variables...) can be used to view and set system variable values. In the dialog, there is a link named System Variables List which opens a web page with a list of all system variables, the default value, and description.

To customize a particular system variable:

1. Type the system variable name in the first column of Set System Variables, without the @ symbol. For example, if you wanted to make a global change to the Recalculate mode of analysis dialog boxes, type: DAM
2. Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set Recalculate to Auto, type the value: 1.
3. Add optional comments in the third column and click OK to close dialog.

This modified value will be remembered and applied in every Origin session.

You can quickly read or set the value of a writable system variable in the Script Window (Window: Script Window) by typing @systemVariable= as, for example ...

```plaintext
@DAM=
```

... then pressing ENTER. When setting the value of a system variable in this way, note that that typing in the Script Window sets the variable value for the current session only.

21.1.3 3D OpenGL Settings Dialog

Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced performance including fast drawing, fast rotation and zoom, transparency, and lighting support.

For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware’s support for OpenGL, run Origin and choose Preferences: 3D OpenGL Settings.... Look under OpenGL Info for information on graphics hardware and the supported version of OpenGL.

If your graphics hardware is older, you may experience compatibility issues with things such as transparency settings and anti-aliasing. The controls under the Settings node in this dialog allow you do such things as disabling transparency. The dialog box also provides information on disabling OpenGL.

For more information on OpenGL in Origin, see the links under "Topics for Further Reading" at the end of this chapter.

21.2 Customizing Menus

21.2.1 Collapsible Menus

Like many software products, Origin uses an auto-expanding "collapsible" menu feature that shows only a partial list of menu commands when opening longer menus. If you want to show all commands upon opening, click Preferences: Options, click the Miscellaneous tab and clear the Enable Collapsible Menus check box.
21.2.2 Custom Menu Organizer

If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom Menu Organizer you can...

- Create up to 3 main menus and corresponding sub-menus
- Assign LabTalk scripts and X-Functions to a menu item
- Restrict menu item access to specific window types
- Hide unused built-in menu items, streamlining your Origin workspace

To open the Custom Menu Organizer, choose Preferences: Custom Menu Organizer... from the main menu. Then press F1 or click the button in the upper-right hand corner of the dialog box for instructions.

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from the Preferences: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch from one configuration to another. A Default configuration is also available in the fly-out, to revert to default menu settings. Configuration files can be shared among colleagues so that you use a common set of menu commands.

21.2.3 Displaying Bitmaps in Menus

You’ll note that form some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap indicates that there is an equivalent toolbar button.

On some systems such as VirtualPC or Terminal Servers, such bitmaps may cause a long delay when opening menus. To turn off the display of menu command bitmaps:

1. Select Preferences: Options to open the Options dialog box.
2. Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK.

You can modify the size of the Plot menu icons using the LabTalk system variable @PPS. To find out how to change the value of a system variable, see Customizing Origin Using System Variables.

21.3 Customizing Toolbars and Buttons

In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing complex but repetitive Origin routines, you’ll want to explore creating and sharing custom toolbars.

21.3.1 Displaying, Hiding or Moving Toolbar buttons
• Click the small down arrow at the end of any toolbar and select the Add or Remove Buttons context menu. Then select desired sub menu and check/uncheck to show/hide buttons. A Reset option is also available.
• Press ALT key and drag a button to any new toolbar location.
• Press ALT key and drag a button to blank Origin workspace to create a new toolbar.
• Press ALT key and drag a button to any window till X shows, then release to delete the toolbar.

21.3.2 Customizing Toolbar Button Appearance

Use controls on the Options tab (View: Toolbars) to:

• Show toolbar screen tips and shortcut keys on hover
• Increase toolbar and toolbar button size
• Toggle between “flat” or 3D toolbar buttons

21.3.3 Displaying or Hiding a Toolbar

• Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to dock.
• In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to edge of the Origin workspace to dock.
• In docked mode, drag the left/top end of a toolbar to reposition.
• To show/hide multiple toolbars together, choose View: Toolbars... from the main menu. Use the check boxes on Toolbars tab to show/hide toolbars. Click the New button to add a new toolbar, then drag buttons from the Button Groups tab to add buttons on the new toolbar.
• Use the Reset, Reset All buttons to reset toolbars.

21.3.4 Creating New Toolbars with New Bitmap Images

Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run when click it. Choose View: Toolbars... and create new button group on Button Group tab.

• Origin ships with three button groups starting with User Defined... with a bunch of bitmap images.
• Click any button and click Settings... button to link .ogs (Script) file section with the button.
• Drag the button to Origin workspace to create toolbar button.
• If you are feeling really creative, Origin allows you to define a new button group that uses your own 16 color, 16 x 16 pixel bitmaps.
• Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag and drop the OPX file onto Origin workspace to install the toolbar.

Note: To learn more about creating and exporting user-defined toolbars, see:
21.3.5 Add a Custom Button to the Window Title Bar

Origin supports adding a system button to the left of the minimize button on the window title bar. A custom LabTalk script can then be associated with this button.

Note: Please view the -tbb option of the LabTalk Page command in the Programming help file:


21.4 Customizing the Status Bar

Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other useful information depending upon current action, selection, window, etc.

- Right-click on Status Bar to customize the display.
- Press ALT and drag items along the Status Bar to reorder.

21.5 Customizing the Origin Workspace

Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages Log windows.

- Right click on the window title bar to specify dock, hide, auto hide, and other settings.
- When auto-hide is unchecked, double click to float the window.
- Drag the window title to move or dock to a new location.
- Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space.
- Choose View: Toolbars... from main menu. On the Toolbar tab:
  - The Reinitialize button resets menu, toolbar and dockable windows to default settings.
  - The Export button exports the current menu, toolbar and dockable window settings to an .OPX file. Drag and drop the OPX file onto another Origin installation to configure the workspace to match your customized settings.

Occasionally, an Origin workspace component goes "missing" -- The Data Display window, one of the panels in Project Explorer, etc. When this happens, you can reset your workspace by choosing View: Toolbars: Reinitialize. The downside has been that this also resets workspace customizations and toolbar configurations. Beginning with Origin 2018, clicking the Reinitialize button produces an attention message asking if you want to restore the workspace settings from your previous version or use the 2018 system defaults.

21.6 Templates and Themes
The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to the creation of custom settings for repeat use. You can save your custom settings either as templates or themes, described briefly in the following sections.

**Note:** For detailed information please refer to Origin Help file, see:

Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM)

### 21.6.1 Templates

The Origin template concept applies to graphs, workbooks, matrixbooks, and Analysis Templates™. Templates allow you to choose a set of properties or operations and save those for repeat use.

#### 21.6.1.1 Workbook Templates and Analysis Templates

You can save workbook or matrixbook settings, such as the number of columns and sheets, column plot designations, fonts, colors, display formats, custom header rows, scripts associated with the sheet, or dimension and coordinate settings, to OTWU (workbook template) or OTMU (matrix template) files.

When the workbook or matrix window is active and you choose **File: Save Template As**, you save any window customizations, minus any data that might exist in the window at the time of saving, to a template file. The template file can then be used to create new windows, as needed, for storing and analyzing your data.

Starting with Origin 2019, you can use the **New Workbook** dialog box for managing your workbook templates, both built-in (System Templates) and custom (User Templates). The dialog allows you to save a custom template with a description as well as a preview image, making it easier to keep your various workbook templates organized and ready for use.

You can use the same **New Workbook** dialog to organize and open your Analysis Templates™. An Analysis Template starts from a workbook but differs in that when you save it as an Analysis Template (**File: Save Workbook as Analysis Template**), it is saved with whatever analysis operations and dependent graphing operations, exist in the workbook at the time of saving. Analysis Templates are discussed briefly in the **Batch Analysis** section of **How to Handle Repetitive Tasks** chapter of this guide.

For a more in-depth discussion of Analysis Templates, see these topics:

- Analysis Templates.
- Creating and Using Analysis Templates (tutorial).
- Batch Processing with Word Template for Reporting (tutorial).

#### 21.6.1.2 Graph Templates

Origin ships with over 100 built-in graph templates that are used to create Origin’s many science and engineering graph types. Using one of these as a starting point, you can create your own graph, adding more layers, setting scale or dimensional relationships between layers, modifying data plot properties, etc., and then save your customizations as a user-defined graph template (.OTP) file by clicking **File: Save Template as...**.

As with built-in workbook and matrix templates, you cannot overwrite built-in (system) graph templates. If you customize a built-in graph template then choose **File: Save Template As** and save the file with the default name, the file is saved to your **User Files Folder (UFF)**. This UFF copy then becomes the default template associated with a given Plot menu command or graph toolbar button (e.g. **Plot > Basic 2D: Scatter** or the **Scatter** toolbar button). To reconnect a built-in template with these menu commands or toolbar buttons, delete (or remove) your customized template from your UFF.

An important subset of graph templates are what are called “cloneable” templates. A cloneable template requires a very specific data arrangement in your worksheet or matrix; the idea being that if you have once created a complex arrangement between worksheet datasets, matrix objects, etc. and, for instance, layers or panels in your graph, then you shouldn’t need to recreate this arrangement every time you want to recreate
such a graph. Cloneable templates are identifiable in the **Template Library** by the presence of a "sheep" icon next to the template name or preview image. When the sheep icon is blue, a cloneable template is compatible with the current active workbook/matrix; when gray, the cloneable template is not compatible with the current active workbook/matrix. For more information, see the section on cloneable templates in **Graph Template Basics** in your Origin Help file.

![Template Library](image)

You can **Search** in the Template Library. Enter a keyword to in the **Search Template** box or clear the field to show all templates. Additionally, now collapse (or expand) individual categories when you do not want templates in that particular category.

![Search in Template Library](image)

### 21.6.2 Themes

An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis dialog can be saved as a Theme. If you were to open the Theme Organizer (see below), you would see that there are tabs for **Graph, Worksheet, Dialog, Function** and **System Increment Lists**.
Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take the object properties of one graph and apply them to all the other graphs in the same project.

Right-click on plot, layer, object, etc. in graph -- or right click with nothing selected in graph -- and choose **Copy Format** context menu to copy format. Depending where you right click, the corresponding selection's format can be copied. Then right-click on corresponding selection or right click in target graph and click **Paste Format** to apply the copied settings to the target selection or graph. You can also choose **Edit: Paste Format...** to paste the Format to multiple target graphs.

The **Theme Organizer** dialog box is opened from the **Preferences** menu. Use this dialog to organize your graph, worksheet, and dialog themes.

With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple graph themes in the Theme Organizer dialog, hold down **Ctrl** while selecting the Themes, and then right-click to access the **Combine** context menu. The context menu in the tool provides an option to edit a Theme, allowing the user to add/delete properties to an existing theme. Setting a Theme as a System Theme means that it will be applied to new graphs automatically, if the graph template allows a System Theme to override template settings (see the **Allow System Theme & System Increment Lists to Override** check box).
The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of settings in the **Linear Fit** dialog box (**Analysis:Fitting:Linear Fitting**), and then save those settings to disk as a named Theme file. You can save multiple Theme files for a given dialog box and then load them into the dialog, as needed, using the dialog box's **Dialog Theme** drop-down list. Saving multiple Themes for a dialog box allows you to customize your analysis routines from different experiments, when each requires using a specific (and unique) group of settings.
Dialog themes are explained in more detail in the How to Handle Repetitive Tasks chapter of this guide.

21.7 Topics for Further Reading

- The 3D openGL Settings Dialog Box
- Creating Custom Menus
- The Custom Menu Organizer
- Analysis Themes
- How to Manage Multiple Menu Configuration (.OMC) Files
- Managing Collapsible Menus
- The User Files Folder
22 Sharing Origin Files

You may want to customize some aspect of your Origin installation and then share your customizations with other Origin users. Custom settings can be saved in many file types including graph templates (.otpu) and themes (.oth), analysis templates (.ogwu or .opjw), dialog themes, curve fitting functions, import wizard filters, LabTalk script files (.ogs), and X-Functions.

22.1 Drag and Drop Sharing

A quick and easy way to share a file with another user is simply to send it as an email attachment. The recipient can then drag and drop the file into the Origin workspace.

Drag-and-drop is supported for most Origin file types. Origin project (.opjw) and graph template (.otpu) files automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a dialog opens asking how you want to categorize the new fitting function.

22.2 Sharing Files with Multiple Machines for Single Users

If you are a single user and have installed Origin on multiple machines, you can share your custom settings across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive, or even a USB flash drive, and use the same UFF path with each installation.

Note: For information on changing the UFF path, see:

Help: Origin: Origin Help > Customization and Automation > Setting Your Preferences > The
**User Files Folder**

### 22.3 Sharing Files with Other Users in a Network

You can set up and use a group folder to share files among users. Multiple groups are allowed, and each group can have some power user(s) set as the group leader. The group leader can use the **Group Folder Manager** tool to publish custom files for sharing with other group members. When a group member launches Origin, the published files will be copied to their Origin automatically and made ready for use.

Origin supports setting multiple group folders, making it possible to share different files between groups. A leader machine can set up multiple groups and publish different files to different groups. A member machine can belong to multiple groups and thus receive all files published by group leaders.

**Note:** For information on group folders, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with Multiple Clients > Setting a Group Folder Location

### 22.4 Packaging Files

Origin provides a **Package Manager** tool for packing multiple files into a single Origin Package (.opx) file. This is a convenient way to distribute custom applications that may contain multiple Origin files, such as templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk scripts before and after installation.

To access the Package Manager, click **Tools**, and then click **Package Manager**...

To install the contents of an .opx file, simply drag and drop into the Origin workspace.

**Note:** For information on packaging files, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Packaging Multiple Files as OPX

Two new mechanisms for distributing preset system variables and opx/opk files during software installation, are added for **Origin 2021**:

- Create a folder named *UpdateUserFile* in the Origin 2021 setup folder (with setup.exe or msi) and it will be copied to the Origin 2021 Program Folder. When Origin 2021 runs, it is copied to the UFF.
- Create a folder named *Auto Install* in the Origin 2021 setup folder (with setup.exe or msi) and it will be copied to the Origin 2021 Program Folder. When Origin 2021 runs, contained opx/opk are auto-installed.

### 22.5 The Origin Viewer
Sharing Origin Files

The **Origin Viewer** is a freely distributed, standalone application that allows viewing and copying of information contained in Origin project files and window (graph, worksheet, matrix) files on computers that do not have Origin installed.

- The Origin Viewer is distributed as a single EXE file - no installation needed.
- Available as a 32- or 64-bit Windows application, or as a native Mac application.
- Project Explorer-like folder view with graph previews on hover, icon or details views, X-large icon view option.
- Open a graph in a pop-up window for better viewing.
- Supports viewing and rotating Origin’s OpenGL 3D graphs.

Origin 2018 introduced a new Unicode-compliant project file type (OPJU). Origin Viewer versions **9.6.5** or later allow anyone to save the Unicode-compliant OPJU project files to the pre-2018 OPJ format for sharing of projects with users of older versions of Origin.

If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin, you might direct them to the Origin Viewer page ([www.originlab.com/viewer](http://www.originlab.com/viewer)) where they can find out more and download the free EXE.

### 22.6 Topics for Further Reading

- [The User Files Folder](#)
- [Attaching Files to the Origin Project](#)
- [Package Manager](#)
- [Setting Up a Group Folder](#)
- [Exporting Custom Button Groups](#)
- [Exporting Toolbar Settings](#)
- [Apps for Origin](#)
23 Origin Toolbars

This is a list of Origin toolbars, and buttons by button group. Toolbars are shown in their default configurations. You will note that some buttons are missing from default toolbar configurations. This may be because a button has been deprecated (e.g. Open Excel), because it is duplicated on another toolbar, or simply because it is a lesser-used button.

To add or remove buttons from a toolbar:

1. Click View: Toolbars to open the Customize dialog box.
2. Click on the Button Groups tab and drag desired buttons to a toolbar or to an empty portion of the workspace.
3. To remove a button-toolbar, drag it from the toolbar back to the Buttons list or click the small "x" in the upper right-corner of the toolbar (removes entire toolbar from the workspace).

Note also that some toolbar buttons have a small downward pointing arrow next to them. Clicking the tool displayed on these "split buttons" carries out the action associated with the displayed tool. Clicking the arrow beside it opens a menu, allowing you to pick another tool. A split button displays the tool that was last used.

Finally, toolbar buttons will be inaccessible (dimmed) if the object that they act on is not active. For instance, the 3D-Rotation Toolbar is only available when a 3D graph is active.

23.1 Standard

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New Project" /></td>
<td>New Project</td>
<td></td>
<td><img src="image" alt="New Folder" /></td>
<td>New Folder</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="New Workbook" /></td>
<td>New Workbook</td>
<td></td>
<td><img src="image" alt="New Excel" /></td>
<td>New Excel</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="New Graph" /></td>
<td>New Graph</td>
<td></td>
<td><img src="image" alt="New Matrix" /></td>
<td>New Matrix</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="New Function" /></td>
<td>New Function</td>
<td></td>
<td><img src="image" alt="New 2D (Function) Plot" /></td>
<td>New 2D (Function) Plot</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="New 2D Parametric (Function) Plot" /></td>
<td>New 2D Parametric (Function) Plot</td>
<td></td>
<td><img src="image" alt="New 3D (Function) Plot" /></td>
<td>New 3D (Function) Plot</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="New 3D Parametric (Function) Plot" /></td>
<td>New 3D Parametric (Function) Plot</td>
<td></td>
<td><img src="image" alt="New Layout" /></td>
<td>New Layout</td>
<td></td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
<td>Keyboard Shortcut</td>
<td>Additional Info</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>------------------------------</td>
<td>-------------------</td>
<td>----------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="New Notes" /></td>
<td>New Notes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Digitize Image" /></td>
<td>Digitize Image</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Open</td>
<td>Ctrl+O</td>
<td>Open Template</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Open Excel" /></td>
<td>Open Excel</td>
<td></td>
<td>Import Excel Ctrl+E</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save Project" /></td>
<td>Save Project</td>
<td>Ctrl+S</td>
<td>Save Template</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Recalculate Auto" /></td>
<td>Recalculate Auto</td>
<td></td>
<td>Recalculate Manual</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Import Wizard" /></td>
<td>Import Wizard</td>
<td>Ctrl+3</td>
<td>Import Single ASCII Ctrl+K</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Import Multiple ASCII" /></td>
<td>Import Multiple ASCII</td>
<td></td>
<td>Batch Processing</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Zoom In and Out by Percentage" /></td>
<td>Zoom In and Out by Percentage</td>
<td></td>
<td>Print</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Slide Show of Graphs" /></td>
<td>Slide Show of Graphs</td>
<td></td>
<td>Send Graphs to PowerPoint</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Open Video Builder" /></td>
<td>Open Video Builder</td>
<td></td>
<td>Refresh F5</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Duplicate" /></td>
<td>Duplicate</td>
<td></td>
<td>Custom Routine</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Project Explorer" /></td>
<td>Project Explorer</td>
<td>Alt + 1</td>
<td>Object Manager Alt + 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Results Log" /></td>
<td>Results Log</td>
<td>Alt + 2</td>
<td>Command Window Alt + 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Code Builder" /></td>
<td>Code Builder</td>
<td>Alt + 4</td>
<td>Add New Columns</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

23.2 Import
### Import Toolbars

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Import Wizard]</td>
<td>Import Wizard</td>
<td></td>
<td>![Import Single ASCII]</td>
<td>Import Single ASCII</td>
<td></td>
</tr>
<tr>
<td>![Import Multiple ASCII]</td>
<td>Import Multiple ASCII</td>
<td></td>
<td>![Import Excel]</td>
<td>Import Excel</td>
<td></td>
</tr>
<tr>
<td>![Re-import no Dialog]</td>
<td>Re-import no Dialog</td>
<td>CTRL + 4</td>
<td>![Re-import with Dialog]</td>
<td>Re-import with Dialog</td>
<td></td>
</tr>
<tr>
<td>![Clone Import]</td>
<td>Clone Import</td>
<td></td>
<td>![Batch Processing]</td>
<td>Batch Processing</td>
<td></td>
</tr>
<tr>
<td>![Connect to Data from Web]</td>
<td>Connect to Data from Web</td>
<td></td>
<td>![Connect Multiple Files]</td>
<td>Connect Multiple Files</td>
<td></td>
</tr>
<tr>
<td>![Import All Connected Data]</td>
<td>Import All Connected Data</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 23.3 Edit

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Cut]</td>
<td>Cut</td>
<td>Ctrl+X</td>
<td>![Copy]</td>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>![Paste]</td>
<td>Paste</td>
<td>Ctrl+V</td>
<td>![Undo]</td>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
</tbody>
</table>

### 23.4 Graph
<table>
<thead>
<tr>
<th>Function</th>
<th>Key Stroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable Anti-Aliasing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rescale X</td>
<td></td>
<td>Rescale Y</td>
</tr>
<tr>
<td>Rescale XY</td>
<td></td>
<td>Rescale Z</td>
</tr>
<tr>
<td>Exchange the X and Y axes</td>
<td></td>
<td>Enable/Disable Speed Mode</td>
</tr>
<tr>
<td>Extract to Layers</td>
<td></td>
<td>Extract to Graphs</td>
</tr>
<tr>
<td>Merge</td>
<td></td>
<td>Duplicate with New Columns/Sheets/Books</td>
</tr>
<tr>
<td>Add Bottom-X Left-Y Layer</td>
<td></td>
<td>Add Top-X Layer</td>
</tr>
<tr>
<td>Add Right-Y Layer</td>
<td></td>
<td>Add Top-X Right-Y Layer</td>
</tr>
<tr>
<td>Add Inset Graph</td>
<td></td>
<td>Add Inset Graph With Data</td>
</tr>
<tr>
<td>Zoom In</td>
<td></td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Whole Page</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 23.5 2D Graphs

Note that a few plot types do not have a toolbar button. The most complete list of Origin plot types is found on the **Plot** menu.
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Line" /></td>
<td>Line</td>
<td><img src="image" alt="Horizontal Step" /></td>
<td>Horizontal Step</td>
</tr>
<tr>
<td><img src="image" alt="Vertical Step" /></td>
<td>Vertical Step</td>
<td><img src="image" alt="Spline Connected" /></td>
<td>Spline Connected</td>
</tr>
<tr>
<td><img src="image" alt="Scatter" /></td>
<td>Scatter</td>
<td><img src="image" alt="Grouped Scatter - Indexed Data" /></td>
<td>Grouped Scatter - Indexed Data</td>
</tr>
<tr>
<td><img src="image" alt="Scatter Central" /></td>
<td>Scatter Central</td>
<td><img src="image" alt="Column Scatter" /></td>
<td>Column Scatter</td>
</tr>
<tr>
<td><img src="image" alt="Y Error" /></td>
<td>Y Error</td>
<td><img src="image" alt="X Y Error" /></td>
<td>X Y Error</td>
</tr>
<tr>
<td><img src="image" alt="Vertical Drop Line" /></td>
<td>Vertical Drop Line</td>
<td><img src="image" alt="Bubble" /></td>
<td>Bubble</td>
</tr>
<tr>
<td><img src="image" alt="Color Mapped" /></td>
<td>Color Mapped</td>
<td><img src="image" alt="Bubble + Color Mapped" /></td>
<td>Bubble + Color Mapped</td>
</tr>
<tr>
<td><img src="image" alt="Line + Symbol" /></td>
<td>Line + Symbol</td>
<td><img src="image" alt="Line Series" /></td>
<td>Line Series</td>
</tr>
<tr>
<td><img src="image" alt="2 Point Segment" /></td>
<td>2 Point Segment</td>
<td><img src="image" alt="3 Point Segment" /></td>
<td>3 Point Segment</td>
</tr>
<tr>
<td><img src="image" alt="Row-wise" /></td>
<td>Row-wise</td>
<td><img src="image" alt="Column" /></td>
<td>Column</td>
</tr>
<tr>
<td><img src="image" alt="Column + Label" /></td>
<td>Column + Label</td>
<td><img src="image" alt="Grouped Column-Indexed Data" /></td>
<td>Grouped Column-Indexed Data</td>
</tr>
<tr>
<td><img src="image" alt="Bar" /></td>
<td>Bar</td>
<td><img src="image" alt="Stacked Column" /></td>
<td>Stacked Column</td>
</tr>
<tr>
<td><img src="image" alt="Stacked Bar" /></td>
<td>Stacked Bar</td>
<td><img src="image" alt="100% Stacked Column" /></td>
<td>100% Stacked Column</td>
</tr>
<tr>
<td><img src="image" alt="100% Stacked Bar" /></td>
<td>100% Stacked Bar</td>
<td><img src="image" alt="Floating Column" /></td>
<td>Floating Column</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------------------------------------</td>
<td>------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Floating Bar" /></td>
<td>Floating Bar</td>
<td><img src="image" alt="3D Color Pie Chart" /></td>
<td>3D Color Pie Chart</td>
</tr>
<tr>
<td><img src="image" alt="2D B&amp;W Pie Chart" /></td>
<td>2D B&amp;W Pie Chart</td>
<td><img src="image" alt="Double Y Axis" /></td>
<td>Double Y Axis</td>
</tr>
<tr>
<td><img src="image" alt="3Ys Y-YY" /></td>
<td>3Ys Y-YY</td>
<td><img src="image" alt="3Ys Y-Y-Y" /></td>
<td>3Ys Y-Y-Y</td>
</tr>
<tr>
<td><img src="image" alt="4Ys Y-YYYY" /></td>
<td>4Ys Y-YYYY</td>
<td><img src="image" alt="4Ys YY-YY" /></td>
<td>4Ys YY-YY</td>
</tr>
<tr>
<td><img src="image" alt="Multiple Y Axes" /></td>
<td>Multiple Y Axes</td>
<td><img src="image" alt="Stacked Lines By Y Offsets" /></td>
<td>Stacked Lines By Y Offsets</td>
</tr>
<tr>
<td><img src="image" alt="Colormapped Line Series" /></td>
<td>Colormapped Line Series</td>
<td><img src="image" alt="Waterfall" /></td>
<td>Waterfall</td>
</tr>
<tr>
<td><img src="image" alt="3D Waterfall" /></td>
<td>3D Waterfall</td>
<td><img src="image" alt="3D Waterfall Y: Color Mapping" /></td>
<td>3D Waterfall Y: Color Mapping</td>
</tr>
<tr>
<td><img src="image" alt="3D Waterfall Z: Color Mapping" /></td>
<td>3D Waterfall Z: Color Mapping</td>
<td><img src="image" alt="Vertical 2 Panel" /></td>
<td>Vertical 2 Panel</td>
</tr>
<tr>
<td><img src="image" alt="Horizontal 2 Panel" /></td>
<td>Horizontal 2 Panel</td>
<td><img src="image" alt="4 Panel" /></td>
<td>4 Panel</td>
</tr>
<tr>
<td><img src="image" alt="9 Panel" /></td>
<td>9 Panel</td>
<td><img src="image" alt="Stack" /></td>
<td>Stack</td>
</tr>
<tr>
<td><img src="image" alt="Multiple Panels by Label" /></td>
<td>Multiple Panels by Label</td>
<td><img src="image" alt="Trellis Plot" /></td>
<td>Trellis Plot</td>
</tr>
<tr>
<td><img src="image" alt="Cluster Plot" /></td>
<td>Cluster Plot</td>
<td><img src="image" alt="Box Chart" /></td>
<td>Box Chart</td>
</tr>
<tr>
<td><img src="image" alt="Violin with Box" /></td>
<td>Violin with Box</td>
<td><img src="image" alt="Grouped Box Charts-Indexed Data" /></td>
<td>Grouped Box Charts-Indexed Data</td>
</tr>
<tr>
<td><img src="image" alt="Grouped Box Charts-Raw Data" /></td>
<td>Grouped Box Charts-Raw Data</td>
<td><img src="image" alt="Interval Plot" /></td>
<td>Interval Plot</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------</td>
<td>------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Histogram" /></td>
<td>Histogram</td>
<td><img src="image" alt="Histogram + Probabilities" /></td>
<td>Histogram + Probabilities</td>
</tr>
<tr>
<td><img src="image" alt="Multi-Panel Histogram" /></td>
<td>Multi-Panel Histogram</td>
<td><img src="image" alt="Marginal Histograms" /></td>
<td>Marginal Histograms</td>
</tr>
<tr>
<td><img src="image" alt="Marginal Boxes" /></td>
<td>Marginal Boxes</td>
<td><img src="image" alt="Distribution + Rug" /></td>
<td>Distribution + Rug</td>
</tr>
<tr>
<td><img src="image" alt="2D Kernel Density" /></td>
<td>2D Kernel Density</td>
<td><img src="image" alt="QC(X-bar R) Chart" /></td>
<td>QC(X-bar R) Chart</td>
</tr>
<tr>
<td><img src="image" alt="Pareto Chart-Binned Data" /></td>
<td>Pareto Chart-Binned Data</td>
<td><img src="image" alt="Pareto Chart-Raw Data" /></td>
<td>Pareto Chart-Raw Data</td>
</tr>
<tr>
<td><img src="image" alt="Scatter Matrix" /></td>
<td>Scatter Matrix</td>
<td><img src="image" alt="Probability Plot" /></td>
<td>Probability Plot</td>
</tr>
<tr>
<td><img src="image" alt="Q-Q Plot" /></td>
<td>Q-Q Plot</td>
<td><img src="image" alt="Parallel Plot" /></td>
<td>Parallel Plot</td>
</tr>
<tr>
<td><img src="image" alt="Area" /></td>
<td>Area</td>
<td><img src="image" alt="Stacked Area" /></td>
<td>Stacked Area</td>
</tr>
<tr>
<td><img src="image" alt="Fill Area" /></td>
<td>Fill Area</td>
<td><img src="image" alt="Zoom" /></td>
<td>Zoom</td>
</tr>
<tr>
<td>![Polar theta(X) r(Y)]</td>
<td>Polar theta(X) r(Y)</td>
<td>![Polar r(X) theta(Y)]</td>
<td>Polar r(X) theta(Y)</td>
</tr>
<tr>
<td><img src="image" alt="Wind Rose-Binned Data" /></td>
<td>Wind Rose-Binned Data</td>
<td><img src="image" alt="Wind Rose-Raw Data" /></td>
<td>Wind Rose-Raw Data</td>
</tr>
<tr>
<td><img src="image" alt="Ternary" /></td>
<td>Ternary</td>
<td><img src="image" alt="Piper" /></td>
<td>Piper</td>
</tr>
<tr>
<td><img src="image" alt="Smith Chart" /></td>
<td>Smith Chart</td>
<td><img src="image" alt="Radar" /></td>
<td>Radar</td>
</tr>
<tr>
<td><img src="image" alt="Vector XYAM" /></td>
<td>Vector XYAM</td>
<td><img src="image" alt="Vector XYXY" /></td>
<td>Vector XYXY</td>
</tr>
<tr>
<td><img src="image" alt="High-Low-Close" /></td>
<td>High-Low-Close</td>
<td><img src="image" alt="Japanese Candlestick" /></td>
<td>Japanese Candlestick</td>
</tr>
</tbody>
</table>
23.6 Add Object to Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Add Color Scale</td>
<td></td>
<td>📝</td>
<td>Reconstruct Legend</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td></td>
<td>Add Asterisk Bracket</td>
<td></td>
<td></td>
<td>Add XY Scale</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Date &amp; Time</td>
<td></td>
<td></td>
<td>Project Path</td>
<td></td>
</tr>
<tr>
<td></td>
<td>New Link Table</td>
<td></td>
<td></td>
<td>Add Bubble Scale</td>
<td></td>
</tr>
</tbody>
</table>

23.7 3D and Contour Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>3D Scatter Plot</td>
<td>🌟</td>
<td>3D Trajectory</td>
</tr>
<tr>
<td></td>
<td>3D Scatter + Error Bar</td>
<td></td>
<td>3D Vector XYZ XYZ</td>
</tr>
<tr>
<td></td>
<td>3D Vector XYZ dXdYdZ</td>
<td></td>
<td>3D Tetrahedral</td>
</tr>
<tr>
<td></td>
<td>3D Bars</td>
<td>3D Stacked Bars</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------</td>
<td>--------------------------</td>
<td></td>
</tr>
<tr>
<td>3D 100% Stacked Bars</td>
<td></td>
<td>XYY 3D Bars</td>
<td></td>
</tr>
<tr>
<td>XYY 3D Stacked Bars</td>
<td></td>
<td>XYY 3D 100% Stacked Bars</td>
<td></td>
</tr>
<tr>
<td>3D Ribbons</td>
<td></td>
<td>3D Walls</td>
<td></td>
</tr>
<tr>
<td>3D Waterfall</td>
<td></td>
<td>3D Waterfall Y: Color Mapping</td>
<td></td>
</tr>
<tr>
<td>3D Waterfall Z: Color Mapping</td>
<td></td>
<td>3D Color Fill Surface</td>
<td></td>
</tr>
<tr>
<td>Multiple Color Fill Surfaces</td>
<td></td>
<td>3D X Constant with Base</td>
<td></td>
</tr>
<tr>
<td>3D Y Constant with Base</td>
<td></td>
<td>3D Colormap Surface</td>
<td></td>
</tr>
<tr>
<td>Multiple Colormap Surfaces</td>
<td></td>
<td>3D Color Fill Surface with Error Bar</td>
<td></td>
</tr>
<tr>
<td>3D Colormap Surface with Error Bar</td>
<td></td>
<td>3D Wire Frame</td>
<td></td>
</tr>
<tr>
<td>3D Wire Surface</td>
<td></td>
<td>3D Colormap Surface with Projection</td>
<td></td>
</tr>
<tr>
<td>3D Ternary Colormap Surface</td>
<td></td>
<td>Contour - Color fill</td>
<td></td>
</tr>
<tr>
<td>Contour - B/W Lines + Labels</td>
<td></td>
<td>Gray Scale Map</td>
<td></td>
</tr>
<tr>
<td>Contour Profiles</td>
<td></td>
<td>Polar Contour theta(X) r(Y)</td>
<td></td>
</tr>
<tr>
<td>Polar Contour r(X) theta(Y)</td>
<td></td>
<td>Ternary Contour</td>
<td></td>
</tr>
</tbody>
</table>
23.8 3D Rotation

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="icon" /></td>
<td>Rotate counterclockwise</td>
<td><img src="image2.png" alt="icon" /></td>
<td>Rotate clockwise</td>
</tr>
<tr>
<td><img src="image3.png" alt="icon" /></td>
<td>Tilt left</td>
<td><img src="image4.png" alt="icon" /></td>
<td>Tilt right</td>
</tr>
<tr>
<td><img src="image5.png" alt="icon" /></td>
<td>Tilt down</td>
<td><img src="image6.png" alt="icon" /></td>
<td>Tilt up</td>
</tr>
<tr>
<td><img src="image7.png" alt="icon" /></td>
<td>Increase perspective</td>
<td><img src="image8.png" alt="icon" /></td>
<td>Decrease perspective</td>
</tr>
<tr>
<td><img src="image9.png" alt="icon" /></td>
<td>Fit frame to layer</td>
<td><img src="image10.png" alt="icon" /></td>
<td>Reset Rotation</td>
</tr>
<tr>
<td><img src="image11.png" alt="icon" /></td>
<td>Reset</td>
<td><img src="image12.png" alt="icon" /></td>
<td>Rotate on any direction</td>
</tr>
<tr>
<td><img src="image13.png" alt="icon" /></td>
<td>Rotation Angle</td>
<td><img src="image14.png" alt="icon" /></td>
<td>10</td>
</tr>
</tbody>
</table>

23.9 Worksheet Data

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image15.png" alt="icon" /></td>
<td>Statistics on Column(s)</td>
<td></td>
<td><img src="image16.png" alt="icon" /></td>
<td>Statistics on Row(s)</td>
<td></td>
</tr>
</tbody>
</table>
### 23.10 Column

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="X" /></td>
<td>Set as X</td>
<td><img src="image" alt="Y" /></td>
<td>Set as Y</td>
</tr>
<tr>
<td><img src="image" alt="Z" /></td>
<td>Set as Z</td>
<td><img src="image" alt="i" /></td>
<td>Set as Y Error Bars</td>
</tr>
<tr>
<td><img src="image" alt="a" /></td>
<td>Set as Labels</td>
<td><img src="image" alt="G" /></td>
<td>Set as Disregard</td>
</tr>
<tr>
<td><img src="image" alt="G" /></td>
<td>Set as Grouping</td>
<td><img src="image" alt="S" /></td>
<td>Set as Subject</td>
</tr>
<tr>
<td><img src="image" alt="left" /></td>
<td>Move to First</td>
<td><img src="image" alt="left" /></td>
<td>Move Left</td>
</tr>
<tr>
<td><img src="image" alt="right" /></td>
<td>Move Right</td>
<td><img src="image" alt="right" /></td>
<td>Move to Last</td>
</tr>
<tr>
<td><img src="image" alt="swap" /></td>
<td>Swap Columns</td>
<td><img src="image" alt="add" /></td>
<td>Add Sparkline</td>
</tr>
</tbody>
</table>
## 23.11 Layout

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add Graph" /></td>
<td>Add Graph</td>
<td><img src="image" alt="Add Worksheet" /></td>
<td>Add Worksheet</td>
</tr>
</tbody>
</table>

## 23.12 Mask

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mask Range" /></td>
<td>Mask Range</td>
<td><img src="image" alt="Unmask Range" /></td>
<td>Unmask Range</td>
</tr>
<tr>
<td><img src="image" alt="Change mask color" /></td>
<td>Change mask color</td>
<td><img src="image" alt="Hide/Show masked points" /></td>
<td>Hide/Show masked points</td>
</tr>
<tr>
<td><img src="image" alt="Swap mask" /></td>
<td>Swap mask</td>
<td></td>
<td>Disable/Enable masking</td>
</tr>
</tbody>
</table>

## 23.13 Tools

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pointer" /></td>
<td>Pointer</td>
<td></td>
<td><img src="image" alt="Scale In" /></td>
<td>Scale In</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Scale Out" /></td>
<td>Scale Out</td>
<td></td>
<td><img src="image" alt="Screen Reader" /></td>
<td>Screen Reader</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Data Highlighter" /></td>
<td>Data Highlighter</td>
<td></td>
<td><img src="image" alt="Data Reader" /></td>
<td>Data Reader</td>
<td></td>
</tr>
<tr>
<td>ToolBAR</td>
<td>ToolBAR</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Cursor</td>
<td>Data Selector</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selection on Active Plot</td>
<td>Selection on All Plots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mask Points on Active Plot</td>
<td>Mask Points on All Plots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unmask Points on Active Plot</td>
<td>Unmask Points on All Plots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Data</td>
<td>Text Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Annotation</td>
<td>Arrow Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Curved Arrow Tool</td>
<td>Line Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polyline Tool</td>
<td>Curve Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freehand Draw Tool</td>
<td>Rectangle Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circle Tool</td>
<td>Polygon Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region Tool</td>
<td>Zoom-Panning Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Equation</td>
<td>Insert Word Object</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Excel Object</td>
<td>Insert Object</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Graph</td>
<td>Insert Worksheet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
23.14 Object Edit

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Left" /></td>
<td>Left</td>
<td><img src="image" alt="Right" /></td>
<td>Right</td>
</tr>
<tr>
<td><img src="image" alt="Top" /></td>
<td>Top</td>
<td><img src="image" alt="Bottom" /></td>
<td>Bottom</td>
</tr>
<tr>
<td><img src="image" alt="Vertical" /></td>
<td>Vertical</td>
<td><img src="image" alt="Horizontal" /></td>
<td>Horizontal</td>
</tr>
<tr>
<td><img src="image" alt="Uniform Width" /></td>
<td>Uniform Width</td>
<td><img src="image" alt="Uniform Height" /></td>
<td>Uniform Height</td>
</tr>
<tr>
<td><img src="image" alt="Group" /></td>
<td>Group</td>
<td><img src="image" alt="Ungroup" /></td>
<td>Ungroup</td>
</tr>
<tr>
<td><img src="image" alt="Distribute Selected Layers" /></td>
<td>Distribute Selected Layers/Graphic Objects Evenly in Vertical Dimension</td>
<td><img src="image" alt="Distribute Selected Layers" /></td>
<td>Distribute Selected Layers/Graphic Objects Evenly in Horizontal Dimension</td>
</tr>
<tr>
<td><img src="image" alt="Front" /></td>
<td>Front</td>
<td><img src="image" alt="Back" /></td>
<td>Back</td>
</tr>
<tr>
<td><img src="image" alt="Forward" /></td>
<td>Forward</td>
<td><img src="image" alt="Backward" /></td>
<td>Backward</td>
</tr>
<tr>
<td><img src="image" alt="Front(data)" /></td>
<td>Front(data)</td>
<td><img src="image" alt="Back(data)" /></td>
<td>Back(data)</td>
</tr>
</tbody>
</table>

23.15 Arrow
### Origin Toolbars

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Horizontal Alignment</td>
<td></td>
<td>Vertical Alignment</td>
</tr>
<tr>
<td></td>
<td>Widen Head</td>
<td></td>
<td>Narrow Head</td>
</tr>
<tr>
<td></td>
<td>Lengthen Head</td>
<td></td>
<td>Shorten Head</td>
</tr>
</tbody>
</table>

#### 23.16Style

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Fill Color</td>
<td></td>
<td></td>
<td>Line/Border Color</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lighting Control Dialog</td>
<td></td>
<td></td>
<td>Palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Line/Border Style</td>
<td>0.5</td>
<td></td>
<td>Line/Border Width</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fill Pattern</td>
<td>0</td>
<td></td>
<td>Fill Pattern Width</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pattern Color</td>
<td></td>
<td></td>
<td>Clear Borders</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Left Border</td>
<td></td>
<td></td>
<td>Top Border</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Right Border</td>
<td></td>
<td></td>
<td>Bottom Border</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Frame Borders</td>
<td></td>
<td></td>
<td>Inside Horizontal Borders</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inside Vertical Borders</td>
<td></td>
<td></td>
<td>Inside Horiz and Vert Borders</td>
<td></td>
</tr>
</tbody>
</table>
23.17 Format

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Font" /></td>
<td>Font</td>
<td></td>
<td><img src="image" alt="Font size" /></td>
<td>Font size</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>Bold</td>
<td>Ctrl+&quot;B&quot;</td>
<td><img src="image" alt="Italic" /></td>
<td>Italic</td>
<td>Ctrl+&quot;I&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Underline" /></td>
<td>Underline</td>
<td>Ctrl+&quot;U&quot;</td>
<td><img src="image" alt="Superscript" /></td>
<td>Superscript</td>
<td>Ctrl+&quot;^&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Subscript" /></td>
<td>Subscript</td>
<td>Ctrl+&quot;=&quot;</td>
<td><img src="image" alt="SuperScript" /></td>
<td>SuperScript</td>
<td>Ctrl+&quot;.&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Increase Font" /></td>
<td>Increase Font</td>
<td>Ctrl+&quot;&gt;&quot;</td>
<td><img src="image" alt="Decrease Font" /></td>
<td>Decrease Font</td>
<td>Ctrl+&quot;&lt;&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Greek" /></td>
<td>Greek</td>
<td>Ctrl+&quot;G&quot;</td>
<td></td>
<td>Left</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Center Horizontal" /></td>
<td>Center Horizontal</td>
<td></td>
<td><img src="image" alt="Right" /></td>
<td>Right</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Top" /></td>
<td>Top</td>
<td></td>
<td><img src="image" alt="Center Vertical" /></td>
<td>Center Vertical</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Bottom" /></td>
<td>Bottom</td>
<td></td>
<td><img src="image" alt="Font Color" /></td>
<td>Font Color</td>
<td></td>
</tr>
</tbody>
</table>
### 23.18 Auto Update

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Auto Update Button]</td>
<td>Block Auto Update</td>
</tr>
</tbody>
</table>

### 23.19 Database Access

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Open SQL Editor]</td>
<td>Open SQL Editor</td>
<td>![Open Query Builder]</td>
<td>Open Query Builder</td>
</tr>
<tr>
<td>![Load ODQ File]</td>
<td>Load ODQ File</td>
<td>![Preview Import]</td>
<td>Preview Import</td>
</tr>
<tr>
<td>![Import Data]</td>
<td>Import data</td>
<td>![Remove SQL]</td>
<td>Remove SQL</td>
</tr>
</tbody>
</table>

### 23.20 Markers & Locks

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Add Data Markers]</td>
<td>Add Data Markers</td>
<td>Ctrl+Alt+M</td>
<td>![Clear Data Markers]</td>
<td>Clear Data Markers</td>
<td>Ctrl+Alt+N</td>
</tr>
<tr>
<td>![Marker Size]</td>
<td>Marker Size</td>
<td></td>
<td>![Marker Hide Show]</td>
<td>Marker Hide Show</td>
<td></td>
</tr>
<tr>
<td>![Lock Positions]</td>
<td>Lock Positions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Index

242

2D Integration ................................................ 267

3

32- and 64-bit .................................................... 3

3D Graphing, Hardware Compatibility ........ 363

3D Surface Fitting ............................................. 14

A

AB? ................................................................. 76
ABF ................................................................... 76
Active Dataset ................................................ 276
Analysis Markers ............................................. 283
Analysis Reports ............................................. 325
Analysis Templates ........................................ 122, 325
Analysis Themes ............................................. 368
Animating Graphs.......................................... 341
Annotation Tool............................................... 255
ANOVA ........................................................... 308
Apps Gallery ..................................................... 47
ASCII Data ....................................................... 73
ASCII Data, Import to Graph ............................ 161
Auto Recalculate ............................................ 314
Automating Origin ......................................... 313, 330
Automation Server, Origin as ....................... 360–59
Axis Dialog Box ............................................. 196, 209

B

B2D ................................................................. 76
Batch Peak Analysis ....................................... 296
Batch Plotting ............................................... 321
Batch Processing ........................................... 313
BDF ................................................................. 76
Binary 2D Array, Import ..................................... 76
Binary Data ...................................................... 77
BRUKER OPUS ............................................... 76
Buttons, Adding Programmable to Origin Windows366

C

CDF ............................................................... 76
CGM ................................................................ 76
Child Windows ............................................... 50
Clipboard Data, Importing ................................ 77
Code Builder ................................................... 56
Column Label Rows, Worksheet ..................... 99
Column Plot Designations .............................. 158
Column Values, Setting .................................. 110
Columns, Naming .......................................... 88
Command Window ........................................... 52
Concurrent Network ........................................ 5
Consulting .................................................... 9
Convolution ..................................................... 299
Coordinate Values, Reading/Annotating .......... 267
Coordinates, Reading/Labeling ...................... 263
Copy/Paste Graphs ........................................ 337
CSV Files ......................................................... 69
Curve Fit, Linear and Polynomial ..................... 293
Curve Fit, Nonlinear ....................................... 294–93
Curve Fitting ................................................... 267
Custom Menu Organizer ................................. 364
Customizing Menus ......................................... 363
Customizing Origin, Global Settings ............... 361
Customizing Toolbars and Buttons ................. 364

D

DAT ................................................................. 76
Data Cursor Tool ........................................... 258
Data Display ................................................... 257
Data Info Window .......................................... 261
Data Markers .................................................. 281, 283
Data Points, Deleting ...................................... 289–88
Data Points, Drawing .................................... 289
Data Reader .................................................... 257
Data Reduction, Graphs ................................ 165
Data Reduction, Worksheets ........................................... 121
Datasets, Creating .......................................................... 108
DCF ................................................................. 76
Deactivate License .......................................................... 7
Derivatives, Plot .......................................................... 267
Descriptive Statistics ......................................................... 267
Dialog Box Themes .......................................................... 316
Differentiation ................................................................. 267
Digitizing Scatter Plots ....................................................... 82
Drag and Drop Plotting ..................................................... 159
Drag-and-Drop Origin File Sharing ...................................... 373
DX ................................................................. 76
DX1 ................................................................. 76
EarthProbe ................................................................. 76
EDF ................................................................. 76
Embed Graphs, 3rd Party Applications .................................. 337
Embed Graphs, Origin Templates ......................................... 318
EPA ................................................................. 76
ETAS INCA ................................................................. 76
Excel ................................................................. 51, 70, 228, 360, 361
Exporting a Matrix .......................................................... 343
Exporting Graphs/Layout Pages .......................................... 338
Exporting Worksheets ........................................................ 342
Famos ................................................................. 76
FFT ................................................................. 267, 298
File Types, Origin .......................................................... 61
Filtering, Signal Processing .................................................. 298
FLEXnet ................................................................. 5
Full Menus ................................................................. 34
Function Plots, 2D and 3D ..................................................... 150
Gadgeted ................................................................. 15, 263, 267
Graph Gallery ................................................................. 11
Graph Layer ................................................................. 152
Graph Layer Frame ........................................................ 152
Graph Page ................................................................. 152
Graph Types ................................................................. 167
Graphical Exploration Tools, Annotation ............................. 261
Graphical Exploration Tools, Data Cursor ........................... 261
Graphical Exploration Tools, Data Info Window ...................... 261
Graphical Exploration Tools, Data Reader ............................ 261
Graphing Matrix Data ....................................................... 149–48
Graphing, Functions ......................................................... 150
Graphs, Add Data by Insert Plot to Layer ................................ 160
Graphs, Adding or Removing Plots ....................................... 159
Graphs, Adding Text & Drawing Objects .................................. 225
Graphs, Animating ........................................................... 341
Graphs, Browser ........................................................... 186
Graphs, Cloning with New Data ........................................... 321
Graphs, Copy/Paste Format ................................................. 242, 368
Graphs, Copy/Paste or Embedding ....................................... 337
Graphs, Creating ........................................................... 145
Graphs, Customizing Axes .................................................. 196, 209, 219
Graphs, Customizing Data Points ........................................ 206
Graphs, Customizing Grouped Plots ...................................... 202
Graphs, Distance Between Two Points .................................. 258
Graphs, Embed in Worksheets ............................................. 122
Graphs, Exporting ........................................................... 338
Graphs, Extract to Graphs ................................................... 234
Graphs, Extract to Layers ................................................... 234
Graphs, Function ............................................................ 150
Graphs, Insert Equation ..................................................... 228
Graphs, Inset ............................................................ 240–38
Graphs, Labeling a Data Point ............................................. 228
Graphs, Layer Contents Dialog Box ..................................... 160
Graphs, Layer Customizations ............................................ 198
Graphs, Legend Customization ............................................ 219
Graphs, Linking Axis Scales ................................................. 236
Graphs, Listed by Type ...................................................... 168, 172, 175, 177, 180, 183, 186, 188
Graphs, Merge ............................................................. 197
Graphs, Plot Details ........................................................ 196, 199
Index

Graphs, Reading Coordinate Values .................. 253
Graphs, Reorder Layers .................................. 236
Graphs, Save Format as Theme .......................... 198
Graphs, Saving Custom Templates .................... 198
Graphs, Scaling Objects ................................ 232
Graphs, Send to PowerPoint .............................. 340
Graphs, Slide Show ......................................... 341
Graphs, Speed Mode ....................................... 165
Graphs, Template Library .................................. 198
Graphs, Templates .......................................... 241
Graphs, Theme Organizer .................................. 243
Graphs, Themes .............................................. 242, 368
Group Folder Manager ..................................... 374
Grouping Plots ................................................ 164

H
H5 ................................................................ 76
HDF5 .............................................................. 76
HE ................................................................ 76
HEKA .............................................................. 76
Help Files, Updating ........................................... 9
Hiding Worksheet Columns .................................. 119
Hints, Software ................................................ 54
HPF ................................................................ 76
HYP ................................................................ 76

I
IBW ................................................................. 76
IgorPro ............................................................ 76
Image Processing ............................................. 16, 300
Image Profile .................................................. 267
Image, Import .................................................. 267
Images, Matrix ................................................ 127
IMG ................................................................. 76
Import Wizard ................................................... 74
Importing, Filter Files (OIF) .............................. 61
imzML ............................................................. 76
Installing Origin .............................................. 3
Integration ...................................................... 267
Interpolation .................................................... 267
ISF ................................................................. 76
J
JCAMP ............................................................. 76
JCAMP-DX ....................................................... 76
JCM ................................................................. 76
JDX ................................................................. 76
JNB ................................................................. 76
K
KaleidaGraph .................................................. 76

L
LabTalk .......................................................... 356
LabVIEW™ ..................................................... 360
Layer Contents Dialog Box .............................. 160, 164
Layer Icon, Graph ............................................ 152
Layers, Graph .................................................. 152
Layout Pages, Exporting ................................... 338
Legend, Box Charts ......................................... 222
Legend, Bubble Scales ....................................... 222
Legend, Color Scales ......................................... 222
Legend, Customizing ....................................... 197, 219
Legend, Update vs. Reconstruct ........................ 221
License Management ........................................ 3
License, Dongle ............................................... 5
License, Maintenance ....................................... 6
License, Node-locked ....................................... 5
License, System Transfers ................................. 7
Limitations, Matrix .......................................... 125
Limitations, Workbook .................................... 104
Limitations, Workbooks ................................... 87
Lock, Recalculate ............................................ 314

M
Magnifying Graphs ........................................... 248
Manual Recalculate ......................................... 314
Masking Data, Graphs ....................................... 286
Masking Data, Remove or Disable Mask ............... 286
Masking Data, Worksheets ................................. 286

397
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mat</td>
<td>76</td>
</tr>
<tr>
<td>Math Tools, Area/Volume</td>
<td>292</td>
</tr>
<tr>
<td>Math Tools, Basic</td>
<td>290</td>
</tr>
<tr>
<td>Math Tools, Interpolation</td>
<td>291</td>
</tr>
<tr>
<td>MATLAB</td>
<td>76</td>
</tr>
<tr>
<td>Matrix Image Thumbnails</td>
<td>135</td>
</tr>
<tr>
<td>Matrix Objects</td>
<td>129</td>
</tr>
<tr>
<td>Matrix Objects, Naming</td>
<td>125</td>
</tr>
<tr>
<td>Matrix Organizer</td>
<td>135</td>
</tr>
<tr>
<td>Matrix Templates</td>
<td>135</td>
</tr>
<tr>
<td>Matrix, Converting to Worksheet</td>
<td>140</td>
</tr>
<tr>
<td>Matrix, Converting Worksheet Data</td>
<td>139</td>
</tr>
<tr>
<td>Matrix, Data Mode vs. Image Mode</td>
<td>127</td>
</tr>
<tr>
<td>Matrix, Exporting</td>
<td>343</td>
</tr>
<tr>
<td>Matrix, Manipulating Data</td>
<td>136</td>
</tr>
<tr>
<td>Matrix, Profiling</td>
<td>142</td>
</tr>
<tr>
<td>Matrix, Script Panel</td>
<td>135</td>
</tr>
<tr>
<td>Matrix, Set Values</td>
<td>136</td>
</tr>
<tr>
<td>Matrix, Virtual</td>
<td>134</td>
</tr>
<tr>
<td>Matrixbooks, Naming</td>
<td>125</td>
</tr>
<tr>
<td>Matrixsheets, Naming</td>
<td>125</td>
</tr>
<tr>
<td>MDF</td>
<td>76</td>
</tr>
<tr>
<td>Menus</td>
<td>34</td>
</tr>
<tr>
<td>Menus, Customizing</td>
<td>363</td>
</tr>
<tr>
<td>Menus, Organizer</td>
<td>35</td>
</tr>
<tr>
<td>Messages Log</td>
<td>56</td>
</tr>
<tr>
<td>Minitab</td>
<td>76</td>
</tr>
<tr>
<td>Modifying Toolbars</td>
<td>364</td>
</tr>
<tr>
<td>Movies, Animating Graphs</td>
<td>341</td>
</tr>
<tr>
<td>MPJ</td>
<td>76</td>
</tr>
<tr>
<td>MTW</td>
<td>76</td>
</tr>
<tr>
<td>Multivariate Analysis</td>
<td>14</td>
</tr>
<tr>
<td>Multivariate Statistics</td>
<td>309</td>
</tr>
<tr>
<td>mzData</td>
<td>76</td>
</tr>
<tr>
<td>mzML</td>
<td>76</td>
</tr>
<tr>
<td>mzXML</td>
<td>76</td>
</tr>
<tr>
<td>NAG Numerical Library</td>
<td>359</td>
</tr>
<tr>
<td>Naming Columns</td>
<td>88</td>
</tr>
<tr>
<td>Naming Matrix Objects</td>
<td>125</td>
</tr>
<tr>
<td>Naming Matrixbooks</td>
<td>125</td>
</tr>
<tr>
<td>Naming Matrixsheets</td>
<td>125</td>
</tr>
<tr>
<td>Naming Workbooks</td>
<td>88</td>
</tr>
<tr>
<td>Naming Worksheets</td>
<td>88</td>
</tr>
<tr>
<td>National Instruments</td>
<td>76</td>
</tr>
<tr>
<td>National Instruments™ LabVIEW™</td>
<td>360</td>
</tr>
<tr>
<td>NC</td>
<td>76</td>
</tr>
<tr>
<td>NetCDF</td>
<td>76</td>
</tr>
<tr>
<td>Networks, Concurrent</td>
<td>5</td>
</tr>
<tr>
<td>Networks, Installation</td>
<td>5</td>
</tr>
<tr>
<td>Networks, Multi-seat Node-locked</td>
<td>3</td>
</tr>
<tr>
<td>New Features</td>
<td>19</td>
</tr>
<tr>
<td>NI DIAdem</td>
<td>76</td>
</tr>
<tr>
<td>NI TDM</td>
<td>76</td>
</tr>
<tr>
<td>Non-parametric Statistics</td>
<td>308</td>
</tr>
<tr>
<td>Numbers in Origin</td>
<td>57</td>
</tr>
<tr>
<td>Object Linking and Embedding (OLE)</td>
<td>337</td>
</tr>
<tr>
<td>Object Manager</td>
<td>49, 153, 162</td>
</tr>
<tr>
<td>OGG Files</td>
<td>61</td>
</tr>
<tr>
<td>OIF Files</td>
<td>61</td>
</tr>
<tr>
<td>OpenGL</td>
<td>363, 375</td>
</tr>
<tr>
<td>OPX Files</td>
<td>374</td>
</tr>
<tr>
<td>Orglab</td>
<td>360</td>
</tr>
<tr>
<td>Origin C</td>
<td>359</td>
</tr>
<tr>
<td>Origin C, IDE</td>
<td>56</td>
</tr>
<tr>
<td>Origin Viewer</td>
<td>375</td>
</tr>
<tr>
<td>Origin Workspace</td>
<td>33</td>
</tr>
<tr>
<td>Origin, Display Language</td>
<td>7</td>
</tr>
<tr>
<td>Origin, License Deactivation</td>
<td>7</td>
</tr>
<tr>
<td>Origin, Licensing</td>
<td>3</td>
</tr>
<tr>
<td>Origin, New Features</td>
<td>19</td>
</tr>
<tr>
<td>Origin, Registering</td>
<td>5</td>
</tr>
</tbody>
</table>

398
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin, Service Releases</td>
<td>6</td>
</tr>
<tr>
<td>Origin, Sharing Files</td>
<td>373</td>
</tr>
<tr>
<td>Origin, System Transfers</td>
<td>7</td>
</tr>
<tr>
<td>Origin, Uninstalling</td>
<td>7</td>
</tr>
<tr>
<td>Origin, Upgrading</td>
<td>3</td>
</tr>
<tr>
<td>OriginPro, Features</td>
<td>13</td>
</tr>
<tr>
<td>Orthogonal Regression</td>
<td>13</td>
</tr>
<tr>
<td>OTM Files</td>
<td>61</td>
</tr>
<tr>
<td>OTW Files</td>
<td>105</td>
</tr>
<tr>
<td>P</td>
<td>152</td>
</tr>
<tr>
<td>Page, Graph</td>
<td>152</td>
</tr>
<tr>
<td>Panning Graphs</td>
<td>248</td>
</tr>
<tr>
<td>parametric function plots</td>
<td>150</td>
</tr>
<tr>
<td>Parametric Function Plots, 2D and 3D</td>
<td>150</td>
</tr>
<tr>
<td>pClamp</td>
<td>76</td>
</tr>
<tr>
<td>pCLAMP</td>
<td>76</td>
</tr>
<tr>
<td>Peak Analysis</td>
<td>14, 267, 296</td>
</tr>
<tr>
<td>Pivot Tables</td>
<td>119</td>
</tr>
<tr>
<td>Plot Designation</td>
<td>147</td>
</tr>
<tr>
<td>Plot Details Dialog Box</td>
<td>153, 199</td>
</tr>
<tr>
<td>Plot Setup Dialog Box</td>
<td>154, 161, 165</td>
</tr>
<tr>
<td>Plots, Exchanging</td>
<td>158</td>
</tr>
<tr>
<td>Plotting Virtual Matrix Data</td>
<td>149</td>
</tr>
<tr>
<td>Plotting Worksheet Data</td>
<td>148–47</td>
</tr>
<tr>
<td>PowerPoint, Exporting to</td>
<td>340</td>
</tr>
<tr>
<td>Preferences</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td>361</td>
</tr>
<tr>
<td>Princeton Instruments</td>
<td>76</td>
</tr>
<tr>
<td>Prism</td>
<td>76</td>
</tr>
<tr>
<td>Profiling Images</td>
<td>142</td>
</tr>
<tr>
<td>Profiling Matrix Data</td>
<td>142</td>
</tr>
<tr>
<td>Programming Origin</td>
<td>330, 355</td>
</tr>
<tr>
<td>Programming Origin, LabTalk</td>
<td>356–55</td>
</tr>
<tr>
<td>Programming Origin, Origin C</td>
<td>359</td>
</tr>
<tr>
<td>Programming Origin, R</td>
<td>358</td>
</tr>
<tr>
<td>Programming Origin, X-Functions</td>
<td>359</td>
</tr>
<tr>
<td>Project Explorer</td>
<td>41</td>
</tr>
<tr>
<td>PXP</td>
<td>76</td>
</tr>
<tr>
<td>Python</td>
<td>357</td>
</tr>
<tr>
<td>PZFX</td>
<td>76</td>
</tr>
<tr>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>QDA</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td></td>
</tr>
<tr>
<td>R 358</td>
<td></td>
</tr>
<tr>
<td>RAW</td>
<td>76</td>
</tr>
<tr>
<td>REC</td>
<td>76</td>
</tr>
<tr>
<td>Recalculate</td>
<td>314</td>
</tr>
<tr>
<td>Recalculation of Results</td>
<td>314</td>
</tr>
<tr>
<td>Region of Interest</td>
<td>127</td>
</tr>
<tr>
<td>Region of Interest (ROI)</td>
<td>263, 264, 267, 290, 291, 292, 294, 296, 324</td>
</tr>
<tr>
<td>Regional Data Selector</td>
<td>279</td>
</tr>
<tr>
<td>Re-Importing</td>
<td>84</td>
</tr>
<tr>
<td>Repetitive Tasks, Filters for</td>
<td>328</td>
</tr>
<tr>
<td>Reports, Analysis</td>
<td>325</td>
</tr>
<tr>
<td>Rescaling Graphs</td>
<td>248</td>
</tr>
<tr>
<td>Results Log</td>
<td>56</td>
</tr>
<tr>
<td>Rise Time</td>
<td>267</td>
</tr>
<tr>
<td>ROC Curve</td>
<td>310</td>
</tr>
<tr>
<td>Sample Projects</td>
<td>9</td>
</tr>
<tr>
<td>SAS</td>
<td>76</td>
</tr>
<tr>
<td>sas7bdat</td>
<td>76</td>
</tr>
<tr>
<td>SAV</td>
<td>76</td>
</tr>
<tr>
<td>Screen Reader</td>
<td>257</td>
</tr>
<tr>
<td>Scripting</td>
<td>356</td>
</tr>
<tr>
<td>Selecting Data, Graph</td>
<td>276</td>
</tr>
<tr>
<td>Selecting Data, Worksheet</td>
<td>273</td>
</tr>
<tr>
<td>Set Column Values, Worksheet</td>
<td>110</td>
</tr>
<tr>
<td>Set Matrix Values</td>
<td>136</td>
</tr>
<tr>
<td>Sharing Files with Multiple Users</td>
<td>374</td>
</tr>
<tr>
<td>Sharing Origin Files</td>
<td>373, 374</td>
</tr>
<tr>
<td>SIE</td>
<td>76</td>
</tr>
<tr>
<td>SigmaPlot</td>
<td>76</td>
</tr>
<tr>
<td>Sigmoidal Fit</td>
<td>267</td>
</tr>
</tbody>
</table>
Signal Processing .............................................. 15
Signal Processing, Coherence ........................... 299
Signal Processing, Correlation ........................... 298
Signal Processing, Decimation ........................... 299
Signal Processing, Envelope Curves .................... 299
Signal Processing, Filtering ............................... 298
Signal Processing, Rise Time ............................. 299
Signal Processing, Smoothing ........................... 298
Signal Processing, Transforms .......................... 297
Slide Show of Graphs ....................................... 341
Smart Hints ...................................................... 54
Smoothing ..................................................... 298
Somat .................................................................. 76
Sorting Worksheet Data ................................... 119
Sparklines ........................................................ 102
SPC .................................................................. 76
SPE .................................................................. 76
SPSS .................................................................. 76
SQL Data .......................................................... 80
Statistics ......................................................... 14, 263, 267
Statistics, Basic ............................................... 301
Statistics, Charts ............................................. 305
Statistics, Data Selection ................................. 304
Statistics, Descriptive ...................................... 301
Statistics, Multivariate ..................................... 14
Statistics, Report to Script/Command Window .... 304
Statistics, Report to Status Bar .......................... 304
Status Bar ........................................................ 54
Surface Fit ........................................................ 294
Surface Fitting, 3D ............................................. 14
Survival Analysis .............................................. 310
System Transfer ............................................... 7
System Variables .............................................. 363
TDM .................................................................. 76
TDMS .................................................................. 76
Technical Support ............................................ 9
Tektronix .......................................................... 76
Templates ........................................................ 366
Templates, Analysis ........................................... 122, 319, 325
Templates, Matrix ............................................. 135
Templates, Project ............................................ 318
Templates, Workbook ....................................... 105, 318
Theme Organizer ............................................. 198, 243, 369
Themes ........................................................... 366
Themes, Dialog Box ......................................... 316
Themes, File Types .......................................... 61
Thermo ............................................................ 76
Toolbar Bitmaps, in Menus ............................... 364
Toolbar Buttons, Custom ................................. 365
Toolbars and Buttons, Customizing .................... 364
Toolbars, Customizing ..................................... 35
Training ........................................................... 9
Transfer User Files ............................................ 5
t-Tests ........................................................... 308
Tutorials, Help File .......................................... 9
Tutorials, Video ................................................ 10
U
Update Legend ................................................. 197
Upgrading Origin .............................................. 3
User Files Folder (UFF) ................................. 4, 373
User Files, Transferring .................................... 3
User Forum ..................................................... 9
V
Video Builder .................................................. 341
Virtual Matrix .................................................. 134
Visual Basic/Visual C/C# ................................. 360–59
W
WAV .................................................................. 76
Wavelet Analysis ............................................. 299
Windows, Dock/Float/Auto-Hide ................. 57
Workbook Organizer ....................................... 103
Workbook Templates ....................................... 105
Workbooks, Naming ....................................... 88
Index

Worksheet Column Label Rows ......................... 99
Worksheet Column Properties ........................... 94
Worksheet Plot Designations ......................... 152
Worksheets, Converting from Matrix ............. 140
Worksheets, Converting to Matrix ................ 139
Worksheets, Exporting ................................ 342
Worksheets, Naming ................................... 88
Worksheets, Processing Data ....................... 119
Worksheets, Set Column Values ...................... 110
Worksheets, Sorting Data .............................. 119
Worksheets, Transposing Data ..................... 119

X
X-Functions ............................................. 359

XML ....................................................... 76

Z
Zooming Graphs ........................................ 248